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1 - INTRODUCTION 

INTRODUCTION 
SADiE™ has been designed to be simple and intuitive to learn and use. Despite this, you will find the manual 
and on-screen help valuable in explaining the underlying concepts of the system, suggesting methods of 
completing common tasks, and as a technical reference. We have tried to keep the manual and on-screen help 
as concise and clear as possible. In a comprehensive and professional system such as SADiE, there are many 
methods for performing specific tasks and you will develop your own methods as you become more familiar 
with the system. 

Getting Started explains the concepts behind the system and the terminology used and gives you a quick guide 
to getting your system working for you. The Tutorial provides a step-by-step guide to editing. It is 
recommended that you have a go at this first to save you time later. 

Recording, Using the Playlist, Arranging an EDL, Editing, Mixing, and File Management provide details about 
common tasks. 

Specific Applications contains notes on operations relevant to more specialised areas of work.  

Customising SADiE explains the user settings available for changing the way the system works or how it 
appears on screen. 

Please take a little time to read the manual; it will pay off in time saved later. If you cannot find the answer to a 
problem in the manual or this help file, then please contact our technical support. 

To Access the SADiE Web site go to www.sadie.com, oder Unsere deutschen Seiten www.sadie.de 

See also the Software Licence Agreement.  

MOVING AROUND THE HELP FILE 
Words that are blue and underlined contain jumps to other topics, pop-up information, and hyperlinks to the 
Internet. Some graphics have jumps and pop-ups associated with them. Some larger graphics have multiple 
"hot" areas, click on buttons to see descriptions and other links. 

To navigate around the help file, use the arrow buttons at the top to turn the pages of the chapter. 

Throughout the help file the following symbols have been used: 

 
For other operations on the screen using the mouse. 

 
For operations using the hardware controllers. 

 
Where a specified function is available as a Hotkey. Please see the Hotkey Setup section for details 
on how to set your Hotkeys. 

The following terms are used in describing mouse movements: 

Click Press and release the left mouse button once. To "press" an on-screen button, point at it and 
single-click. 

Double-Click Quickly press and release the left mouse button twice. 

Right-Click Press and release the right mouse button. 

Drag Click and hold the left mouse button over the chosen item, move it with the mouse to a new 
position, and then release the button. 
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Right-button clicking with the mouse over many areas gives you a menu of alternatives for that part of the 
screen; remember to try this everywhere! On screen button names will be printed in BOLD, and their picture 
shown in the margin. 

Hardware controller instructions will usually follow the mouse description, and the controller's button names 
will be printed in BOLD. The SHIFT button of the hardware controller is used in conjunction with other 
buttons (e.g. SHIFT + MUTE is the solo function), but it does not need to be held down. The function keys 
F1-F12 can be set by the user (see Customising SADiE). Hardware controller users should also read all the 
mouse instructions. See the look up table of Hardware Controller Functions. 

The computer keyboard is used for typing in names, and for Hotkeys, which are useful shortcuts to many 
functions. They can be customised to your own preference and so are not referred to at every point in the 
manual; look up the default Hotkey settings in Customising SADiE. 

On the keyboard you will use the Shift key (marked ), the Control (marked Ctrl) key, the Alt. Key and the 
Return ( ) key (duplicated by the Enter key). 

Ctrl + X means hold the Control key while pressing the X key.  

LICENCE AGREEMENT 
This legally binding agreement is between you (either an individual or a single entity), the dealer or distributor, 
and Studio Audio and Video Ltd (referred to herein as SADiE). 

SADiE retains ownership in all its software in any form and its use by you is governed exclusively by this 
agreement, which is to be interpreted and enforced under English law. This agreement also sets out the limited 
warranties provided by SADiE in relation to the software. You agree to the terms of this agreement by 
installing and/or using the software package. 

If you do not agree with the terms of this agreement, do not install the software onto your hard disk. Return 
the software together with all documentation, packaging and associated hardware purchased for a full refund if 
applicable less any handling charges notified to you by your distributor. 

SADiE SOFTWARE LICENCE 

SADiE makes this software (the Software) available for the support of the hardware product (the Hardware) 
with which it is supplied provided that you comply with all terms and conditions of this agreement. The 
software comprises executable programs that perform specific tasks and tools. The sale price of the digital 
audio system includes the software licence fee. 

The use of the software with any hardware other than that manufactured by SADiE (with the exception of the 
computer system to which the hardware is physically attached) is expressly forbidden. 

 

RIGHTS AND LIMITATIONS 

You may: 

1. Make safety backup copies of the Software and transfer the Software to the hard disc of the computer 
or computers to which the supplied hardware is to be connected, provided that these copies are not 
supplied to any third party. 

2. Use the software programs and tools on the machine or machines onto which they have been copied 
as permitted in item 1 above. 

3. Use the documentation that accompanies the Software for internal, non-commercial reference 
purposes only. 

 

You must not: 

1. Disclose or make the software available in any form to third parties. 

2. Reverse engineer, decompile, disassemble or otherwise inspect the workings of software in object or 
executable form. 

3. Assign the benefit of this agreement to any third party. 

4. Install the Software or future updates or upgrades if you are not using a licensed copy of the Software. 
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5. Use the software in any application where there is risk of life or accidental harm to persons. 

6. Distribute the software to any third party without the express written permission of SADiE. 

 

RESERVATION OF RIGHTS AND OWNERSHIP 

SADiE reserves all rights not expressly granted to you in this agreement.  The Software is protected by 
copyright and other intellectual property laws and treaties. SADiE owns the title, copyright, and other 
intellectual property rights in the Software.  The Software is licensed, not sold.  This agreement does not grant 
you any rights to trademarks or service marks of SADiE. 

 

TERMINATION 

1. You terminate this licence by selling some or all the hardware with which it is supplied. SADiE will 
provide a new software licence to the purchaser on payment of a registration and licence fee. 

2. You also terminate this agreement by violating any of its conditions. 

3. The licence fee is not refundable on termination. 

4. On termination, all copies of the software in your possession must be destroyed, and the original disks 
returned to SADiE. 

MEDIA WARRANTY AND EXCLUSION OF WARRANTY 

1. The physical media on which the software is distributed is supplied with the same warranty conditions 
as the hardware. The software is made available with no warranties whatsoever. It is up to you the 
user to determine that the software is suitable for the purposes to which you intend to put it. Whilst 
every effort is made to ensure its correctness, SADiE cannot anticipate all the uses to which the 
software may be put. SADiE does not accept any liability for the software failing to perform in any 
way, whether by design or through negligence and whether used on its own or in conjunction with 
other software. 

2. Neither SADiE nor its employees, distributors, or anyone involved in the manufacture or supply of the 
software shall be liable for any losses due to the use of, misuse of or the inability to use the software 
whether direct, indirect, consequential or incidental. 

3. Any liability that may be determined to be SADiE's or its employees', distributors' or others shall be 
limited to the purchase price of the hardware with which this software is supplied and which together 
comprise SADiE. 

LAW 

1. This agreement is governed by English law. In the event that any terms are found to be invalid by a 
court of law, the remainder of the agreement remains in force to the extent that it can be interpreted. 

2. This agreement is the entirety of the agreement between you and SADiE. No verbal or written 
variation is in force, whether to vary to the terms of this agreement, or to imply any suitability of the 
software for any specific purpose. 

All queries relating to this agreement should be addressed in writing to the registered office: 

SADiE UK, The Old School, High Street, Stretham, Ely, Cambridge, CB6 3LD,  

 

 

COPYRIGHT NOTICE 
This user manual is provided for use by bona-fide customers of Studio Audio & Video Ltd. for use in the 
support of the SADiE BB2 and BB2-J products. All other uses are expressly forbidden.  Whilst we have made 
every effort to ensure that the information in this manual is correct at the time of going to press, Studio Audio 
and Video Limited can accept no liability for any errors or mis-statements it may contain. We reserve the right 
to change specifications without notice in the interests of product improvement. No part of this manual may be 
reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying and 
recording, for any purpose without the express written permission of Studio Audio and Video Limited. 
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Copyright © Studio Audio and Video Limited, 1991 - 2004. All rights reserved. 

Studio Audio & Video Ltd. reserves the right to make changes to specifications at any time and without prior 
notice. The information contained herein is believed to be accurate and reliable, however, no responsibility is 
assumed by Studio Audio & Video Ltd. for its use, nor for any infringement of patents or other rights of third 
parties resulting from its use. 

Errors and Omissions Excepted. 

Reference is made to the following in this manual: 

Microsoft and MS-DOS are registered trademarks and Windows is a trademark of the Microsoft Corporation. 

USB is a trademark of the Universal Serial Bus Implementers Forum Inc.  

SADiE is a trademark of Studio Audio and Video Limited 

Other brand and product names are trademarks or registered trademarks of their respective holders 
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2 - GETTING STARTED 

GETTING STARTED 
Digital Audio Editing 

SADiE Systems 

SADiE Basics 

Tutorials 

Basic Tutorial 

Post Tutorial 

DIGITAL AUDIO EDITING 
Traditional analogue audio is a continuously varying electrical signal representing (analogous to) the sound 
waves that produced it. This can be stored on tape as a varying magnetic image and on vinyl as physical 
variations in the wall of the groove. With digital audio, this signal is sampled (measured) very frequently and so 
converted to a stream of numbers. These numbers are kept in binary form (that consists of only ones and 
zeroes), which can be stored on a digital storage medium, such as a computer hard disk. They can later be read 
back and re-converted to recreate the analogue waveform. Digital audio is not subject to the same 
deterioration as analogue and is in a form that can be manipulated by computer software. 

In SADiE™, the digital audio is stored on dedicated hard disk drives. The SADiE software can achieve complex 
editing and mixing operations by telling the computer to find and play back different sections of the audio on 
the hard disks at different times, or simultaneously. This has the effect of cutting sections out, varying the 
running order and mixing sections together, although the material recorded on the hard disks actually remains 
unchanged; it is only the instructions for replaying it that are altered. The great advantage of this is that edits 
can always be undone and many different versions of the same edit can be produced (hence the term "non-
destructive editing").  

SADIE SYSTEMS 
A SADiE system will comprise a host computer (which displays the user interface on a monitor and tells the 
system what you want it to do), running the SADiE software and specialised audio hardware, appropriate to 
the system you have bought. The hardware consists of Digital Signal Processing (DSP) cards connected directly 
to one or more hard disk drives that store the digital audio. 

The DSP cards are dedicated to handling the audio to professional standards, leaving the host computer's 
power free to handle the control and display functions of the interface. This is modelled on the familiar studio 
concepts of a multi-track tape machine, razor blade, mixing desk, etc. Just like a tape recorder, the system has 
inputs for recording material in and outputs for playing it out again. The difference is you can do a lot more 
with it while it is in SADiE. 

This current version of SADiE 5 can be operated on a number of different hardware platforms:- 

PCM-H64 

PCM8 

PCM4 

DSD8 

BB2 

There are some small variances in software functionality between the platforms as described in the "Additional 
Notes".section 
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SADIE BASICS 
NOTE: SADiE v5 software uses the Microsoft® Windows 2000, or XP operating systems. If you are not 
familiar with Windows and the use of a mouse, it would be a good idea to go through the "Windows 
Fundamentals" chapter of the Microsoft Windows User Guide. Modern operating systems may not have 
printed documentation, but a Help file is always available by pressing the START button on the 
Windows Taskbar, and selecting HELP from the menu.  

SADiE is modelled very closely on the traditional studio concepts of a multi-track tape machine and mixing 
desk. These are represented by the Playlist and the Mixer . There is a flexible routing path between the 
system's physical inputs, the Streams of the Playlist, the Mixer's channel strips and the physical outputs. Audio 
processing such as Equalisation and Dynamics may be done in the Mixer and can be automated, whilst virtual 
outboard units provide other processes. Most of the editing functions are performed in the Playlist, and a Trim 
Editor is available for detailed edit adjustment.  

USER MANAGEMENT BASICS 

There is a separate User Management application (program) for multi-user SADiE installations where security is 
important. This application can only be run by designated SADiE System Administrators, and allows the 
database of users and their passwords to be altered. User Management describes the use of this application in 
detail. 

User management provides: 

1. Password security to stop unrecognised users starting SADiE. 

2. Privilege levels for different SADiE users - some users may be allowed to record and edit, others to 
play back only. 

The Project system, (as described in File Management), can also restrict user access to Projects. 

If you do not need the full user management facility, the first time you run SADiE v5, you will be asked for your 
user name and logged as the single user. To later add the security of a password, select "Change Password" in 
the File menu.  

STARTING SADIE 

In this manual, the illustrations assume that your computer is running with a display resolution of 1024 x 768. If 
you want to change this, see Changing Screen Resolution. 

Turn on your computer and let the operating system boot up. If you have bought a Turnkey system, double-
click on the SADiE shortcut on your desktop. If it is not there, press the Start button on the Windows Taskbar 
then Programs, the SADiE group, and finally select SADiE. 

You are presented with a box to log in to the system. If you are starting SADiE for the first time, you will be 
asked for a user name. In a multi-user installation that has been already set up, you will need to type your user 
name and password. If you have a DSD system you will also see a tick box, asking you if you want to start in 
PCM or DSD mode. 

The following Project Start-up box will appear: 
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Select "Create a new Project" as this will keep all your work together for the following tutorial. A box will 
appear asking you to name the Project. Type "Tutorial" as the Project name (replacing the default "projname" in 
the box) and click the "Create" button. If you have more than one disk on your system you will now be asked 
which disk you want to record onto. Select one from the list or check the "Least Full Disk" box and click "OK". 
The main SADiE window will now appear. 

NOTE: We recommend that users hide the Windows Taskbar in order to maximize the available screen 
area for SADiE. If your Taskbar is appearing on top of the SADiE window, right-click on the Taskbar and 
select "Properties". Under the "Taskbar Options" section, deselect "Always on top". You can then 
activate the start button by pressing Ctrl + Esc, and switch between applications with Alt +Tab. 

NOTE on CD-R: If you are intending to create CD-R's fairly regularly, it would be a good idea to enable 
this function now. Press the "View" menu, select "Setup Window", click on "PQ Settings" on the left side 
of the page, and tick the box marked "Enable PQ Editing Features". Close Setup, (by clicking the close 
window button ). Now Delete this empty project; go to the Project menu, select Delete project and 
answer "Yes" to all the warning messages. Then go to the Project menu again, this time select "New 
project", name it "Tutorial" again, and continue. It is not a problem if you don't do this now, but it will 
save you a few mouse clicks later on when you come to write a CD-R.  
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THE DISPLAY 

 

1. Menu Bar 

2. Playlist  

3. Playlist toolbar 

4. Mixer  

5. Mixer Toolbar 

6. Status Bar 

7. Minimised Clipstore  

8. Transport Controls 

9. Project Window 

The main SADiE window, filling the whole screen, has a title bar and menu bar in common with most Windows 
applications. The menu bar contains words that reveal drop-down menus with commands for setting-up, file 
handling and display functions. For example, the File menu is displayed by clicking on the word "File". Windows 
has quick keyboard shortcuts to all menu commands; press Alt + the underlined letter of the menu you want, 
and then the underlined letter of the command you want. SADiE's menu commands are listed in the Index (of 
both the help file and the user manual) under each menu name, with references to the relevant sections of the 
manual / help file. 

 
For most common tasks, however, the system has been designed to be operated by pressing on-
screen buttons (by pointing and clicking with the mouse), or by using the hardware controllers. 
Buttons on the screen have a 3-D appearance and should look "depressed" in their On position. 

At the bottom of the screen, the status bar describes on screen buttons when you point at them. This bar can 
also be customised to display and control certain settings affecting the way SADiE is working. Additionally, 
most menu commands and button actions can be programmed for performance by SADiE's own Hotkeys on 
the computer keyboard, and by hardware controller function buttons. 

The rest of the screen is a work area within which are displayed windows such as the Playlist, Mixer and 
Clipstore. Like all windows, these can be opened, closed, moved around or re-sized with the mouse. Different 
arrangements of your screen can be stored as desktop files, and reloaded when you want. This will be very 
useful when switching between tasks. 
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For now, let's stick with the default desktop supplied. However many windows are on screen only one will be 
active, indicated by a coloured title bar. 

 
Clicking the mouse within a window always makes it become the active one and appear on top of any 
that may overlap it. The list at the bottom of the Window menu shows all open windows and is 
useful for quickly making an obscured one active or restoring a minimised one to size. 

 
On the hardware controllers the WINDOW button cycles through them. 

NOTE: Many of the menu bar commands are dependant on the active window. For example "Save" 
under the File menu will save the EDL file when the Playlist is the active window, and the Clipstore file 
when the Clipstore is active. 

Each window has one or more toolbars containing buttons relevant to it. These toolbars can be attached to 
different parts of the window, hidden, or floated and moved somewhere else on the screen. Floating toolbars 
always appear on top of windows. Right-click over the toolbar to see the options. The icons on buttons are 
shown in faint outline when their actions are not available. 

 
 

1. Current Time 
Display 

2. Rewind 

3. Fast Forward 

4. Stop 

5. Play 

6. Record 

7. Pause 

The Transport Controls are a permanently active, floating toolbar used to control the whole system. 
Therefore they will always have a coloured title bar and appear on top of any overlapping windows. The tabs 
along the top indicate which sections of the Controls are displayed. The basic Transport section contains 
familiar tape-machine type buttons, a current-time display and an "Online" button which enables timecode and 
external machine synchronisation. On the keyboard, the spacebar duplicates Play and Stop. 

You can close the Transport Controls (by clicking the close window button ) when you don't need them 
taking up screen space, and reopen them again under the "View" menu, or by pressing F10. A miniature 
current-time display and Play and Stop buttons can be displayed on the status bar by selecting it in SADiE's 
Setup window. 

 
PLAY, STOP, RECORD, PAUSE and ONLINE are duplicated on the hardware controllers. 

ON-SCREEN HELP 

Resting the mouse pointer over a button displays the button name in a yellow box, and the status bar at the 
bottom of the screen describes its action. 

SADiE also has a Help File, which you can see by clicking on "Help" in the menu bar, then selecting "Help on 
SADiE v5" (but you've already had some success on that front, otherwise you wouldn't be here, would you?) 
This help file is similar in terms of text and structure to the manual, however there are a few additional topics 
(and tips) in the help file. The latest help file will always be available in the downloads area of our web site, if 
you choose not to install it with the software. 

Another advantage of the help file is its searching facilities - pressing the INDEX button allows you to type in 
words/functions/buttons etc. to search for and the Help topic will be displayed instantly. Additionally the 
SEARCH button will allow you to search through the Help file for occurrences of any word you type.  
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TUTORIALS 
There are two separate tutorials in this manual. 

The first Basic Tutorial section describes recording and simple editing, in a situation where synchronisation is 
of no concern. This Tutorial is ideal for learning the basic ideas involved when working for instance for radio, 
music or CD Pre-mastering. If you are working in mastering, you will also want to look at the later CD-
Mastering section in the "Specific Applications" chapter, to find out how to write your finished edits to a CD 
master. 

The second Post Tutorial is aimed at applications involving sync to picture - the techniques are similar, indeed a 
lot of the tutorial will be much the same. 

For either of these tutorials you will need some audio material, and the SADiE will need to be connected to 
appropriate devices for recording this material, and listening to it.  

BASIC TUTORIAL 

This section will take you through simple recording and editing. You will need to find some source material - 
ideally a piece of speech material and a couple of short music tracks. It is recommended that you do this 
tutorial to save time later. The editing involved is quite basic, and it will serve as a good exercise whatever your 
area of work. You need to have already been through the Starting SADiE section above.  

CONNECTIONS 

Your connections will depend on your source material; if its coming from an analogue source you will need to 
connect a line level signal (via a mixing desk if you wish) to analogue inputs 1&2. If your signal is digital then 
choose the appropriate connection. Connect outputs 1&2 to your monitoring system.  

RECORDING MATERIAL INTO SADIE 

You are about to record three Tracks. First, a voice piece that will require editing, then two short pieces of 
music to mix in with the edited speech. Speech is best to demonstrate basic editing because it is quick and easy 
to make edits that are obvious, but choose any material you feel would be best. 

For simplicity, all the audio for this tutorial will be stereo, so you should create a stereo Stream in the Playlist 
at this point. First right-click over the small Stream control buttons of Stream 1. 

 

Select "Merge into Stereo Stream". Streams 1&2 will then be combined into a stereo Stream with a single set of 
control buttons. Now do the same on Stream 3 to merge Streams 3&4 into a stereo Stream, which will be 
used later. 

NOTE: In future you should identify mono material and save space on your audio disk by recording it as 
mono Tracks. See Recording. 

AUDIO SETUP 

Open up the Record section of the Transport Controls by clicking on the Record tab. 



Getting Started 

11 

 
Press SETUP. This will open the Audio section of SADiE's Setup window. 

 
Select the input source appropriate to your input equipment, and the Sample Rate and input resolution 
appropriate to your workplace. 
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NOTE: If you are not sure which sample rate to use it is worth consulting your engineering staff. 
Choosing the wrong sample rate when recording can give you problems later on. 

Whilst in Setup, check another setting that determines how the inputs are monitored. Click on "Mixer " on the 
left side of the Setup window, and towards the bottom, check that "E-E on record enabled streams" is ticked. 

Close the Setup window (by clicking the close window button ). 

PREPARING TO RECORD 

 
Press SHOW ALL PROFILES in the top left corner of the Playlist, or F12 on the keyboard or 
Hardware controller to change the EDL Entries from blocks to profiles (which give a visual display 
of the audio); the waveform will draw as you record. 

Name the Track by clicking in the Transport Controls' white name box, typing "Voice", then pressing the  
Return key. You can use the  Backspace key to correct mistakes. 

RECORDING 

 
Press the small red RECORD-ENABLE button on the stereo Stream 1&2 of the Playlist. This will tell SADiE 
to record a stereo Track and place it on those Streams. 

Play the source material and you will be able to monitor it through SADiE and check the input level on the 
meters of Mixer channels one and two. If this is an analogue input it may be necessary to adjust the level at the 
playback machine or mixing desk to avoid overloading SADiE's Analogue-to-Digital converters, which would 
produce a permanently distorted recording. 

 
Rewind the source material and play it again from the beginning. Press RECORD to start SADiE 
recording. You will see the time display counting. 

 
Record your speech track in. When you have two or three minutes of audio, or have got too 
impatient to wait any longer, press STOP and stop the player. 

You have now recorded a Track called "Voice" and a stereo EDL Entry with the same name will appear on the 
stereo Stream 1&2 of the Playlist. Now you are going to record the music, so enter the name "Music 1" for the 
new Track, as above. 

Press RECORD, and restart the player (if you got the level right for the speech, and it is coming from the 
same source, it should be fine for the music, so no need to check it again). 

When the music stops, rush to the nearest chair and sit down. Failing that, press STOP and stop the player 
again. Now you've recorded another track and there will be a second EDL Entry in the Playlist. 

Repeat to record a third Track, naming it "Music 2". At the end of the second piece of music, stop both SADiE 
and the player. 

Finally, release the RECORD-ENABLE button on Stream 1&2.  

PLAYING THE EDL 

 You have already created an EDL , as SADiE automatically placed Entries for each of the three Tracks 
in the Playlist . You can view all three by pressing the horizontal ZOOM OUT button a few times. 

 
On the hardware controller, select ZOOM and adjust with the wheel. 
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1. Playlist Toolbar 

2. Time Bar 

3. Mouse Time Display 

4. Scrollbar 

5. Current-time Cursor 

6. Zoom Controls 

 

 
Double-click the STOP button. This is a very useful zero-locate function. The current-time cursor 
will return to zero, as shown by the Transport Controls' time display. 

 
Press SHIFT then END. The current-time cursor will locate at the start of the first EDL Entry. 

 
You can now play back the EDL by pressing PLAY, or using the keyboard spacebar, which duplicates 
play and stop functions. 

Notice the current-time cursor moving left to right across the Playlist, which will scroll automatically, and the 
current-time display in the Transport Controls or hardware controller reflecting the EDL time in the time bar 
at the top of the Playlist. The rewind, fast-forward, stop, play and pause buttons will do what you expect, but 
there is a much faster way of getting around in the Playlist. 

 
 

Double-click in the white area of the time bar (notice that the exact time you are pointing to is 
indicated by the mouse time display). Playback will start immediately from that point. Single-click 
anywhere in the time bar to stop playback. Single-click anywhere in the time bar when playback is 
stopped to locate the current-time cursor to that point. 

 
To access points not currently in the window, scroll the display by using the Scrollbar along the 
bottom of the Playlist. You can single click or hold down the arrow buttons, or click in the bar either 
side of the moving box. When the system is playing back it will override scrolling in order to keep 
the current time in view. (Scrollbars are a standard Windows feature; see the user manual Appendix 
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A - Windows Basics, or the Windows help file.) 

 
Deselect ZOOM and move the scrub wheel to locate the current-time cursor to the desired point 
and press PLAY. (For quick locating, make sure the wheel is not in jog or shuttle mode, as selected 
by the SCRUB button.) The window will scroll automatically. 

 You can zoom in and out both horizontally and vertically with the two pairs of magnifying glass 
buttons (see left). This is a useful way of getting at different parts of the EDL as well as changing your 
overall view. 

 
Hit ZOOM (horizontal) or SHIFT then ZOOM (vertical) and use the wheel. 

NOTE: When zooming in and out the Playlist will always stay centred on the position of the cursor, so 
reposition it before zooming in, if necessary. 

Practise getting around the Playlist to play different sections. Other ways of locating to given points are 
covered in Using the Playlist.  

ARRANGING THE EDL 

Now you need to change the order of your Entries so that the speech comes after both pieces of music. Set 
the zoom level so that all three Entries are in view. 

 
Click on the Entry "Voice" to select it. It will turn red. You can now drag it with the mouse to a later 
location in the EDL and drop it after "Music 2". 

NOTE: Red is a warning! After moving the selected Entry using the mouse, it is a very good idea to 
deselect it by clicking on a blank, grey area of a Stream, or by holding the Shift key and clicking on the 
selected Entry again. This keeps it safe from being moved accidentally. 

 
You can select more than one Entry for moving by holding the Shift key whilst clicking on them, or by 
dragging across them with the mouse to draw out a box that covers them. Be careful not to do this 
on an Entry that is already selected, because you will then be moving it. 

CUT AND PASTE 

An Entry can also be moved using the cut and paste tools. 

 
Press the SELECT TOOLBARS button, and then select "Paste" from the menu, to reveal the Paste 
toolbar. 

 
Notice that there are a number of other toolbars that can be revealed and hidden by using this button. Your 
start-up desktop only shows a few of these to keep the screen tidier, but if you find you are requiring certain 
buttons to be on screen permanently, you can rearrange your view to suit your own style of working. (This is 
described further in Toolbars.) 

 
Select the entry and then press CUT and it will be removed from the EDL to a temporary "paste 
buffer". 

 
Press PASTE and you can position the mouse where you want to re-insert it (the mouse pointer 
changes to a reel of tape) and paste it back in with a single click. 

 
If you press COPY instead of CUT, it won't remove the Entry from the EDL, but will still copy it to 
the paste buffer, allowing you to paste it in somewhere else, and so repeat that section of audio. 
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After pasting, the Entry is still in the paste buffer, so you could paste in more copies. CUT, COPY and 
PASTE will therefore move, remove and allow you to repeat Entries in the EDL in just the same way as you 
would with text on a word processor. 

 
Move the current-time cursor with the wheel so that it is over the Entry "Voice". Press 
EDIT/SELECT to select the Entry. It will turn red. Now press CUT and it will be removed from 
the EDL to a temporary paste buffer. Move the cursor to a new position, after the Entry "Music 2" 
and press PASTE. "Voice" will be re-inserted after "Music 2". 

NOTE: When hitting EDIT/SELECT, make sure that the IN, HOT, and OUT buttons above the 
wheel have not been pressed and lit, otherwise you will enter editing mode, covered later. 

 
SHIFT + EDIT/SELECT will deselect the Entry under the cursor or add other Entries for multiple 
selection. Other Entries can be selected with the PREVIOUS and NEXT buttons. Pressing 
EDIT/SELECT with no Entries under the cursor will deselect them all. If you have the CLIP button 
selected and lit, the wheel will select Entries in turn. 

SLIP 

 
Press the SELECT TOOLBARS button, and then select "Slip" from the menu, to reveal the Slip 
toolbar. 

 
Press the first ENABLE SLIP button and then the third SLIP RIGHT button. Select an EDL Entry. When it 
turns red, all following Entries will turn dark blue indicating that they will move with the red one. Try it. 

SLIP LEFT and SLIP RIGHT pre-select whether previous and/or following Entries will be slipped when 
ENABLE SLIP is pressed. This is essential when you have many Entries in the EDL and you want to open or 
close up gaps without disturbing previous or following edits. On other occasions you will want to move an 
Entry on it's own and will then turn SLIP off. 

 
To move an Entry to the left so that it butts up to the one before it, select it and press REMOVE 
GAP. The SLIP feature will apply if enabled. 

 
Once you have pre-selected SLIP LEFT and/or SLIP RIGHT with the mouse as above, SLIP on 
the hardware controller enables/disables the feature. With SLIP on, you will find that cutting and 
pasting Entries causes Entries to the right to slip accordingly.  

 
Use the default Hotkey - F6 on the keyboard - to remove gaps to the left of the selected Entry. 

 
If you make a mistake whilst working on your EDL, you can step backwards through your actions by 
pressing UNDO. REDO steps you forward again. The number of actions you can undo (maximum 
50) is adjustable in the Undo section of the Setup window. 

 
UNDO is at the bottom right of the panel and SHIFT + UNDO is redo. 

Practise moving your Entries around in the Playlist . 

NOTE: It is actually helpful to have the first Entry in your EDL starting some time after 00:00, so you 
can easily start playback just before it by double-clicking in the time bar. The Entry will also have room 
to move to the left during certain editing operations. To arrange this, move the whole EDL to the right 
a bit by moving the first Entry with Slip Right enabled. In future, if you position the cursor at a point 
after 00:00 before you start recording, the first Entry will automatically appear there. 
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When you have practised enough, leave yourself with just the three Entries starting some time after 00:00, and 
in the following order: "Music 1", "Voice" then "Music 2".  

SAVING YOUR WORK 

At this point, if you were doing something more exciting than this tutorial, you might have created a complex 
EDL arrangement, so this is a good time to save your work as a file on the computer's internal Windows hard 
drive. 

 
Select "Save Project " from the Project menu, or press SAVE ALL PROJECT in the Project 
Window. 

 
Make the Project window active with the WINDOW button (its the one with the green folder icon) 
and press the SAVE button. The Project window can stay minimised when you do this. 

Alternatively, on the computer keyboard press "Alt + P" then "S" to use the Project menu Save command. 

Saving in this way will save all the components of your "Tutorial" Project, including the EDL you have created 
so far.  

EDITING THE SPEECH 

Make sure that SLIP Left and Right are enabled, as described above. 

Experiment with playing the EDL and changing the horizontal and vertical zoom settings. If you are viewing the 
wave profiles, you should be able to identify words and spaces in the Entry "Voice" as the cursor passes over 
them. 

 
Display the Edit section of the Transport Controls. You can turn off the Record section, now that 
you've finished with it. 

 

 
Click with the mouse over the scrub wheel and, holding the mouse button down, move the mouse 
up and down. This is "Shuttle" mode (like spooling forwards and backwards across the heads of a 
tape machine) the more you move the mouse, the faster you go. Move the mouse from left to right 
and you will switch to "jog mode" (like nudging the reels of a tape machine backwards and forwards). 
Practice this on the speech as you are now going to find and mark two edit-points between which 
you want to remove the audio, just like on a 1/4" tape machine. 

The next bit will depend on the audio you have recorded for the "Voice" track . Identify where you want to 
make the first edit, by playing or scrubbing. If it is speech, then why not just remove a couple of words, or 
perhaps your voice artist has made some mistakes that you want to get rid of? Scrub to a position just before 
the words you want to remove and release the mouse button. 

 
Then press RAZOR CUT. Now scrub to just after the mistake, e.g. where you want to come back 
in, and press RAZOR CUT again. 
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 Use the ZOOM buttons to find a suitable degree of magnification. Don't worry too much about 
being very accurate, as this is non-destructive editing; you can always use UNDO to go back and 
have another go, or adjust the edit later. 

You will see that you have now divided the EDL Entry "Voice" into three. To complete the edit you need to 
remove the middle Entry (between the two razor cuts you have just made) and join up the remaining bits. 

 
Select the middle Entry by clicking on it and turning it red, then press CUT. The Entry will be 
removed from the EDL and, if you have SLIP on as suggested, the following Entries will be 
automatically moved forward to butt up to the first one. Play over the edit. If you don't like it, press 
UNDO (two or three steps) and do it again. 

NOTE: Although you have just deleted an Entry from the EDL, no audio has been lost from the system. 
The original Track is unaffected - you have just removed the instructions to play that part of it in this 
particular EDL. 

 
On the hardware controller, SCRUB toggles the scrub wheel through jog, shuttle and normal cursor 
modes, as indicated by the LED's to the right of the wheel. Choose jog or shuttle, use the wheel to 
locate your two edit points and press RAZOR to mark a cut at each. Then move the cursor over 
the Entry now formed between them, press EDIT/SELECT to turn it red and CUT to remove it. 
Keep SLIP on, so that the gap is automatically joined up. Move the cursor back with the wheel and 
play over the edit. If you don't like it, UNDO (up to three steps) and do it again. 

Note: there is a setup option to change the Scrub toggling to be two-way and only between Jog and 
cursor, thus ignoring shuttle. See Transport Controls Setup. 

That's all there is to cut-and-splice editing with SAuDiE. Do a few more edits to get the hang of it, but leave 
some edits until later when you'll try another method. 

After all that editing, save the Project again.  

ADJUSTING THE EDITS 

Play through the edits you have done so far. Let's just pretend for a moment that you are not yet God's Gift 
To Hard Disk Editing and there is an edit that you'd like to tweak a bit. To do this you need to go into Playlist 
Editing mode. 

 
Press the PLAYLIST EDITING button on the Playlist toolbar and select the earlier of the two 
Entries at the edit point to be adjusted. 

 
You will need to press AUDIO SCRUB in the Transport Controls if you want to hear the edit as 
you adjust it. 

 
Position the mouse over the Entry just before the edit, so that it's pointer changes to a  
symbol, then click and scrub with the mouse. You can jog or shuttle, just as you did over the scrub 
wheel. Adjust the out-point (the "left hand" side of the edit). The Entry being adjusted turns a 
brighter red. Now select the Entry after the edit, get the  symbol and scrub to adjust the in-
point (the right hand side of the edit). 

 
Listen to the result by playing over the edit in the normal way, or by using the PLAY THROUGH 
edit preview button in the Transport Controls. 

 
NOTE: Whilst making adjustments, it is sometimes helpful to listen to just one side of an edit. 
You can do this with the PLAY TO and PLAY FROM edit preview buttons. 

You can now adjust other edits by selecting the Entries before or after them and scrubbing with the 
appropriate mouse symbol. 

Come out of PLAYLIST EDITING mode by releasing the button. 



SADiE v5.4 PCM Manual 

18 

 
Using the hardware controller, first find the edit you want to adjust. This is, as always, the join 
between two EDL Entries. 

Check that the EDL/SOURCE button in the top row is selected to source (light on). This will mean 
you are editing radio-style rather than working to picture sync. (For more details, see Editing.) Make 
sure SLIP is still on. 

First work on the left hand side of the edit. This means adjusting the out-point of the left hand Entry, 
so select OUT. The in, hot and out edit point buttons are directly above the wheel (the "hotspot" is 
covered in Manipulating EDL entries). 

With the wheel, position the current-time cursor over the left hand Entry and press 
EDIT/SELECT. Because you have selected an edit point, SADiE will automatically go into Playlist 
Editing mode as well as selecting the Entry. 

Select jog or shuttle mode with the SCRUB button and adjust the out-point with the wheel. 

Now press NEXT. This will select the in-point of the next Entry (e.g. the right-hand side of the edit). 
Adjust it with the wheel. 

Listen to the edit by pressing the PREVIEW button; adjust the two sides if necessary. 

Press EDIT/SELECT again to turn Playlist Editing mode off, thus confirming the edit, or use NEXT 
or PREVIOUS to move to other edits. 

BOTH AT THE SAME TIME 

The swots in the front row of the class may have realised that you can use the above method of adjusting edits 
to remove the unwanted material in the first place. 

 Listen to more of the speech. As soon as you hear the next mistake that needs editing, make a single 
razor cut. This can be done on the fly during playback, or whilst shuttling through. The initial cut 
doesn't have to be accurate as you are going to adjust it straight away. 

 Stop playback, if necessary. 

 Go into Playlist Editing mode and adjust the out point (left-hand side of the edit) as before. 

 Now go to the right hand side of the edit by selecting the next entry. You can lose all the unwanted 
audio by slipping it "into the cut" as you shuttle along to find, and set, the in-point exactly as described 
above. Remember playing tape out onto the floor? It is just like that, except you don't have to worry 
about treading on it. 

Use whichever method you prefer to do the rest of the edits in the speech. It is easier to remove very small 
bits (de-umming, for instance) with Playlist Editing. 

NOTE: For hardware controller users it is generally safest to confirm each edit by pressing 
EDIT/SELECT to turn Playlist Editing off. You are then free to use the wheel without spoiling the last 
edit. If you do leave Playlist Editing mode on, you will find that each time you do a new RAZOR cut, 
you should immediately select the OUT point (on the Transport Controls or hardware controller). 
This will position the cursor at the new edit point. 

Lastly, you can "top and tail" the speech by using Playlist Editing to trim the in-point of the first Entry and the 
out-point of the last. Save the Project again. 

NOTE: It is worth noting that the original, unedited, Tracks that you recorded are always available in 
the Clipstore. Restore your Clipstore window to normal size and you will see them in a folder labelled 
Source Tracks. So, if you wanted to start the editing exercise all over again, you could use the original 
tracks out of the Clipstore.  

MIXING IN THE MUSIC 

You should now have and EDL Entry called "Music 1", another called "Music 2", and lots of Entries called 
"Voice" as the result of your editing. 

Although not essential, for this exercise it is a good idea to group all the "Voice" Entries together. 
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Press the SELECT TOOLBARS button on the Playlist toolbar again. Select "Group" to reveal the 
Group toolbar. 

 
Select all the "Voice" entries. You can do this by dragging across them with the mouse, but perhaps it would be 
easier to select all the Entries in the EDL and then deselect the two music ones: 

 Click on "Edit" on the menu bar, then "Select All" (or press Alt + E, S on the keyboard). 

 Deselect the two music Entries by holding Shift on the keyboard while clicking on them with the 
mouse. (On the hardware controller make sure no in, hot or out edit points are selected, position the 
current-time cursor over the Entries and press SHIFT + EDIT/SELECT.) 

 
Press GROUP SELECTED EDL ENTRIES. They will be redrawn as a single block in the Playlist 
and can therefore be moved around together easily. 

Now move the music Entries to Streams 3&4 so you can control them with separate faders. 

 Turn SLIP off, as you want to move the music without moving the speech. 

 Select the two entries and use Ctrl +  on the keyboard or ASSIGN + F2,  on the hardware 
controller to move them down to Streams 3&4. 

 Position them so that the EDL starts with "Music 1", then the edited Voice group, starting before 
"Music 1" ends, and finally "Music 2", starting before the speech begins. 

 
At any time you can break a group back down into its component Entries by selecting it and pressing 
UNGROUP. Do this now to view the profile of the speech again. 

 
If you play your EDL now, the levels will quite obviously be wrong, as the music will drown out the speech 
where they overlap. Time to do a mix. 
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1. Strip Input 

2. Enable Automation 

3. Strip Number 

4. Mixer Configuration Tools 

5. Automation Tools 

The Mixer works just like a studio mixing desk with a multi-track tape machine. The default Mixer you have on 
screen contains a channel strip to control each Stream and two more acting as stereo masters by controlling 
the Mixer's internal busses 1&2. So this Mixer's routing arrangement is as follows: 

Stream 1  Fader Strip 1     

Stream 2  Fader Strip 2     

Stream 3  Fader Strip 3     

Stream 4  Fader Strip 4  Internal Bus 1  Master Fader, Strip 9  Output 1 

Stream 5  Fader Strip 5  Internal Bus 2  Master Fader, Strip 10  Output 2 

Stream 6  Fader Strip 6     

Stream 7  Fader Strip 7     

Stream 8  Fader Strip 8  

 

   

NOTE: An internal bus can be thought of as a subgroup within the mixer. 

 
With the mouse, it is easier to have a single fader controlling both channels of audio for the stereo 
Entries, so let's create stereo mixer strips to go with the merged Playlist Streams: 

 Right-click on Mixer strip one, just above the fader, and select "Merge into Stereo Strip". This will 
combine two separate Mixer strips into a single stereo one controlling Streams 1&2. 
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 Repeat to merge the strips controlling Streams 3&4 into a Stereo strip. Note that the strip numbers 
are now different from the numbers of the Streams that they control. 

 
If you are using hardware controllers, merging strips is perhaps less necessary as you have the added 
dexterity of separate fingers on separate faders. However merging streams does give you "more" 
faders on the panel. 

 
Press the ENABLE AUTOMATION button on the Mixer configuration toolbar. 

 
Make sure that the Mixer is the active window (coloured title bar). If not, use the WINDOW 
button. Then hit AUTO to enable the automation. The automation toolbar will be added to the 
Mixer. 

 
For this tutorial, make sure that the KEEP button is down, as this will let you try just one 
automation mode. 

Play the Playlist from just before "Music 1". As you see the first words of the speech coming up you can fade 
down Streams 3&4 for a voice-over, and finally fade out the music completely. 

Play over that section again; your fader movements will be reproduced and your mix replayed. 

NOTE: Because the fader movements you make are being recorded as changes to the EDL, you can use 
UNDO to go back a step and do the first mix again, or improve on it by playing it and making small 
adjustments. 

Go to the end of the Playlist and do a mix to fade "Music 2" in under the last words of the speech. 

When you are (reasonably) satisfied with the result, save the Project again. This will save all the components of 
the Project (e.g. the EDL with its editing, the Stream layout and fader automation, and also the new Mixer 
layout). 

NOTE: Each time you save the EDL within the Project, you are overwriting the previously saved 
version. If you want to be able to return to an earlier version of an EDL, you need to save the new one 
with a different name. To do this, make the Playlist active and select "Save As" from the File menu. You 
can then type in a different name, thus creating a second EDL within this Project. 

NOTE: When you make any File command, the type of file to be opened, closed, or saved is determined 
by which window is active.  

THE FINISHED PRODUCT 

If you are pleased with what you have done, you can dub it onto another medium (say a DAT or 1/4" tape) by 
playing the EDL and recording from SADiE's (digital or analogue) outputs 1&2. 

If you choose to use SADiE's digital outputs, you may need to set the digital output format: 
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 In the menu bar, choose "View", then "Setup Window". From the list on the left, double-click on 
"Audio" and select "Further Audio Settings". 

 In the "Output Format" section, select SPDIF or AES/EBU to match the format required by your 
recorder's digital input. 

NOTE: The selected format is available on the XLR connector on the Breakout Panel. It is standard to 
use an XLR for AES/EBU and an RCA phono socket for SPDIF, and so you will need a connector 
converter and/or impedance match to connect to an RCA SPDIF input.  

SHUTTING SADIE DOWN 

It is important to shut down the software correctly and only turn off your computer when you have done so. If 
you simply turn off the power when SADiE is running, you risk losing work or even damaging the audio disk. 

1. Close the SADiE main window by: 

i. Clicking on the window close button  on the right of SADiE's main window title bar, OR 

ii. Double-clicking on the icon on the left of SADiE's main window title bar, OR 

iii. Selecting "Exit" from the File menu, OR 

iv. Pressing Alt + F4 on the keyboard. 

2. SADiE will warn you if there are any EDL's, Clipstores, or Projects that have not been saved since 
they were last altered. 

3. Click on the "Start" button on the Windows Taskbar, select "Shutdown" and "Yes" to shutting down 
the computer. 

4. Windows will tell you when it is safe to turn off the power.  

POST TUTORIAL 

This section will take you through simple recording and editing. You need to have already been through the 
Starting SADiE section above, as all the terminology used will follow the descriptions there, and it is assumed 
that you have started SADiE, are able to use the mouse, and have a basic understanding of Windows. 

This tutorial will describe the use of SADiE running in sync, and controlling a video player via a 9-pin 
connection. It is assumed for the most part that you are using SADiE's Hardware Control panels, although 
mouse operation will also be described. 

The choice of audio material is not so important, but ideally, find some audio that is already synchronised to 
picture (preferably speech), along with some "wild" music and if possible some sound effects.  

CONNECTIONS 

You will need to connect a VTR, hopefully with 9-pin control and set up both sync and audio settings. Sync 
settings are described in more detail later in this manual. For now, only one possible scenario is described to 
keep things simple, however if your available equipment differs from that suggested, refer to the 
Synchronisation section. 

This tutorial assumes you are working and monitoring in stereo, and operation with a single audio unit is 
described here. 

AUDIO CONNECTIONS 

You will need to listen to the SADiE, so connect outputs one and two from the breakout box to your 
monitoring or console. 

You will need to connect some audio into SADiE. For now, connect the analogue outputs one and two of your 
video deck into SADiE's analogue inputs one and two on the break out box. SADiE's analogue inputs are 
factory set to +18 dBu on the balanced breakout box, but this may depend on your hardware configuration. 

For a bit of variety, you'll need to load some music in from CD, so connect a CD player up to SADiE's Inputs 
three and four. 
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SYNC CONNECTIONS 

You will need a 9-pin RS422 lead from one of SADiE's 9-pin ports on the back of the break-out box, connected 
to the Remote connector on the video deck. You will also need a video lead for video synchronisation; this 
connects to the bottom BNC connector on the SADiE's CAT card (at the back of the PC), and will be fed 
either from a composite output of the video deck itself, or preferably from an external synchronisation source, 
to which the video deck is also synchronised. 

You will want to view the VTR also, so connect a video monitor. 

SAMPLE RATE 

It is likely that you will have a standard operating sample rate, and it's usual to be 48 kHz in many Post 
applications. This does cause a potential problem when you are trying to record digitally from CD, as CD is 
always recorded at 44,1 kHz. SADiE can play audio at differing bit rates, but cannot combine different sample 
rates in the same EDL . Any audio at the wrong sample rate will play, but it will be at the wrong speed. Thus if 
you are working at 48 kHz and recording from CD you will either have to record via analogue, or sample rate 
convert the CD on the way in; perhaps your console or other equipment in the studio can do this for you. 

For the purpose of this tutorial a working sample rate of 48 kHz is assumed. 

At this point it is assumed that SADiE is currently open, and you have (as was suggested in "Getting Started") 
created a new project called "Tutorial". 

SYNC SETUP 

See Setting up Sync Details and Setting up 9-Pin Control for full details. 

Open up the Setup page, by selecting the "View" menu, then selecting "Setup Window". 

The Setup page has several sections listed on the left hand side. Clicking on a topic in this list will show the 
corresponding page on the right hand side. Some pages marked with a + character have other sub-pages, which 
can be viewed by double-clicking on the main topic, then clicking on the sub-topic. 

First click on the "9-pin Details" page: 

 You have four possible 9-pin ports. If you are using a Hardware controller, this will occupy one port 
(usually port number one), and the Box by the side of "9-pin channel 1" will say "Hardware 
Controller". 

 Having attached the 9-pin lead to Port number two, in this Setup page, click on the box by the side of 
"9-pin channel 2", and from the drop-down list choose "Sony 9-pin Master". This port will be used to 
control the transports of the VTR deck, and when SADiE plays, the VTR will play. Likewise SADiE and 
the VTR will locate and scrub together. 

Next click on the Sync page of Setup: 

 Choose your video frame rate. 

 Tick "9-pin" in the "Timecode Type" section. 

 Tick "Slave Mode" under "Sync Mode". 

Now, briefly check that the 9-pin device is being controlled correctly. 

CONTROLLING THE VTR 

 
Press the WINDOW button repeatedly until the Playlist Window is focused. Press ONLINE and 
then press PLAY. 

The VTR should start playing from where it is currently parked, and SADiE's Playlist will jump to that 
time, and start playing (although there is nothing to play yet); the Time display will follow the VTR's 
time display. Press STOP. It stops. Now move the wheel. At this point none of the 
jog/shuttle/edit/mode lights on the Jog Panel should be lit. If JOG or SHUTTLE are lit (you've been 
jumping ahead!), then press the SCRUB button once or twice until they go out. 

Moving the wheel should move the current time display in the Playlist, but not the VTR. Move the 
time forward by about 1 minute, and then press PLAY again. Aha - the current time jumps back to 
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where the VTR is parked, and the VTR plays from where it left off. 

So press STOP again, move the wheel forward by 1 minute again, and now this time press SHIFT, 
and then PLAY. This time the VTR will fast forward to the time at which you've just positioned 
SADiE's current time cursor, and then play from that point. 

 
Mouse operation is similar. Use the on-screen transport window for transport controls (there is an 
ONLINE button to enable the 9-pin machine). 

There are separate transport controls also available for 9-pin machines. 

From the View menu, select Machine Control, and then from the next menu choose the device you're 
controlling; "9-pin ch. 2" or the name of your machine will appear. 

The Machine Control Window will appear (there are more details later on). This window gives you separate 
remote control on the 9-pin device. Transports, and some other generic 9-pin commands are available. When 
this window is focused, the Hardware Controls are operating just the 9-pin machine (no need to press 
ONLINE), and you can use the WINDOW button to move to the Playlist to control it together with SADiE, 
or back to Machine Control to control it on its own.  

RECORDING MATERIAL 

You're going to record some audio now from the video machine.  

For simplicity, all the audio for this tutorial will be stereo, so you should create a stereo Stream in the Playlist 
at this point. First right-click over the small Stream control buttons of Stream 1. 

 

Select "Merge into Stereo Stream". Streams 1&2 will then be combined into a stereo Stream with a single set of 
control buttons. Now do the same on Stream 3 to merge Streams 3&4 into a stereo Stream, which will be 
used later. 

NOTE: In future you should identify mono material and save space on your audio disk by recording it as 
mono Tracks. 

AUDIO SETUP 

Open up the Record section of the Transport Controls by clicking on the Record tab. 
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Press SETUP. This will open the Audio section of SADiE's Setup window. 

 

 Select the input source appropriate to your input equipment, and the Sample Rate and input 
resolution appropriate to your workplace. 
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NOTE: If you are not sure which sample rate to use it is worth consulting your engineering 
staff. Choosing the wrong sample rate when recording can give you problems later on. 

 Whilst in Setup, check another setting that determines how the inputs are monitored. Click on "Mixer 
" on the left side of the Setup window, and towards the bottom, check that "E-E on record enabled 
streams" is ticked. 

 Close the Setup window (by clicking the close window button ). 

PREPARING TO RECORD 

 
Press SHOW ALL PROFILES in the top left corner of the Playlist, or F12 on the keyboard or 
Hardware controller to change the EDL Entries from blocks to profiles (which give a visual display of 
the audio); the waveform will draw as you record. 

Name the Track by clicking in the Transport Controls' white name box, typing "Voice", then pressing the 
return key ( ). You can use the Backspace key to correct mistakes. 

On the Record tab of the Transport Controls again, tick "Source". Input monitoring and the function of the E-E 
and Source options are discussed in more detail under Monitoring the Recording in the Recording chapter. 

RECORDING 

 
Press the small RECORD-ENABLE button on the stereo Stream 1&2 of the Playlist. This will tell SADiE to 
record a stereo Track and place it on those Streams. 

 
With ONLINE enabled, press play and, as before, the VTR and SADiE's Playlist will start playing, but 
this time you'll hear the audio tracks of the VTR if that's what you have connected to inputs one and 
two. It may be necessary to adjust the level at the playback machine or mixing desk to avoid 
overloading SADiE's Analogue-to-Digital converters, which would produce a permanently distorted 
recording. 

Try scrubbing (press the Hardware Controllers SCRUB button). Now when you turn the wheel, the 
VTR will jog, and you should still be hearing the audio through on the inputs. Press SCRUB again 
and now turning the wheel will shuttle the VTR. The amount of rotation of the wheel determines the 
speed of the VTR. 

By means of scrubbing or by using the wheel (with no jog or shuttle light lit) locate the VTR to the 
beginning of your chosen recording and press PLAY (or SHIFT then PLAY if you are using the 
wheel in "free-run" mode). 

 
The RECORD button will be flashing. At or before the moment you wish to start recording, press 
RECORD to start SADiE recording; you will see the time display counting. 

 
Record your speech track in. When you have two or three minutes of audio, or have got too 
impatient to wait any longer, press the STOP button and stop the player. You could alternatively 
press RECORD again to stop the recording and continue the playback. If you press RECORD once 
more will punch into record again. But we only need one recording for now! 

You have now recorded a Track called "Voice" and a green stereo EDL Entry with the same name will appear 
on the stereo Stream 1&2 of the Playlist. 

Release the RECORD-ENABLE button on Stream 1&2 to disable recording for now. 

You can try some more playback and scrubbing in sync; you're still ONLINE so the VTR and SADiE are still 
locked. 
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Press SHIFT then END, and SADiE will locate to the beginning of this "Voice" entry. Alternatively, 
press "Home" on the keyboard. Press SHIFT then PLAY on the Hardware Controller, and the VTR 
will locate back to the start of the "Voice" entry, then start playing. 

If you still have a Jog or Shuttle light lit, turning the wheel will put the VTR and SADiE into scrub. If 
not press SCRUB and turn the wheel. 

You now want to record the music and sound effects. These are coming from CD (or maybe DAT) and there 
is a player attached to inputs three and four. 

 If you're going to carry on using the VTR as the source, then you can change the Record Source for 
each Stream by pressing the INPUT button at the left side of the stream, and choosing the 
appropriate input from the drop-down list. 

 Enter the name "Music" for the new Track, in the Transport Window as above. 

 Press ONLINE (to take SADiE off line) 

 Press the small RECORD-ENABLE button on the stereo Stream 3&4. 

It doesn't matter where you start recording from; this is a "wild" track and we can move it later, but perhaps 
you could locate the Playlist to an appropriate position, maybe 20 seconds or so before the Voice entry starts. 

 Start the CD, and press the RECORD button. 

 When the music stops, press STOP and stop the player again. Now you've recorded another track 
and there will be a second EDL Entry in the Playlist on Streams 3&4. 

 Disable record on Stream 3&4, and set Streams 5&6's input to be from Input 3&4 (e.g. the CD player) 

 Repeat the record process to record a third Track, naming it "SFX". It would be nice to make this 
recording something quite recognisable, like a single band or crash, rather than ambiance. At the end, 
stop both SADiE and the player. 

 Finally, release the RECORD-ENABLE button on Stream 5&6.  

 PLAYING THE EDL 

 You have already created an EDL . as SADiE automatically placed Entries for each of the three 
Tracks in the Playlist . You can view all three by pressing the horizontal ZOOM OUT button a 
few times. 

 On the hardware controller, select ZOOM and adjust with the wheel. 

NOTE: When zooming in and out the Playlist will always stay centred on the position of the cursor, so re-
position it before zooming in if necessary. 
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1. Playlist Toolbar 

2. Time Bar 

3. Mouse Time Display 

4. Scrollbar 

5. Current Time Cursor 

6. Zoom buttons 

ZOOM CONTROLS 

LOCATING AND PLAYING 

We've already seen quite a few methods of playing, locating and scrubbing the Playlist. Let's just re-cap and 
introduce a few other methods, using the mouse, keyboard and Hardware controllers. 

Note that, because VTR's usually take a longer time to locate than a random access system like SADiE, when 
you are ONLINE, the VTR is not automatically located when you locate SADiE; the 9-pin locate command is 
sent when you press SHIFT + PLAY, or double-click in the Time Bar as described below. This gives you the 
flexibility of being able to quickly and repeatedly move through the Playlist in SADiE, without having to wait for 
the VTR for every move. 

There are lots of ways to move around the Playlist; of course the REWIND, FAST-FWD, STOP, and 
PLAY buttons (both on the Hardware controller and the software screen) will do what you expect, but there 
are other ways of getting around in the Playlist, so try them out. 

 
Move the jog wheel in the console (the operation of this will depend on the status of the JOG switch 
next to the wheel). The JOG switch has three states, and repeatedly pressing this switch will toggle 
around the three states. 

When the light is off, the Jog wheel moves the current time line in the Playlist freely; you could wind 
the wheel back so that the time line is at the beginning of an entry in the Playlist and press play to 
start at that time. 

The next push of the JOG switch puts SADiE into Jog mode; moving the wheel will scrub the audio 
underneath the timeline at a speed determined by the speed of rotation of the wheel (and its 
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direction). Note that the green Jog light on the console underneath the SADiE screen will be lit in 
this mode. 

A further push of JOG will light the green Shuttle LED; moving the wheel will scrub the audio 
underneath the timeline at a fixed speed and this speed is determined by the amount and direction 
you've turned the wheel. 

 
While scrubbing quickly look at scrubbing the VTR. There's a special 9-pin control feature, which 
allows you toggle on/off the audible scrubbing of SADiE's Playlist, whilst still scrubbing the 9-pin 
device. The reason for having this function is that SADiE's audio may not be able to play at the sort of 
speeds that VTR's can achieve at their maximum scrub speed (which often approaches 16 or 20X). 

Press GRABTIME on the Hardware controller while in jog or shuttle, and SADiE's audio will turn 
off; this is very useful for quick locating the video (and continuing to view it) if you have a fair distance 
to move. Press GRABTIME again to revert to normal picture-and-SADiE scrubbing. The name of 
this button does not obviously describe its function! 

 
Clicking with the mouse in the white area of the time bar (notice that the exact time you are pointing 
to is indicated by the mouse time display), will locate to that position (but not the 9-pin VTR yet). 

Double-clicking with the mouse in the white area of the time bar will locate and start playback 
immediately from the selected position. When you are ONLINE, the mouse double click locates the 
VTR first. Thus double-clicking is the same as locating with the wheel, then pressing SHIFT then 
PLAY. 

On the keyboard, you can press "Home" to jump to the beginning of the first entry, or "End" to jump to the 
end of the last entry. 

 
Pressing the PREVIOUS or NEXT hardware controller buttons will select the previous (or next) 
entry and place the timeline at the beginning of that entry. Thus pressing these keys repeatedly will 
roll the timeline through each entry in turn. 

You can now play back the EDL by pressing PLAY, (or SHIFT then PLAY when you are ONLINE, in order 
to locate the VTR first) or using the keyboard spacebar (which duplicates Play and Stop functions). Notice the 
current-time cursor moving left to right across the Playlist, (which will scroll automatically), and the current-
time display in the Transport Controls or hardware controller reflecting the EDL time in the time bar at the 
top of the Playlist. Single-click anywhere in the time bar to stop playback. 

 
To access points not currently in the window, scroll the display by using the Scrollbar along the 
bottom of the Playlist. You can single click or hold down the arrow buttons, or click in the bar 
either side of the moving box. When the system is playing back it will override scrolling in order to 
keep the current time in view. (Scrollbars are a standard Windows feature; see the user manual 
Appendix A - Windows Basics, or the Windows help file.) 

Practice getting around the Playlist to play different sections. Other ways of locating to given points are 
covered in Using the Playlist.  

ARRANGING THE EDL 

Set the zoom level so that all three Entries are in view. Assume for now that the piece you called "Voice" is in 
sync with the picture, and your task is to move the other clips to appropriate positions. Thus for now, don't 
move "Voice" from it's sync position. There is no real purpose to the movements you are about to do except 
to show it can be done. 

For the sake of this tutorial, it's best to take the 9-pin device off line until you wish to play anything. 

 
Click on the Entry "Music" to select it. It will turn red. You can now drag it with the mouse to a later 
location in the EDL and drop it after "SFX". 
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NOTE: Red is a warning! After moving the selected Entry using the mouse, it is a very good idea to 
deselect it by clicking on a blank, grey area of a Stream, or by holding the Shift key and clicking on the 
selected Entry again. This keeps it safe from being moved accidentally. 

 
You can select more than one Entry for moving by holding the Shift key whilst clicking on them, or by 
dragging across them with the mouse to draw out a box that covers them. Be careful not to do this 
on an Entry that is already selected, because you will then be moving it. 

An Entry can also be moved using the cut and paste tools. 

 
Press the SELECT TOOLBARS button, and then select "Paste" from the menu, to reveal the Paste 
toolbar. 

 
Notice that there are a number of other toolbars that can be revealed and hidden by using this button. Your 
start-up desktop only shows a few of these to keep the screen tidier, but if you find you are requiring certain 
buttons to be on screen permanently, you can rearrange your view to suit your own style of working. (This is 
described further in Toolbars.) 

 
Select the entry and then press CUT and it will be removed from the EDL to a temporary "paste 
buffer". 

 
Press PASTE and you can position the mouse where you want to re-insert it (the mouse pointer 
changes to a reel of tape) and paste it back in with a single click. 

 
If you press COPY instead of CUT, it won't remove the Entry from the EDL, but will still copy it to 
the paste buffer, allowing you to paste it in somewhere else, and so repeat that section of audio. 

After pasting, the Entry is still in the paste buffer, so you could paste in more copies. CUT, COPY and 
PASTE will therefore move, remove and allow you to repeat Entries in the EDL in just the same way as you 
would with text on a word processor. 

There are other methods to try, using the mouse in conjunction with some keyboard modifiers: 

1. When you hold the Ctrl. key on the keyboard, your drag-and-drop of entries will produce a COPY of 
the entry at a different time (and/or stream) location. 

2. When you hold the Alt key on the keyboard, you'll find that the drag-and-drop now only allows you 
to move the entry up or down to another stream, and thus retains the entry's sync position. 

3. Combining both of these allows you to make a copy on another stream, but at the exact same time as 
the original. 

 
You've now probably made a complete mess of your Playlist , so press the UNDO button on the 
Hardware Controller (or UNDO on the Playlist toolbar with the mouse) a few times to get it back 
to the initial state. There are 50 levels of undo. SHIFT + UNDO (or REDO) is REDO. 

These methods of arranging can also be executed using the hardware controls. There are some issues to 
consider; crude mouse movement of entries tends to be a little simpler because with one mouse movement 
you can quickly "grab" any entry you can see, but you'll find that once you're on a roll, accurate editing of the 
entries will be a lot faster with the Hardware controller. 

ENABLING STREAMS 

 
When you press EDIT/SELECT on the hardware controller, the entry directly underneath the 
current time will be selected in red. However, if there is more than one entry, you must also choose 
which Playlist stream you are pointing at. This is achieved by means of "Enabling" and "Disabling" 
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Playlist streams. An enabled stream appears with a lighter grey background, disabled streams use a 
darker grey. When some streams are disabled, then the EDIT/SELECT button, used in this way, 
will select entries on the topmost enabled stream (thus if streams 1&2 are disabled, an entry on 
stream 3 will be selected). Enabling and disabling streams is used for other functions, but these will be 
discussed later. 

 Clicking on the stream name button  will toggle the enabled/disabled state of a stream. 

 
Pressing the STREAM button on the hardware controllers will display a red border around a stream 
name button, which can be changed by using PREVIOUS/NEXT buttons or the wheel. 
EDIT/SELECT then changes an enabled stream to disabled and vice versa 

Modifier keys can be used to "block" change several streams: 

 Holding the Ctrl key on the keyboard, whilst clicking on a stream name button, will leave that stream 
enabled, whilst disabling all the others. 

 With the mouse or Hardware Controller, holding shift while clicking on a stream name button (or 
pressing SHIFT then EDIT/SELECT whilst in Stream mode) will toggle the enabled/disabled status 
of all streams above that stream that have the same status. Thus with the tutorial Playlist, with all 
streams enabled (light grey), if you hold shift and click on Stream 5&6, then 1&2, 3&4 and 5&6 will 
become disabled. Press shift and click on 5&6 to re-enable them. 

CUT AND PASTE WITH HARDWARE CONTROLLERS 

 
Disable Streams 1&2, and 3&4, by pressing their respective Stream name buttons. Move the current-
time cursor with the wheel so that it is over the entry "SFX". Press EDIT/SELECT to select the 
entry. It will turn red. Now press CUT and it will be removed from the EDL to a temporary paste 
buffer. Move the cursor to a new position, after the Entry "Music" and press PASTE. "SFX" will be 
placed so that its start is at the current time. As Streams 1&2, and 3&4 are disabled, the entry is 
pasted back to Streams 5&6. If you disabled 5&6 before pasting, then the entry would paste to 
Streams 7&8 and so on. 

NOTE: When hitting EDIT/SELECT, make sure that the IN, HOT, and OUT buttons above the 
wheel have not been pressed and lit, otherwise you will enter editing mode, which will be covered soon. 

 
SHIFT + EDIT/SELECT will deselect the entry under the cursor or add other entries for multiple 
selection. Other entries can be selected with the PREVIOUS and NEXT buttons. Pressing 
EDIT/SELECT with no entries under the cursor will deselect them all. If you have the CLIP button 
selected and lit, the wheel will select entries in turn. 

SLIP 

 
Press the SELECT TOOLBARS button on the Playlist toolbar again and select "Slip" to reveal the 
Slip toolbar: 

 
Press the first ENABLE SLIP button and then the third SLIP RIGHT button. Select an EDL Entry. When it 
turns red, all following Entries will turn dark blue indicating that they will move with the red one. Try it. 

SLIP LEFT and SLIP RIGHT pre-select whether previous and/or following Entries will be slipped when 
ENABLE SLIP is pressed. This is essential when you have many Entries in the EDL and you want to open or 
close up gaps without disturbing previous or following edits. On other occasions you will want to move an 
Entry on its own and will then turn SLIP off. 
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To move an Entry to the left so that it butts up to the one before it, select it and press REMOVE 
GAP. The SLIP feature will apply if enabled. 

 
Once you have pre-selected SLIP LEFT and/or SLIP RIGHT with the mouse as above, SLIP on 
the hardware controller enables/disables the feature. With SLIP on, you will find that cutting and 
pasting Entries causes Entries to the right to slip accordingly.  

 
Use the default Hotkey - F6 on the keyboard - to remove gaps to the left of the selected Entry. 

The stream enable/disable setting determines how the Slip function works; only entries on enabled streams will 
be slipped. Thus be careful to disable streams that must stay in sync (e.g. Stream 1&2 in our example). 

LOCK 

 
The lock buttons on the toolbar and streams, lock streams or entries to their current EDL time. 
These buttons are duplicated with Hotkeys and the LOCK button on the Hardware Controllers. 

Practice moving your entries around in the Playlist. 

When you have practiced enough, leave yourself with just the three Entries in the following rough order: 
"Music" (on Streams 3&4), "Voice" (on Streams 1&2) then "SFX" (on Streams 5&6).  

SAVING YOUR WORK 

At this point, if you were doing something more exciting than this tutorial, you might have created a complex 
EDL arrangement, so this is a good time to save your work as a file on the computer's internal Windows hard 
drive. 

 
Select "Save Project " from the Project menu, or press SAVE ALL PROJECT in the Project 
Window. 

 
Make the Project window active with the WINDOW button (its the one with the green folder icon) 
and press the SAVE button. The Project window can stay minimised when you do this. 

Alternatively, on the computer keyboard press Alt + P then S to use the Project menu Save command. 

Saving in this way will save all the components of your "Tutorial" Project, including the EDL you have created 
so far.  

EDITING - TOP AND TAILING 

Assume that the "Voice" clip is the sync material, and that it is placed in the correct position in the Playlist 
already, in sync with the video it was recorded with. If sync is of no consequence to the material you've chosen 
then don't worry. This is just an example. 

If you've made a complete muddle of your Playlist, then you can put the "Voice" clip back where it was 
recorded: 

 
Press the SELECT TOOLBARS button, and then select "Autoplace" from the menu, to reveal the 
Autoplace toolbar. 

 

 
Press the leftmost button AUTOPLACE ON, so that it's cross changes to a tick. 



Getting Started 

33 

 
Press AUTOPLACE BY TRACK START. Now pick the "Voice" entry up with the mouse and 
drop it again (anywhere) and it will snap back to it's original recorded time. 

 
Now turn off Autoplace, by pressing AUTOPLACE ON again, and then close the Autoplace 
toolbar by pressing the close window button  in the top right corner. 

Enable only Streams 1&2 (press Ctrl and click with the mouse on its stream name button); you're only 
concerned with this "Voice" entry at present. 

 It will also be convenient to mute the other streams using the MUTE buttons on the Mixer window, 
or MUTES on the Hardware Fader Panel. 

Experiment with playing the EDL and changing the horizontal and vertical zoom settings. You should be able to 
identify words and spaces in the Entry "Voice" as the cursor passes over them. At the moment you're most 
interested in the beginning and end of this clip. It is very likely that there will some silence or background noise 
at the beginning that you'll want to remove. 

 
Position the current time near the beginning of this entry, press JOG once to put the Hardware 
Controller into normal jog mode, and scrub the EDL until you're happy that you're as close as you 
need to be to the beginning of the entry. 

RAZOR CUTTING 

 
Press the RAZOR button on the hardware controller (or the RAZOR button on the Playlist 
toolbar) and the original "Voice" entry will now become two entries. 

 
Wind the wheel backwards until it is now over the shorter entry at the beginning, press 
EDIT/SELECT to make it red, and then CUT will make it disappear. 

That was a bit too easy really. Try another method. Press UNDO twice to put the beginning back to the way 
it was. 

PLAYLIST EDITING 

Position the current time near the beginning of the entry again. Now press IN on the hardware controller, 
check that the EDL/SOURCE button is not lit, and press EDIT/SELECT. The entry will visually change to 
have a red outline (to indicate that you are now in Playlist Edit Mode). Now, when you move the wheel, (in 
scrub or in "free-run"), the start of the clip will move, and (in scrub) you will hear the audio as the entry's new 
In point moves over it. 

Press PREVIEW to hear the result of your edit. 

Take this one step further. For some reason you've decided that this entry starts a bit "boldly" and would like a 
smooth fade into this audio. So, from the position you've left it in, now press CROSSFADE. Now, when you 
move the wheel, the graphic changes to show a ramp on the start of the entry to represent a fade in. Again 
preview until you're happy, switch off CROSSFADE and press EDIT/SELECT again; you have now exited 
Playlist edit mode, and have confirmed the changes back to the Playlist. You can switch back and forth between 
crossfade and In-point and you can change the zoom to give yourself a better view as well. 

Press OUT, and EDIT/SELECT and you will now jump to the end of the "Voice" entry and tidy up its end. 

To recap, CUT, COPY and PASTE allows you to delete, or move or copy clips to new positions in the 
Playlist. The RAZOR button cuts an entry into two separate entries. With IN, OUT or HOT selected, the 
EDIT/SELECT button puts you into Playlist Edit mode and allows fine tweaking of the beginning or end (the 
use of HOT will be discussed later) of the entry and CROSSFADE adjusts the fade-in or fade-out of this 
entry. You have been using the "EDL" mode of Playlist editing. 

NOTE: All of these changes do not make any changes to the basic recording; all your editing is NON-
DESTRUCTIVE. You are only changing the EDIT LIST, not the raw material. 

After all that editing, save the Project again. 



SADiE v5.4 PCM Manual 

34 

More detail on Playlist Editing Mode, and its operation with the mouse is described in the Editing chapter of 
this manual.  

EDITING THE MUSIC 

Now you're going to do a slightly more complex manoeuvre. In this example, you've now decided that the 
music is too long, and perhaps we want to use only a couple of sections of the music. 

First, unmute Streams 3&4, and mute 1&2 as you're working on the "Music" entry now. Also Enable just 
Streams 3&4 by Ctrl-clicking on its stream name button. 

This will also enable just streams 3&4, which will be important, as you'll be doing some slipping on this music 
(but you don't want to slip the sync track on 1&2). Also now, turn on SLIP as we did above, but this time 
make it SLIP BOTH (slip left and right pressed, and the SLIP button on) 

Move the current time and take a look and listen to the "Music" clip . You'll have to use some imagination, but 
remove some sections, then make a nice clean edit between the sections that remain. 

So, by listening and scrubbing, make a RAZOR cut at the beginning of a section that is going to be removed. 
Now on the hardware controller, press IN and press EDL /SOURCE, so that the light is lit. Edge the wheel a 
little to the right, so that the current time is definitely positioned over the right-side entry. 

Now press EDIT/SELECT. The entry on right side of your razor cut will go into Playlist Edit Mode, but we 
are now using the "source" mode for editing. This time, moving the wheel will move the whole of the edited 
clip through the edit point, so now the edit point is stationary and the whole entry is sliding against sync. If you 
move the wheel anti-clockwise, the audio will move forwards and you will be "throwing away" the audio that 
disappears under the In point. Or moving the wheel clockwise will move the entry in the other direction, now 
you will be repeating the previous section (perhaps you want to loop this section to extend it?). Using scrub, 
find a position that will make a nice edit (!). 

You may discover that having found a decent point in the right-side entry, when you PREVIEW, the edit is 
still not perfect and perhaps you need to re-adjust the left side. You can press PREVIOUS and now the right 
side entry of this edit will go into Playlist Edit Mode, this time focusing on it's Out point; PREVIOUS and 
NEXT toggle between viewing the Out point of the out-going (right-side) entry and the In point of the in-
coming (right-side) entry. 

When you're happy with the first edit, do it again, later on in the "Music" piece. You may notice that on other 
edits, the clips previous and after the edit point will slide together (so as not to destroy the edits you've just 
made). This is caused by the SLIP function; the action of slipping an entry by using the Source mode of Playlist 
Editing causes the same amount of slip to happen on entries to the left and right (assuming we have SLIP 
BOTH set). Thus edits stay together. 

Now you have 2 or 3 edits, and hence 3 or 4 entries comprising your music. You may want to top and tail the 
first and last entry too. You may have also used the Crossfade function again to smooth some these edits. 

GROUPS 

It may be a good idea to group these three music entries together, so that any further movement works on 
them all together. 

Select all the "Music" entries. You can do this by dragging across them with the mouse. 

 
Press the SELECT TOOLBARS button, and then select "Group" from the menu, to reveal the 
Group toolbar. 

 

 
Press GROUP SELECTED EDL ENTRIES. They will be redrawn as a single block in the Playlist 
and can therefore be moved around together easily. 

 
Note that you cannot use Playlist editing on group clips, and thus if you do need to tweak these edits 
further, you will need to ungroup the group clip, e.g. select the group then press UNGROUP. 
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Ideally your music is long enough to run all the way underneath your "Voice" clip. It doesn't matter if it doesn't; 
it can be "Intro" music rather than a "bed". Select all these "Music" entries with the mouse, by dragging a box 
around them and making them all red, then drag and drop all of them into an appropriate position. There are 
ways of positioning these more accurately by using Cut and Paste in conjunction with other Autoplace options, 
but for this is not so important; for now consider the music to be "wild". 

Unmute everything to listen back to your Playlist so far. Save the project again. 

To recap, the "Source" mode of editing differs from the previously described "EDL" mode in that the audio 
slips through a stationary edit point, whereas with EDL mode editing, it is the edit point itself that moves, and 
the audio remains in sync. Source mode can offer very quick and powerful editing to remove errors (umms and 
errs maybe) and edit music, but it does destroy the sync of the material.  

SPOTTING EFFECTS 

So we have a "Voice" entry on Stream 1&2 and now a set or group of edited "Music" entries on Streams 3&4. 
The "SFX" entry is sitting somewhere on Streams 5&6. You now want to place this sound effect at an 
appropriate position with respect to the rest of our audio. You can now go back ONLINE again, as you're 
going to use the picture as a reference for the positioning of this "SFX" entry. 

First, tidy up the bang, or whatever "SFX" you've chosen. You can unmute everything now; the Voice track and 
the music may be relevant to the placement of this entry. Enable just Streams 5&6 (by Ctrl-clicking on the 
stream name button again), and locate close to the position of this "SFX" entry, then top and tail it using Playlist 
Edit to suit. 

When it is tidy, exit Playlist editing mode. 

Now, by using Play and/or Scrubbing the rest of the Playlist (ONLINE with the VTR), find the exact position 
that you want this "SFX" to occur, referring to the Video and the "Voice" entry. 

Without moving the current time, using the mouse, drag the "SFX" entry until it is underneath the current 
time, close to it's final position. (If you're getting good at this, you'll probably be able to see the bang from its 
waveform and thus be able to place it with perfect accuracy, but that would be showing off.) 

 
Press HOT and then SOURCE (EDL/SOURCE light lit) and EDIT/SELECT to put the "SFX" 
entry into Playlist Editing using HOT/SOURCE mode. Check that you're still editing in Jog. 

Now when you move the wheel, the whole edited "SFX" entry will slip in time, without changing any 
other In or Out edit points. Because the current time is fixed, you should be able to fine-tune the 
position of this bang to put it exactly in sync with your chosen position in the rest of the material. 

Preview it. Sounds nice? Better oughtta save again! 

CLIPSTORES 

Try one more thing. Let's say that you want to use this "SFX" clip a few more times during this project . You 
can save this edited clip in Clipstore, so that next time you need it, it is nicely edited up and ready to drop in 
place. 

There's a little more preparation you can do on this entry before you save it. First, with the mouse, select the 
edited "SFX" entry, then right-mouse-click it. Go for the Edit Entry Name option in the menu that appears. Call 
it "Bang" or some such other recognisable name. 

Next mark a Hotspot inside the clip; this will be set as a sync marker inside (or outside if necessary) the entry, 
and when you re-use this entry, you can automatically place it with respect to this Hotspot/sync marker. 

 
HOT should still be selected, and this time you'll use EDL mode (EDL/SOURCE light not lit), so 
press EDIT/SELECT again. This time, moving the wheel will move only a little blue vertical line 
within the clip; this blue line is the Hotspot. Scrub this until you're satisfied that you've marked the 
sync point within this "Bang", probably the point at which the "Bang" reaches its first peak, or some 
other recognisable point you can use for synchronisation. 

Press EDIT/SELECT to finish editing again. 
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Now press the COPY TO CLIPSTORE button on the Playlist toolbar. This makes a copy of the 
entry, with all its edit details, into the Clipstore. Click in the Clipstore or press WINDOW to move 
to it, and you will see the new entry, "Bang". 

Any Clipstore entry can dragged and dropped into the Playlist with the mouse (or Copy and Paste 
using hardware controller), but all the others currently in your Clipstore refer to "source tracks" e.g. 
original recordings, whereas the new "Bang" is an edit. 

NOTE: It is worth noting that the original, unedited, Tracks that you recorded are always available in 
the Clipstore. Restore your Clipstore window to normal size and you will see them in a folder labelled 
Source Tracks. So, if you wanted to start the editing exercise all over again, you could use the original 
tracks out of the Clipstore. 

Move on to find a new position in the existing Playlist that requires a jolly good "Bang"! Play and scrub until 
you've located the exact sync position for another effect. 

Remember the AUTOPLACE toolbar? You used it above when you made a mess of our Playlist, and this 
helped you put the "Voice" entry back in sync. Well there are some more Autoplace options. 

 
Press the SELECT TOOLBARS button, and then select "Autoplace" from the menu, to reveal the 
Autoplace toolbar. 

 

 
Press the leftmost button AUTOPLACE ON, so that it's cross changes to a tick. 

 
This time press AUTOPLACE HOTSPOT TO CURRENT TIME. 

 
With this Autoplace setting, view the Clipstore again. Click and hold the "Bang" clip, and drag it onto 
the appropriate stream (5&6 this time) in the Playlist, and wherever you drop it, it will snap so that 
the previous marked Hotspot jumps to the current time. 

 
View the Clipstore using WINDOW, and Select the "Bang" clip using the wheel. Press COPY, then 
WINDOW to get back to the Playlist, then press PASTE. 

Of course, if you fill up your Clipstore with appropriately pre-edited sound effects clips, then picking them and 
spotting them into the Playlist becomes a very quick routine.  

MIXING AND AUTOMATION 

You've been encouraged to do a rough mix, using just the faders on the Mixer Window or Hardware Fader 
Panel, but let's take this just a little further. 
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1. Strip Input 

2. Enable Automation 

3. Strip Number 

4. Mixer Configuration Tools 

5. Automation Tools 

The Mixer works just like a studio mixing desk with a multi-track tape machine. The default Mixer you have on 
screen contains a channel strip to control each Stream and two more acting as stereo masters by controlling 
the Mixer's internal busses one and two. So this Mixer's routing arrangement is as follows: 

Stream 1  Fader Strip 1     

Stream 2  Fader Strip 2     

Stream 3  Fader Strip 3     

Stream 4  Fader Strip 4  Internal Bus 1  Master Fader, Strip 9  Output 1 

Stream 5  Fader Strip 5  Internal Bus 2  Master Fader, Strip 10  Output 2 

Stream 6  Fader Strip 6     

Stream 7  Fader Strip 7     

Stream 8  Fader Strip 8  

 

   

NOTE: An internal bus can be thought of as a subgroup within the mixer. 

 
With the mouse, it is easier to have a single fader controlling both channels of audio for the stereo 
Entries, so let's create stereo mixer strips to go with the merged Playlist Streams: 

 Right-click on Mixer strip 1, just above the fader, and select "Merge into Stereo Strip". This will 
combine two separate Mixer strips into a single stereo one controlling Streams 1&2. 
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 Repeat to merge the strips controlling Streams 3&4 into a Stereo strip. Note that the strip numbers 
are now different from the numbers of the Streams that they control. 

 
If you are using hardware controllers, merging strips is perhaps less necessary as you have the added 
dexterity of separate fingers on separate faders. However merging streams does give you "more" 
faders on the panel. 

 
Press the ENABLE AUTOMATION button on the Mixer configuration toolbar. 

 
Make sure that the Mixer is the active window (coloured title bar). If not, use the WINDOW 
button. Then hit AUTO to enable the automation. 

The automation toolbar will be added to the Mixer. 

 
For this tutorial, make sure that the KEEP button is down, as this will let you try just one 
automation mode. 

Play the Playlist from just before the start. As you see the first words of the speech coming up you can fade 
down the "Music" on Streams 3&4. 

Play over that section again; your fader movements will be reproduced and your mix replayed. 

NOTE: Because the fader movements you make are being recorded as changes to the EDL . you can use 
UNDO to go back a step and do the first mix again, or improve on it by playing it and making small 
adjustments. 

You can view the automation moves as a line graph over the clips by focusing the Playlist (with the WINDOW 

button) and pressing AUTO on the Hardware controller, or by pressing near the top left corner of the 
Playlist. 
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Go to the end of the "Voice" entry and do a mix to fade the "Music" back up again during the end of the 
"Voice". 

When you are (reasonably) satisfied with the result, save the Project again. This will save all the components of 
the Project . e.g. the EDL (with its editing, Stream layout and fader automation), and the new Mixer layout. 

NOTE: Each time you save the EDL within the Project, you are overwriting the previously saved 
version. If you want to be able to return to an earlier version of an EDL, you need to save the new one 
with a different name. To do this, make the Playlist active and select "Save As" from the File menu. You 
can then type in a different name, thus creating a second EDL within this Project. 

NOTE: When you make any File command, the type of file to be opened, closed, or saved is determined 
by which window is active. 

There is a more detailed description of Mixer functions and Automation in the Mixing and Processing chapter 
of this manual.  

THE FINISHED PRODUCT 

If you are pleased with what you have done, you can dub it onto another medium (say a DAT or 1/4" tape) by 
playing the EDL and recording from SADiE's (digital or analogue) outputs one and two. 

If you choose to use SADiE's digital outputs, you may need to set the digital output format: 

 In the menu bar, choose "View", then "Setup Window". From the list on the left, double-click on 
"Audio" and select "Further Audio Settings". 

 In the "Output Format" section, select SPDIF or AES/EBU to match the format required by your 
recorder's digital input. 

NOTE: The selected format is available on the XLR connector on the Breakout Panel. It is standard to 
use an XLR for AES/EBU and an RCA phono socket for SPDIF, and so you will need a connector 
converter and/or impedance match to connect to an RCA SPDIF input. 

If you are very pleased with the result, you could perhaps record this back to the videotape, using the Edit 
controls on the Machine Control Window; refer to the section in the "Specific Applications" chapter.  

SHUTTING SADIE DOWN 

It is important to shut down the software correctly and only turn off your computer when you have done so. If 
you simply turn off the power when SADiE is running, you risk losing work or even damaging the audio disk. 
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1. Close the SADiE main window by: 

i. Clicking on the window close button  on the right of SADiE's main window title bar, OR 

ii. Double-clicking on the icon on the left of SADiE's main window title bar, OR 

iii. Selecting "Exit" from the File menu, OR 

iv. Pressing Alt + F4 on the keyboard. 

2. SADiE will warn you if there are any EDL's, Clipstores, or Projects that have not been saved since 
they were last altered. 

3. Click on the "Start" button on the Windows Taskbar, select "Shutdown" and "Yes" to shutting down 
the computer. 

4. Windows will tell you when it is safe to turn off the power.  
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3 - RECORDING 

RECORDING 
Overview 

Multichannel Tracks 

Recording to the Playlist 

Background Recording 

Time Stamping 

Choosing a disk for recording 

Input Monitor Window 

Importing and Ingesting Audio 

RECORDING OVERVIEW 
When you record a Track (SADiE's name for an audio file) you are always recording directly to one of your 
hard disks. 

There are two ways of recording source Tracks. If you record using the Playlist and Transport Controls, SADiE 
will place the Track as an EDL Entry in sync with the position of the current-time cursor during recording. This 
is like recording to a multi-track tape machine. 

Alternatively, you can use the Background Recording window, which doesn't place the Track in a Playlist, but 
actually lets you work on and replay another Playlist, whilst recording "in the background". In either case, the 
Track will always be available in the relevant Clipstore's Source Tracks folder, or available to be imported into 
the Tracklist of any Project . so that you can paste it into any Playlist.  

Modern workflows often use file-based methods of importing or ingesting audio material. In a later part of 
this section you will find topics describing the Importing of audio from disk drives or from CDs. 

MULTICHANNEL TRACKS 
SADiE labels Tracks that you record in one of three ways: Mono, Stereo, or Multichannel. Multichannel Tracks 
are made up of individual mono or stereo parts. 

For example, you might want to record eight channels of drums, from a stereo pair of overheads and six 
individual mono microphones. The resulting Multichannel Track will be made up of one stereo and six mono 
parts. As a single Track, it will be treated as a whole when moved around the system, but the component parts 
are accessible by opening up the tree structure in the Clipstore, or using the UNGROUP button. 

The parts of Multichannel tracks are identified by the name of the Stream to which they were recorded, so you 
may want to rename Streams before recording (see Arranging an EDL).  

RECORDING TO THE PLAYLIST 
NOTE: If you have already been using a Playlist and now want to record unrelated material for different 
work, you may want to open up a new, empty Playlist to record into. This can be done under the File 
menu. However, it is more useful to create a new Project; this will give you a new Playlist and set you 
up for keeping track of all your work. 
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1. Open the Record section of the Transport Controls. 

2. Press SETUP which takes you directly to the Audio section of the main Setup window, so that you 
can check or change: 

i. The input source that you are recording (AES Digital, SPDIF Digital, Analogue or Optical 
digital). Depending on your hardware, some of these options may not be available. 

ii. The input sample rate and resolution. 

NOTE: With an analogue input, the sample rate and resolution will determine how the signal is 
converted to digital audio. The bit resolution of your hardware will determine the maximum bit 
depth possible. Of course, you can use external converters to convert an analogue signal to 
other sample resolutions before being feeding it to SADiE as a digital input. With digital input, 
SADiE's sample rate needs to match that of the input signal, otherwise your material will play 
back at the wrong speed, and the profile will not line up with the audio. 

3. Enter a name for the Track you are about to record by clicking in the white Track name box. Finish 
with the Return key ( ). 

i. The AUTOTAKE button adds a two or three character take number to the name. This 
number increases automatically each time you enter record. This saves you retyping a name 
each time when recording multiple takes. For the purposes of this Help file, it is assumed that 
you have Autotake ticked, so that if you go into record repeatedly, there is no need to type a 
new Track name. If you don't have Autotake set, when you go into record and the current 
Track name exists already, you will be warned and will have to change the name in order to 
carry on recording. 

ii. The RETAKE button lets you delete the last take and so keep the take number for the next 
attempt. 

iii. PROPERTIES brings up a box showing details that will be stored with the Track, some of 
which you may want to enter or change at the time of recording. See the next section for a 
description of each. 

4. Check that the RECORD SOURCE button for each Stream that you want to record onto is set 
correctly. 

i. You can change the recording source by pressing the INPUT SELECT button and 
selecting from the drop-box that appears. 

ii. Normally you will be recording direct from the system's physical inputs, but you can also 
record from the outputs of Streams, internal busses, or the whole system. This enables you 
to "bounce-down" material in SADiE, or use a Mixer channel strip to apply EQ, dynamics 
processing or digital level control to the input before it is sent to the recording Stream.  

5. Press the  (or see below) RECORD ENABLE buttons on the Stream(s) you want to record 
onto. 

i. If you have "E to E" selected in the Mixer section of the Setup window, you will now be able 
to monitor and check the level of the input signal. See Recording Levels, below. 
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ii.  
There are Hotkeys available to Record Enable the first 32 Audio Streams. There are 
also Hotkeys to Record Enable all Streams, and to Disarm all Streams. These are set 
in the Playlist Record Enable section of the Hotkey Setup. 

6. Press RECORD to start recording immediately, or play the Playlist (you will be in record-standby 
and the record button will flash) and hit RECORD to drop in ("punch-in") on the fly (see Dropping 
in). 

Pressing PAUSE before you press record will put you in record-standby mode, with input 
monitoring. If you press PAUSE while you are recording, the current Track will end. A new one will 
begin when you release the pause button again. The small time display at the bottom of the Transport 
Controls shows the duration so far of the Track being recorded, or the amount of remaining time 
available on the relevant audio disk, depending which button is selected above it. 

7. Press  STOP to stop recording.  

* Note there is an optional appearance for the  record enable buttons. As default they appear as a Red 
R, however buttons with more colour can be chosen. The circular coloured record enable buttons 
change colour to give information about the current record status. See the Multi-track Rec Enable 
setting in Playlist setup 

- Record Tab 

MONITORING THE RECORDING 

There are two functions that determine how the input is monitored during a recording. 

1. E TO E MODE 

This is a setting (under View menu, Setup window, Mixer , E to E mode). More usually you 
would want to hear audio from the physical input when you press the  RECORD ENABLE 
buttons for the streams; this is the default setting and "E to E on record enabled streams" ticked. 
You do have the option to disable this. This determines what happens when the Playlist is 
stopped. 

2. MONITOR SOURCE 

This is a tick-box on the Transport Controls Record Tab, which determines what happens 
during playback but before you punch into record. 

This toggles monitoring to be "from source" or "off tape". When ticked, you will hear the source, and 
hence the new recording. When unticked, you will always hear any clips that are currently on the 
stream; if there are none then it will be silent. You can toggle the SOURCE button during playback 
to switch between input and what's already on the stream. When the  RECORD button is 
pressed, you will always be monitoring the input source, as the entries underneath are always 
replaced. 

Below is a table, which describes what will be monitored with the various combinations of E to E and 
Source Monitoring. 

E-E SOURCE Playlist stopped, 

Record enabled 

Playlist playing, 

Record ready 

Playlist playing, 

Recording 

OFF OFF Nothing EDL Entries Input Source 

ON OFF Input Source EDL Entries Input Source 

ON ON Input Source Input Source Input Source 

OFF ON Nothing Input Source Input Source 
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TRACK PROPERTIES 

The Properties box displays, and allows editing of, information that will be stored with each Track. After 
recording, it can be accessed from the listing of Tracks in the Project window. 

 "Format" allows you to select the file format of the Track to be recorded here. See File Formats. If 
you leave this set to "Native", SADiE will use the recording format appropriate to the formatting of 
the disk being used. 

 The "Reel Name" and "Track Number" boxes are only used for Autoconforming. 

 The "Start Time" and "Length" are for later display only. 

 The "Sample Rate" and "Resolution" will normally follow the input settings in the Setup window. 
However, you can set this Track to be recorded at a lower sample resolution than the current input 
setting. 

NOTE: You can record with Varispeed on. This may be useful for performing frame-rate conversion 
using the 24/25 and 25/24 pre-sets. 

 "Emphasis" sets either of the two standard emphasis flags for the Track. 

 "Backup" references for the Track will be displayed in the Tracklist in the appropriate Project window; 
see the section on Archiving. 

 "Comments" can be entered for the Track, if recorded to a SADiE 3-formatted disk. These will then 
be displayed for later viewing of the Track Properties box.  

RECORDING LEVELS 

The Mixer's meters and the small PPM's alongside the Stream controls will give some indication as to the input 
level, however you may find it useful to open the Metering Window when recording, in order to view the Input 
PPM's. Otherwise Stream strips can show levels Pre-fader, whereas Output mixer strips will show level and 
peaks Post-fader (hence if you've applied any level changes in the Mixer, they will not show the input level). If 
your Stream and Output faders are at 0dB, then the metering on the Output faders will be displaying the same 
as the Input meters. 

If you do set up a Mixer strip to control the system input it is possible to apply digital level control to the 
recording. However, this control is after the analogue-to-digital converters, so any adjustments necessary to 
analogue input signals in order to avoid overloading or under-modulating the converters must be made 
externally (e.g. on your mixing desk). 

Adjusting the fader of such a Mixer input strip will affect the level recorded on the audio disk. Note that you 
can overload the recording if you increase the level, so watch the meters. You can't improve a noisy signal that 
results from converting analogue at too low a level. 

If you don't apply any input level adjustment, digital input signals will be optimally transferred as 1:1 copies.  

RECORDING IN NON-REAL-TIME 

Certain recording operations, such as internal bouncing down with processing, are not restricted to real-time 
operation, by the need to work at the same rate as the equipment supplying the audio input. When NON-
REAL-TIME is selected, these tasks will be carried out as fast as possible. Of course, if you want to listen to 
the audio as it is recorded, you must work in real time.  

MAKING CUTS DURING RECORDING 

 
The RAZOR and SCISSORS buttons will work during recording, dividing the Entry that is being 
placed in the Playlist. This can be a useful way of marking edit points that you will need to return to 
later. 

 
If you operate the PAUSE button during recording, you can "edit-out" the incoming signal until you 
release it again. Recording will resume as a new Track, so you must use Autotake, otherwise SADiE 
will assume you want to re-record using the previous Track name. 
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An alternative pair of functions exists which can be used to mark edits and also remove unwanted sections 
during recording. These are the "Clip In (and Out) point to current time" Hotkeys, as described under Quick 
Edit. 

OVERDUBBING 

When you record into a Playlist that already has EDL Entries in it, these will be replayed as you record. 
Therefore you can record, for example, a singer on Stream 3 in sync with, and listening to, a stereo guitar 
already recorded on Streams 1&2; or a voice-over on Stream 1, while hearing a music bed already on Streams 
3&4. You can even use the automation to record a mix of the level changes for the music bed while you record 
the voice-over. When overdubbing, you will probably want to drop into and out of record as described below.  

DROPPING IN AND OUT OF RECORD 

Once you have record-enabled your chosen Stream(s), you can drop into record ("punch-in") manually as 
follows: 

1. Play the EDL from any point (the Record button will flash red to indicate that you are in record-
standby). You will not be monitoring the input, (unless you have selected E-to-E mode in the Mixer 
section of the Setup window). 

2. Hit the record button when you want to drop in. If there is an EDL Entry on the Stream at this point, 
SADiE will replace it with an Entry of the new recording up to the point where you... 

3. Drop out or record by pressing the play button again. 

NOTE: As this is non-destructive, the underlying recording has not been erased. It is still available by 
using Undo when using any of SADiE's editing modes, or returning to a previously saved EDL. 
Additionally, the whole Source Track can still be found in the Clipstore. If you don't want to replace an 
EDL Entry, record on a different Stream. 

NOTE: You cannot use the record-enable buttons on each Stream to actually drop in. These must be 
pre-set, and the record button used to do the drop-in. 

Automatic drop-ins can be set up as follows: 

1. Open the L-R locators section of the Transport Controls 

 
2. Set the Left and Right locators to the points you want to drop into and out of record. There are 

several ways you can do this: 

i. Click on the L and R buttons to set them to the current time, either on the fly during 
playback, or when stopped. The red indicator will show that a point is stored in the button 
memory. The time displays show the EDL time set, OR 

ii. Hold the Shift key and click at the required point in the Playlist time bar. Use the left and 
right mouse buttons for L and R points respectively. 

Once set, clicking on a button will locate to that point (this is not allowed during playback) and 
markers will appear in the Playlist time bar to show the position of each. Dragging these with the 
mouse will adjust the points. Other ways to adjust them are described in "Using the Playlist". 

3.  
Press the DROP-IN button. Once you have record-enabled your chosen Stream(s), when you 
play the EDL, SADiE will drop into record at the Left locator point and drop out at the Right. 

 
Pressing LOOP causes playback to repeat between the left and right locator points. In the Transport 
Controls section of the Setup window (accessible from the "View" menu), you can set pre and post-
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roll times. These determine how much of the EDL SADiE plays either side of the L and R points. 

Thus you can repeat a section, recording in sync each time, until you have the take you want. A new 
Track is created for each drop-in. 

NOTE: SADiE actually records a second or two after any dropout and a second or two before an 
automatic drop-in. These pre and post-handles allow later edit adjustment. 

Double-click on an L or R button, or click while holding the Ctrl key, to clear the button's memory.  

BACKGROUND RECORDING 
In many ways this is the quickest and easiest way to record a mono or stereo Track that you can then access 
from the Source Tracks folder in the Clipstore. What's more, you can carry on other work in a Playlist while 
the new Track is being recorded. 

As with Recording to the Playlist, described above, first make sure you have the correct settings in the Audio 
section of the main Setup window. This is accessible from the "View" menu or from the SETUP button in the 
Transport Controls. 

 
1. Open up the Background Recording dialogue box from the "View" menu. 

2. Enter a name for the Track you are about to record by clicking in the white Track name box. Finish 
with the Return key ( ). 

i. The AUTOTAKE button adds a two or three character take number to the name, and this 
number increases automatically each time you enter record. This saves you retyping a name 
each time, when you are recording multiple takes. 

ii. The PROPERTIES button is described under Playlist recording. 

3. Select whether to record a Stereo or Mono Track. 

NOTE: If the material you are recording into SADiE is mono, don't record it as a stereo Track, 
otherwise you will be using twice as much disk space as necessary. 

4. Press the INPUT selection button to determine which inputs you are recording from. 

5. The MONITOR selection button determines what outputs you can monitor the recording on. Note 
that if you intend to play anything through your current Mixer while background recording, you 
cannot monitor the recording on the same outputs used for the Mixer. With a multi-card system, you 
can only monitor on the same unit as the input. 

6. Press START to begin recording. 
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i. Check the recording level on the meters. Any adjustments necessary to analogue input signals 
in order to avoid overloading the system's analogue-to-digital converters must be made 
externally (e.g. on your mixing desk). 

ii. Depending what you select, either the duration of the Track being recorded, or the remaining 
time available on the audio disk will be displayed in the small time display. 

7. Close the box and recording will continue in the background while you do something else. 

8. To stop recording, open the window again and press STOP. 

i. Alternatively, if you select SPECIFY LENGTH, you can use the time display below to enter 
the length of time that the recording is to last. It will then stop automatically.  

TIME STAMPING 
When recording into the Playlist, the position of the current-time cursor as you record indicates the "time-
stamp" that will be applied to the Track. You can see the start time recorded in the Track Start column of the 
Clipstore. So, when you are recording in sync (either by being synchronised to external equipment, or by 
overdubbing in sync with other material in the Playlist) the new Track will always carry a record of its correct 
original EDL position. If you move it, or store it in a Clipstore, it can always be replaced in a Playlist in the 
correct sync by using the "Autoplace by Track Start" function. 

When background recording, the Track will always be time-stamped from zero. 

The Time-stamp of an entire track can be changed, using the "Resync Track" function. This is a permanent 
change, and there is no way of undoing this process; this is potentially a very dangerous thing to do unless you 
are sure that you want to do it. The function is found by right-mouse clicking on a single EDL entry. It works 
by changing the Track Start time of the Source Track so that the currently selected entry becomes perfectly in 
sync. 

EDL's find the correct audio to play by searching the associated Source Tracks for the correct Entry Time 
range, and so if you change the time stamp you will change the Entry times. EDL's that reference the track you 
are resynchronising will be adjusted to use the new Entry times but only if they are open when the "Resync 
Track" process takes place. If an EDL that uses the track is closed, it will have no knowledge of the sync 
change, and thus will play the wrong audio, or not be able to find the Entry time range if it now no longer 
exists. 

For these reasons, the undo history is re-set when you resynchronise a track.  

NOTE: Time stamping can only apply to Tracks that are recorded in a file format that can hold a time 
stamp. For instance, simple WAV or AIFF format files cannot hold a time stamp, and thus will always be 
time stamped from zero. SADiE native format and BWF (Broadcast Wave) can be time stamped. 

CHOOSING A DISK FOR RECORDING 
When recording, it is possible to record to one specified disk drive, to alternate disk drives when you record 
or, if you have a Multi-card system, to choose a different drive for each unit. 

When you start a project, with a system that has more than one disk drive, you will be offered the Audio Disk 
Selection Window. 

Drives and/or directories in this list are those that have been nominated as potential Record Destinations in 
Disk Management. 

 
You can also see this window by pressing the SELECT DISK button on the Project Window 
toolbar. 
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This lists the recordable drives attached to your system. 

This window will open up, defaulting to "Use specified disk(s)". If you select a drive and press "OK", the disk 
you select will be chosen for every recording. 

"Use least full local disk" allows you to record to whichever drive has the most space remaining. 

"Use each local disk in turn" will choose a different drive for every track when SADiE goes into record. The 
number of tracks depends on how many streams are involved, how they are grouped (a stereo track is one 
track not two) and what file format you are recording to. So if for instance you are recording 8 tracks and you 
have 4 disks connected, then each disk will record 2 tracks, and thus the load on the disks is evenly spread. If 
your disks start to become full when making multi-track recordings, your maximum record time is the time 
remaining on the most full drive. 

Tracks that are recorded at the same time are grouped together in the Playlist and can be manipulated and 
edited as if they are one single, Multichannel clip. You can separate these clips out and regroup them, as long as 
they are still in the same time relationship to each other. This applies to multi-unit and multi-disk recordings as 
well as those on single unit systems. 

INPUT MONITOR WINDOW 

 
The Input Monitor Window is called up from the "View" menu. It reports on the state of the digital inputs to 
the SADiE system. On enabling a digital input, the top box of the window will display Channel Status 
information and the list below will log errors if and when they appear. The logging will tell you the time of day 
if there is no playback, or the EDL time if an error is logged during recording. If the error has an EDL time, 
double clicking on that line in the list will locate the EDL to the correct position. 
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If you tick "Pop up automatically on error" you can hide the window and it will re-appear should anything need 
reporting. 

Errors may be caused by poor connections or dropouts on digital tape, and are often detected when DAT 
machines are in pause or shuttle modes.  

IMPORTING AUDIO FILES 
SADiE provides a number of ways of Importing (otherwise known as Ingesting) Audio files into a project. 

 Audio associated with EDLs, or external Interchange formats (such as AAF, OMF, AES31, Pro 
Tools sessions etc.) will usually be imported at the same time as the EDL is converted and attached to 
the project. If however the file's location has changed substantially from the reference contained in the 
EDL, it may be necessary to import the files manually by the next method to link them to the EDL. 

 Import Source Tracks - you can browse for files that are located on local or network disk drives 
(or CD-ROM, DVD-ROM etc) and import them - this function is accessible either from the Clipstore 
or from Disk Management. 

 Import from CD - this function is available from the Clipstore and copies audio from Audio CDs.  

WHERE ARE THE AUDIO FILES STORED ?  

THE PROJECT HOME FOLDER 

A SADiE project always has a "home" directory into which audio that is first digitised within this project is 
stored. 

You set this in the Project Window - press the  Select Audio Disk button (or right mouse click anywhere 
in the Project window a choose "Select Audio Disk"). This will offer a root directory (or a number of them if 
you have set up more "Record Destinations"), and the Project's home folder will be a sub-folder of the same 
name as the Proiect. 

So, if your Record Destination is "C:\Audio" then the audio belonging to a Project called "Project Name" will 
be stored in a folder called: 

C:\Audio\Project Name 

However it is possible to use files that are not inside this "home" directory - in fact files in any directory on any 
disk drive that can be seen by the PC - whether local or across a network, can be imported and used in the 
Project. 

There are two methods of importing audio into a project a) Import b) Copy and Import which are described 
below. 

The method you choose will depend on your workflow, but the fundamental rule is that  

Audio files in a Project's Home Directory belong to that Project; files that are situated in any other directory do not ! 

Thus when you delete a project, it's Home Directory (or directories) and the Audio fiels inside will be deleted.  

If Project A is using audio situated in Project B's home directory, when Project B is deleted, Project A will no 
longer be able to link to these "foreign" imports (you've just deleted them !). 

Note : if you change a Project's home directory during the life of the Project, then it has a memory of 
it's previous "home" folders; when it comes to deleting the project, any earlier home folders and their 
contents will be deleted. 

 

IMPORT SOURCE TRACKS 

If you right mouse click anywhere inside the Clipstore window, a menu will appear which will contain the items 
we're interested in here: 
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Import source track(s) - Files will be imported into the Clipstore for use in the project, but they will remain 
in their original location. They will be "foreign imports" and do not belong to this project. 

Copy and import source track(s) - Files will first be copied from their original location to the Project's 
current Audio Disk ("home" folder). The copies in the home folder will then be imported into the clipstore for 
use in the project. The original files are untouched, and are not associated with this project. The new copies 
however are in the project's home folder and thus now belong to this project. 

Sample Rate Convert on Import - note that if you use "Copy and Import" on files that are at a different 
sample rate from your current global setting, SADiE will offer to automatically convert them as it copies. 
Sample Rate Conversion is applied at "Super" quality. 

This function may have wider uses - for instance to sample rate convert all the source files in "Project A" , just 
create new project, change the sample rate and Copy-and-Import the files from Project A. 

Additionally these functions are available in Disk Management, by right-mouse-clicking on a folder, file or 
multiple selection of files. 

When used from the Clipstore, either of these opens a Disk Management window; you can browse through 
folders to find the audio you wish to import. 

You can select multiple audio files using CTRL or SHIFT modifiers to select. You can also import an entire 
folder's contents by selecting a folder on the left side of the import window. 

Compressed Audio Files can be imported from MPEG (including movies) or WMA formats. When a 
compressed file is imported, a new linear audio file is created, thus "Import and Copy" and "Import" perform 
the same function in this case. See Compress Audio for more detail.  
 
It's also possible to import audio from an AVI file - right mouse click on the AVI clip in the clipstore and select 
Rip audio from AVI file. 

COPY NON-PROJECT AUDIO LOCALLY 

Also of interest here is the Copy non-project audio locally function. This will look for any "foreign imports" 
that are imported into the project from external folders, and copy them to the Project's current Audio Disk 
(home folder). With this function you can make the external files "belong" to the project. 

You could perhaps choose to use the standard Import function over the Copy & import because of the extra 
time it may take to copy larger files; but then use the "Copy non-project audio locally" function at a more 
convenient time to pull these imports into the project folder. 

I should point out that the term "locally" in the name of this function is a misnomer - it will on only copy files 
locally if the Project's home folder is a local one (as is perhaps more usual) but in the situation where Project 
Folders are on a remote server then of course files will be copied to the server. 

Note that in the case where the project has a history of having several home folders, audio files that are 
in a folder which was once a Home Folder, but is not one at present will not be copied. Once a Home 
Folder, always a Home Folder !  
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IMPORTING FROM CD 

This provides a simple method for copying audio from Audio CDs, and at the same time imports the newly 
created audio files into the current project. 

Automatic Sample Rate Conversion will be applied where needed – i.e. if your current system Sample rate is 
not 44.1KHz, then the SRC will be performed as part of the import process. Sample Rate Conversion is applied 
at "Super" quality. 

Right mouse clicking inside the Clipstore Window, and also Right Mouse clicking over a CD drive in Disk 
Manager, will now offer the menu item: 

Import CD Track(s) 

 
(note as with many CD operations, this box may take a little while to pop up, if you’ve only just inserted the 
CD.) 

The tracks on the CD are listed in order, with their timings. If the CD has CD text, then the track names will 
be displayed above, otherwise they will be called “Track 1”, “Track “” etc…. 

• Preview individual tracks by right-mouse-clicking against the Track name or number. 

• Select the tracks you want to copy by ticking the boxes to the left. 

• Select the read speed. In practise we feel it’s best to set it to a speed which is comfortable, rather than the 
highest speed possible. At the highest speed it may have to stop and start frequently (which could make the 
copy slower than if a slower speed had been chosen). As with all Audio CD copying, the quality and reliability 
of data copied cannot be guaranteed (but in practise and with clean disks it’s usually perfect). 

• You may wish to set a handle. With a handle set to Zero, the track copied will start at its ID1, and continue 
until the next track’s ID1 flag. Thus no countdowns are accounted for. In order to be certain not to clip the 
start of a track, or where the track is from a segue, you may wish to increase the “handle” so as to copy n 
seconds of audio prior to the track start and after the track end. 
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• When the audio is copied, the file will be automatically named by it’s track name or number. Set base name 
allows you to add a global title to all the copied tracks (i.e. you may choose to add the Artist or album name) 

• Press Start to start the copy process. It is possible to run this as a background process. 
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4 - USING THE PLAYLIST 

USING THE PLAYLIST 
The Playlist Display 

Playing the EDL 

Locating 

THE PLAYLIST DISPLAY 

THE PLAYLIST 

 

1. Meter showing audio output from each 
stream  

2. Stereo EDL Entry shown as a profile 

3. Mono EDL Entry shown as a block 

4. Crossfade between Entries 

5. Time bar 

6. Stream showing Entry comments 

7. Drag border to reveal second Playlist view 

8. Stream Control buttons 

9. Drag border to reveal/hide Stream Control 
buttons 

10. Mouse time display 

11. Current time cursor 

12. Mono EDL Entry shown as a profile 

FADE DISPLAYS 

The Playlist Entry Display section of the Setup window provides two options for the way fade-outs, and so 
crossfades, are drawn: 

  

"Show fades on all streams as cuts" "Show fades on all streams as splices" 
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FADE SHAPES 

The Playlist Entry Display section of the Setup window also provides an option for the shape of the fade used 
on a clip to be represented visually in the Playlist: 

 

"Show fades as curves" 

It is recommended that you use this with "Show fades on all streams as cuts" as crossfades look pretty odd 
when the fade down is shown as a bottom left to top right curve as well as the fade up. But if that's how you 
like it... 

-3 DB AND -6 DB POINTS 

The -3 dB and -6 dB down points for a crossfade can be displayed on the fade curves, by right clicking in the 
Playlist, and selecting "Clip Display", "Show -6dB and -3dB markers". It also available as Hotkey "DB Down 
Markers" in the Hotkey Setup. It is best to have "Show fades as curves" set under "Setup Window", "Playlist", 
"Playlist Entry Display", as to be honest, it looks a little odd if you have "Show fades as splices" rather than as 
cuts. 

DISPLAYING COMMENTS 

Right-clicking on the Stream also lets you show or hide any comments you want to associate with the Entry 
(shown as "three, four..." in the above example). You can write comments in the Clip Details Window under 
"Clip Dialogue".  

SHOWING ENTRIES AS PROFILES 

 
The SHOW ALL PROFILES button in the top left-hand corner of the Playlist switches between 
displaying all EDL Entries as solid blocks and waveform profiles. 

 The small profile control button on each Stream does the same for that Stream only. 

NOTE: The Stream control buttons can be revealed or hidden by dragging the border between them 
and the Streams themselves, or by using the Scrollbar beneath them. 

Function key F12 on the keyboard acts as SHOW ALL PROFILES. 

The Profile Display setting is saved in the user settings, and thus SADiE will open in whatever state it was left 
in. 

When displaying profiles, there are 8 different types of waveform profile available, visually boosting different 
parts of the dynamic range. You can change the profile type in "Profile Display Mode" on the "Playlist" menu, to 
find one more suitable to the audio you are working with. Note that the "Playlist" menu only appears on the 
menu bar when the Playlist is the active window. 

The "Profile Display Mode" setting also applies to the Trim Window, as you are very likely to require the same 
view there also. The "Trim" menu also allows you to change the setting, but for this one instance of the Trim 
Window; thereafter the profiles revert to the Playlist setting. You should therefore change the setting from the 
Playlist rather than the Trim Window if you wish to change the global setting. 

The waveform profiles can also be displayed with or without a black outline for visual clarity. This setting is 
found in the "Playlist Entry Display" section of the Setup Window. 
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NOTES ON PROFILES: 

1. The profile display for higher zooms can be altered to suit your personal preference. As default, the 
higher resolution Horizontal zooms from zoom level 16 to 21 are drawn as a bar graph but there is an 
option in the Playlist Display Setup page (under the "View" menu, select "Settings", "Playlist", then 
"Playlist Display"); select "Show higher zoom waveforms as lines" which will display these as a point-to-
point line graph. 

2. Depending on the performance of your PC, the profiles may update slowly when you are playing the 
Playlist, particularly at the higher horizontal zooms above zoom 15, As default, when you press play 
whilst viewing at a zoom level greater than 15, the waveforms are not displayed again until you press 
stop, however you can choose "Keep updating profiles when playing (slow)" in the Playlist Display 
Setup, and SADiE will attempt to re-draw the screen whilst playing. 

3. There is an option to change the zoom level at which "Profiles" (e.g. those on disc) become 
"Waveforms" (e.g. those that are displayed on-the-fly). The display around horizontal zoom 14 and 15 
can look a little "blocky", so there is an option to calculate these as and when they are required. If you 
choose the option to "Keep updating waveforms when playing (slow)" you see find a slight 
performance issue, particularly when running multi-track Playlists. This will use some DSP as well as 
PC resources for displaying. You have to restart SADiE for a change to this to take effect. 

4. The highest three horizontal zooms (zooms 22 - 24) are the only zooms at which you will be able to 
see single samples. These zooms are always drawn as point-to-point lines. 

5. See also Recreate Profiles.  

LEVEL-RESPONSIVE PROFILES 

There are facilities in the Playlist and Trim windows to draw the profiles of the clips proportional to the 
current clip level. This means that waveforms will now grow and shrink to show fade in and outs, and any clip-
wide level changes that have been made. This option is found in the "Playlist Entry Display" section of the Setup 
Window; "Draw profiles proportional to clip level". It is also available as a Hotkey. 
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Clips without level response 

 
Clips with level response 

Both clips shown in the examples above have had a drop of 3dB in relative level, hence the narrower waveform 
in the second example.  

There is also a facility to view a "ghost" of the original profile behind the level responsive waveform to serve as 
a reference when editing. 
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Clips with level responsive waveforms and ghosts of the original profile 

It is recommended that black outlines are enabled in the "Playlist Entry Display" section of the Setup Window, 
as when clips are being edited they also turn grey, and will seem to disappear into the "ghost" profile, unless 
they are outlined in black. The "ghost" profiles are enabled using the right-click menu in the Playlist "Draw 
ghost profiles of original audio".  

 
When entries are selected in the Playlist, they normally change colour to red. The ghost profile (if displayed) 
also changes to red, otherwise if level has been changed significantly, it can be difficult to see that the clip is 
selected. This re-colouring of the ghost profiles can be disabled in Setup / Playlist / Playlist Entry Display / Draw 
original clip profile in red when selected. 

The picture on the right shows a clip with ghost profile drawn in red, in the left it's drawn in grey. 

  

The facilities are also available in the Trim Window, and the setting here will reflect the setting in the Playlist. 
However, in the Trim Window the "ghost" of the original profile is always shown. 
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SCROLLING AND ZOOMING 

When the Playlist is playing back, the audio will ordinarily appear stationary, and the timeline will scroll across 
it. There are options for the timeline to appear stationary, and for scrolling to be turned off, so that the 
timeline will move off the edge of the screen. This option is available under the "Playlist" Menu. 

When moving around the Playlist to access different parts of your EDL . you may want to change which part or 
how much of it is displayed. This can be done either by using the Navigator Window, or by scrolling and 
zooming on the Playlist. 

To do this, you will either need to scroll it so that a different part is in the window, or change its magnification 
by zooming in or out of the display. Don't forget that you can also change the size of the whole Playlist 
window. 

 
There are two Playlist Scrollbars with attached zoom buttons. The one along the bottom of the 
Playlist display scrolls and zooms horizontally so that you can view a later or earlier part of the EDL. 
The one at the right-hand side scrolls and zooms vertically so that you can reveal Streams that are 
not currently in view. 

 

1. Drag box for coarse scrolling 

2. Click either side of the box to scroll one window width 

3. Click or hold down arrows for fine scrolling 

4. Zoom out 

5. Zoom in 
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You can press the zoom buttons repeatedly, until you reach maximum or minimum magnification. 

Alternatively, under the Playlist menu (when the Playlist is the active window), you can jump directly between 
different levels of horizontal and vertical magnification. These zoom menus are also available if you hold the 
Ctrl. key down when you click on the normal zoom buttons with the mouse. 

 
Select ZOOM for horizontal magnification, SHIFT + ZOOM for vertical magnification, and adjust 
with the wheel. 

Without ZOOM or CLIP, or STREAM selected and without Jog or Shuttle modes selected by the 
SCRUB button, the wheel will move the current-time cursor up and down the Playlist, which will 
scroll accordingly. In this mode, all of the small LED's by the wheel will be off. 

 
Additionally EDL Streams can be zoomed individually. Right-click in the area to left of the stream. 
There are two options for zooming: "Stream vertical zoom" changes the zoom setting for just that 
stream, and "Selected streams' vertical zoom" changes the zoom setting for all enabled (light grey) 
streams, (to allow setting changes for groups of streams, or to return all streams to the global zoom 
control). 

 There are 4 preset zoom buttons to the left of the horizontal Scrollbar, and a button labelled 
"A" that will "Zoom to All" (e.g. the entire Playlist). The preset zoom level assigned to each 
button can be changed by right clicking on the appropriate button and selecting a new zoom 
level. 

 To the left of these is a "Centre display on Timeline" button, so that if the timeline is off screen 
the display can jump quickly to it, without having to scroll or zoom. 

 
These functions are also available as Hotkeys. 

 
For users who have a mouse with a wheel, it works in the Playlist as follows: 

 Wheel = Vertical scroll 

 Ctrl + Wheel = Vertical Zoom in/out 

 Shift + Wheel = Horizontal Zoom in/out 

NOTES ON ZOOMING: 

1. During playback you can zoom in or out, but you cannot override the automatic scrolling that keeps 
the current time on view. 

2. The Playlist will always stay centred on the position of the cursor. Reposition it before zooming in, if 
necessary. 

3. At the extreme settings of zooming out, all Entries are shown as blocks and not profiles. 

4. If you want to quickly switch between two different vertical and horizontal zoom settings, save them 
in two different Desktops. You can then switch between the Desktops by using the keyboard 
shortcuts to the "Desktop" menu; press Alt + D, followed by the number of the desktop file listed. 

5. Where an EDL contains PQ or Video Streams, these have only two size settings, "Large" or "Small", 
set by right-clicking in the grey area to the left of the stream. 

There is another way you can change the way the profiles look on screen. For instance if your audio is very 
quiet, the waveform on screen may be very small, or alternatively if the audio level is very high and not terribly 
dynamic it may look like a thick straight line. Under the "Playlist" menu, the "Profile Display Mode" option 
offers 8 alternative ways of viewing the profile; the high numbers will make lower level audio look "fatter". 
Type 1 is the default. See also Notes on Profiles.  
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STATIONARY TIMELINE 

There is an option to fix the Playlist Timeline marker to the centre of the Playlist's main area during playback. 
This has been requested by users (particularly those in Post Production) for some time, and gives some 
advantages over the "moving time line and page-turn" method. This is perhaps particularly useful when mixing, 
in that you are much less likely to be "surprised" by something forward of the current time suddenly appearing 
due to a "page-turn". 

It may or may not be appropriate to your method of work, and hence this is invoked in a Setup page (but of 
course you can change that setting at will). Additionally a status display can be set for Stationary Timeline, and 
in the usual way, double clicking on this display will turn the mode on or off. The option for this is found under 
the "Playlist Display" section of the Setup Window. 

You may find that the PC's performance (and its graphics card performance) may have an impact on how 
quickly the SADiE screen re-draws, and this playback mode will always be slower than the original "moving 
timeline" method (although if your PC is powerful enough you shouldn't be able to detect any difference). 

There is an option to have stationary point at between 10 and 90% on the Playlist screen. Notice that in this 
mode the Current Timeline is not actually locked to the stationary point, and by the usual method of clicking in 
the top time bar you can move this line (for positioning it for razoring for instance). However, the Current 
Time will always jump back to the stationary point when play is started.  

If the Playlist's first clip is close to 00:00:00, you will find that under certain zooms, the Current Time line will 
move from left to right (in the original way) until it gets to the centre, at which point the line will fix and the 
clips will start to move. This will only happen at times when centring the display would otherwise show an area 
of the Playlist that would be before 00:00:00.  

PLAYING AND LOCATING 

TRANSPORT CONTROLS 

 
 

1. Current Time 
Display 

2. Rewind 

3. Fast Forward 

4. Stop 

5. Play 

6. Record 

7. Pause 

The Transport Controls are a permanently floating toolbar, so they will always appear on top of other 
windows. You can hide them by clicking on their close window button , and display them again from the 
View menu. 

If you don't need the full Transport Controls, the status bar at the bottom of the screen can contain a simple 
Play/Stop/Current-time display version. To show it, from the View menu select the Setup window and go to 
the "Status Displays" section under "General". 

The Transport Controls apply to the active window, so to play the EDL, then the Playlist needs to be active 
(with a coloured title bar). If it is not, click anywhere in the Playlist or use the hardware controller's 
WINDOW button to select it. 

 
The PLAY, STOP, and PAUSE buttons in the Transport Controls are duplicated on the 
hardware controllers. Note that there may be a brief delay when pressing PLAY while 
SADiE compiles the current EDL. 

PLAY and STOP are also activated by the spacebar on the computer keyboard. 

PAUSE, when released, gives you an instant start. 
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Double-clicking in the time bar activates PLAY (see Locating). 

A single click in the time bar activates STOP. 

The ONLINE button in the Transport Controls and on the hardware controller has two 
functions: 

1. It enables timecode synchronisation (master or slave as selected in the "Sync" 
section of the Setup window). 

2. It enables 9-pin external machine control of any of up to four machines. These can 
be selected individually by right clicking on the button. The 9-pin section of the 
Setup window sets which 9-pin channels these are connected to. 

Additionally the Playlist Menu provides some useful extra play functions: 

 Play Selected Entries - This previews only the selected entries and can be used to quickly play one clip 
or several, separated from the EDL. 

 Auto-Return on...  

 ...Stop - Creates a temporary locator at the point at which play starts, and when play is 
stopped the timeline will jump back to that point. 

 ...Play - As for stop, but the timeline will only jump back to the locator when play is restarted. 

This function is available as a status bar option, like Autoplace. It is also available on Hotkeys with 
some extra functionality: 

 Return on Stop 
enabled 

Return on Play 
enabled 

Off 

Space in Stop starts playback at current 
time and drops marker 

locates to marker and 
starts playback 

starts playback and drops 
a (hidden) marker 

Space in Play stops playback, locates to 
marker 

stops playback, stays 
where it is 

stops playback, stays 
where it is 

Alt + Space in Stop starts playback at current 
time and drops marker 

starts playback at current 
time and drops marker 

locates to (hidden) 
marker and starts 
playback 

Alt + Space in Play stops playback and stays 
where it is - doesn't 
Return to the marker. 

stops playback and stays 
where it is - doesn't 
Return to the marker 

stops playback, locates to 
marker 

 

 

TIME DISPLAY WINDOW 

For applications where exact time is important, there is a re-sizable time display window available. 
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This window can be displayed via the "View" menu, the two buttons will be named according to their current 
setting. Pressing either button shows a menu to allow you to change how time is displayed in this window. 

The left side button in the picture has four options to determine what time is being displayed: 

1. Current - This displays the current absolute time within the Playlist  

2. Countdown - This counts down to the end of the final entry in the Playlist 

3. Play - This counts the time up from the last point at which play started 

4. Start - This counts the time up from the beginning of the first entry in the Playlist 

The right side button in the picture allows you to change the format of the time display: 

1. Auto - this Time Display will follow the global setting under Setup / General / Time Format 

2. The other five options allow you change the format to make this Time Display show a separate format 
to that shown by the Transport Controls and the timeline. 

As with other Windows, you may click in the top left hand corner of this window and set it to "Always on 
Top" 

STREAM SOLO AND MUTE 

Each Stream has its own control buttons on the left for  soloing and  muting individual streams. They 
duplicate the solo and mute buttons controlling those Streams on the Mixer strips or hardware controllers. 

 
There is a MUTE button above each fader. SHIFT + MUTE is solo. 

NOTE: Solo and Mute buttons are grouped when you group their faders in the Mixer.  

LOCATING 

LOCATING CURRENT-TIME CURSOR TO EDL POINTS 

There are several ways of locating the current-time cursor to points in the EDL: 
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USING THE TIME-BAR 

 
Double-click in the white time bar area at the top of the Playlist to start playback immediately from 
that point. The mouse time display will show the exact time you are pointing to. 

Single-click anywhere in the time bar to stop playback. 

Single-click in the time bar when playback is stopped to locate the current-time cursor to that point. 

NOTE: Scroll or zoom out to access parts of the EDL that are not currently on view (see The Playlist 
Display). You can also move around the Playlist using the Text EDL. 

USING THE CURRENT-TIME DISPLAY 

 
Click, hold and drag the mouse up or down over any field of digits in the time display (e.g. the hours, 
minutes or seconds, etc.). Their value will increase or decrease, and the more you move the mouse, 
the faster they change. Release to set the new value and locate the current-time cursor. 

Alternatively, double-click on the time display. 

 
The box that pops up allows you to: 

 Directly type in the time that you want to locate to (or use the mouse cursor to drag across and 
overwrite only part of the displayed value). End with the keyboard  Return key. 

 Click on "Zero" to Zero-locate, followed by "OK". 

 Use the up / down arrows to adjust the time. These nudge the lowest units. Hold the keyboard Shift 
to nudge seconds, Ctrl to nudge minutes. Finish with "OK". 

 
There is a "Locate to time..." Hotkey available to open this box, found in the Transport Controls 
section of the Hotkey setup. 

USING THE TRANSPORT CONTROLS 

 
Double-clicking on the  STOP button is a useful and quick zero-locate. 

 
The REWIND and FAST-FORWARD buttons are latching with the speed of wind increasing 
the longer they operate. Using the time bar as described above is usually quicker and easier for 
most operators. 

USING HOTKEYS 

 
There are two very useful default Hotkeys on the computer keyboard: 

 "Home" will locate to the start of the first Entry in the EDL. 

 "End" will locate to the end of the last Entry. 

There also options in the Hotkey Setup for Locating to previous/next cue points and quantisation 
points. 
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USING THE HARDWARE CONTROLLERS 

 
Without Jog or Shuttle modes selected by the SCRUB button, the wheel will move the current-time 
cursor up and down the Playlist. The scale of movement is related to the magnification of the Playlist, 
so use zoom if necessary. The current-time display in the Transport Controls and the EDL time 
display on the hardware controller will indicate the exact time you are locating. 

NOTE: To move the current-time cursor, make sure that neither ZOOM nor CLIP , nor STREAM 
modes are selected. The small LED's by the wheel should all be off. 

 
END will locate to the end of the last Entry in the EDL. 

SHIFT + END will locate to the start of the first Entry. 

NAVIGATOR WINDOW 

The button in the top left corner of the Playlist Window turns on and off the display of the Navigator Window. 

 
The Navigator Window is a bar that is attached to the bottom of the Playlist, which shows a block view of all 
the clips in the entire Playlist. This gives you an easy view of the whole EDL, and operations in this Navigator 
Window will allow you to quickly and easily locate, scroll and change zoom on the main Playlist display. This 
should significantly speed up the process of getting about in the Playlist as now you can see an outline of the 
whole list, and quickly jump to an area that you can see displayed in this Navigator. 

OPTIONS 

There are two simple options to determine how Navigator displays: 

Under the "View menu", "Setup Window", "Playlist", "Playlist Display" (which is revealed by double-clicking on 
Playlist on the left-side of the Setup Window) "Start navigator window display" from: 

 "Time Zero" (which will show any unused time at the start of the EDL), or 

 "Start of first clip" (which will start the navigator display at the beginning of the first clip, as in the 
picture above) 
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COLOURS 

The colours in the Navigator will reflect the colours in the Playlist and show whether clips are selected (Red), 
part of a Slip selection (Blue), or being edited (Grey), etc. You will not see waveforms in the Navigator, merely 
clip blocks. 

NAVIGATING 

You will see an outlined white box on the Navigator, which shows the area of the Playlist that is in the 
current view. 

A single click inside the Navigator will move this white box to a new position (both horizontally and 
vertically) and update the Playlist accordingly. The box is positioned so that the click position is central in the 
display. (Of course when a Playlist is in playback and set to scroll, Navigator operations such as this could 
change the focus to somewhere that isn't close to the current timeline, and so the Playlist display will flick to 
the new position but then the playback will override this repositioning back to the area that's being played.) 

Drawing a box in the Navigator (by clicking with the left mouse button, dragging and releasing.) will scroll and 
zoom the Playlist to view the selected area. Again vertical and horizontal size and positioning of the box has an 
effect (so for instance it's very quick to focus on a group of clips on higher numbered streams). When you 
draw a box, you'll find the size of it will be changed to fit into a standard zoom and that the vertical scrolling is 
adjusted so as to view a whole Stream. 

Holding the Ctrl key and dragging the box will scroll the Playlist display as you drag the box. 

Double-clicking anywhere in the Navigator will re-position the box as with a single click, and then put the 
Playlist into playback within that Navigator box. 

SPLIT PLAYLIST VIEW 

If you are in the habit of using the secondary Playlist view you will be pleased to hear that operation of this is 
included in the Navigator. 

 
If you're not familiar with this view (try dragging the right-hand edge of the Playlist) there is a line between the 
main grey area and the vertical scroll bar where the mouse cursor changes to a double-bar with left/right 
arrows. Clicking and dragging here will reveal this second view. The second view can be used to show different 
zooms or different areas of the Playlist, and using the option under Playlist Display section in the Setup 
window, you can choose "Time lock split views" (or not) to determine whether this second view will scroll 
with the main view (or not). 

Operation of Navigator is much the same as with the main view, however we use the Shift modifier for the 
second view, and the view-box for the second view is drawn in grey. (In the picture above the second view is 
showing the whole EDL so the grey line is not so easy to see.) Thus: 



SADiE v5.4 PCM Manual 

66 

Shift + click moves the grey box. 

Draw a box + Shift defines the grey box and thus area of focus of the second view. 

Shift + Ctrl + drag the box to scroll the second view. 

Shift + double-click to play in the second view.  

LOCATING TO IN AND OUT POINTS 

 
The current-time cursor will locate to the in or out point (whichever button is down in the 
Transport Controls) of the previous or next EDL entry on any enabled Stream when you use these 
keyboard Hotkeys: 

 Select previous Entry (default is Ctrl + Alt + B). 

 Select next Entry (default is Ctrl + Alt + N). 

See Hotkey settings. 

There are also Hotkeys available for "Locate to Selection start" and "Locate to Selection end" under 
the Playlist section of the Hotkey setup. These are set to Ctrl + Home and Ctrl + End by default. 

 
PREVIOUS and NEXT buttons do the same as the Hotkeys described above. 

LOCATORS AND MARKERS 

There are three different types of Locator that can be used to mark specific times in the Playlist. These 
markers are always saved as part of each Playlist. They appear as markers along the timeline, but each type can 
have different properties. 

 A single pair of Left and Right points for looping, automatic punch-in recording and region editing.  

 Ten numbered locator points each with their own dedicated hotkey sets for Setting, Locating to (Go 
To), and Clearing. 

 Any number of Named locator points which have text attached. These have a generic set of 
hotkeys for Setting, Locating To (Go To next and previous locator), Clearing, Renaming etc. 
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THE LOCATOR TABLE 

There is a table showing the locators and their individual properties, which can be seen at the bottom of 
the Playlist window by pressing the "Show/Hide Text Pane" button at the top right of the Playlist, and then 
selecting the "Locators" tab. 

This works in a similar fashion  to the Text EDL: 

 you can edit parameters in the table 

 you can re-order by clicking on the column header. 

 you can double-click in the Entry number column to start playback from that locator; single click here 
locates without starting playback. 

SETTING LOCATORS 

Locators can be set using either 

 Mouse - clicking on buttons in the Transport Controls' Locators pane. 

 Hotkeys 

 Hardware Controller - has dedicated keys for the numbered and L & R locators. 

This is described in more detail below. 

LOCATOR PARAMETERS AND FEATURES 

1. Once set, locators can be dragged with the mouse to re-position them. This is only allowed if they are 
set to be "Moveable" either in the table, or from the menu that appears when you right-mouse-click 
over the locator. There is a setup option to allow locators to default to "moveable" or not.  

2. Locators can be set to follow slip rules (or not). When edits in the Playlist are causing entries up- or 
down-stream to slip, then so will the Locators. There are setup options to determine the default 
state, but individual locators can be set to slip or not, hence some locators can be fixed time marks, 
and others can mark audio events. The Slip state of a locator can be changed, either in the table, or by 
choosing the Slip item from the menu that appears when you right-mouse-click over the locator.  

3. "Named" Locators have text, which can be viewed in a yellow help-bubble that appears when you 
hover the mouse over the locator. This text can be edited, either in the table, or by choosing the Edit 
item from the menu that appears when you right-mouse-click over the locator.  

4. There is the concept of a “Current Named locator” – you can click on a locator and it changes 
colour to red. A number of hotkeys (under the “Transport- Locators” section of hotkey setup) can be 
set to work on the “Current Locator” :- 
 
”Delete current named locator” 
 
”Edit text of current named locator” 
 
”Next…..” and “Previous named locator” which selects the next (or previous) locator, and locates the 
timeline to its position. If the timeline is not at the Current Locator position, then the first press of a 
“Next” or “Previous” will locate to current locator. 

5. There are two hotkeys for setting named locators: 
”Insert named locator at current time” (which auto-names it from the text alongside the "Get" button 
in the Locators pane of the Transport Controls.) 
 
”Insert and edit named locator at current time” (which puts up a dialog box for you to name the 
locator straight after setting it). 
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MULTI-DIMENSIONAL LOCATORS.  

If the setup switch in Locators Setup \Multi-dimensional locators is ticked, then when you capture a locator 
position, the Horizontal and Vertical Zoom as well as the Vertical streams view is captured, and recalled when 
you "Go To" to that locator. There are fields in the Locator Table for these :- Stream, Vertical Zoom and 
Horizontal Zoom where their values can be changed or disabled. For instance it would be possible to save just 
Stream and set V- and H-zoom to be unspecified if you so wished. 

STORING AND RECALLING LOCATOR POINTS 

With the mouse in the Transport Controls 

 
Open the L-R and Locators sections of the Transport Controls: 

 

1. Left locator time display 

2. Right locator time display 

3. Numbered locators 

4. Named locator time display 

5. Named locator name box 

The LEFT, RIGHT and 1-10 numbered locator points can be set in the following ways: 

1. From the current time by clicking on their buttons. This can be done on the fly (during playback), or 
when stopped. The red indicator will show that a point is stored in the button memory. The L and R 
points have time displays to show their EDL times. 

2. The L and R points can also be set by holding Shift and clicking at the required point in the time bar 
with the left and right mouse buttons respectively. 

3. Once set, click on a locator button to locate to that point. (This is not allowed during playback.) 
Clicking on Z will locate to zero. 

4. Double-click on a button, or click while holding the Ctrl key, to clear its memory. 

Markers will appear in the Playlist time bar to show the position of these locator points: 

 

 
Pressing LOOP causes playback to be repeated between the left and right locator points. 
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Pressing the PUNCH-IN button causes SADiE to drop into record at the Left locator point and 
drop out at the Right (see Recording). The pre and post-roll times for these are set in the Transport 
Controls section of the Setup window (accessible from the View menu). 

Named locator points appear with a small triangular symbol on the time line and can be set as follows: 

1. Click in the white name box at the bottom of the Transport Controls and type in a name ("endsting" 
in the above example). 

2.  
Each time you press GET, SADiE will store a locator point with the name you typed and a 
number added to it, e.g. endsting [01], endsting [02], etc. The EDL time of the point currently 
in the name box is displayed above it. 

3. You can type in a new name at any time and start storing points with that name. 

4.  Press the arrow next to the name box to drop down a list of all your named locator points 
and select the one you next want to locate. It will appear in the name box. 

5.  
Press GO to locate to the point in the name box. 

6.  
Press DEL to delete the locator in the name box. The next one in the list will replace it. 
Repeat to delete them all. 

The Left, Right and currently displayed named locator can all have their values adjusted or reset by using their 
time displays in the following ways: 

 
1. Click, hold and drag the mouse up or down over any field of digits in the time display (e.g. 

the hours, minutes or seconds, etc.). Their value will increase or decrease - the more you 
move the mouse, the faster they change. Release to set the new value. 

2. Use the up/down arrows beside the display to nudge its value by the lowest units. Hold Shift 
to nudge seconds, Ctrl to nudge minutes. 

3. Double-click on the time display itself. 

 
The box that pops up allows you to: 

i. Directly type in a new value (or use the mouse cursor to drag across and overwrite 
only part of the displayed value). End with the keyboard  Return key. 

ii. Click on "Zero" to set to 00:00:00, followed by "OK". 

iii. Click on "Cur Time" to set to the current time, followed by "OK". 

iv. Use the up/down arrows to adjust the time, as above, followed by "OK". 

4. The L and R locator points can also be adjusted by dragging their markers in the Playlist time 
bar. 

NOTE: Locator memories are stored with the EDL, and apply to only that EDL.  

 Setting Locators with Hotkeys   

The Numbered and L and R locators have Hotkeys for "Set Locator", "Go To Locator" and "Clear Locator". 
The "Go To Locator" Hotkeys will always set the locator if it's unassigned, then locate to the set point on a 
second push. The "Set Locator" function puts the current time into the locator whether currently assigned to 
something else (e.g. overwrite locator) or not. 
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To store a new Named Locator you have the choice of: 

 Press the hotkey for ”Insert named locator at current time” or  

 the hotkey for ”Insert and edit named locator at current time”  

Thus you would either allow the locator to be named from  the default name, or type in a name as you place 
the locator. 

Other named locator hotkeys (i.e. delete, rename, etc.) work on the currently selected named locator (it will 
be displayed with a red triangle symbol). 

 

Setting Locators with Hardware Controllers 

 
On the hardware controllers press LOCATE followed by F1-F10 to set or go to locators 1-10, and 
LOCATE + F11 and F12 for the Left and Right locators. To re-set a stored locator point, press 
SHIFT + LOCATE + F1-F12 

The Hardware Controllers have no dedicated hotkeys for setting Named Locators, however these can be set 
in the usual way onto the user-definable F-keys. 

ADVANCED PLAYLIST OPTIONS 

SPLITTING THE VIEW 

 
If you drag the right hand edge of the Playlist (inside the Scrollbar) inwards, you can open up a second 
view of the Playlist that has its own zoom buttons, Scrollbar and current time cursor. This could be 
useful if you want to jump back and forth between different places in the EDL or have one view in 
zoomed in close and the other showing you a larger section. Clicking with the mouse will switch 
between active views. 

You are able to change the synchronisation between the split Playlist views. Under the "View" menu, select 
"Setup", "Playlist", and then "Playlist display". Tick "Time lock split views" and the current time will update 
synchronously in both panes; unticked, they will move independently.  

STREAM UNITS 

Streams are grouped into "units", which may be closed down or opened up for display. This is done by double-
clicking on the thin divider bar containing the unit name, to the left side of the EDL streams. 

 
Your hardware platform and the work you are doing will determine the number of unit dividers available. 

There can be unit dividers for an audio unit (whose streams contain the audio clips), a PQ stream, and "mixer-
only" streams if applicable.  

VARISPEED PLAYBACK 

Use the "View" menu to display the Setup window, and then select the Audio section. 
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The Varispeed controls in the Sample Rate part of the window adjust the Record or Playback speed up to a 
maximum of ±10%. Whereas an analogue tape machine does this by varying the speed of the capstan motor, 
SADiE varies the current playback sample rate. 

 

Clicking on the check button enables Varispeed, and the knob just below it controls the 
speed. Click and drag up and down to adjust. A small fader will pop up to indicate the setting 
and the numerical display on the right will indicate the percentage speed change. 

Double-clicking keeps the pop-up fader on view and allows you to adjust it more finely (click 
on a grey bit of the window to hide the fader). 

You can also adjust the setting by entering a percentage value directly into the numerical 
display in any of the following ways: 

1. Click, hold and drag the mouse up or down over the digits on either side of the 
decimal point. Their value will increase or decrease, and the more you move the 
mouse, the faster they change. Release to set the new value. 

2. Use the up/down arrows beside the display to nudge the value by whole percentage 
points. Hold Ctrl. to nudge by decimal points. 

3. Double-click on the time display itself and directly type in a new value ending with 
the keyboard  Return key. 

You can now turn Varispeed off and retain the setting for the next time you turn it on again. 

The square button drops down a selection list of useful pre-set Varispeed settings, for example to convert 
from 24 frames per second to 25 and vice versa. Select "User" to return to adjustment with the knob. It may 
be useful to do this during recording. 

NOTE: As Varispeed works by changing the sample rate, the digital output from SADiE will be non-
standard and may not be accepted by other digital equipment, especially DAT machines. SADiE's Digital 
to Analogue converters will work from about 30 kHz to 50 kHz to produce a valid analogue output, 
although they may temporarily mute if you change the Varispeed setting too quickly. Varispeed of 
individual Clips or EDL Entries by amounts much greater than 10% can be done with the "Resampling" 
section of the Process window.  

TRANSMISSION MODE 

This mode is a means of locking out the keyboard and mouse to prevent accidents during an important 
playback. 

To enter Transmission Mode, either: 

 Hold Ctrl. whilst starting playback in the usual way, OR 

  

 
Use the keyboard Hotkey (set in the "Hotkeys" section of the Setup window) after 
starting playback. The default Hotkey is Alt + X. 

The following box will appear: 

 
The only way to change anything now is to click on one of the two buttons.  
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AUDIBLE SCRUBBING 

To quickly search audibly through the Playlist: 

 
Reveal the Edit section of the Transport Controls: 

 

Click and hold the mouse button over the Scrubwheel: 

 Moving the mouse up/down gives you forward/reverse shuttle. The more you move from your original 
position, the faster it goes. This is like spooling tape against the heads. 

 Moving the mouse right/left gives you forward/reverse jog. This is like nudging the reels back and 
forth. 

 You can move between jog and shuttle modes without releasing the mouse button. 

 
Select jog or shuttle mode with the SCRUB button. (Make sure you haven't got STREAM, CLIP 
or ZOOM selected.) The LED's next to the wheel indicate the mode. Then use the wheel! 

FIXED SPEED SCRUBBING 

 
There are hot-keys available for putting the Playlist (or Trim window, or clips in the Clipstore) into 
audible scrub at a fixed speed. 

By default, these are set to be on the numeric keypad of the keyboard (you must have Num Lock 
On), and three different fixed speeds can be set up at once. For instance Keys 1 and 3 will play 
backwards and forwards at half-speed, 4 and 6 will do the same at normal speed, and 7 and 8 at 
double speed. 

The key assignments are set in the usual Hotkey section of the Setup window, under "Transport", 
"Edit Controls". The three speeds can be changed in the Setup page too, this time under the Scrub 
Setup sub-section of "Transport Controls".  
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5 - ARRANGING AN EDL 

ARRANGING AN EDL 
Overview 

Playlist Streams 

Toolbars 

Manipulating EDL Entries 

Bounce-down 

Undo and Redo 

Locking Entries to EDL time 

Grouping and Hiding Streams 

Clip Details 

Text EDL 

OVERVIEW TO ARRANGING AN EDL 

 

 

 

1. Meter showing audio output from each 
stream  

2. Stereo EDL Entry shown as a profile 

3. Mono EDL Entry shown as a block 

4. Crossfade between Entries 

5. Time bar 

6. Stream showing Entry comments 

7. Drag border to reveal second Playlist view 

8. Stream Control buttons 

9. Drag border to reveal/hide Stream Control 
buttons 

10. Mouse time display 

11. Current time cursor 

12. Mono EDL Entry shown as a profile 
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The EDL in SADiE is like a word processor document; when you first switch SADiE on and create a new 
Project, the system will open a Playlist window containing an empty EDL named after the Project. You can then 
build up the EDL by recording directly into it, or by pasting in Clips from the Clipstore. Alternatively, you may 
open an existing Project and EDL to play back or do further work on. 

NOTE: After making any changes in the Playlist, you will need to save the EDL. See File Management. 

Whether you are rearranging EDL Entries that were not recorded in their final playback order, building an EDL 
from the Clipstore, or creating different versions of the same material, you will want to move Entries around, 
add them to and remove them from the Playlist. 

Where you place Entries horizontally in the Playlist determines at what time they are played back in the EDL. 
The choice of where you place them vertically, e.g. on which Stream they are placed, will depend on how you 
want to control them with the Mixer . It is very easy to move Entries around in time and between Streams, so 
you can always change your mind! 

NOTE: You can place as many Entries as you like on top of each other on the same Stream, although 
this will not make them easy to view, and they will all play back together.  

PLAYLIST STREAMS 

ENABLING AND DISABLING STREAMS 

 

Enabling and disabling streams provides a means of separating some streams from others for certain editing 
functions, and of allowing you to select a stream or sets of streams that you are working on without effecting 
others. 

Disabled streams are shown with a darker grey background than enabled streams. When a stream is disabled, it 
will play back as usual, but is not affected by SLIP (when enabled) or RAZOR functions. This also provides a 
means of selecting entries on streams when you are working with multi-track projects. It is easy with the 
mouse to click anywhere in 2 dimensions. With the Hardware controls, the wheel will set your time 
(horizontal) position in the Playlist ; the selected streams determine the vertical position. 

When selecting entries with the Hardware controllers, the entry underneath the current time on the topmost 
enabled stream will be selected first when you press the EDIT/SELECT button. Repeatedly pressing 
EDIT/SELECT will select other entries on enabled streams in turn, but ignore those on disabled streams 
Also the PASTE function always pastes entries to the topmost streams. Thus in multi-track projects, it is a 
good idea to enable the stream you are currently working on and disable others, to make sure you can quickly 
select the entry you want to work on, particularly if you are working with hardware controllers. 

 The STREAM NAME button displays the Stream name and clicking on this enables/disables that 
stream for the editing, SLIP and hardware controller operations described in the following 
sections. The Playlist will start with all Streams enabled. Holding the Shift key when clicking this 
button acts on the group of Streams above it that are all the same status. This is like using the Shift 
key to select items from a list in most Windows applications. Additionally there is a "reverse" 
enabling function; if you hold the Ctrl key when clicking the stream button, then this stream will 
be enabled and all other streams will be disabled. 

NOTE: The border between the Stream control buttons and the Streams themselves can be dragged to 
the left or right to hide or reveal the buttons. 

 
On the hardware controller select STREAM and use the wheel or PREVIOUS/NEXT to highlight 
a Stream, then hit EDIT/SELECT to enable/disable it. SHIFT + EDIT/SELECT acts on the group 
of Streams above it that are all the same status. 
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CHANGING THE LAYOUT 

You may want more or fewer Streams than your current Playlist contains. There is no limit to the number of 
Streams a Playlist may contain, only to the number of Entries the system hardware can play back at the same 
time, with the required processing. 

You can also merge any number of Streams so that they can be controlled together and reduced in height to 
save display space. 

Stereo Streams can be added to the Playlist or created by merging two mono Streams. When you record onto 
a stereo Stream, you create a Stereo Track, whereas recording onto two mono Streams produces a two-
channel Track. (See Recording) 

Right-click over the small Stream control buttons: 

 

 "Merge Into Stereo Stream" merges two adjacent Streams. (Odd numbered Streams are merged with 
the one after, and even numbered Streams with the one before.) 

 "Merge Selected Streams" merges all enabled Streams together. 

 "Rename Stream" is described below. 

 "Insert Streams" will insert a pair (before odd numbered Streams or after even numbered ones), and 
renumber all Streams accordingly. 

 "Remove Stream" will remove the one you clicked on and renumber remaining Streams. 

When Streams are merged, they retain separate channels of audio but are linked in the following ways: 

1. They have a single set of Stream control buttons, so they can be muted, soloed, or enabled/disabled 
together. Merging Streams is also useful when recording Multichannel inputs, as you can use a single 
record enable button. 

NOTE: The mute and solo buttons of merged Streams are linked to those of all Mixer strips to 
which they are routed. 

2. Automation data on merged Streams is edited together. Stereo Streams are therefore necessary if you 
want to edit automation data for left and right channels of stereo material together (see Editing 
Automation Data). 

Right-clicking on merged Streams gives you options to change how they are displayed and to ungroup them 
again: 
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Stereo Streams Multiple Streams 

NOTE: Be careful if choosing to view one channel only, as there may be audio material coming up 
that you won't see. 

A NOTE ABOUT STEREO ENTRIES: 

Stereo EDL Entries can be placed on any odd/even pair of adjacent mono Streams as well as on stereo 
Streams. Audio editing will always affect both channels unless the Entry is deliberately split into two 
mono ones with the UNGROUP button described below. However, we recommend that you use 
stereo Streams in your Playlist for the following reasons: 

1. Recording onto stereo Streams creates stereo Tracks. 

2. Mixer automation for stereo material is edited on both channels. 

3. Single Stream control buttons are easier to use. 

A stereo Stream can be routed to either two mono Mixer strips or a stereo strip. 

If you wish to save your customised Playlist to be used again, save it as a Template.  

RENAMING STREAMS 

 The Stream name appears on the long name button on the left hand side. By default, Streams are 
labelled with ascending numbers, but you can change this to any 8-character name. Right-click over 
the small Stream buttons and select "Rename Stream", type in the new name, followed by Return 
( ). To avoid confusion, don't give the same name or number to different Streams! 

NOTE: The layout of Playlist Streams (how many merged Streams, single Streams and their names) is 
saved when you save the EDL displayed in that Playlist. The Setup window allows you to specify the 
default arrangement of stereo and mono Streams when new Playlists are created.  

TOOLBARS 
All windows have a number of toolbars that can be docked to edge of the window or "floated" anywhere on 
the screen. Right-click on a toolbar to show a menu that allows this "docking". To view toolbars that aren't 
currently displayed, there is an option under the "View" menu; click on "Toolbars", then select the window the 
toolbar belongs to, to show a list of all the toolbars relating to that window. 
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The Playlist particularly has a large number of buttons controlling editing functions, and depending on your style 
of working with SADiE, you may find you don't use some of the buttons, or perhaps you always use Hotkeys or 
hardware controls for certain functions. You will notice that the Playlist toolbars are split into a number of 
separate small toolbars each containing related buttons. This allows you to keep your desktop tidier by 
displaying buttons that you use regularly. Alternatively there is a Playlist toolbar named "Classic tools" which 
shows a selection of the most widely used buttons from other toolbars, but grouped into a single toolbar. 

It is worth spending a little time thinking about the tools you use often, and arrange them on the screen to 
your liking. When you are happy with your layout (the entire screen layout), then save a desktop. Loading this 
desktop will push the toolbars to where you docked them. If you want SADiE to start up with this desktop 
every time, then go to the "Environment" window and select "Save Desktop as Startup Desktop". 

For the Playlist toolbars, there is a button on the main Playlist tools bar, and the classic toolbar, which allows 
you to quickly turn on and off all of the other Playlist toolbars. 

 
This button is called the SELECT TOOLBARS button, and pressing this will show the following 
menu: 

 

The ticked items are already being displayed; clicking on one of the others 
will display it. 

When a toolbar is displayed "floating" (e.g. not docked to the window), then 
you can hide it again by clicking on the close window button  in its top 
right hand corner. Otherwise a right mouse click on a docked toolbar will 
offer the "hide" option. 

The operation of most of the buttons on the toolbars is discussed elsewhere 
in the manual. 

The "Windows" toolbar has some special functions to allow you to bring to 
the front of the screen, respectively, the Project window, the Clipstore, the 
Mixer, and the Transport controls. 

The "Automation Edit" toolbar is special in that opening the toolbar enables 
the automation editing function, and you have to hide the toolbar to turn it 
off. 

There is one other toolbar for the Playlist (not available from the Select Toolbars button): select "View", then 
"Toolbars", then "Classic". This displays most popular Playlist buttons on one big toolbar, in a similar layout to 
that which existed in SADiE software versions up to v3.70.01. This is for users who have become accustomed 
to that particular layout. Again, docking this toolbar and removing others, then saving your desktop "as Startup 
desktop" will allow you to start up SADiE with the view that you are familiar with. 

If you can't find a button, look here: Playlist buttons.  

MANIPULATING EDL ENTRIES 
SELECTING ENTRIES 

To perform any function on an EDL Entry, it first needs to be selected: 

 
To select one Entry, click on it. It will turn red to show it is selected. 

To select more than one, hold the Shift key whilst clicking on them. 

To select adjacent Entries, click, hold and drag the mouse. You will see it draw a box as you move it 
vertically and horizontally. Draw the box to cover the Entries you want to select as a batch. 

WARNING: Don't start the box on an Entry that is already red, or you will find you are moving it! 
Holding the Shift key whilst drawing the box will prevent this. 
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To select all the Entries in the EDL , click on the "Edit" menu, then "Select All". Alternatively press 
Alt, E, and S on the keyboard. 

To deselect individual Entries, hold Shift whilst clicking on them again. 

To deselect all Entries, click on a grey bit of a Playlist Stream. 

NOTE: Selected Entries are red. Red is a warning! Once selected it is quite easy to move Entries by 
mistake, so always deselect them when you have finished. 

 
To select Entries, do either of the following: 

1. Position the current-time cursor over the required Entry (by using the wheel in the Move 
Cursor mode, e.g. with no other modes like Jog, Shuttle, Clip , Stream or Zoom selected) 
and press EDIT/SELECT. The button will cycle through selecting all Entries under the 
cursor on enabled Streams. Pressing SHIFT and then EDIT/SELECT will let you select a 
second Entry. Holding SHIFT down will let you select more than two Entries. 

2. Select CLIP mode and use the wheel to cycle through selecting Entries on enabled Streams. 
Pressing SHIFT before using the wheel selects multiple Entries. Press CLIP again to exit 
this mode. 

3. Press PREVIOUS or NEXT to select the previous or next Entries on enabled streams. If 
none are initially selected this will begin with the last or first Entry. Pressing SHIFT and 
then PREVIOUS or NEXT will let you select a second Entry. Holding SHIFT down will 
let you select more than two Entries. 

 
To deselect individual Entries, position the cursor over the Entry, disable all lower numbered 
Streams, press SHIFT and then EDIT/SELECT. 

To deselect all Entries, position the current-time cursor on an empty (grey) bit of the lowest 
numbered, enabled Stream and press EDIT/SELECT. 

NOTE: When several Entries are already selected, selecting a single Entry will deselect the rest. For 
example, pressing NEXT will quickly deselect all other Entries.  

 
There is a Hotkey available to "Select Entry". This will select the clip under the current time on the 
topmost enable stream. If there are clips under the line on higher-numbered streams, then pressing 
this button again will select the next clip down and so on. 

There is also a Hotkey to "Select All", duplicating the Edit Menu command. 

RAZOR CUTTING AND GLUING 

RAZOR CUT 

 
The RAZOR-CUT button in the Playlist and RAZOR on the hardware controller divides the Entry 
under the current-time cursor on any enabled Stream into two at that point. This is primarily for 
editing, but can also be used to create a new Entry that you can then change in any of the ways 
described in the rest of this chapter. 

 
Mouse users have the option of using the "scissors" to make razor-cuts. Whereas the RAZOR 
button always cuts at the current-time cursor, when you press the SCISSORS button, the mouse-
pointer will change into a dinky scissors icon with a cross to show the target point. You can then 
make a freehand cut anywhere in the Playlist. This is useful if you can see exactly where to cut from 
the waveform profile. 

NOTE: With the RAZOR, if there are Entries at the cut point on other Streams and you don't want 
them to be cut as well, disable those Streams first. The SCISSORS function cuts only on the Stream 
the mouse icon is over, providing a useful shortcut to disabling Streams before using the razor blade. 

Holding the Ctrl key whilst scissor-cutting cuts across all enabled streams. 
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Holding the Alt key whilst scissor-cutting cuts at the current time rather than at the mouse time.  

Using Ctrl + Alt cuts on all streams at current time, much the same as the razor. 

Right clicking while you have the scissors selected disables them and returns the cursor to its normal "select" 
mode. 

GLUE 

 
Any razor cut where no editing has been done to the Entries either side may be repaired; press the 
GLUE button, position the cross-hair of the glue cursor icon over the join and click again. 

RENAMING ENTRIES 

 
Right-click over the Entry itself and select "Edit Entry Name". Type the appropriate name, and then 
press Return ( ). 

 
There is a Hotkey available for this function, but this will on one clip only, and it must be on screen at 
the time. 

NOTE: You can also rename Entries in the Clip Details window and the Text EDL.  

CUT, COPY, AND PASTE 

 
These techniques can be used to remove, move and add EDL Entries in exactly the same way that text is 
manipulated in a word processor. 

Entries are pasted into the EDL from a temporary store called the Paste Buffer. This can be loaded from the 
Clipstore to add new Entries to the EDL, but is also loaded with Entries that you cut (remove) or copy from 
the EDL. So you to can move Entries by cutting and pasting them in somewhere else and you can repeat them 
by copying them and pasting the copy somewhere else. 

These tools are on the Playlist PASTE toolbar. 

CUTTING AND REMOVING ENTRIES 

Select the Entry/Entries as described above, then: 

 
Press CUT ENTRIES TO PASTE BUFFER. 

 
Press CUT. 

NOTE: The previous contents of the Paste Buffer are replaced each time it is loaded. If you want to 
remove an Entry from the EDL without it being loaded into the Paste Buffer, select it and press the 
keyboard Delete key, or right-click on it and select "Delete Entry". This may be useful if the Paste Buffer 
already contains something you want to paste in later. 

COPYING ENTRIES 

Select the Entry/Entries as described above, then: 

 
Press COPY ENTRIES TO PASTE BUFFER. 

 
Press COPY. 
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PASTING ENTRIES 

NOTE: The Paste Buffer first needs to be loaded from cutting or copying EDL Entries as described 
above, or with a Clip from the Clipstore, (see below). It is also possible to load Entries to the Paste 
Buffer from the Trim Editor. If the Paste Buffer is not loaded, its button picture will appear faint. 

 
Press LOAD PASTE BUFFER TO CURSOR. When you move your mouse pointer (or cursor) 
over the Playlist Streams, you will see that it has changed to a reel of tape with a cross indicating 
where the in-point of the Entry/Entries will be positioned. The mouse time display will give you the 
exact EDL time. Click to paste the Entry/Entries into the Playlist. 

 
This "Paste to Cursor" function is available as a Hotkey in the Playlist section of the Hotkey setup. 

NOTE: To cancel pasting and drop the paste symbol from the mouse pointer, press the button again, or 
right-click with the mouse. 

 
Or pressing the PASTE TO CURRENT TIME button will place the contents of the paste buffer 
into the Playlist at the current time, exactly as with the PASTE button on the Hardware Controller. 
Under normal circumstances, this will be with the entry's start time to the current time, but of 
course, if Autoplace is on, then the Autoplace rules will be followed. 

 
Use the wheel to position the current-time cursor to the time at which you want the Entry to start. 
(Make sure the wheel is not in STREAM , CLIP, ZOOM, JOG or SHUTTLE modes; all the 
LED's by the wheel should be off.) The display in the Transport Controls, or the EDL time display on 
the controller will show the exact time. 

Press PASTE to insert the Entry/Entries with their in-point at the current time. 

NOTE: Multiple Entries cut or copied from the EDL will be pasted back with the same time and Stream 
relationships between them. After pasting, the Paste Buffer is not emptied, so you can paste further 
copies as many times as you like. 

PASTING WHOLE EDL'S TO ANOTHER EDL 

The paste buffer can be loaded with an entire EDL that has been previously saved. On the menu bar, select 
"File", then "Load to Paste". An "Open EDL" box will appear allowing you to select the EDL you want, then 
press "Ok". 

The PASTE button will have been pressed for you so you can immediately paste the selected EDL into your 
current EDL. This is very useful for compiling work that you have built up in sections; for example, edited 
tracks compiled into albums, scenes compiled into reels, etc.  

MOVING ENTRIES 

You can move entries around the EDL in many ways: 

1. Cut and Paste them back in at a new time, as described above. 

2. Select Entries, and then simply drag them with the mouse to a new location or Stream. The Playlist 
will scroll automatically if you move the Entry near its edges. 

NOTE: While you are moving the Entry, the mouse time display will change to show the start time 
you are about to set when you "drop" it. Red is a warning! Once selected it is quite easy to move 
Entries by mistake, so always deselect them when you have finished. 

There is an option in the Setup Window to display guide lines for the entry start, end of fade-in, start 
of fade-out, hotspot, and entry end. These can also be displayed for grouped entries. 

 
There is a Hotkey toggle available for each of these functions. 
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3. Nudge them by small amounts left/right (earlier/later in the EDL) or up/down (to different Streams 
without changing in and out times and so maintaining sync): 

 
Press the SELECT TOOLBARS button, and then select "Nudge" from the menu, to 
reveal the Nudge toolbar. 

 
The buttons nudge the selected Entry/Entries left/right/up/down. Each press of the left/right buttons 
nudges by a fixed amount. This can be set in the "Playlist Nudge" section of the Setup Window, which is 
displayed from the "View" menu. An alternative nudge amount is available by holding the Alt Key whilst 
nudging. 

On the computer keyboard, Ctrl + the cursor keys (the ones with the arrows) duplicates these nudge 
buttons. 

 
Function keys F1, F2, F3, F5 are also marked with arrows indicating that they duplicate 
the Autoplace toolbar nudge buttons when pressed after the ASSIGN key. 

4. Use the Clip Details Window or the Text EDL to adjust their start times. 

NOTE: You can also move Entries when using Playlist Editing mode. 

CHANGING STREAMS 

You may wish to move EDL entries to another Playlist stream, without changing the EDL time. There are 3 
different ways of achieving this. 

1. If you hold the ALT key down while dragging and dropping entries with the mouse, the stream can be 
changed but the EDL time cannot. 

2. The up and down nudge buttons on the Nudge toolbar (described above), change the stream of an 
entry, one stream at a time. 

3. "Move selected clips onto stream..." option in the "Playlist" menu, forces entries to a new stream. 

 
Select the new stream from the drop-down list, and however many streams the entries were on 
previously, they will be moved, without changing the EDL time, to the new stream.  

ADDING AND REPEATING ENTRIES 

ADDING NEW EDL ENTRIES 

 
Click and hold on the Clip you want in the Clipstore and drag it (actually a "copy" of it) to the Stream 
and time that you want it to start in the Playlist . You will see that the mouse pointer has changed to 
a reel of tape, with a cross indicating where the in-point of the Clip will be positioned. Release the 
mouse button to paste the Clip into the Playlist. This does not use the Paste Buffer. 
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Alternatively, select the Clip in the Clipstore by clicking on it, press the LOAD TO PASTE button 
and then paste it into the EDL from the Paste Buffer. The Playlist PASTE button will have been 
pressed for you! 

 
Use the WINDOW button to make the Clipstore the active window and then select the Clip you 
want either with the wheel or the PREVIOUS/NEXT buttons. Press COPY. 

Return to the Playlist with the WINDOW button. PASTE the Clip into the Playlist as described 
above. 

NOTE: You can place as many Entries as you like on top of each other on the same Stream, although this 
will not make them easy to view. 

REPEATING EDL ENTRIES 

To repeat one or more Entries, either: 

1. Copy them and then paste them in at a new point, as described above, OR 

2. Select them and then hold the Ctrl key whilst dragging a copy with the mouse to the required 
position.  

PLACEMENT OF ENTRIES 

REMOVE GAP 

 
Press the REMOVE GAP button (on the main Playlist Tools toolbar) to move any selected Entry 
to the left (e.g. forward in time) so that it butts up to the previous Entry on that Stream. The start 
of the selected Entry's fade-in will be changed to coincide with the start of the preceding Entry's 
fade-out. 

 
On the keyboard this "Snap entry..." is available as a Hotkey under the Playlist section of the 
Hotkey Setup. The default is F6. 

 
Remove Gap can be set to a Hardware Controller Hotkey F1-F12. The default is F6. 

NOTE: The SLIP facility described below will automatically remove gaps left after cutting Entries from 
the EDL. 

SNAP TO CURSOR 

This is a very useful tool for synchronising Entries. Right-click over the Entry you want to move and select 
either "Snap in-point to current-time", "Snap end-point to current-time", "Snap Hotspot to current time", or 
"Snap fade in-point to current time". The Entry will jump to a new position with either its Hotspot, its fade in-
point, or its in or out-point on the current-time cursor. This is useful: 

 On the fly whilst listening to music to run alongside speech. A voice Clip can be snapped to cursor 
during playback. 

 After positioning the current-time cursor by double-clicking on the current-time display and typing a 
new value. 

 After positioning the cursor by scrubbing with the Edit section of the transport controls, perhaps 
scrubbing to find a sync point in one piece of audio, to which you need to reference the start, end or 
hot spot of another. 

 
These snap functions are also available as Hotkeys. 
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PREVIEW 

The standard Editing preview functions are available in the playlist for playing up to, from or through the 
current position. These are available as hotkeys, or on the Transport Controls edit pane. The Pre- and Post-
roll for the preview is set in the Setup Page / PrePost Roll, and three different sets of times can be set. Using 
the CTRL or SHIFT modifier key with the preview buttons will preview with different pre and post roll times. 

GRID LINES 

From the Playlist right-click menu, you can select "Show Grid". This will show a series of major and minor grid 
lines across your Playlist for easy alignment and positioning of clips. The position of the grid lines will be 
dependant on the Time Display selected in the Setup Window, and on your Zoom level. 

AUTOPLACE 

All of the functions for positioning Entries described above are affected by further options provided on the 
Autoplace toolbar. 

 
Press the SELECT TOOLBARS button, and then select "Autoplace" from the menu, to reveal the 
Autoplace toolbar. 

 

 
Turns the Autoplace function on or off. 

There are several different Autoplace Options available. Clicking on the second button will reveal a menu for 
selecting your Autoplace Option: 

 
The second button will change appearance depending on the Autoplace Mode: 

 
Autoplace an Entry to butt up to the previous one on that Stream. The start of its fade-in will 
coincide with the start of the previous Entry's fade-out (like Remove Gap). 

 
Autoplace an Entry with a pre-set gap separating it from the end of the previous one. The gap can be 
set in the Playlist section of the Setup window, displayed from the View menu. 

NOTE: The above two functions are handy for roughly putting together an EDL that you are 
going to fine tune later. 

 
Autoplace an Entry in sync with the EDL time when the Track was recorded. 

 
Autoplace an Entry so that the Hotspot rather than the in-point goes to the EDL time shown by the 
mouse time display (or the current-time display when using the hardware controller). 

NOTE: The Hotspot is a useful marker that you can set at a particular point within a Clip or 
Entry and then use as the reference when placing it. For example, when you place a sound 
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effect of a screech of car tyres followed by a crash, it is probably the crash that you want to 
position accurately. The Hotspot may actually be outside the in and out points of the Entry 
you are placing; you wouldn't include the sound of the clapper board recorded at the start of a 
dialogue Track, but you can still use it as the Hotspot in order to place Entries from that 
Track in sync. To set or adjust the Hotspot, see Chapter 5, Editing, and the Clip Details 
Window section of this chapter. 

 
Autoplace an Entry with its in-point at the current time. This can usefully be done on the fly, whilst 
listening to the rest of the EDL to get the "feel" of where you want an Entry to start. 

NOTE: As SADiE loads the EDL into memory when you start to play it, you will not hear any 
changes you make during playback until the next time you start it. 

 
Autoplace an Entry with its Hotspot at the current time. Use in the same way as the above. 

 
Autoplace an Entry with the end of its fade-in at the current time. Use in the same way as the above. 

 
Autoplace an entry or group of entries at the original EDL time. Thus when used in the same EDL, an 
entry will snap to the same time (but you can move it up or down a stream as with nudge for 
instance). This is perhaps most useful if you want to copy and paste entries from one EDL into 
another. Use this to snap the entries to the same EDL time. 

Additionally this can be used with a certain type of SD2 format audio file; with other audio 
workstations it is possible to embed the EDL time into the audio file. With this "Autoplace to original 
time" mode, when dropped into the EDL, these SD2 files will snap to the EDL time from the original 
workstation. 

 
Autoplace an entry with its end point at the current time, similar to "Autoplace Now", and 
"Autoplace Hot-now" as above. 

NOTE: The Autoplace functions: Now, Out-Now and End-now, are available for single entries 
on the Entry menu that appears when you right-click on an entry (e.g. "Snap In/End/Hot point 
to current time"). 

 
Autoplace an entry to snap to the nearest quantisation point. There are two further buttons here, for 
setting up quantisation: 

Allows you to select which part of the clip to snap to the quantisation point: 

 

Allows you to select a suitable quantisation level. You can either quantise to grid lines or to a 
note value in Bars and Beats. 
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SLIP 

All of the functions for positioning Entries described above are affected by further options provided on the Slip 
toolbar. 

 
Press the SELECT TOOLBARS button, and then select "Slip" from the menu, to reveal the Slip 
toolbar. 

 

 
Turns the Slip function on or off. 

 
Pre-selects Slipping of Entries to the left of the selected one. 

 
Pre-selects Slipping of Entries to the right of the selected one. 

With the function on and an Entry is selected, other Entries on enabled Streams will turn dark blue and will 
automatically be moved in the following circumstances: 

 Moving an Entry by nudging, dragging it with the mouse, using Remove Gap, or by any editing functions 
will cause Slipped Entries to move with it. 

 If right-hand Slip is selected, removing an Entry from the EDL will cause later Entries to be brought 
forward by an amount equal to its duration. This means that removing an Entry between two cuts in 
continuous audio will automatically remove the gap that would otherwise be left. 

 If right-hand Slip is selected, pasting a new Entry into the EDL causes Entries after it to be moved back 
by an amount equal to its duration, e.g. they make room for it! 

NOTE: The current Autoplace and Slip settings can be displayed on the Status bar at the bottom of the 
screen. Right clicking on them will then bring up a box to change settings. This avoids taking up screen 
space with the toolbar. Double clicking on the status boxes, will toggle them between On and Off, thus 
you can set the Autoplace or slip type with the right mouse, and turn it on and off, by double clicking. 
Use the "View" menu to display the Setup window, double-click on "General" and select the Status 
displays section. You can then choose which displays are shown. 

 
NOTE: The hardware controller has a SLIP button, which operates the SLIP ON/OFF. 
You will need to set your slip type with the mouse. All slip and Autoplace types, along with 
Autoplace and Slip ON/OFF, can be also assigned to Hotkeys. 

 

GROUPING OF ENTRIES 

GROUP ENTRIES 

Any number of Entries may be grouped together. They will be redrawn as a single block in the Playlist. This 
may be for convenience of display, for repeated operations to the same group, or to avoid accidentally undoing 
edits. You can rename a group, and store it in a Clipstore, so a heavily edited piece can be stored as a single 
Clip. 

 
Press the SELECT TOOLBARS button on the Playlist toolbar again. Select "Group" to reveal the 
Group toolbar. 
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Select the Entries you want to group and then press GROUP SELECTED EDL ENTRIES. 

NOTE: When selecting lots of Entries it may be easier to select all the Entries in the EDL and then 
deselect the ones you don't want included in the group. Click on "Edit" on the menu bar, then "Select 
All" (or press Alt, E, S on the keyboard). Deselect Entries by holding Shift on the keyboard while clicking 
on them with the mouse. (On the hardware controller make sure no in, hot or out edit points are 
selected, position the current-time cursor over the Entries and press SHIFT + EDIT/SELECT.) 

Groups may be further grouped with other Entries or other groups and a hierarchy is formed. 

 
At any time you can break a group back down into its component parts by selecting it and pressing 
the UNGROUP button. 

MAKING ENTRIES STEREO AND MONO 

 
To make a stereo entry into two mono entries, select the entry and push the UNGROUP button. 

You can make a mono entry into a stereo entry, only if the mono entry was originally part of a stereo one, and 
therefore another leg exists. Right-click on the entry and select "Make Stereo". This option will only be 
available if the audio exists. 

NOTE: You can UNGROUP a Multichannel Entry into its component parts, or a stereo Entry into its 
left and right mono parts in order to treat them separately. For example, you might introduce a time 
shift between the two channels, or delete one channel from the EDL completely; especially useful when 
working with M&S stereo or material you thought was stereo when you recorded it, but turns out to be 
mono!  

BOUNCE-DOWN 

 
Entries may be permanently grouped by re-recording them internally. The Bounce Window provides a simple 
method for doing this. 

 
Press the SELECT TOOLBARS button on the Playlist toolbar again. Select "Bounce" to reveal the 
Bounce toolbar. 
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You may choose to bounce entries down for a number of reasons: 

 To create a "master" mix file. Nowadays it's increasingly more likely that you will be asked to deliver 
masters as files, rather than on a tape or other recordable medium.  

 Convenience. You want the mixed or processed result to always appear as a single EDL Entry, or you 
don't want to bother with setting the Mixer or Automation to process the required Entries every time 
you play the EDL. 

 To clear disk space. You want to re-record small parts of one or more much longer Tracks that you 
can then delete (as described under Audio Disk Management). 

 There is not enough DSP power available to carry out the processing you require in real time and/or 
play the number of simultaneous Entries you require. Process and re-record the necessary Entries 
with "Non-real-time" selected in the Transport Controls' Record section. Then you can use the 
processed versions in the full EDL.  

 Bounce can provide convenient "batch" processes for sample rate converting or resampling 

 To export to a compressed audio format (n/a in DSD mode). SADiE works only with linear digital 
audio formats, but is able to import or export compressed formats such as MPEG or WMA. To 
export to compressed formats uses a variant of the Bounce Window that is launched from the 
Compress Audio button. This is described in more detail later in this section. 

BOUNCE OVERVIEW 

The Bounce Window can re-record a group of clips, with or without the mixer, automation or processing, so 
that they become a single mono, stereo, or Multichannel track. There are many possibilities but let's follow a 
fairly simple example where you are re-recording some edited clips to form a "master" stereo track 

1. First, select the clips in the EDL. These clips will be re-recorded through the mixer, so check the 
mixer balance is correct. 
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2. Click on the bounce icon to open the Bounce Window. 

3. The first section of this window serves the same purpose as the Record tab of the Transport window, 
so enter a name for the recording. 

4. This is going to be a stereo mix-down so select "Stereo" under "Output Channels" and at the bottom 
tick "Bounce through mixer" because we do want to include some level changes we've made on the 
mixer. 

5. Next tick "Selected Clips" in the Source section. The Source section tells Bounce what to re-record; 
"Complete EDL" or "Selected Streams" are the other possibilities. The new recording is made through 
the mixer, so check that "o/p 1&2" are chosen from the pop-up list; SADiE will record what is 
appearing on these outputs. 

6. Choose, in the "Destination" section, what's going to happen to the new track after re-recording: 

i. "Replace Source Clips" will place the new track on the topmost stream occupied by the 
source clips, and will delete all the source clips when the bounce is finished. 

ii. "Stream(s)"- tells Bounce to put it into the same EDL on streams specified in the pop-up list. 
The "Remove Source" tick box will delete the source clips after the bounce. This mode is 
useful if you want to push the result of the bounce to a new stream 

iii. "Clipstore" - leaves the Playlist unaffected, and places the new track into the current 
Clipstore. 

iv. "PC" - this is explained in the "Special Bounce functions" section below. It is unadvisable to 
choose this option unless you have a specific need to. 

The bottom section allows you to choose "Bounce in non real time". If this is selected the bounce will be 
performed as quickly as possible, but will not be audible. The other two options allow you to turn off 
automation and/or the mixer for the bounce. 

Press "Start". The process will start, and during the bounce the ball icon in the Bounce button will "bounce". Be 
careful not to click in the time-line in the Playlist or press transport buttons, as you will halt the bounce.  

OUTPUT CHANNEL SETTING 

The Output Channel setting determines the channel width of the resulting track. 

Stereo and Mono are obvious – a two channel or single channel track is recorded. 

Original will create a new track with the same number of channels as the source clip. However this can only 
be used for bounces that are not through mixer, because of course the mixer changes the channel width. 
Original works for group clips and multi-channel clips. Note that clip level changes are included in the bounce, 
but Bounce through Mixer is automatically turned off. 

When Original is used with Multi-bounce (which is a batch process that bounces many clips singly – described 
below) each individual source clip will determine the number of channels in its respective bounce track – i.e. if 
you have three clips in the EDL that have 2, 1, and 16 channels, the resulting three clips will be 2, 1, and 16 
channels wide.  

All O/Ps (all outputs) is the converse – the number of physical outputs in use by the mixer determines the 
width of the resulting bounce.  

When this is set you will be forced to Bouncing through the mixer, and all Physical Outputs in use will be re-
recorded internally except any that are used only for Aux sends.  

If you do want to record Aux sends, then route them to an intermediate bus and to the output via a fader. 
Existence of a fader routed to a physical output causes everything routed to that output to be re-recorded. 
Thus if outputs used by an Aux send are also being used elsewhere, then the audio sent via the Aux send pot 
will also be re-recorded. 

If you regularly require "flat" bounces (e.g. NOT through the mixer), then use Original mode.  

All Output bounces can be performed in Non Real Time.  

There is a small feature in SADiE that is particularly relevant now for Surround "All output" bounces. Any 
bounce will have the output number or name appended to the new file that's created, and thus you can append 
channel labelling to the Bounce files by renaming the Outputs appropriately. 
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The easiest way to do this perhaps is in the Routing toolbar.  

 
Press the ROUTING button on the Mixer  

 

Double click on "Physical Outputs" and then again on "O/p 1 & 
O/p 2... O/p 5" to view each Output individually. 

Then right mouse click on each separate O/p and rename them 
as: 

O/p 1 L, O/p 2 R, O/p 3 LS, O/p 4 RS, O/p 5 C, and O/p 6 on 
it's own to Sub if that's the output you're using for the Sub. 

(you can choose your own nomenclature here: i.e. LeftRear or 
Left Surr or LR will do) 

The resulting bounce files will be called something like: 

Bounce-L01.WAV... 

where "Bounce" is the track name you've typed, "-L" represents 
the channel, and "01" is the take number (which will only appear 
if you have auto-take switched on). 

Labelling bounces in this way will make channel assignment easier 
once the files have made their way to the DVD author. 

 

 

SPECIAL BOUNCE FUNCTIONS 

1. Multi-Bounce - with Multi selected as the source for the bounce, every entry in the EDL will be re-
recorded as a separate audio file on the disc drive. If you want a group of entries to become a single 
audio track then simply group the entries; a Group Entry is treated as one entry. You must have 
either Autotake, or Clip Name selected, as the new tracks will be automatically named. "Autotake" 
will use the Bounce track name as the main part  of the name and increment the take number for 
every bounce. "Clip name" will use the source clip's name for every track. If "Autotake" is not 
switched on in conjunction with "Clip Name", and if duplicate names are found during the multi-
bounce, a take name will be added anyway, and you will be informed this has happened at the end of 
the multi-bounce 

2. PC - Bounce to PC Disk: Of course every bounce is to the PC disk, however this provides a facility 
for bouncing to a directory that it different to the project's record directory. This can be useful when 
Master mixes are being created, they can automatically be "exported" to a pre-defined directory. 
There is a button alongside the PC option which shows where the "PC" bounce will go – pressing this 
button allows you to change to a different destination directory. There is also a tick box called 
"Create Profiles" which is connected to PC bounces, and this allows you to choose whether the 
profile files that SADiE uses for displaying waveforms are created or not. 

3. Reverse - this option in the Bounce window allows you to make a backwards copy of an EDL entry 
or entries. Note also that right mouse clicking over an entry will initiate the Bounce window with 
Reverse enabled. Otherwise the Bounce window works in the normal way. Note that as usual the 
Bounce records the Output of the mixer including any level changes or processing. 

Reverse cannot be used in conjunction with any Non 1-1 process, such as Resample or Timemod.  
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4. Bounce Through Process - Selecting this option will open up a process window, allowing you to 
perform the bounce with a process in-line – this could be a Sample Rate conversion, a 
Resampler/Varispeed, or a Time-mod. In the case of the DSD8, a DSD Sample Rate Converter and 
Varispeed is available for converting PCM to and from DSD. 

Choose which process option you require from the drop-down list, set up it's parameters, and then in 
the usual way set the bounce and press Start. 

Notice that "Bounce Through Process" cannot be through the mixer and you will see that "Original" is 
automatically set for the Output Channel setting. 

This option is currently only available in DSD mode 

 COMPRESSED AUDIO 

SADiE records and plays back only high quality linear PCM files, but includes the facilities to import and export 
MPEG or WMA audio formats. 

The functions for Exporting and Importing to and from compressed audio formats use existing encoders 
and decoders installed on your computer along with Windows Media Player, and so the formats and qualities 
available will depend on your installation. If you are upgrading or freshly installing Windows Media Player, we 
advise that you use Media Player 10 (or higher), and that you then re-install SADiE in order to re-configure this 
feature. 

Windows Media Player 10 is currently available from www.microsoft.com as a free download. 

Windows Media Player 10 or higher offers encoding to the most common PC formats - i.e. Windows 
Media Audio (WMA) and MPEG 1 layer-3 (MP3). 

Media Player 10 can decode a wider variety of formats than it can encode, and so you will find that MPEG 1 
layer 2 files and other formats can be imported. 

EXPORTING TO COMPRESSED AUDIO FORMATS 

The  Compress Audio button reveals a variant of the bounce window, which can mix down and re-
record the EDL, or clips within it, to create a new audio file in a compressed format. 
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Operation is very similar to the normal bounce window. For example:- 

1. First, select the clips in the EDL.  

2. Click on the  Compress Audio icon to open the Compressed Bounce Window. 

3. The first section of this window serves the same purpose as the Record tab of the Transport window, 
so enter a name for the recording. 

4. Select "Stereo" or "Mono" under "Output Channels" and at the bottom tick "Bounce through mixer" if 
you want to include some level changes made on the mixer. (See note below on stereo/mono.) 

5. Next tick "Selected Clips" in the Source section. The Source section tells Bounce what to re-record; 
"Complete EDL" or "Selected Streams" are the other possibilities. The new recording is made through 
the mixer, so check that "o/p 1&2" are chosen from the pop-up list; SADiE will record what is 
appearing on these outputs. 

6. Next select the location and format for the bounced file. 

i. Select the folder where the file is to be placed by pressing the long button (c:\ in the picture) 
underneath Destination: . 

ii. Under Codec: select Windows Media Audio or MPEG Layer-3 

iii. Under Bit Rate choose the quality - the higher the number for kb/s and Hz, the higher the 
quality will be, and of course the larger the file size will be.  
If you are only offered 56kb/s for the MPEG Layer-3 format, then that is the limit of the 
encoder on your machine - install Media Player 10 then re-install SADiE. 

7. The bottom section allows you to choose "Bounce in non real time". If this is selected the bounce will 
be performed as quickly as possible, but will not be audible during the operation. The other two 
options allow you to turn off automation and/or the mixer for the bounce. 
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Press "Start". The process will start, and during the bounce the ball icon in the Bounce button will "bounce". Be 
careful not to click in the time-line in the Playlist or press transport buttons, as you will halt the bounce.  

Note on bit rates and stereo files. The most common encoder installed by Windows Media Player 10 creates 
only mono files at rates of less than 96kb/s. 

IMPORTING FROM COMPRESSED AUDIO FORMATS 

Importing of WMA or MPEG files works through the normal "Import Source Tracks" or "Copy and Import 
Source Tracks" in the clipstore. It makes no difference which of these you choose - a "copy and import" 
process runs in either case. On import the compressed audio file is converted to SADiE's current record 
format (see Properties on the Transport Controls' record tab) at the current sample and bit rate. 

If sample rate conversion is required, i.e. SADiE's current sample rate is different to the compressed file, then a 
sample rate conversion will be applied by Windows Media Player (this isn't using SADiE's own SRC function). 

SADiE is able to import files with the extensions: 

.WMA 

.MP3 

.MPG 

.MUS 

.MP2 

Note that some WMA files are copy protected, in which case it will not be possible to import them. 

The Compressed Audio Import and Export feature is available as a software option - contact your dealer for 
details of how to obtain it. 

 

UNDO AND REDO 

 
Pressing UNDO can reverse the last change that you made to the EDL . Press UNDO again to 
reverse the change before that, and so on, stepping back through the history of your actions. The 
maximum number of undo levels is set in the Setup window and can be up to fifty. 

REDO steps you back the other way after using undo. 

 
UNDO is at the bottom right of the panel and SHIFT + UNDO is redo. 

NOTE: Undo and Redo are also available on the menu bar under "Edit". This may be useful as it also 
gives a description of the operation to be undone. Note that the "Edit" menu Undo and Redo 
commands can also apply to the Mixer and Clipstore, if either is the active window. 

NOTE: The Undo memory is cleared if Streams are removed from or added to a Playlist.  

LOCKING CLIPS AND STREAMS 
There are facilities for Locking clips, more aptly described as a "Sync Lock". This is not a "Full lock" or "Write 
protect". 

Clips in a Playlist can be locked individually and multiple selections of clips can be locked and unlocked using a 
Hotkey ("Lock selected Clips" and "Unlock selected Clips" under the Playlist section of Hotkey Setup) or the 
options at the bottom of the Playlist menu, and also Streams can be locked by using the little padlock buttons 
in the left side of the Playlist. 
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The STREAM LOCK buttons toggle (locked/unlocked) the status for all clips on that stream, and these 
buttons can be set in groups by using a similar logic to that used for Stream enabling, e.g. Shift + LOCK will 
lock all streams above the stream being locked up to the next stream above that changes status. There are two 
new buttons on a new Lock Streams toolbar for the Playlist to LOCK ALL STREAMS and UNLOCK ALL 
STREAMS. 

 
When clips are locked, they will show a new red LOCKED icon in the top left corner (assuming there's space 
to display this). A yellow LOCKED icon shows that some clips within a group clip are locked (and others not). 

 
Note that locking works on two levels. Clips that are locked individually (or as a multi-selection) cannot be 
unlocked by a Stream unlock. Likewise Clips that are on a locked stream become unlocked when you move 
them (by using Alt + drag or Nudge Down) onto an unlocked stream. This allows different methods of utilising 
the locks (stream or clip based or a combination of both). 

Locked clips can still be edited, but no functions that may cause a sync-slip are allowed. Thus you will be 
allowed to nudge up or down a stream, and you can Playlist edit in the "EDL" mode, but you cannot nudge left 
and right or perform "Source" style edits. Also the new "Set In point" style editing is allowed (because it 
doesn't slip audio). 

You can't pick up a locked clip and move it, but you can "Alt + drag" a clip to change its stream. If you move a 
selection that contains a mixture of locked and unlocked clips, only the unlocked clips will move. If you group 
together any selection that contains a locked clip, then the whole group clip will become locked. The group will 
act as if it is single locked clip. However, the padlock symbol will be yellow instead of red, to denote that only 
one physical clip is locked. 

If you lock a single stream that contains stereo or n-channel clips, then the other legs of the clip on unlocked 
streams are considered to be locked (until you ungroup the clip).  

 
The LOCK button matches the LOCK STREAMS buttons in the Playlist. Therefore, pressing 
LOCK will lock all streams, and press SHIFT + LOCK will unlock all streams. 

 
There are Hotkeys available for these functions 
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GROUPING PLAYLIST STREAMS 

GROUPING AND HIDING STREAMS 

Right Mouse click somewhere in the left hand side of the playlist, over the stream labels, and select the menu 
item "Show/Hide Stream Groups Lists". The Hide & Group tools will appear on the left side of the main Playlist 
window. 

The top half of this vertical strip is for Hiding and Showing playlist streams. 

The bottom half gives us tools for Grouping Playlist Streams so that certain actions can be performed on 
multiple streams quickly, for instance for enabling editing, or slip, or razor, and also for mute, solo and record 
enable functions. 

 

STREAM GROUPS 

To Create a New Stream Group FIRST enable some streams, disable streams that are not part of the group, 
THEN press the “Create New Group” button.  

Enabling and Disabling of streams is achieved by pressing  the Stream Name buttons. Shift-clicking 
on those buttons changes ranges of streams; Ctrl-clicking on a stream disables all others. 

Enabled streams appear with a light grey background (button down) and Disabled streams have a dark grey 
background (button up). 

The grouping functions are always enabled, but you will want to see their interface to set up stream groups. 

Right Mouse click somewhere in the left hand side of the playlist, over the stream labels, and select the menu 
item Show/Hide Stream Groups Lists 
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This will reveal a new vertical strip divided into two sections, and eight buttons and the Playlist will look 
something like the picture above. 

Stream Grouping List 

This bottom section is initially empty apart from the word “All”, but this is where you will see stream groups 
as you create them. 

First, enable a few streams in your playlist and disable the others. 

The left most button is Create New Group. Press it; you’ll be asked to type a name for the group; that 
name will appear in the list. 

Click on the word “All” and all streams will become enabled. Click on your new group’s name in the Groups 
List and the stream enabling will revert to the way it was when you saved that group. 

Make some more groups – enjoy yourself ! 

CTRL-click on a group to add it so as to select multiple groups. 

Right-mouse-click (RMC) on a group name displays only that group. CTRL-RMC adds a new group to those 
displayed. 

Streams ARE allowed to belong to more than one group. 

You will notice the colouring of the background to the group name will change when you enable groups, or 
enable/disable individually.  

 When a group name is displayed with a blue background it means that all of the streams belonging to 
that group are selected. (Blue may not be blue if your Windows colour scheme has been changed.) 

 When a group name is displayed with a pink background it means that some of the streams belonging 
to that group are selected. 

Thus, at a glance you can reliably determine whether streams are enabled or not. 

Other functions can be applied to selected groups :- 

(selected groups are those that have the * asterix by the side – the last one(s) you clicked on) 

Solo group(s) 

Mute group(s) 

Record Enable Selected Streams 

And another right-mouse click menu on the four buttons shows a few more functions: 

• Save Group – you can alter the stream grouping with this : i) Select the group ii) change the stream enabling 
iii) RMC over the Groups Toolbar and select Save Group iv) press OK – the name of the Group you’re re-
saving will be displayed to show you that you’re saving the correct one. 

• Delete group 

• Rename Group 

• Enable/Disable All 

• Reverse Enabled/Disabled 

• Unmute all streams 

• Activate/Deactivate Streams (which makes Enabled Streams Active, disabled streams inactive – inactive means 
that those streams will not play and will not use DSP resources – i.e like ALT-clicking on a  stream button.) 

Note also that ALT-clicking on a group toggles that group inactive/active. 
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DISPLAY GROUPS AS ONE STREAM 

This function, found in the Right-mouse-click menu of the Grouping List, or as a hotkey, will "collapse" all 
streams in the same group down to a single stream. The single stream select button will change colour to cyan 
and show the name of the group. This is useful for very large playlist where perhaps you are working with 
stems - it may be useful to simplify the view of the playlist. 

As an example this is a 40 track Playlist made up,a grouped into 5 or 6 channel stems 

 
You can choose which stream is viewed by right-mouse-clicking on the cyan stream button and selecting View 
next channel. 

You can choose to View All Channels of a specific group, again from the right-mouse-click menu on the 
stream button, and once in this state you can revert to View One Channel Only again with a right-mouse-
click. 

Display All Streams in Groups found in the Right-mouse-click menu of the Grouping List, or as a 
hotkey,will revert the entire playlist to it's usual view. 

Display All Streams in Selected Groups also found in the Right-mouse-click menu of the Grouping List, or 
as a hotkey, will explode only the selected group to view it's component streams. 

NOTE that if a stream is a member of more than one group, it only appears in one display group under 
this regime, and it will appear in the first group to which it was joined. 

HIDING & SHOWING STREAMS 

THE SHOW/HIDE LIST 

The top section is called the “Show/Hide List”. This provides secondary functions for hiding streams or groups 
of streams. There will see a number or name for every playlist stream. If you click on a single number/name, 
that stream will be hidden.  

 Streams number/names with a blue background are being displayed 

 Streams number/names with a grey background are hidden 

 Streams number/names with an * asterix by the side are enabled. 

Thus at a glance you can see which streams are being shown, hidden or are enabled, as you can see on the 
picture above. 
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The buttons along the top are fairly self explanatory:- 

Show All 

Show Enabled Streams (and thus hide disabled streams) 

Enabled Streams at Top 

Hide Enabled Streams (and thus display disabled streams). 

Right Mouse clicking over any of these buttons, will show a menu that includes these functions and a couple 
more: 

Hide All Streams (not as useless as you might imagine); Auto Zoom on Show/Hide. 

A couple of these need a little more explanation. 

Enabled Streams at Top is a mode – as you change the enabling of streams (and thus as you edit different 
sets of streams) they will be pushed to the top of the display to avoid you having to keep scrolling up and down 
the playlist. This is not a permanent re-ordering of streams, only temporary. 

Auto Zoom on Show/Hide - as the number of streams being displayed changes, the vertical zoom will 
change also, thus when you show less streams they will be bigger. 

Auto Zoom Selected Streams - vertical zoom will change to ensure that enabled streams are always 
viewed 

CLIP DETAILS 

CHANGING ENTRY CHARACTERISTICS 

The Clip Details window lets you alter the way EDL Entries in the Playlist are replayed as well as providing 
another way to alter their positions in the EDL and labelling. 

NOTE: The Clip Details window can be equally well used to alter the details of Clips in the Clipstore. 
This will affect the way they are replayed when they come to be placed in an EDL. If you want to store 
different versions of Clips in the Clipstore, change their name before writing them back to it. For 
example, a Clip called "Splash" could be loaded into the Clip Details window, have its level adjusted and 
name changed to "Quietsplash" and then be written back to be used as an alternative version. 

NOTE: Although each Clip Details window only refers to a single Clip or Entry, you can have several 
Clip Detail windows open at the same time. 

 
First select the single Entry or Clip you want to adjust. Then load it to a Clips Details window by 
pressing the CLIP DETAILS button (red on the Playlist toolbar, blue on the Clipstore toolbar). 

NOTE: In the Playlist section of the Setup window there is an option to open the Clip Details window 
by double-clicking on the Entry. 

The Clip Details window has a row of buttons along the bottom providing: 

 

 A "Write-back" button which updates the Playlist or Clipstore with the new details. 

 Buttons providing four ways of loading new Clips/Entries into the existing window for alteration. Each 
is described by the on-screen help. Remember to write back one Clip's details before loading the next. 

 A preview button for hearing the Clip/Entry with the changes you are making in real time. 

 A Close button for closing the window when you've finished with it. 

There are three tabs along the top, which reveal three different sections: 

Fades and Levels 

Entry Times 
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Miscellaneous  

FADES AND LEVELS 

 
The Fader changes the level the Clip /Entry will be replayed at. There is a PPM meter next to the fader to 
check the level. 

NOTE: This sets the Entry's replay level relative to others on the same Stream, which will then be 
affected by the faders of the Mixer . It is useful for changing the level of a single Entry without bothering 
with Mixer automation. 

The Balance control is a true stereo balance, or offset, adjusting the relative levels of the left and right channels 
of stereo material. It will not be active for mono Clips/Entries. Click and drag it left and right to adjust. A small 
fader will pop up to indicate the setting. Double-clicking keeps pop up open and allows you to adjust the pop-
up fader: 

 

Nudge Drag Centre 

The rest of this section displays the details of the fade-in (on the left) and the fade-out (on the right). Every 
Clip or Entry in SADiE has a fade-in and fade-out, the length of which can be adjusted from the whole of the 
Clip's duration right down to zero, and the curve of which can be selected from a list of 117 different types. 

NOTE: The default fade-ins and fade-outs which result from starting and stopping recording, and from 
making razor-cuts when editing can be set in the "Default Crossfade" section of the Setup window. A 
standard time of 21 milliseconds/40 timecode subframes/1 CD frame (the "General" section sets how 
times are displayed) will give smooth edits for most purposes. For fine editing, like removing clicks and 
pops, you might want to reduce this by at least half. Note that zero-length crossfades are likely to cause 
clicks unless you use the Trim Editor at its highest magnification to make sure the waveform either side 
of the edit point does not jump in level. 

To adjust a fade length, do one of the following: 

1. Click, hold and drag the mouse up or down over any field of digits in its time display (e.g. the hours, 
minutes or seconds, etc.). Their value will increase or decrease; the more you move the mouse, the 
faster they change. Release to set the new value. 

2. Use the up/down arrows beside the display to nudge its value by the lowest units. Hold Shift to nudge 
seconds, Ctrl to nudge minutes. 

3. Double-click on the display. 
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The box that pops up allows you to: 

i. Directly type in a new duration (or use the mouse cursor to drag across and overwrite only 
part of the displayed duration). End with the keyboard  Return key. 

ii. Click on "Zero" to enter zero, followed by "OK". 

iii. Use the up/down arrows to adjust the time, followed by "OK". 

NOTE: Fade lengths can also be adjusted graphically in the Playlist and the Trim Editor. 

To change a fade type, press the  down-arrow button next to the name of the current type. 

The drop-box that appears lets you choose from 117 fade curves. Either use the Scrollbars and select the new 
fade with the mouse, or type the first letter of the fade you want, followed by  Return on the keyboard. 
Alternatively you'll find that if you select the fade type, the keyboard up and down arrows enable you to move 
through the list of fades. Each fade's shape will be displayed above as you do this. 

The fade curve is drawn in the box above the name. There are 7 different logarithmic and exponential curves: 

 Exponential fade-outs are good music fades. 

 Short logarithmic fade-ins are useful for taking the edge off an abrupt start of speech. 

 Linear fades are a good default for other crossfades and edits on most material. 

Buttons are provided to preview just the fade-in or fade-out, with a pre-roll and post-roll time set in the 
pre/post roll section of the Setup window. Equal Power curves can be found by using the negative partner of a 
positive fade curve. More details about these fades can be found in the Trim Fades and Crossfades section.  

NOTE: The default fade types which result from starting and stopping recording, and from making 
razor-cuts when editing can be set in the "Default Crossfade" section of the Setup window, displayed 
from the View menu. 

NOTE: Setting a long Entry fade-out (for music and effects, for example) is a useful alternative to using 
fader automation in the Mixer.  

ADJUSTING LEVEL OF SELECTED CLIPS 

 

Multiple (or single) selected clips can have their level 
altered using the "Adjust level of selected clips" option in 
the "Playlist" menu. This allows absolute or relative 
change to level for all the selected clips. The level is 
changed by typing a value, or clicking on nudge buttons. 
This function is also available as a Hotkey. 

 

NORMALISE 

The normalise function automatically adjusts clip levels in order that the maximum peak in that clip reaches the 
level set by the user. This option is available from the "Playlist" menu. First you should select the clips that you 
wish to normalise level on. Each clip will be normalised individually; this is the case with individual clips inside 
(yellow) group clips also. Set the "Normalise clip level" and on pressing "OK", SADiE will analyse the clips to 
find the highest peak and then lower or raise the level accordingly. 
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The time taken to perform the Normalise will depend on several factors. Part of the process involves looking 
at profile files. However, if the original track was not recorded with SADiE v5.2 or higher, then the profiles 
may not be accurate enough. And so for older tracks, the normalise function will trigger a "Recreate profiles" 
process. Additionally the normalise analysis itself will take longer if the track is heavily compressed and already 
peaking consistently at the same level. Outside of these two conditions, normalise takes between 20 and 50 
seconds for every hour of stereo material (44.1K). 

 
There is a Hotkey available for this function. 

ENTRY TIMES 

 
This section displays the times at which the in-point, Hotspot and out-point of this particular Entry or Clip 
occur in: 

1. The Source Track - the times define what portion of the original recording is being used for this 
Entry/Clip. 

2. The EDL - the times define at what time that portion will be replayed and will be blank for Clips in the 
Clipstore . 

The fade durations are also displayed here as well as the overall duration of the Entry/Clip. Source Duration is 
the length of the original Track as it was recorded. 

All of the above times (except the source duration) can be altered in the same way as described for fade 
durations in the above section. 

The values are interactive, following the same logic as Source/EDL Playlist editing. So, for instance, if you 
change the Entry duration, the EDL out time will change accordingly.  
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MISCELLANEOUS 

 
Here you can change the name of a Clip /Entry, and write text for dialogue or notes that may be shown 
alongside the Clip in the "Comments" area of the Playlist Stream. The Playlist Display section of the Setup 
window sets whether dialogue or notes are displayed. 

Use the mouse to position the cursor to enter text, or drag across text you want to overwrite. 

Five other buttons affect the way the Clip/Entry behaves: 

 Protects the Entry from having its Source times changed, so it is always the same bit of audio. 

 Causes all Mixer automation data in the EDL to be ignored for this Entry. 

 Phase reverses the left or right channel of stereo Clips/Entries (or the whole mono Clip/Entry). 

 Slip all previous Entries 

 Slip all following Entries when you write back changes that move this Entry in the EDL. These will initially 
reflect the Slip status of the Playlist but can be used to override it when writing back, just like the Trim 
editor's Slip buttons. 

TEXT EDL 

TEXT EDL 

The Playlist is a graphical representation of the EDL. Often, however, it is useful to view and edit the EDL in 
text form, as a "cue-list" of Entries to be played, in order. 

Displaying the Text EDL 

Using the Text EDL 

Viewing and Printing the Text EDL 

Working with more than one EDL  

DISPLAYING THE TEXT EDL 

 
Each Playlist has a Text EDL underneath it, which can be revealed by pressing the TEXT PANE 
button, then selecting the tab marked "Text EDL". You can adjust the boundary between the text 
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pane and the Playlist by dragging it with the mouse. 

NOTE: Enlarge the Playlist window by dragging its outer borders if necessary. You can also open the 
Text EDL in a separate window; ensure the Playlist is active and then from the "Window" menu select 
"New Window" and choose "Text EDL". 

 
For each Entry, the Text EDL shows in columns most of the details that would be shown in the Clip Details 
window. The display scrolls vertically through the EDL and horizontally through the different columns.  

USING THE TEXT EDL 

The Text EDL is fully interactive with the Playlist display, and so all the hardware controller functions on the 
Playlist will still apply. However, you can perform several operations directly on the Text EDL display with the 
mouse: 

 Select Entries by clicking on the Entry number in the "Entry" column. Holding the keyboard Shift key 
whilst selecting another Entry selects all Entries between them. Holding the Ctrl key lets you 
select/deselect any number of Entries. 

 Start playback from the in-point of any Entry by double-clicking on the Entry number. 

 Stop playback by clicking on any Entry number. 

Every Entry detail that can be altered in the Clip Details window described above can also be altered here by 
double-clicking on the display in the relevant column. You can even type in a value in dB for the level! Finish 
with the  Return key, or the Escape key to cancel. 

You can navigate inside the Text EDL using the keyboard. Use the up/down/left/right arrows keys to move 
through the table. The Enter key opens up a field for editing, and then you can type in new values as above, 
press  Return to confirm, or Escape to close the field without making a change. 

 
NOTE: The effect of changing EDL times in the Text EDL depends on the LOCK buttons in 
the Playlist. For example, when Entries are locked, setting a later start time will trim the 
beginning off the Entry, whereas when they are not locked, it will move the Entry in the EDL. 

Additionally you can change Streams in the relevant column by typing in the new Stream number, or the lower 
numbered of the two Streams for a stereo Entry. 

The following details, which relate to the original Track, cannot be changed and are for display only: 

 Track name 

 Sample Rate at which it was recorded 

 Sample Resolution (in bits per sample) at which it was recorded 

 Offset between its original time in the EDL during recording and its time in the present EDL. (Offset 
represents how much out of sync. it is, where sync. is relevant.)  

VIEWING AND PRINTING THE TEXT EDL 

CUSTOMISING THE TEXT EDL DISPLAY 

You can rearrange the columns in the Text EDL to suit yourself. Right-click on the grey column heading 
buttons and select the options that you want from the drop-box. (This works in all of the windows with these 
heading buttons, Disk Manager, Clipstore, etc)  "Insert Column" inserts a duplicate column, which you can then 
redefine by clicking on its heading button and selecting the required display parameter from the list. "Delete 
Column" does just that. Dragging the dividers between the heading buttons changes the width of columns. Left 
click on the column headings to sort the entries by that heading. 
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PRINTING THE TEXT EDL 

The Text EDL can be printed out as arranged on screen. It will print in exactly the order displayed. This is 
available on the "Playlist" menu under "Print Text EDL". 

 "To Printer" prints directly to the printer. Beware that in normal circumstances you are likely to be 
displaying far more Text EDL fields than will fit, width-wise on a normal sheet of paper in a normal 
(readable) sized font, and therefore you will need to customize the display before printing. 

 "To File..." prints to a text file that can be imported into another application for further manipulation. 

The "Printing" section of the Setup window allows you to set the number of characters per line, and also the 
delimiting character. This is particularly useful for importing the list into a spreadsheet or database.  

WORKING WITH MORE THAN ONE EDL 

You may open several Playlists and create EDL 's in each of them. This may be useful to create alternative 
versions of a piece of work. 

To copy an entire EDL from one Playlist to another: 

 Save the EDL in Playlist A. 

 Create a new Playlist B (in the Project window, or the File menu). 

 Load the saved EDL to the paste buffer (under the File menu). 

 Paste it into Playlist B. 

 You now have two identical EDL's and you can make different changes to each of them. 

To copy EDL Entries from one Playlist to another: 

 If both Playlists are visible, hold the Ctrl key and the Shift key and drag the Entry from one Playlist to 
the other, OR 

 Copy to the paste buffer, make the other Playlist the active window, and then paste into it.  
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6 - EDITING 

Overview 

Editing in the Playlist with Hardware Controllers 

Editing in the Playlist with a mouse 

Editing in the Playlist with Hotkeys 

Trim Editor 

Three and Four Point Editing 

Region Editing 

Speech Edit 

EDITING OVERVIEW 
SADiE provides the user with a fast and intuitive interface for editing. With stereo or Multichannel material, 
the two (or more) channels are always edited simultaneously if they were recorded together, unless a 
stereo/Multichannel EDL Entry is first ungrouped as described under Grouping Entries. 

There are four editing techniques at your disposal: 

1. Simple cut-and-splice editing in the Playlist uses the scrub function to accurately locate edit points, and 
make "razor-cuts", just as you would on tape. This creates separate EDL Entries so that unwanted 
material can then be removed. 

2. Playlist Editing allows you to make and also adjust edits by altering the in-point and out-point of any 
Entry. At the same time, you can adjust an Entry's Hotspot. 

3. The Trim Editor is a separate window that works like Playlist Editing, but also provides: 

i. Greater viewing detail - higher magnification of profiles down to waveform level for removing 
clicks and microphone pops and the ability to see the profile of the original Track outside the 
edit points, e.g. the bits that you're not using at this point. 

ii. The ability to adjust more than one EDL Entry simultaneously. For example, by moving the 
fade-in of one Entry and the fade-out of the next Entry together, you can slip the crossfade 
between them along the audio. Many other possible combinations are equally useful. 

iii. The ability to "top and tail" a Clip from the Clipstore, and to create a new Clip from an 
existing Track. 

4. Region Editing - other editing methods are entry based, but region editing is useful for cutting, copying 
areas that haven't yet been defined as entries. You can for instance use region editing to remove a 
complete section of the Playlist across all streams. 

All edit functions can be achieved by using both the Hardware Controllers and the mouse. You will find that 
the hardware controls often provide a quicker method of editing, particularly for repeated actions, but there 
may be some times when it is appropriate to use the mouse instead. The following sections describe the edit 
functions from both perspectives.  

SYNC OR NON-SYNC EDITING 

If you work in an audio-only field like radio, when you cut out material, you will usually want to slip everything 
else along the EDL to fill up the gap, like joining up two bits of tape. Enabling SLIP will do this for you. For 
safety, pre-select both left and right Slip (see Placement of Entries). 

If you are working to picture and for some music applications, much of the time you are likely to want your 
audio material to be fixed to the EDL so that it remains in sync. This means you will have SLIP off. But you can 
enable slip on some streams by enabling/disabling streams to perform edits that require this. 

SADiE makes it easy for you to work either way, and to switch between modes as necessary.  
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FADE SHAPES 

 
Whenever you make a "razor-cut" to divide an EDL Entry into two, you will actually create a new fade-out and 
fade-in at that point. SADiE can do this in either of two ways. These are set in the "Playlist " section of the 
Setup window. 

 Splice-cut mode - the fade-out and fade-in overlap to make a perfect crossfade. This will undoubtedly 
be what you want to do normally. 

 V-cut mode - the first Entry fades out before the next starts to fade in, so there is no overlap. This is 
really only necessary when you are reaching the DSP limit of how many Entries SADiE can play at 
once. This obviously creates a "drop-out", although it is often not noticeable in clean speech if you are 
laying music or effects underneath. 

The default fade lengths and curve types that are created when you make a razor-cut can be set in the "Default 
Crossfade" section of the Setup window. A standard default of 20 milliseconds/40 timecode subframes/1 CD 
frame (the "General" Setup section sets how times are displayed) and a linear curve will give smooth edits for 
most purposes. For repeated fine editing, like removing clicks and pops, you might want to reduce this to less 
than 5 milliseconds. If you are just doing the occasional fine edit, you don't need to change the default, as each 
crossfade time is easily adjusted in the Trim Editor or Clip Details window. 

NOTE: Zero-length crossfades are likely to cause clicks and are best avoided.  

There are 117 possible fade shapes. 

These are: 

Cos (+01 and -01) Cosine 

Cosh (+01 and -01) Hyper Cosine 

Exp (+01... +16 and -01... -16) Exponential 

Linear (Just linear) Linear 

Log (+01... +16 and -01... -16) Logarithmic 

Pow (+01... +16 and -01... -16) Power 

S (+01... +16) S shaped 

These are selected in the drop-down boxes in the Clip Details window. The Trim Window allows the 
"dragging" of Log, Pow, Exp and S fade shapes to different "depths", as well as saving and loading of fade shapes 
to and from a file. 

Most of the curves have a corresponding opposite curve (denoted by a minus sign), which will provide an equal 
power crossfade when the two are used together. For example if Log (+08) is combined with Log (-08) for a 
crossfade then the crossover point of the edit will be -3 dB. 

The Pow set of curves is based on: y = xˆp (0 >= x <= 1). 
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The value of p is a constant for a specific curve and varies from 7/6 to 22/6 in steps of 1/6 over the set Pow 
(+01) to Pow (+16). 

Older versions of SADiE had only 20 curves, and SADiE  will automatically converts users' default crossfade 
and EDL conversion settings to the new regime. Old EDL's are also upgraded on loading. 

EDITING IN THE PLAYLIST WITH HARDWARE CONTROLLERS 

BASIC EDITING 

CUT AND SPLICE EDITING 

1. First disable any Streams you do not want to cut on: 

i. Select STREAM and use the wheel or PREVIOUS/NEXT to highlight a Stream, then hit 
EDIT/SELECT to enable/disable it. SHIFT + EDIT/SELECT acts on the group of 
Streams above the highlighted one which are all the same status. 

ii. Deselect STREAM (and make sure you do not have CLIP or ZOOM selected either). 

2. Use the SCRUB button to select jog, shuttle or move cursor modes (indicated by the small LED's 
next to the wheel) and locate your edit point with the wheel. 

i. "Jog" is the equivalent of rocking the reels of a tape recorder back and forth: The more you 
move the wheel, the more audio you hear. 

ii. "Shuttle" is the equivalent of spooling the tape across the heads; the more you move the 
wheel, the faster the audio goes forward or backwards. 

iii. "Move cursor" mode (all LED's off) lets you quickly locate the current-time cursor without 
audible scrubbing. 

iv. There are also Hotkeys for three fixed forward and reverse scrub speeds and a scrub-pause. 
These can be assigned to the keyboard, or the hardware controller's function buttons, under 
"Edit Controls" in the "Hotkey" section of the Setup window. The default keys are on the 
keyboard's number pad. The speed for each Hotkey can be set in the Scrub Setup section of 
the Transport Controls, Setup window. 

NOTE: You will hear all Streams that are not muted, so you may choose to solo the relevant 
Stream(s). Use SHIFT + MUTE above the hardware faders. If you are using machine control 
of a VTR, hit ONLINE to scrub the picture in sync. 

3. Press the RAZOR button. The Entry/Entries on enabled Streams will be divided under the current-
time cursor. 

NOTE: If you are trimming an Entry's top or tail, you can now simply remove the new Entry to the 
left or the right of the razor-cut. If you are removing material internally, you will need to make two 
razor-cuts so that you can remove the new Entry between them. 

4. Select the relevant Entry by moving the current-time cursor over it and pressing EDIT/SELECT and 
remove it by pressing CUT. If you have SLIP on, the resulting gap will be automatically joined up. 

5. Play the finished edit by moving the cursor back a bit and pressing PLAY. If you don't like it, use 
UNDO and do it again or adjust it using Playlist Editing Mode.  

PLAYLIST EDITING MODE 

In this mode, when an entry is selected in the Playlist , it will change to a waveform profile and its In and Out 
points and Hotspot can be adjusted. 

Playlist Editing has the following uses: 

 After making a razor cut as described above, by adjusting the out-point of the preceding EDL Entry, 
and the in-point of the next, you can remove (or repeat) material at the edit point. The initial razor-
cut doesn't even have to be that accurate, as the adjustment will fine-tune the edit. 
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NOTE: If you are using the razor to make cuts "on-the-fly" during normal speed playback, you may 
want to use the option in the Playlist section of the Setup window which stops playback when you 
make a cut. 

 You can adjust an existing edit. 

 You can adjust the join between two unrelated EDL Entries, such as the way a music Entry fades and 
speech starts over it. 

 You can adjust an Entry's Hotspot. 

There are six possible adjustments, from selecting IN, HOT, or OUT and either EDL or SOURCE mode. 
(Source mode is with the button LED on.) 

EDL The EDL time of the IN or OUT point of the Entry is adjusted, as well as its time in the source 
Track . This will be most used when working to picture, as the profile (and so the audio) is fixed to 
the EDL, and sync is maintained. The Hotspot can be moved without moving the audio. 

SOURCE The IN or OUT point being adjusted remains at the same EDL time, but it's time in the 
SOURCE Track is adjusted by slipping the profile. This will be most used for sound-only editing. 
With HOT selected, the whole entry can be moved and will scrub across the current-time cursor. 

Note: this describes the newer logic of the Hardware Controller buttons as set when the 
"Hardware Controller Edit/Select is select only" setup option under Setup;Playlist; Playlist and 
Trim Edit; is ticked. The older method is described later. 

1. Select the entry to be adjusted by using the wheel to move the current-time cursor over it. To 
activate Playlist Editing on that Entry, you should press the In, Out or Hot button, depending on which 
of the three points you wish to edit. The entry will turn brighter red, and the "Edit" LED by the wheel 
will flash. 

NOTE: If you have Entries on several Streams at this point, you will be selecting the one on the 
lowest numbered, enabled Stream. If necessary, disable Streams as described for cut-and-splice 
editing. If you have just made a razor-cut, you will have done this already.  

2. Adjust the edit point with the wheel. The SCRUB button will select: 

i. "Jog" mode - the more you move the wheel, the more audio you hear. 

ii. "Shuttle" mode - the more you move the wheel, the faster the audio goes forward or 
backwards. 

iii. "Move" mode (no LED permanently on) - quick adjustment without audible scrubbing. This is 
sometimes useful if you can tell from the profile exactly what you want to do. 

 
You can also adjust the edit with various Hotkeys, which may be assigned to the keyboard 
or the Hardware Controller function buttons under "Edit Controls" in the "Hotkey" section 
of the Setup window: 

i. "Nudge Edit Point" Hotkeys will adjust the edit in small increments which are pre-
set in the "Trim Edit Nudge" section of the Setup window. 

ii. There are three fixed scrub speed Hotkeys for forward and reverse adjustment, 
and a scrub-pause key. The default keys are on the keyboard's number pad. The 
speed for each Hotkey can be set in the Scrub Setup section of the "Transport 
Controls", Setup window. 

NOTES: Shuttle is useful for losing large amounts of material at an edit point, just like dumping 
tape onto the floor. The time displays on the controller will indicate the time at which the 
selected edit point occurs in the Source Track and in the EDL. When moving a whole Entry 
(HOT + SOURCE), an on-screen display on the Stream will show the EDL in and out times. 
If SLIP is on, whether previous or subsequent Entries move when you finish an edit is 
determined by which Slip mode is pre-selected and which Streams are enabled to be slipped 
(see Placement of Entries). 
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4. Press PREVIEW to play across the edit point with the pre and post-roll times set in the Setup 
Window (under "View" on the menu bar). Note that alternative pre and post-roll times can be set in 
the Setup window. 

5. Press the selected edit point (In Hot or Out) again to turn Playlist Editing off and confirm the 
edit, choose another edit point by pressing i.e Out, Hot, In, or select other entries with NEXT and 
PREVIOUS. 

IN PRACTICE Playlist Editing is much quicker to do than to read about!: 

 For most non-sync editing (SLIP and SOURCE on), in your chosen SCRUB mode locate the edit 
point with the wheel, press RAZOR to make a cut, move the cursor back a bit, hit OUT. Adjust the 
left side of the edit with the wheel then press NEXT and adjust the right side. 

 Edit sync material in the same way with SLIP off and in EDL mode. For extra safety, you will have 
LOCK on as well. 

Generally it is safest to confirm each edit by pressing In, Hot or Hot to turn Playlist Editing (and the LEDs on 
the three keys) off. You are then free to use the wheel without accidentally re-adjusting the last edit.  

PLAYLIST EDIT WITH HWC - ORIGINAL METHOD 

This describes Playlist Editing with the Hardware Controller using the original logic of the Edit Select and the 
In, Out, Hot buttons, which goes back to SADiE v3. At v5.3 an alternative method has been added, but users 
have the choice of using the new logic (as described in the "Playlist Editing with Hardware Controller" section ) 
or this old method if they prefer not to change their working methods. 

The logic is changed in the Setup window, under Playlist; Playlist and Trim Edit; "Hardware Controller 
Edit/Select is select only". 

This sequence of button pushes works when the setup option is un-ticked. 

1. First select the edit point to be adjusted: IN, OUT, or HOT. 

2. Next select the entry to be adjusted by using the wheel to move the current-time cursor over it and 
pressing EDIT/SELECT. As an edit point is already selected, this will activate Playlist Editing on that 
Entry, which will turn brighter red, and the "Edit" LED by the wheel will flash. 

NOTE: If you have Entries on several Streams at this point, you will be selecting the one on the 
lowest numbered, enabled Stream. If necessary, disable Streams as described for cut-and-splice 
editing. If you have just made a razor-cut, you will have done this already. To avoid disabling 
Streams, select the Entry by pressing EDIT/SELECT or PREVIOUS/NEXT repeatedly to cycle 
through all Entries under the cursor, select IN, HOT, or OUT, and finally press EDIT/SELECT 
again to activate Playlist Editing. 

3. Adjust the edit point with the wheel. The SCRUB button will select: 

i. "Jog" mode - the more you move the wheel, the more audio you hear. 

ii. "Shuttle" mode - the more you move the wheel, the faster the audio goes forward or 
backwards. 

iii. "Move" mode (no LED permanently on) - quick adjustment without audible scrubbing. This is 
sometimes useful if you can tell from the profile exactly what you want to do. 

 
You can also adjust the edit with various Hotkeys, which may be assigned to the keyboard 
or the Hardware Controller function buttons under "Edit Controls" in the "Hotkey" section 
of the Setup window: 

i. "Nudge Edit Point" Hotkeys will adjust the edit in small increments which are pre-
set in the "Trim Edit Nudge" section of the Setup window. 

ii. There are three fixed scrub speed Hotkeys for forward and reverse adjustment, 
and a scrub-pause key. The default keys are on the keyboard's number pad. The 
speed for each Hotkey can be set in the Scrub Setup section of the "Transport 
Controls", Setup window. 
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NOTES: Shuttle is useful for losing large amounts of material at an edit point, just like dumping 
tape onto the floor. The time displays on the controller will indicate the time at which the 
selected edit point occurs in the Source Track and in the EDL. When moving a whole Entry 
(HOT + SOURCE), an on-screen display on the Stream will show the EDL in and out times. 
If SLIP is on, whether previous or subsequent Entries move when you finish an edit is 
determined by which Slip mode is pre-selected and which Streams are enabled to be slipped 
(see Placement of Entries). 

4. Press PREVIEW to play across the edit point with the pre and post-roll times set in the Setup 
Window (under "View" on the menu bar). Note that alternative pre and post-roll times can be set in 
the Setup window. 

5. Press EDIT/SELECT again to turn Playlist Editing off and confirm the edit, or select other entries 
with NEXT and PREVIOUS. 

IN PRACTICE Playlist Editing is much quicker to do than to read about!: 

 For most non-sync editing (SLIP and SOURCE on), in your chosen SCRUB mode locate the edit 
point with the wheel, press RAZOR to make a cut, move the cursor back a bit, hit OUT, then 
EDIT/SELECT. Adjust the left side of the edit with the wheel then press NEXT and adjust the right 
side. 

 Edit sync material in the same way with SLIP off and in EDL mode. For extra safety, you will have 
LOCK on as well. 

Generally it is safest to confirm each edit by pressing EDIT/SELECT to turn Playlist Editing off. You are then 
free to use the wheel without accidentally re-adjusting the last edit.  

 

FADES AND CROSSFADES 

To adjust the length of fades IN or OUT, and overlap them to create crossfades, press CROSSFADE to 
move the inner point (e.g. the end of a fade-in or the start of a fade-out) and SHIFT + CROSSFADE to 
move the outer point (the start of a fade-in or the end of a fade-out). 

The type of fade curve can be altered in the Clip Details window for the Entry, or in the Text EDL. 

Greater flexibility for adjusting crossfades may be possible with the Trim Editor. 

Further details on the use of Hardware Controllers can be found in Hardware Controller Functions.  

EDITING IN THE PLAYLIST WITH A MOUSE 

BASIC EDITING 

RAZOR OR SCISSORS? 

Mouse users have the option of using the "scissors" to make razor-cuts. 

 
Whereas the RAZOR-CUT button always cuts at the current-time cursor, when you press the 
SCISSORS button, the mouse-pointer will change into a dinky scissors icon with a cross to show 
the target point. You can then make a freehand cut anywhere in the Playlist (useful if you can see 
where to cut from the waveform profile) and so skip the process of scrubbing to locate the edit 
point. 

The following editing instructions describe scrubbing to locate and then using the razor-cut, but remember that 
the scissors have the same function. 
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CUT-AND-SPLICE EDITING 

 

1. Display the Edit section of the Transport Controls by clicking on the tab at the top. 

2. Click and hold the mouse button over the Scrubwheel and drag it to scrub the current-time cursor 
along the EDL: 

i. Moving the mouse up/down gives you forward/reverse shuttle. The more you move from 
your original position, the faster it goes. This is like spooling tape against the heads. 

ii. Moving the mouse right/left gives you forward/reverse jog. The more you move, the more 
you hear. This is like nudging a tape machine's reels back and forth. 

You can move between jog and shuttle modes without releasing the mouse button. 

NOTE: You will hear all Streams that are not muted, so you may choose to  SOLO the 
relevant Stream(s) with the small Stream control button. 

NOTE: If you are using machine control of a VTR, hit ONLINE in the Transport Controls to 
scrub to picture. 

NOTE: Don't position the Scrubwheel too near the top or bottom of the screen, or it will 
restrict the amount of movement you have for shuttling. 

Locate your edit point and release the mouse button. 

There are also Hotkeys for three fixed forward and reverse scrub speeds and a scrub-pause. These 
are assigned to the keyboard under "Edit Controls" in the Hotkey section of the Setup window. The 
default keys are on the keyboard's number pad. The speed for each Hotkey can be set in the "Scrub 
Setup" section of the "Transport Controls", Setup window. 

3. Before you make a razor-cut you should disable any other Streams that have EDL Entries at this point 
that you don't want to edit. The STREAM NAME button enables/disables Streams for cutting. 
Disabled Streams are darker grey. 

4.  
Press the RAZOR CUT button. The Entry/Entries on enabled Streams will be divided under 
the current-time cursor. 

If you are trimming an Entry's top or tail, you can now simply remove the new Entry to the left or the 
right of the razor-cut. If you are removing material internally, you will need to locate and make a second 
razor-cut so that you can remove the new Entry between them. 

5. Select (by clicking on it) the relevant Entry and remove it (CUT TO PASTE). If you have SLIP on, 
the resulting gap will be automatically joined up. 

6. Play the finished edit by double-clicking in the time bar just before it. If you don't like it, use UNDO 
and do it again or adjust it using Playlist Editing Mode.  
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PLAYLIST EDITING MODE 

In this mode, when an entry is selected in the Playlist, it will change to a waveform profile and its In and Out 
points and Hotspot can be adjusted. 

Playlist Editing has the following uses: 

 After making a razor or scissors cut as described above, by adjusting the out-point of the preceding 
EDL Entry, and the in-point of the next, you can remove (or repeat) material at the edit point. The 
initial razor-cut doesn't even have to be that accurate, as the adjustment will fine-tune the edit. 

NOTE: If you are using the razor to make cuts "on-the-fly" during normal speed playback, you may 
want to use the option in the Playlist section of the Setup window which stops playback when you 
make a cut. 

 You can adjust an existing edit. 

 You can adjust the join between two unrelated EDL Entries, such as the way a music Entry fades and 
speech starts over it. 

 You can adjust an Entry's Hotspot. 

 

1. Display the Edit section of the Transport Controls by clicking on the tab at the top. 

2.  
Activate PLAYLIST EDITING mode with this button on the Playlist toolbar. 

3. With the mouse, select the Entry on whichever side of the edit point you want to adjust. The Entry 
turns a brighter red. 

NOTE: The AUDIO SCRUB button needs to be down if you want to hear the edit point as you adjust 
it. With the button up, adjustment will be faster, as SADiE doesn't have to output the audio. This is 
sometimes useful if you can tell from the profile exactly what you want to do. 

4. With the MOUSE EDIT SELECTION button down (the default position), depending where you 
point the mouse over the Entry, a handy little graphic at the mouse pointer will appear to tell you 
which bits of the Entry are going to move. When you click the mouse button, the IN, HOT, OUT 
and EDL/SOURCE buttons automatically select what will be adjusted as follows: 

Mouse 
Graphic 

Point Selected Mode 
Selected 

Operation 

 In EDL Fade-in moves 

 In Source Body and Fade-out move 

 Hot EDL Hotspot moves 
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 Hot Source Whole Entry moves 

 Out EDL Fade-out moves 

 Out Source Fade-in and Body move 

 Main body/ Hot while 
holding CTRL key 

Source Moves the body of the entry but leaves the In 
and Out where they were. 

5. The mouse graphic is probably enough to tell you what will happen when you edit, but if you ever 
want to manually select the editing adjustment by turning MOUSE EDIT SELECTION off (for 
example, to move the Hotspot when it coincides with the in point), a description of the two modes 
may be useful: 

 
EDL Mode: The EDL time of the In or Out point of the Entry is adjusted, as well as it's time 
in the Source Track . This will be most used when working to picture, as the profile (and so 
the audio) is fixed to the EDL and sync is maintained. The Hotspot can be moved without 
moving the audio. 

 
SOURCE Mode: The In or Out point being adjusted remains at the same EDL time, but it's 
time in the Source Track is adjusted by slipping the profile. This will be most used for sound-
only editing. With HOT selected, the whole entry can be moved and will scrub across the 
current-time cursor. 

6. When you have the mouse graphic you want, click and drag the mouse over the Entry profile, to 
either jog or shuttle it, as described in Cut-and-Splice Editing. When you release the mouse button, 
the edit adjustment is done! 

4.  

 
You can also adjust the edit in small increments by "nudging" it with the EDIT NUDGE 
buttons in the "Edit" section of the Transport Controls or buttons above the Scrubwheel. 
The nudge steps are set in the "Trim Edit Nudge" section of the Setup window. There are 
two settings: 

i. Pressing the buttons. 

ii. Holding Alt. while pressing the buttons. 

The buttons can be pressed repeatedly, or held down. You will not hear the audio when 
using them. 

5. NOTE: Shuttle is useful for losing large amounts of material at an edit point, just like dumping tape 
onto the floor, but you don't have to worry about stepping on it. 

NOTE: Whether previous or subsequent Entries move when you release the mouse button will be 
determined by whether you have selected a SLIP mode and which Streams are enabled to be 
slipped (see Placement of Entries). 

NOTE: The time display in the Transport Controls edit section will show you the time of the 
In/Hot/Out point being adjusted in either the EDL or the Source Track, and both of these (or the 
new duration) appear alongside the Entry profile on the Stream. When moving the whole Entry, 
the Stream display shows EDL in and out times. 

6. To hear the edit you can either play it normally, by double-clicking in the time bar just before it, or 
use the preview buttons, which play a pre-set amount either side of the edit point: 
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PLAY THROUGH EDIT plays through the edit. 

 
PLAY TO EDIT plays just the left-hand side of the edit and 

 
PLAY FROM EDIT plays just the right-hand side. TO and FROM can be useful for 
assessing which side you still need to adjust. 

 
PREVIEW EDIT will play the selected EDL Entry, from one edit point to the next. 

7. You can cancel a preview while it is playing with a second press of its button. 

8. There are three pre-roll and post-roll lengths available by pressing: 

i. Only the preview button. 

ii. Shift + the preview button. 

iii. Ctrl + the preview button. 

The lengths of each are pre-set in a dedicated section of the Setup window. 

IN PRACTICE Playlist Editing is much quicker to do than to read about!: 

 Normal non-sync editing (SLIP on) means making a cut, hitting the PLAYLIST EDITING button, 
selecting and adjusting the left side of the edit with , then selecting and adjusting the right side 
with . 

 Editing sync material (SLIP off) will usually mean doing the same to trim the ends of Entries with  
and . For extra safety, you will have LOCK ALL ENTRIES on as well.  

FADES AND CROSSFADES 

There are four more mouse symbols which let you increase the length of the fades at the in and out points by 
dragging out the start or the end of each fade. Overlapping them will create crossfades. 

Hold the keyboard Ctrl key as you move the mouse over the edit point: 

Mouse Graphic Click and Drag 

 Start of the Fade-in 

 End of the Fade-in 

 Start of the Fade-out 

 End of the Fade-out 

The type of fade curve can be altered in the Clip Details window for the Entry, or by holding the keyboard Alt 
key, or Alt + Shift keys as you move the mouse over the edit point (as in the Trim Editor): 
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Mouse Graphic Click and Drag 

 Fade-in Shape 

 Fade-out Shape 

Greater flexibility for adjusting crossfades may be possible with the Trim Editor.  

MULTI-TRACK PLAYLIST EDITING 

So far we have only discussed adjusting the edit points and fades of a single Playlist Entry, however it's possible 
to apply these same functions to : 

 Two entries on a single stream (thus we are working on the Edit point between the two entries, 
much like working in the Trim Window.) A group clip (i.e. a yellow clip that contains a number of 
edited entries) is considered to be a single entry, and only the start and end of the group clip can be 
edited, and thus not the internal edits. 

 Entries on multiple streams - even though they may (or may not) be grouped together into group 
clips, by selecting them together, you may still edit them all together. 
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When two entries on a stream (or two entries on any number of streams) are selected for Playlist Editing, the 
following functions are available on the pair:- 

 The standard Playlist Edit (PLE) functions for In Out and Hot point editing, and in both EDL and 
Source modes as described above. 

 Fade lengths and Fade shapes as above. 

In addition :- 

 The crossfade between each pair of entries (i.e. the Out point of the first entry,and the In point of 
the second) can be moved to change the position of the crossfade - i.e. change the edit point to be 
earlier or later without changing the timing relationship of the two entries. 

 The length of the crossfade can be adjusted by using the standard CTRL-click&drag modifier when 
the mouse is over the edit point. 

 The crossfade shape can be adjusted in the usual way using the SHIFT-ALT and ALT modifiers. 
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 Fade lengths and Shapes can be mirrored from the Out fade of the first to the In fade of the second 
(and vice versa). This is only available on a keyboard shortcut, and uses the same hotkey that has been 
set for the same function in the Trim Window. - i.e. Setup/Hotkey Setup/Trim Window/Crossfades: 
Mirror (L to R and R to L). 

SELECTING ENTRIES FOR PLAYLIST EDIT 

Some rules apply to determine how entries are edited together. 

STREAM ENABLING AND GROUPING 

Note that Playlist Edit (PLE) works in conjunction with the stream grouping functions – Playlist Edit and Trim 
only operate on streams that are enabled (the stream grouping functions allow quicker ways of 
enabling/disabling streams). 

SELECTING ENTRIES 

When the entries are being selected, a decision is made as to how the clips will be edited together.  

If the selection has two clips on each stream then the decision is simple – when you select and move the fade 
out of the first clip on any stream, then the fade out on the first clip of every stream will be moved, along with 
the fade in of the second clip on every stream. In other words – you move the Edit Point between the pairs of 
clips. 

If the selection includes three or more clips on any stream, playlist editing will not be allowed. 

For the situation where one clip per stream is selected, or else a mixture of one clip on some streams, two 
on others, then the method of selecting the clips becomes important. 

Clip Selection across all streams 

ALT-select. If you hold the ALT key and click and drag the mouse pointer horizontally, all clips in the “region” 
selected will be selected when you let go of the mouse button. Thus you can select streams without viewing 
them. This is like the “box-drawing” method but works on all clips vertically. 

Box-Selection 

Whilst you are dragging a box to enclose a selection, a region will be drawn, until you let go and the entire 
entries are drawn in red. 

When ALT-selecting OR Box-selecting, the clip in- or out-points enclosed by the region/box will 
determine which ends of the clips go into edit together. 

 

MULTI-TRACK EDITING 

When you’re ALT-selecting , if you want to work on a “two clip” EDIT (i.e. there are “outgoing” clips on the 
left side of the edit, and “incoming” clips on the right side) then you should select across all clip ends that are 
included in the edit. SADiE can edit multiple clips together even if they do not have the same beginning or end 
times, or the same length fades. By ALT-selecting the “region” encompassing the edit, you choose which edit is 
being worked on.  

To change between adjusting one side of the two-clip edit (perhaps you want to adjust the outgoing fade out 
without adjusting the incoming fade in ?) then just ALT-scratch across the left (or right) side of the edit (you 
don’t have to come out of Playlist Edit first). 

You can change selection on the fly, thus putting different selections into Playlist Edit. Note also that you can 
change the streams that are enabled on-the-fly, to change which streams are being (or not being) edited. Thus 
you should disable streams that you do not want to edit. You can use the ALT-selection method to select all 
clips (except those on disabled streams) vertically. Alternatively, you can use normal box-drawing, & shift-
selecting methods to determine the clips that you wish to edit. 

When you are working with multiple clips in a  “two clip” edit, then selecting and dragging the edit point will 
move both the fade out and the associated fade in. Likewise ALT-drag will change the fade shape (SHIFT-ALT 
drag being the “coarse” control as normal) for both points. 
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Note that ALT-clicking inside the “edit” or “crossfade” area will perform a fade-shape change, whereas ALT-
clicking outside this area will perform the “vertical-select” function. 

 

If, by mistake, you select a region that includes more than two clips on any single stream, a message will appear 
telling you to reduce the number of clips per stream in the selection. 

Yellow group clips are treated as a single clip, but when they are in PLE, you cannot adjust the internal edits, 
only the start and end of the yellow clip. You can only move the start and end of a yellow group up to the next 
internal edit – any further would break the internal edit which is not allowed. (It is assumed that you grouped 
the clips together to “lock” the internal edits) 

 

EXAMPLE SELECTIONS 

Two clips per stream 

Example 1. Alt-Selecting across all streams 
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On each of these eleven streams a crossfade is enclosed in the Alt-selected region, and thus on every stream, 
when you click and drag the crossfade edit whilst in PLE, all of the edit points will move together as below. You 
can see that I’ve moved the crossfade across all streams about two seconds to the right 
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Example 2 – Selective ALT-selecting 

 
In this example, you can see that edits the two Saxes on streams 8, and10 are not enclosed by the ALT-select 
region, but it does touch the left-hand-side clips on those three streams. And so as below, when you click and 
drag on the edit point ( and in this case I’ve moved it two seconds to the left )  the right-side Sax clips are not 
edited (and in this case a gap is created). 
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Example 3 – Using Stream enabling/disabling in conjunction with ALT-select 

 
Here, I have disabled streams 7,8,9,10 (dark grey) for the Amb, Saxes, and Hammond, and used ALT-select to 
enclose all the crossfades. Then I dragged the crossfade two seconds to the left – you can see below that the 
crossfades on the enabled streams have moved together, but those on the disabled streams have not moved. 
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ONE CLIP PER STREAM 

Example 4 - Selecting the Start of both clip or the End of both clips using Box-selection. 

 

In any of 
these three examples, the In points of both clips will be edited together. Likewise, the Out points of both 
clips will move together. In this case, ALT-Selection of the same regions would have the same effect. 
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Example 5 - Selecting the Start of the lower clip and the End of the top clip (i.e. the Edit point between a 
“chequer-boarded edit pair)”: 

 
In this example, the edit between the two clips is selected and so when you adjust the end of the top clip, the 
start of the lower clip will move at the same time. Editing the start of the top clip, or the end of the lower clip, 
will edit each of them alone. 

EDITING IN THE PLAYLIST WITH HOTKEYS 

QUICK EDIT 

 

The Quick Edit Toolbar is available in the Playlist (from the usual  Select Toolbars button).  

These functions are also available as hotkeys. The most useful of these are (found under Playlist section of 
Hotkeys setup): 

 Clip In-point to current time 

 Clip Out-point to current time 

 Clip Hotspot to current time 

These act on a single selected clip in the Playlist and will move the Clip's In-point, Out-point or Hotspot to the 
current time cursor, without slipping the audio. Thus if you press "Clip In-point to current time" whilst the 
current time is inside a selected clip, this is much the same as making a razor cut on that clip and deleting the 
first of the two clips that are produced. In other words, this will perform an "IN-EDL" style Playlist edit without 
having to open the Playlist edit function. And if the current time is positioned outside the clip, then the clip will 
be extended to that new position (if enough source audio exists). 

Note also that this works during record. Pressing the "Out" key when recording will finish the clip that was in 
record, and start a new clip (which automatically becomes selected in preparation for a new "Set In/Out" 
action). Pressing "In" during recording moves the in point of the "growing" clip. Note this does not make a new 
track; it's similar to (but perhaps a bit more elegant than) the method of razoring to split clips during recording. 
To smooth the operation of these functions during record, there is a Setup option (under Playlist/Playlist Entry 
Display) called "Auto-select recording clip on entering record". This will save you having to click on the clip 
that is "growing" in the Playlist.  

There are two additional Hotkeys available for this way of editing: 

 Clip In-point fade to current time 

 Clip Out-point fade to current time 
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These again act on a single selected clip in the Playlist and will move the inside edge of the Clip's In-point fade, 
or Out-point fade to the current time cursor, without slipping the audio. Thus if you press "Clip In-point fade 
to current time" whilst the current time is inside a selected clip, the end of the fade in will jump to the current 
time, thus shortening the clip. If the current time is positioned outside the clip, then the clip will be extended 
to that new position (again, if enough source audio exists). This can be particularly useful for aligning a 
crossfade. 

These "Quick edit" keys can be used in conjunction with a set of "Snap" Hotkeys so as to perform a quick "top 
and tail" operation and then move the edited clip to a new position. Another important Hotkey for this type of 
editing is the "Locate to time..." Hotkey found in the Transport Controls section of the Hotkey setup. This 
opens the time box in the Transport Controls to allow quick movement to another time. 

For example, you have dropped a rough clip into the Playlist that needs to be synchronised to a video event 
(although of course there are a number of uses for these facilities). 

1. Select the clip in red 

2. Scrub or otherwise position the current time to the beginning of the audio (i.e. mark the top) 

3. To check your position you may wish to preview up to, from or thru this point - you can use the 
standard "Transport - Edit Controls" Preview hotkeys (default F1, F2, and F3) for this. 

4. Press the key for "Clip In-point to current time" deletes the rough start of the clip. 

5. Similarly scrub or position to the end of the audio and use "Clip Out-point to current time" to edit 
the tail of the clip. 

6. Now scrub or position the current time over the Audio sync point (a clapper or audibly recognisable 
event) and press "Clip Hot-spot to current time" key. 

7. Now press Online, and scrub the picture to the Video sync point that matches the Audio sync point 
(Hot-spot) you've just marked. 

8. Now press the Hotkey for "Snap entry hotspot to current time" and the clip will jump to match the 
video and audio sync points. 

This procedure, or variants of it can be used to provide a number of speedy and tidy "edit and place" functions, 
whether or not your application is synchronising to picture. 

The "Snap" keys are set under Setup/Hotkey Setup/Playlist and are called: "Snap entry fade in point to current 
time"; "Snap entry hotspot to current time"; "Snap entry in point to current time"; and "Snap entry's end to 
current time".  
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TRIM EDITOR 

 
OVERVIEW 

The Trim Editor provides similar facilities for editing to Playlist Editing, but adds extra tools, more preview 
variations, and a different style of view. 

 
As an example, the picture above shows a single channel of an edit that may have many more channels. The 
green sections on the top "stream" show the outgoing entry, the green sections of the lower "stream" shows 
the incoming entry. The grey segments display "out-takes" - this the audio we are "throwing away" to create 
the edit. 

The Trim Window's display of these grey "out-takes" can be a very useful visual tool for aligning edits. 

Entries are loaded into the Trim Window for editing, and then when you're happy with the edit you will write 
it back to the Playlist - allowing you to try out different edits "off-line" before confirming the changes back to 
the Playlist. 

You can load any number of EDL entries into the Trim Window, but for simplicity's sake, let's first cover the 
situations with one or two entries loaded, then we can will see how these ideas can easily be extended to 
working with many entries spread across multiple streams of the EDL. 

As with Playlist Editing, a group clip - either a yellow one or a multi-channel green group clip - is considered as 
being ONE EDL entry. The Trim Window cannot change any internal edits in Yellow group entries without 
first un-grouping the entry. 

You might load it with ONE Clip or Entry: 

 To "top and tail" a Track selected in the Clipstore and store it back there as a new Clip for later use. 

 To top and tail a single Playlist Entry, removing unwanted material either side of a bit of dialogue, for 
instance. 
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 When you want to search through a Track to define a new Clip; say you need to grab a breath or a 
word. In this instance you will probably load the Trim Editor from the Track in the Clipstore, define 
the new Clip and paste it straight into your EDL. 

You might load it with TWO Entries from the Playlist: 

 To make fine adjustments to an edit. All edits are a join between two Playlist Entries, so it is the 
Entries either side of the edit point that will be loaded. 

 To adjust any other join between two Entries. For example, how a piece of music fades down under a 
voice-over, or how one piece of atmosphere crossfades into the next. 

 

OPENING THE TRIM EDITOR 

From the Playlist or the Text EDL: 

 Select the Entry or Entries you want load into the Trim Editor. Selecting Entries is described fully in 
Arranging an EDL. They do not have to be adjacent, or on the same Stream, but the streams they are 
on must be enabled. 

  
Press the OPEN TRIM EDITOR button on the Playlist toolbar, or the designated function 
button on the hardware controller. 

From the Clipstore: 

 Select the Clip that you want to load. 

  
Press the LOAD CLIP TO TRIM EDITOR button on the Clipstore's toolbar. 

On the hardware controller, you can designate two Hotkey commands to function buttons: one to open the 
Trim Editor, and another to load the selected Clip in the Clipstore. 

A Trim Editor window will now appear containing the Entries or Clips that you loaded: 
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1. EDL Time Bar 

2. Time relative to edit 

3. Selected clip highlighted 

4. Load buttons 

5. Write-back buttons 

6. Paste buffer buttons 

7. Preview edit 

8. Preview selected clip 

9. Crossfade Details 

In the example above, two Entries have been loaded from the Playlist: a stereo Entry called "Music", followed 
by a mono Entry called "Voice". The right channel of "Music" is displayed below "Voice" so that you can zoom 
in on just one channel of each Entry, which is generally clearer and quite sufficient for editing. This viewing 
order can be changed; see Other Trim Editor Tools at the end of this chapter. 

The main difference in the way the Clips are displayed here is that because each is drawn on a different line, 
the profile of the whole Track that it comes from can be shown. The parts that are being used, and will be 
played as Playlist Entries, are in green, and the parts not being used are shown in grey. 

This makes it possible to see what you are losing as well as what you are keeping, which can aid editing 
decisions, since the grey sections are always available to be pulled back into the green side of an edit point. 

The Trim Editor has the following features in common with the Playlist: 

 An EDL time bar, which you can use to start and stop playback. In the Trim Window, the current-
time cursor ("playback head") is always fixed in the middle of the window while the waveform profile 
of the audio scrolls past. There is also a second time bar, which shows time relative to the edit point. 

NOTE: In the case of Clips loaded from the Clipstore, the EDL time bar will show the "time 
stamp" given to the source Track when it was recorded into SADiE. 

 Scrollbars to move the display horizontally and vertically. 

 Magnification buttons to zoom in or out of the display.  
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NOTE: When the Trim Editor is the active window, a "Trim" menu appears on the menu bar. This 
allows you to change profile types to find one more suitable to the audio you are working with, 
and to jump between zoom magnification levels. There is also the "User Zoom" function, described 
below, under Other Trim Editor Tools. 

 A small time display showing the mouse pointer position. The current-time display in the Transport 
Controls will show current EDL time for an active Trim Editor.  

CROSSFADE DETAILS 

 
A "Two-clip" Trim window will also display the Clip level for both clips, plus the fade shape and duration for 
the outgoing (top) clip's fade out and the incoming (bottom) clip's fade in, positioned to the left and right side 
respectively of the bar near the bottom of the Trim. This avoids the need to open Clip Details windows to 
adjust these common parameters. A "One-clip" Trim window will have the clip level knob and details for both 
fade in and fade out. This bar will not appear at all if more than two clips are in the Trim window. 

There is also a display on this bar (if you have two clips loaded) which displays the "dB down point" of the 
cross fade. The "dB down point" is the fade curve value at the point where the fade in and out curves cross 
each other. 

If any of these displays are not visible, stretch your trim window horizontally. 

SELECTING WHAT TO ADJUST 

Editing in the Trim Editor is very similar to using Playlist Editing mode. 

NOTE: As the Trim Editor can move Entries in the Playlist, just like Playlist Editing, you need to decide 
whether to have the Playlist SLIP function on or off.  

All Clips in SADiE have three parts: a fade-in, a body and a fade-out. (Unless deliberately lengthened, the fades 
will be very short and so possible not immediately visible, the usual default time being 21 milliseconds.) 
Adjustments in the Trim Editor are made moving any of these parts in relation to the time shown in the time 
bar. 

 
To select which parts of which Clips will move, either: 

 Select them directly by clicking on the required parts of the profile, OR 

 Highlight the required Clip (it will be shown with a grey background) by clicking anywhere 
on its profile. Then select the required parts on the "blade" shaped Clip icon at the bottom 
of the window. This icon allows you to select fades when they might be too small to point at 
on the profile: 

 

Fade-in Body Fade-out 

With nothing selected, all parts are green on icon and profile. 

Hold the Shift key whilst selecting parts of Clips to: 

 Add them to those already selected to be moved, OR 

 Deselect them from those you have selected to move. 

NOTE: The Edit section of the Transport Controls can also be used to control the Trim 
Editor, and is fully interactive with it. The IN, HOT, OUT, and EDL/SOURCE buttons will 
select the corresponding parts of Clips that would move in Playlist Editing. They also move the 
display to the selected edit point. 
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AUTOMATIC SELECTIONS 

 
In order to speed up the most common tasks, when two Clips are in the window, these selections 
are made automatically when using a mouse: 

 Selecting the earlier Clip selects it's fade-in and body (like adjusting the Out-point in Playlist 
Source Mode). 

 Selecting the later Clip selects it's body and fade-out (like adjusting the In-point in Playlist 
Source Mode). 

 Selecting the fade-out of the earlier Clip or the fade-in of the later Clip selects both, e.g. the 
crossfade between them can be slipped against the audio. 

Hold the Shift key while selecting if you want to override the above and select only the part you are 
pointing to. 

NOTE:- when more than two clips are loaded into the Trim Window, the Automatic 

selections will follow the same rules as above when  the Multi-track Auto Select 
button is enabled. There is more detail on the selection rules for multiple entries later in this 
manual. 

 
Using the hardware controller to control the Trim Editor follows the same rules as editing in the 
Playlist. Select the Clips with the PREVIOUS and NEXT buttons, or CLIP + the wheel, and select 
IN, OUT, or HOT points in EDL or SOURCE mode to select the corresponding parts of clips. 

Note also that pressing the SHIFT key before PREVIOUS or NEXT will add to the selection, e.g. 
if IN- EDL mode is selected on the right hand clip, SHIFT + PREVIOUS will add the left hand 
clip's OUT point; in other words, with two clips this selects the whole Edit point. 

When selected in Trim, fades turn dark blue and Clip bodies turn dark red, on both the icon (which is always 
representing the highlighted Clip) and the Clip profiles. Here are some examples: 

 Body and fade-out will move. Same as adjusting IN-point in SOURCE mode . 

 Fade-in selected to move. If selected on one Clip only, same as adjusting IN-point in EDL mode 
. 

 Body only will move, thus adjusting what part of the source audio is used between fixed in and out 
points. 

 Whole Clip will move in relation to EDL time. Same as HOT + SOURCE . 

ADJUSTING THE EDIT 

Once you have selected which parts to move, use the mouse or hardware controller wheel to move them, as 
in the Playlist. The mouse can be used either over the selected Clip's profile, the "blade" Clip icon, or the 
Scrubwheel in the Transport Controls. 

NOTE: For mouse users, using the IN and OUT buttons and Scrubwheel in the Transport Controls is 
the easiest way of moving in and out points in EDL mode. 

 
To hear the audio as it moves across the edit point, press the AUDIO SCRUB button (this is 
available in the Trim Editor as well as the edit section of the Transport Controls). Then move the 
mouse left and right to jog, and up and down to shuttle. On the hardware controller use the 
SCRUB button to select jog or shuttle mode for the wheel. 
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For fine adjustment, you may prefer to use the EDIT NUDGE buttons, which will move the 
selected parts in fixed steps that you can set in the Trim Edit Nudge section of the Setup window. 
There are two settings: pressing the buttons, or holding Alt. while pressing the buttons. 

These duplicate the edit nudge buttons in the Transport Controls and can be pressed repeatedly, or 
held down. You will not hear the audio when using them. 

To hear the results of your adjustments, you can either: 

 Start playback from any point in the time bar (on the hardware controller when no edit points are 
selected, the wheel will position the display and then you can use the PLAY button), OR 

 Use any one of the following preview buttons, which have the advantage of playing you a pre-set 
amount either side of the edit point and then returning the display to it. 

The top three preview buttons duplicate those in the Transport Controls edit section, which are also used for 
Playlist Editing mode: 

 
PLAY THROUGH EDIT plays through the edit. 

 
PLAY TO EDIT plays just the left-hand side of the edit. 

 
PLAY FROM EDIT plays just the right-hand side. TO and FROM can be useful for assessing which 
side you still need to adjust. 

NOTE: There are three pre-roll and post-roll lengths available by pressing: only the preview button, 
Shift + the preview button, or Ctrl + the preview button. The lengths of each are pre-set in a dedicated 
section of the Setup window. 

NOTE: The PLAY THROUGH preview is the one that lets you hear how the edit will sound in the 
Playlist. It also usefully resets the display to the edit point. The PLAY TO and PLAY FROM previews 
are useful for determining which side of the edit unwanted sounds may be. 

The next three preview buttons play only the selected (highlighted) Clip, including it's out-takes (the grey bits): 

 
PLAY SOURCE THROUGH EDIT plays through the edit. 

 
PLAY SOURCE TO EDIT plays just the left-hand side of the edit. 

 
PLAY SOURCE FROM EDIT plays just the right-hand side. TO and FROM can be useful for 
assessing which side you still need to adjust. 

You can cancel a preview while it is playing with a second press of its button 

 
The loop button will cause the selected preview action to repeat continuously. You can continue to 
make adjustments while the preview is repeating. 

There are also some special function preview buttons: 

 
Play Out-takes - this plays the grey parts of the clips around the edit point. This allows you to hear 
the sections you are "throwing away" for comparison. 

 
Play entire track mode - this button can only be pressed when a single clip is in the Trim Editor. 
When pushed in, you will hear the whole source track, both coloured and grey areas, when playing 
or previewing in Trim. 
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Preview in context - when pressed, all previews will include the other audio in the source EDL as 
well as the current contents of the Trim Editor. 

When you are happy with the adjustments, WRITE-BACK what you have done, as described below.  

TOPPING-AND-TAILING AND DEFINING NEW CLIPS 

When you load only one Clip (or multiple clips but only one per stream - described under Multi-track Entries 
later ) into the Trim Editor, you can top-and-tail it by adjusting its in and out points with the mouse or 
hardware controller wheel in the usual way. Use the IN and OUT buttons (in the Transport Controls or on 
the Hardware Controller) to select which you are adjusting. 

To define a totally new Clip, load the Trim Editor with the Track from which the Clip is to come. You can do 
this either by loading the whole Track from the Clipstore, or by loading a Playlist Entry, which contains the 
required bit of the Track. 

 
The DRAW CLIP button turns your mouse pointer into a pencil symbol. Drag it along the 
waveform profile from the new in-point to the new out-point to define a new Clip. Right clicking will 
turn this function off.  

You can make fine adjustments by top-and-tailing the new Clip before giving it a new name (see below) and 
writing it back to the Clipstore, or pasting it into the Playlist. 

NOTE: DRAW CLIP is only available when there is a single Clip in the Trim Editor. 

 
A similar result can be achieved by the different method of marking the IN, HOT and/or OUT 
points "on-the-fly" whilst playing. There are three Hotkey-only functions that are assigned in the 
"Trim" page of the "Hotkey" section in the Setup window: 

 Set In-point to current time 

 Set Hotspot to current time 

 Set Out-point to current time 

Pressing these while playing one clip in the Trim window (or whilst in stop also) will set the 
respective edit point to the current time. The default setting for these functions is F7, F8 and F9 on 
the keyboard. 

These can work with multiple entries in Trim, however will only apply to the single highlighted entry. 

When happy with the adjustments, WRITE-BACK as described below. 

The drawing of clips and marking of edit points "on-the-fly" are useful ways to prepare a clip before you drop it 
into the Playlist. 

For instance you may be cutting out a sound effect from the larger track in which it was recorded. So, you may 
load the raw track into the Trim window, playing and marking it's start and finish with the "Set In-point etc." 
functions, and then writing the edited clip into the Playlist once it is tidy. 

To help with this method, there is another "Trim" Setup option called "Write back single clips with Autoplace", 
so after preparation of clip in the Trim Window, you would move back to the Playlist, and mark the position 
for the new clip in the Playlist by scrubbing to that position and enabling/disabling streams appropriately. Set 
"Autoplace to Now", or maybe "Hot-Now", and then pressing the WRITE-BACK button automatically places 
the new sound effect at the position you've marked in the Playlist, with respect to the start point, (or Hotspot 
if that's the Autoplace mode you're using). 

You can see that the Trim Window behaves slightly differently when it contains just one clip and the DRAW 
CLIP, SET IN POINT, and WRITE BACK WITH AUTOPLACE functions become available These are 
specifically designed to speed up this process of preparing and spotting effects.  
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ADJUSTING THE HOTSPOT 

The Hotspot of each Clip is shown as a vertical red line, which can be moved: 

  
By positioning the mouse over it and, when the pointer changes to a double arrow, dragging 
it to a new position. The small time display will show the time you are setting. 

 By selecting HOT and EDL mode, and using the Scrubwheel in the Transport Controls. 

  
By selecting HOT and EDL mode and using the wheel. 

 In the Clip Details window. 

When you are happy with the adjustment, WRITE-BACK what you have done, as described below.  

RENAMING CLIPS 

Double-click on the Clip name. A box will appear in which you can edit the name before writing the Clip(s) 
back: 

 

FADES AND CROSSFADES 

The lengths of fades of Clips in the Trim Editor can be adjusted: 

1. By setting numerical values for them in the Clip Details window. 

2.  
Graphically, with the mouse on the profile display: 

i. At each in/out point there is actually a fade-in or fade-out (however short) and these fades 
have a start and an end. 

ii. Move the mouse pointer over the fade. It will change to a double arrow. 

iii. You can then move the start of a fade to the left and the end of a fade to the right, so 
lengthening the fade and setting it to where you want over the audio. 

3.  
By pressing CROSSFADE to move the inner point (e.g. the end of a fade-in or the start of a 
fade-out) and SHIFT + CROSSFADE to move the outer point (the start of a fade-in or the 
end of a fade-out). 

Fades can also be edited around their mid point by holding down the control key; Ctrl + dragging the start/end 
of a fade in/out, will also change the fade out/in edge's position. 

Fades are shown in lighter green on the profile and turn dark blue when selected to move. The type of fade 
curve can be altered in the drop-down box at the bottom of the trim window, or in the Clip Details window 
for the Entry. 

Once the fade-out of one Clip overlaps with the fade-in of the next Clip, you have created a crossfade. There 
are two useful tools available when there are two Clips in the Trim Editor: 

 
MIRROR FADES alters the length, position, and shape of the later Clip's fade-in to make it an 
equal-power partner to the earlier Clip's fade-out. 

NOTE: Hold down the Shift key when pressing this button to mirror the other way round, e.g. altering 
the earlier Clip to match the later one. 
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Fade in/out pairs can be linked using the LINK button. An edit to one fade will then automatically be 
reflected in the other. For instance moving the end edge of the fade down will move the end edge of 
the fade up. You can combine this with the Ctrl key to move all four fade edges together. 

 
The -3 dB and -6 dB down points for a crossfade can be displayed on the fade curves using the 
toolbar button, or right clicking on the fade. This display option is also available in the Playlist on a 
right-click menu. It is best to have "Show fades as curves" set under "Setup Window", "Playlist", 
"Playlist Entry Display", as to be honest, it looks a little odd if you have "Show fades as splices" rather 
than as cuts. 

With two Clips in the window, selecting either fade automatically selects them both. Then the whole crossfade 
between two Clips can be moved easily in relation to the audio, simply by clicking and dragging. The overlap of 
a cross-fade can be edited by selecting a fade pair (dark blue) and then holding down the Ctrl key whilst 
dragging one of the fades. The percentage of overlap is displayed in the new bar near the bottom of the Trim 
window. 

When you are happy with the adjustments, WRITE-BACK what you have done, as described below. 

FADE SHAPES 

If you right-click over a fade, and select "Fade Type" from the menu, you will be offered a number of different 
fade types. Each of these types may have a number of different values (or "depths"). Except for Linear and S-
shaped, there are positive and negative versions of each type.  

All of these 117 fade shapes can be freely used, however (conceptually) the positive ones are considered 
"master" shapes, and the negative fades' main purpose is to provide an equal power partner for each respective 
positive shape. The Cos, Cosh, and some of the Pows are included for compatibility with earlier versions of 
SADiE.  

The Log and Exp shapes give a large variety of curves from deep convex through Linear to deep concave. If you 
Alt + click and drag the fade shape left/right, you can alter the "depth" of the fade for Exp and Log fades; the 
depth can be dragged from Exp (+16) through Exp (+01), and Log (+01) to Log (+16). If you set the Fade type 
to negative Exp or Log, then it can be dragged through a different sequence. Remember these are the equal 
power partners for the positive shapes, so some of the negative shapes can appear mildly S-shaped.  

There are other "Alt + drag" sequences for Pow+, Pow-, and S shapes.  

Pressing Alt + shift when dragging will allow you to drag through ALL available fade shapes. To allow enough 
sensitivity to select individual shapes, you will perhaps have to move a long way to drag through the entire 
range. However, note that you can press Shift whilst Alt-dragging to allow you to jump to the next range, then 
let go of Shift to continue Alt-dragging the depth in the new range. 
 
If you press Ctrl and Alt while dragging the fade, the other fade in the crossfade pair is changed to the negative 
equal-power-partner shape and the depth of both fades will be dragged simultaneously. 
 
Remember also that saving and loading Fade Descriptions will give you an alternative quick method of changing 
the fade shape. Also, clicking on the "Fade In type" and "Fade out type" boxes (or any fade selector box, e.g. in 
Clip Details or the Setup window) and pressing the Up and Down arrow keys on the keyboard provides 
another quick way to change the fade shape.  

SAVING AND LOADING FADE DESCRIPTIONS 

You can save a crossfade curve as a "*.FAD" file. This saves the fade shapes, fade lengths, and the overlap for 
the central fade down and fade up pair in a Two-clip Trim edit. This is known as a "Fade Description". 

To save a fade description, right-click anywhere in the clip display area of the Trim window, and the menu that 
appears has the option: "Save Fade Description". Selecting this will show a standard Windows Save dialogue 
where you can give the Fade Description a name. Note that the default directory on the PC drive into which 
fade descriptions are saved (which is also the default from which they are loaded) is the template directory for 
the User. The usual place for this is "C:\SADiE5\bin\templates\username". 
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Similarly, to load a fade description, right-click in the Trim window and select the option "Load Fade 
Description". This in turn shows another menu. This lists: 

 The last Fade Descriptions you have saved or loaded (up to 16, and they are listed in the order you 
used them), 

 A Default option (which will load the Default Cross Fade from the main Setup Window, 

 Other... which allows you to browse the PC drive for Fade Descriptions that don't appear in the list. 

The Load Fade Description menu can also be accessed via a Hotkey (you can set this in "View menu", "Setup 
Window", "Hotkey Setup", "Categories", "Trim Window", "Commands", "Load Fade Description"), in which 
case it appears in the top right corner of the Trim. 

This is a standard Windows menu, and so when it appears you can select which fade you want to load by using 
the down/up keys then pressing Enter. 

EXCEPTIONS 

LOADING AND SAVING ONE FADE ONLY 

So far we've only described what happens when there are two clips in the Trim Window, and you can see that 
in this case we are concentrating on the EDIT point and thus loading fades in pairs. A fade description file 
always includes two fade shapes, lengths and overlap, however this can be loaded into a single fade, both in the 
situations where there are two clips in the Trim or only one (or even more than two). 

The fades that are loaded depend on which clip areas are selected, however this is streamlined for the case 
where there are two clips, in order to make the loading of the edit pair simpler. 
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IN A TWO-CLIP TRIM WINDOW 

If you have selected ONLY one fade of the central pair (e.g. the fade out of the top clip or the fade in of the 
bottom clip) by Shift-clicking on the fade area to make it dark blue (and NOT highlighting the other half of the 
pair in dark blue), then ONLY one fade shape and length is loaded from the Fade Description. Obviously if 
your selection is a Fade In, then the saved Fade In shape will be loaded; if it's a Fade Out then the Fade Out of 
the pair is loaded. If you save when a single fade is selected in this way, then a single fade is saved (and not its 
partner). 

Note that, the outer fades are not considered, and if for instance an entire clip is selected (both fades in dark 
blue and the body in red) then only the central fade is considered for loading and saving Fade Descriptions. 

With any other selection of areas with two clips in the Trim, then the pair is loaded. This means that when you 
have two clips in the Trim window you cannot load fade descriptions into the outer fades (e.g. the Fade In of 
the top clip or the Fade Out of the bottom clip). This makes loading the edit pair much easier as it's the 
simplest default, besides which the outer fades are considered to be part of the previous or next edit. 

IN A ONE-CLIP TRIM WINDOW 

If there is only one clip in Trim, then this special case does not apply (because an "edit point" isn't defined). 

The Load and Save Fade Descriptions menu items will only appear with a right-mouse click if a fade's area is 
selected in dark blue. Likewise the Hotkey requires a fade area to be selected in order to show the Load menu. 

The selected fade is obviously the one that is active for saving and loading Fade Descriptions. Note that when 
you save a single fade to a Fade Description file, if this is loaded back into a pair of fades, the half of the pair 
that wasn't saved is loaded as a mirrored equal and opposite fade shape (e.g. as if you'd pressed the mirror 
button after loading a single fade). 

FADE DESCRIPTIONS THAT BREAK THE RULES 

The Fade Description always loads with respect to the centre (in terms of time) of the existing Fade Out on 
the top clip. There may be times where, due to insufficient audio or "out-takes" being un-available in the 
recorded audio file, the Fade Description may not be able to load with complete accuracy, and in these cases 
the length and/or the overlap of the Cross fade will be adjusted to fit the audio that does exist. If this happens 
you will see a warning when you load the Fade Description. 

COMPLICATED? 

No not really. In short, the main thrust of the Fade Descriptions is to load and save EDITS. When many fades 
exist in the Trim, SADiE needs to know which ones are active for loading, and so the correct ones need to be 
selected. But the default method of loading into the "edit pair" without having to select anything covers the vast 
majority of the scenarios that this is aimed at in a quick and efficient manner.  

MAKING A LOOPABLE EDIT 

 
The LOOPABLE EDIT button is only available if there are two Clips in the Trim Editor. 

This function copies the fade at the start of the right hand clip to the start of the left hand clip, and similarly the 
fade at the end of the left hand clip is copied to the end of the right hand clip. 

The normal situation for using this is when you want to make a single clip loop correctly. The procedure is as 
follows: 

 Roughly razor the clip to suit. 

 Make another copy of the clip in the EDL and REMOVE GAP to butt the two copies together. 

 Open the Trim Editor and load the two clips. 

 Perform the edit. 

 Pressing MAKE A LOOPABLE EDIT will copy the fade attributes for the edit that works to the 
outside points of the two clips. Now both clips are identical. 
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 Write back to the EDL. 

 Make multiple copies of the clip to suit. 

This would normally be with one clip duplicated. It will work with different pieces of audio, but only if they 
have the same time stamps.  

CLIP DETAILS 

 
The Clip Details window for the selected Clip can be opened by pressing CLIP DETAILS, or by 
double-clicking on the Clip (an option in the "Trim Editor" section of the Setup window). 

The Entry times in the window are fully interactive with adjustments to the profile in the Trim Editor. Other 
details can be adjusted here before the Clip is written back. 

Click here for a full description of the Clip Details window.  

WRITING BACK THE FINISHED EDIT 

The Trim Editor is a temporary area for adjusting edits. Once done, the edit (and any other changes you have 
made) needs to be "written-back" to a Playlist or Clipstore, which will then be updated. 

 
If you have loaded the Trim Editor from a Playlist, press WRITE BACK TO SOURCE EDL to 
update that Playlist. (It's a sauce bottle! Not very funny I agree.) 

If you loaded the Trim Editor: 

 From the Clipstore with a Clip that you now want to place in an EDL according to it's Track time 
(recorded "time stamp"), OR 

 From a different EDL to the one you want to write to, 

 
Make the Playlist window containing the target EDL active, and then press COPY TO ACTIVE 
EDL. 

NOTE: Before you write back, as the EDL has not yet been updated, you can play it to hear how the 
edit was before your Trim Editor adjustment. 

 
If you want to save the edited version of a single Clip in the Clipstore, press WRITE TO 
CLIPSTORE. You may want to rename the new version first. 

 
If you want to insert the edited version(s) of Clip(s) into a Playlist at an EDL time of your choosing, 
press WRITE TO PASTE BUFFER and then paste them into the Playlist. 

NOTE: There is an option in the "Trim" section of the Setup window to allow "Auto close trim window 
when writing back to source". This is often more convenient when you are using Hotkeys or the 
Hardware controller, and helps you to avoid opening multiple Trim windows by mistake. 

WRITING BACK AUTOMATICALLY 

In the Trim Editor section of the Setup window, you can select the option to write back the contents of the 
Trim Editor to the current Playlist automatically each time it is loaded: 

 With the LOAD NEXT/PREVIOUS EDIT buttons, OR 

 By using the RAZOR-CUT button. 

This makes it quick and easy to work through an EDL while staying within the Trim Editor, if you wish. 

NOTE: Loading with any of the other buttons does not write the current edit back automatically. This is 
so that if you make a mess of an edit in the Trim Editor, you can reload it from the Playlist and try again.  
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RELOADING 

When you have finished working on one edit, and have written it back, you may want to keep the Trim Editor 
open to do another one. 

NOTE: The following buttons on the Trim Editor's own toolbar reload it with different Entries or Clips, 
whereas using the Trim Editor buttons in the Playlist and Clipstore again will open a second Trim Editor. 

 
LOAD FROM EDL reloads the Trim Editor with the Entries selected (highlighted in red) in the 
Playlist or Text EDL. 

 
LOAD FROM CLIPSTORE reloads the Trim Editor with the Clip selected in the Clipstore. 

 

LOAD PREVIOUS/NEXT EDIT reloads the Trim Editor from the same EDL, moving one Entry 
backwards or forwards. Using these buttons you can easily move along the edits in the EDL to check 
or adjust them. 

 
LOAD FROM PASTE BUFFER reloads the Trim Editor with the contents of the paste buffer. 
This may have been cut or copied from any EDL/Playlist or Clipstore. 

MAKING A NEW EDIT 

Pressing the Trim Editor's own RAZOR-CUT button cuts all the Entries/Clips in the window at the current 
time position (and can be done on the fly while playing back). This has the same effect as having RAZOR-CUT 
them in the Playlist and loaded all the edits so formed into the Trim Editor. You will need to have written back 
your previous edit adjustment first, unless you are set to write back automatically.  

Razor in the Trim Window cannot be used when there are more than two entries loaded into Trim. 

MAINTAINING SYNC 

 
The LOCK CLIPS button prevents you from selecting and moving the body of Clips or Entries 
while they are in the Trim Editor, and therefore safeguards accidental loss of sync to picture or sync 
with music when writing back. If the LOCK STREAMS button on the Playlist toolbar is down, this 
button in the Trim Editor will be down when it is loaded from that Playlist. You can then release the 
button to override the lock status for this edit only. 

 
The SLIP LEFT and SLIP RIGHT buttons only apply with one or with two Entries loaded. 

The logic these buttons follow is controlled in the "Trim" section of the Setup window. 

"Trim Slips Auto-follow EDL Slip settings": 

 When this is ticked, the positions of these buttons on opening the Trim Editor will reflect the SLIP 
setting of the Playlist. They can then be changed to override the setting for this edit only. SLIP LEFT 
will cause EDL Entries before the earlier one in the Trim Editor to move with it when writing back. 
SLIP RIGHT will do the same for Entries after the later one. With this setting, you only have one 
global Slip setting to consider for Playlist movements, Playlist editing and Trim editing. 

 When this is not ticked, the positions of these buttons are completely independent from the SLIP 
settings in the Playlist. The settings of these buttons are held over for future Trim sessions. You might 
want to use this setting if, for instance, you do most of your editing inside the Trim Editor and only 
perform coarser manipulation in the Playlist window. This setting is perhaps more familiar to SADiE v2 
users. 
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NOTE: If you are working with sync material you will want to keep Playlist and Trim Slips off, so that 
slipping one Entry doesn't alter the sync of others. If you are working with sound-only material (like 
editing for radio) you will need to keep Slips on to avoid gaps opening up in your material as you edit. 
Remember that Slip is disabled when writing back from a Trim Editor containing more than two Entries; 
if you need to slip, use Playlist Editing instead.  

OTHER TRIM EDITOR TOOLS 

The four  SNAPSHOT buttons allow you to store and recall four different arrangements of the Clips in 
the Trim Editor, so you can compare different attempts at an edit. Click once to take a snapshot, and the 
button will turn blue to show it has a snap stored. After making adjustments, click on the button again to 
return the Trim Editor to the stored snap. The button of the displayed snap will turn red. To overwrite a 
button with a new snap, hold Ctrl. while clicking on it. 

NOTE: Even if you don't use the snapshots, you can write back an edit to the EDL, try to improve it and 
write back again. Then the Playlist undo and redo buttons can be used to move through the different 
attempts. Any of these can then be reloaded into the Trim Editor. 

NOTE: please don't confuse these camera snapshot buttons to the ones used for automation ! 

 
The USER ZOOM button turns your mouse pointer into a magnifying glass, which you can use to 
draw a box around the part of the profile you want to zoom-in on. The degree of magnification will 
be determined by the size of the box you draw. 

 
The RETURN button (it's supposed to be a telescope !) takes you back to your previous 
magnification level. 

 
The EMPTY TRIM WINDOW button empties the Trim Editor of all Clips/Entries. 

The VIEWING ORDER button is available with more than two Clips in the window: 

 
When it is up, the left channels of all the stereo Clips in the Trim Editor are displayed above all the 
right channels. 

 
When it is down, both channels of each Clip are drawn together. 

NOTE: For most editing, it is generally sufficient and clearer to just view one channel of each Clip. This 
is done with the button up, setting the window's size and magnification to show just the left (or right) 
channels of all the Clips in it. Have the button down when you want to see both channels of each Clip.  

MULTI-TRACK ENTRIES IN THE TRIM WINDOW 

When more than two EDL entries are loaded into the Trim Window, the Multi-track Auto Select 
button becomes active and enabled. 

When this is enabled, SADiE will group entries together and auto-select segments of these entries together so 
as to easily and quickly perform standard styles of editing across multiple streams. 

Remember, except for the case where there is a single entry loaded, the Trim Window is mostly concentrating 
on Edit Points, i.e. the Out of the Outgoing going clip and In of the Incoming clip. When you load two clips 
it's obvious which is the outgoing and which is the incoming (the clip that starts first goes on top if you weren't 
sure), however you can't necessarily apply that rule across the board. 

Thus we have a set of rules to determine how clips will be auto-selected in Trim. In practise, for the majority 
of edits the selections made will be the obvious ones, but to give most flexibility for editing SADiE allows clips 
that do not have the same In or Out points (but are close together) to be edited together. 

You can always disable the Multi-track Auto select function and select segments on your own by clicking and 
shift-clicking to add them to the selection. 
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I shall describe some example scenarios in the pages that follow. 

Mirror is available for Multitrack entries - the fade on the clip you have last selected will be the one to which 
others will align when you use Mirror. 

Razor is not available if there are more than two entries in Trim. 

As with Playlist Editing, a group clip - either a yellow one or a multi-channel green group clip - is considered as 
being ONE EDL entry. The Trim Window cannot change any internal edits in Yellow group entries. 

 

MULTI-TRACK TRIM EXAMPLE 1 

Two EDL Entries selected on every stream 

This one's not difficult - on every stream we have an Outgoing and Incoming clip - as normal, the clip that starts 
first is the Outgoing and appears on the top stream of the Trim window. 

 
This is of course the most usual situation we'll have to deal with - we have a number of streams of audio, you 
made a razor cut across all of them, now you want to tidy up the edit between them. Simple. In this situation 
all the outgoing clips are at the top of each pair in the Trim Window, and all the Incoming clips are at the 
bottom as you can see below. When the Multi-track Auto Select button is enabled (and it always will be when 
you load the Trim Window) then it's as if you'd grouped all the outgoing clips together, grouped all the 
incoming ones together and we are doing a two clip edit. 

The observant among you will see that I've performed what's known in the trade as a In-Source edit on the 
Incoming entries and slid them a couple of drum beats to the right. 
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We can go further, and by deselecting the Multi-track Auto Select button, and now we can change some of the 
edits individually - in this example the first three streams were loaded as a green group clip, and thus they will 
retain this grouping. I've pulled out a longer crossfade on these and adjusted the next pair of streams 
individually as well. 

 



SADiE v5.4 PCM Manual 

144 

Now, just for good measure, I've pressed the Multi-track Auto select again, and now everything links up again - 
with a single click on the crossfade I've been able to drag the entire edit point across all streams little to the 
right, but still retaining its uneven edges and differing crossfades on some legs. 

 
Q.E.D. 
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MULTI-TRACK TRIM EXAMPLE 1A 

The two clip per stream rule still applies where the edit is not the same on every stream. 

This is an extreme and probably foolish example, but the same rules from the previous example will apply - all 
the clips to the left of the horribly uneven edit will be the Outgoing set of clips, all to the right are the 
Incoming, and when you select one clip in each set, all clips will be selected. 

 
The important thing is that, much the same as with Multi-track Playlist Editing, it doesn't matter if the edit is 
offset a little on some legs of the edit, by enabling and disabling the Multi-Track Auto Select button you can 
either treat the entries as a single edit, or edit each clip or fade edge individually as you require.  
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MULTI-TRACK TRIM EXAMPLE 2 

One EDL Entry per stream 

 
Again, it's fairly obvious what should happen here - this is really just a single multi-channel entry, and we want 
to use the Trim Window to top and tail it. 

The ends in this example are a bit ragged, and as before, with Multi-track Auto Select enabled, they will all be 
moved together, and retain the offsets. 

TIP: The Mirror function can be used to align the In or Out points on every stream - the fade on 
the clip you have last selected will be the one to which all others will align when you use Mirror. 
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MULTI-TRACK TRIM EXAMPLE 2A 

One EDL Entry per stream "Chequerboard" 

 
It's quite common to need to edit between clips that are on different streams, but if this were to follow the 
same rule as the last example, then when you moved the out point of the clips on the first two streams, it 
would change the out point of the clips on streams 3 and 4 and NOT their In points which is what you would 
want. 

In the example above, the clips on stream 1&2 are loaded on top as the outgoing clip, those on streams 3&4 
are the incoming side of the edit. As you'd expect. the edit proceeds exactly like Example 1. 

But the key thing is how SADiE knows the difference between this situation and the last example. 

The rule is quite simple: The clip that start first is always an Outgoing clip, those that start before the half-way 
point of that clip are outgoing clips; those that start after the half-way point are on the Incoming side of the 
edit.  

MULTI-TRACK TRIM EXAMPLE 3 

Three or more EDL Entries on a Stream 

 
Following on from the last examples, we shall now see how the Trim Window can handle multiple edit 
points.  

In this very simple example, it's obvious that there are TWO edits, and you will see that you can edit them 
together in the same Trim Window session. 

When these three clips are loaded to Trim, SADiE will not only auto-select the appropriate segments 
depending on where you click, but also Slip clips inside the Trim window when they are not involved in the Edit 
Point that's being focussed. 
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Firstly you can see the Trim streams show two (stereo) groups of three. The first edit will be between "Ding 
...." and "Flim...." and the second edit between "Flim.... and "Ping...." 

In the picture above, I have clicked in the left hand half of "Flim...." so as to select its In point in Source mode. 
SADiE has also auto-selected the whole of "Ping...." and as you can see in the next picture, when I slide "Flim...." 
leftwards, "Ping ...." follows. 

This internal Slip is always applied in such a situation unless you deselect the Multi-track Auto-select button. 
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To work on the second edit, it's best to first de-select by clicking in an empty or grey area, then click on either 
the right-hand half of "Flim...." or the left side of "Ping....". You will see the mouse cursor change to show the 
edit mode. 

Summing Up 

All these rules will combine to allow multiple edits on multiple streams to be edited in Trim. 

You should be a little careful when loading different numbers of clips from each EDL stream - if the clips are 
reasonably well aligned the obvious auto-selections will be made, but if the edges are very uneven you may find 
the Auto-grouping doesn't work the way you want it to - SADiE's only human ! 

THREE AND FOUR POINT EDITING 

 
OVERVIEW 

"Three Point Editing" and "Four Point Editing" refers to a method of working which utilises a traditional 
Source/Destination style of editing. Conceptually this is a little like online editing with VTR decks. 

In SADiE terms this means having your original source material in one Playlist, and copying this audio into the 
correct position in a "Destination" Playlist (this is perhaps your "Master Edit"). 

Three and Four Point editing copies audio marked using the Region Editing Tools Left and Right locators in a 
Source EDL, and then pastes it into an area marked similarly in a Destination EDL. 
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The terms "Three" and "Four" Point refer to the number of Left and Right markers set. If you have Left and 
Right marked in both EDL's then it is a Four Point Edit. If one of the four possible markers is left unset, then it 
is a Three Point Edit. 

The procedure is much the same for both Three and Four point edits. 

PREPARATION 

 
First you need the correct tools to hand. Press the SELECT TOOLBARS button, and then select 
"3 and 4 point edit" from the menu, to reveal the "3 and 4 point edit" toolbar. 

 
Dock it wherever is convenient. Save a desktop and/or default desktop if need be. 

 
If you're using keyboard "Hotkeys", it may be worth reviewing which Hotkeys you are using for 
setting the Left and Right locators. I've personally found it worthwhile moving these to the [ and ] 
square bracket keys, and using modifiers for "Go to" and "Clear". These Hotkeys are found under: 
"Setup", "Hotkey setup", "Transport – Locators". 

A few suitable suggestions (but this is entirely up to you) are: 

 Clear Left Locator SHIFT + CTRL+ [ 

 Clear Right Locator SHIFT + CTRL + ] 

(These two are new Hotkey functions) 

 Go to Locator Left SHIFT + [ 

 Got to Locator Right SHIFT + ] 

 Set Left Locator [ 

 Set Right Locator ] 

While you are in Hotkey Setup, set some keys for the two 3&4 point editing tools and a couple more 
useful facilities (which are found in the Region Editing section of Hotkey Setup). Again, it's your 
choice! Of course the choices here are based on an English keyboard. 

 Three and Four Point Edit = 

(This is the =/+ button above the ] key. This is the "Do it" button for a Three and Four 
Point Edit) 

 Enable Three and Four Point editing mode - 

(i.e. the -/_ key to the left of the =/+) 

And a couple more which will probably come in useful: 

 Snap Left and Right to cuts # 

(This is to the left of the Enter key. There is also a button for this on the Region Edit toolbar, 
to the right of the L and R buttons). 

 Source/Destination focus toggle ' 

(This is immediately to the left of the #. This allows you to flip between the Source and 
Destination EDL's without using a mouse). 

You may alternatively wish to set up some Hotkeys on a Hardware Controller Jog panel. 
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TWO PLAYLISTS 

You cannot do a Three or Four Point Edit unless you have TWO Playlists (and only two Playlists) open. Thus 
this function won't be possible if you are working with the Playlist Setup option "Restrict to one open Playlist" 
ticked. 

If there are fewer or more than two Playlists open at the moment you initiate Three and Four Point Editing, 
then you will be warned appropriately and you will not be able to continue. 

So, you have a Playlist open that contains your source material, and another Playlist open ready to be the 
destination. 

It doesn't matter where these Playlists are positioned on the screen as you'll see soon. 

 
To initiate Three and Four Point Edit Mode, press the THREE AND FOUR POINT MODE 
button on the SOURCE Playlist; this is important as it determines which is the Source for the edit 
and which is the Destination, get the wrong one and you'll be going in the wrong direction.  

 
If you're using the Hotkey to enable Three and Four Point Editing make sure the correct EDL is 
focused by clicking on it with the mouse. 

At this point, the desktop will be rearranged to display the Source Playlist in the bottom half of the screen and 
the Destination at the top. The only other windows visible will be those that have been set to "always on top" 
and the Transport window, which you may want to close or move. Also Region Editing is now enabled in both 
EDL's. 

 
If you've set the Hotkeys, you will see that once Three and Four Point Editing is enabled, you can use 
the "Source/Dest focus toggle" to move back and forth between the two EDL's. 

FOUR POINT EDITING 

Just go for it - the operation will be obvious when you see it. 

First try this with the mouse: scratch the mouse over a region in the Source Playlist, and then do similar across 
a Destination region.  

 
Press the THREE AND FOUR POINT EDIT button on the Source Playlist (or the Hotkey) and 
the Source Region will replace the Destination region. Entries to the right of the Destination region 
will be slipped to fit the new region (the Source Region is unlikely to be exactly the same length as 
the Destination region was). 

Simple really - it's just a copy and paste/replace operation. 

The intention is that this provides a quick and easy compilation function, and thus the result will be as accurate 
as your placement of the Left and Right markers. You may find you will want to use Playlist Edit or the Trim 
window to tidy up the beginning and end of the new inserted region. 

In practice you may use scrub tools, or you could place the Left/Right markers on the fly whilst playing to 
define your Source and Destination regions more accurately. 

THREE POINT EDITING 

Three point editing is quite similar, and uses the same controls. The only difference is that one of the four 
markers is not defined. Thus there are effectively four different types of Three Point Edit, depending on which 
of the four markers is missing. 

When this is the case, SADiE will copy the source region and paste and replace it into a region the same length 
in the Destination Playlist . and hence there will be no slipping.  
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The four scenarios are: 

1. Destination Right missing 

The Source region is pasted, starting at the Destination Left mark, replacing Destination material for 
the Source duration 

2. Destination Left missing 

The Source region is pasted with its end at the Destination Right mark, replacing Destination material 
backwards from Destination Right for the Source duration. 

3. Source Right missing 

The Source region's end is defined by the length of the Destination region; this Source region is then 
pasted into the Destination Region. 

4. Source Left missing 

The Source region's start is defined (backwards from Source Right) by the length of the Destination 
region; this Source region is then pasted into the Destination Region. 

The first method is particularly useful for quick left-to-right compilation into an empty Playlist, moving the 
Destination Left mark to the end of the Playlist after each 3 point edit. 

 
Or perhaps you have an area of the Destination Playlist that needs filling with ambience. Mark the 
region to be filled, then place the Source Left marker in a section of ambience in the Source. Pressing 
the Three and Four Point Edit button fills the Destination with the correct length of ambience. 

CLEARING MARKERS 

If you've set a region with both Left and Right markers, you'll have to remove one to perform a Three Point 
Edit. You can do this with the Hotkeys (Clear Left/Right locator), or by double-clicking on the L or R button in 
the L&R pane of the Transport Controls. 

SNAPPING MARKERS TO EDITS 

 

 

The "Snap L&R to cuts" button and corresponding Hotkey are useful if you want to position the L&R 
markers exactly on the start or end of a clip. Pressing this button/Hotkey will move BOTH markers 
from where they are to the closest clip start or end on enabled streams. 

This is useful for replacing entire clips or sequences of clips. Also you can mark a silent region this 
way in order to fill it with a 3&4 point edit. 

Note: This doesn't place the markers exactly at the start or end, but half-a-default-crossfade after a start 
(or before an end) so that a default crossfade will be produced by the 3&4 Point edit function. However 
the behaviour is different if you have Cut mode set to "V Cut" in the Playlist Setup window. 
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REGION EDITING 

 

 
Region Editing adds another set of editing tools to your palette. The basic principle of Region Editing is that you 
firstly define a "region" of the Playlist, and next perform another action on that region; you may want to delete 
it, move it or copy it elsewhere for instance. The region is defined between the standard Left and Right 
Locators, and usually across all streams enabling you to more easily edit across all streams of a multi-track. 

You could use the region editing tools for removing a section of a multi-track, or for moving it or copying it 
elsewhere. Another possible use for region editing is for simple speech editing tasks. Where you otherwise 
may use razor cutting and Playlist editing, defining a region and deleting it can be very quick, particularly for 
repetitive tasks.  

 
Region editing functions are available on Hotkeys, and this can speed up operation significantly. 

 

ENABLING REGION EDITING 

To access Region Editing first you must be able to see the Region Editing Toolbar. 

 

 
If this is hidden, then pressing the SELECT TOOLBARS button, and choosing "Region Editing" 
from the drop-down menu can reveal it. The above toolbar will appear, and in the usual way you can 
dock it to an edge of the Playlist or allow it float, by dragging it around the desktop, or by right 
mouse clicking and selecting, for instance "dock to top". 

 
To enable Region Editing, press the REGION EDITING ENABLE button; region editing is turned 
on when the button is pressed in. 
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DEFINING THE REGION 

 
DEFINING THE REGION WITH THE MOUSE: 

The mouse cursor will change to a  pencil tool, which signifies that you are ready to define a new region. 

To define a Region, when your mouse is the  pencil tool, click at the position in the Playlist where you want 
the region to start (it doesn't matter which stream you are over when you click, anywhere between the time 
bar and the bottom of the Playlist will do), then whilst holding the mouse button down, drag the region 
rightwards, and when you reach the point at which you want the region to end let go of the mouse button. The 
region will be coloured red, and you'll notice the Left and Right locators are positioned at the start and end of 
the region respectively. 

To help you mark the region, you will notice that the two time displays at the bottom left of the Playlist will be 
displaying current cursor position and the duration of the region respectively. 

You can also start at the end of the region and drag leftwards towards the start, whichever method is most 
convenient. 

 
DEFINING THE REGION WITH THE HARDWARE CONTROLLER: 

All of the region editing functions can have Hotkeys assigned. Notice that the Preview buttons are linked to the 
Transport Edit controls' preview buttons, and similarly the Select Region Start and End buttons are the same as 
the In and Out buttons. 

Having enabled region editing, you can set the region start by setting the Left locator, and the region end with 
the Right locator, in the usual way. 

Also the hardware IN and OUT buttons give you a way of setting the region. Once you're in Region edit 
mode, pressing the IN button while the Playlist is scrubbing makes the Left region marker jump to that 
position. Scrubbing from there moves the Left marker as you scrub. If you press IN when the Playlist is 
stopped, then the current time will locate to the left marker. You have to be careful to stop the scrubbing 
when you've positioned a marker (press the STOP button), otherwise when you come to move on to the 
OUT point, you will jump the Right marker as soon as you press OUT, rather than jump TO the right 
marker (which happens when you're not scrubbing). 

A most important factor is that the region doesn't have to start at an entry's start point; it can begin anywhere 
in the Playlist and can contain any number of entries. Under normal circumstances in SADiE, we are 
manipulating EDL entries or clips, but that's not the case at the moment in region editing. 

BASIC REGION EDIT FUNCTIONS 

To see the sort of thing you can do next just press the Delete key on the keyboard. Assuming you have 
Autoplace and slip off, you will see the region disappear, and razor cuts are made to tidy up the ends of the 
entries left behind. 

Try a few more things: UNDO to put the region back, or set SLIP to be RIGHT. Now press Delete again. 
This time the region disappears, but slipping everything to the right, leftwards, fills in the hole. 

 
Define another region; you will still have the  pencil cursor. This time press the CUT button 
using the mouse. The same thing as before will happen: the region disappears and entries move 
leftwards to fill the hole. 

 
Now go to the end of the Playlist and press PASTE and the mouse cursor changes to the usual 
paste icon. Clicking in the Playlist will now drop a copy of the whole region into the Playlist. 

 
Of course you can use the COPY button to leave the original region unchanged (and un-razored) 
and allow you to paste a copy of the region elsewhere in the list. 
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NOTE: You may want some streams of the EDL to be unaffected by any region editing. Region editing 
only works on streams that are enabled (lighter grey), so to make the region ignore a stream press its 

 stream name button so that it is in the "out" position. With region editing the "Ctrl-enable" 
function (clicking on a stream name button while pressing the CTRL key on the keyboard) can be a 
quicker method of enabling the correct stream; this function is a "reverse" function and disables all 
streams apart from the one you've Ctrl-clicked on.  

ADJUSTING THE REGION 

There are many ways of adjusting the region's bounds once you have defined it. 

1. Clicking with the mouse outside the region, gives you the pencil tool again, and will start making a new 
region. You could use this method to redraw the region from scratch again. 

2. When the mouse is close to the start or end of the region, the mouse cursor will change to a  
left pointing or a  right pointing arrow shaped cursor. Clicking and dragging this point allows you 
to adjust either the region start or end. 

3. The region start and end are the Left and Right Locators, so changing these, in the Transport 
Controls' L-R Tab in the usual way will adjust the length of the region. 

4.  
You can scrub the start and end of the region - either using the Transport controls, Edit 
pane jog wheel, or using the Hardware controller wheel. The SELECT REGION START 
and END buttons determine which end of the region is being scrubbed. 

The Region Editing toolbar has three tools that help you zoom in on the relevant part of the region (the whole 
region, or it's start or end) quickly: 

 
ZOOM IN ON REGION changes the zoom so that you can see the entire region in the Playlist.  

 
ZOOM TO REGION START and END set the zoom to horizontal zoom 15 so you can see 
some detail on the entries at the start and end of the region. 

 
In a similar way, the SELECT REGION START and END buttons move the focus to the start 
and end of the region without changing zoom. Note that the Hotkeys to operate these buttons are 
the same as for the Transport Edit controls' GO TO IN and GO TO OUT respectively. 

PREVIEW TOOLS 

 
The PREVIEW tools operate around the selected point of the region (start or end as set by the START and 
END markers), and as you would expect from the icons, they play from the point, through the point, the 
whole region, and to the point respectively. 

 
PLAY EDIT WITHOUT REGION is a special preview tool, which performs a dummy edit, then 
previews it. On pressing this button, the Playlist will re-draw itself, as if the region had been deleted, 
then preview from before the Left marker to after the Right marker. Having previewed, the Playlist 
will undo this dummy edit, and draw itself back to where it was beforehand. You would normally use 
this tool with SLIP on, otherwise this preview will play silence for the duration of the region.  

 
There is a Hotkey available for this function 
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OTHER REGION EDITING TOOLS 

 
RAZOR CUT REGION puts a razor cut at either end of the region, and turns off region editing. 

REGION INSERT and REGION OVERWRITE modes determine what happens when you paste a region 
into the Playlist. First you have to cut or copy a region to the paste buffer. 

 
In Insert mode, when you paste a region into the Playlist, a razor cut is made across the Playlist at the 
paste position you selected, then the region is pasted at that position. Any entries underneath the 
region remain as they were. But if you are in Slip (which is really how this mode is supposed to be 
used) then (for instance with Slip Right enabled) the entries to the right of the paste position are 
slipped left by the length of the region - in other words, the Playlist is cut in half and slipped to make 
room for the region. 

 
In Overwrite mode, when you paste a region into the Playlist, entries underneath the region are cut 
and deleted to fit the region in. This mode is not supposed to be used with Slip. 

Note that Insert and Overwrite have no effect if Region Editing is turned off; the normal rules for pasting clips 
into the Playlist apply. 

 
Show sample values is a tool that is not specific to Region editing (in fact you have to turn Region 
editing off to use it).  

 
When this button is pushed, and the Playlist is displaying at one of the highest three horizontal zoom levels, 
then the cursor changes to a "magnifying glass" and passing this over the waveform displays the time of that 
sample and it's sample value as a 24 bit number, e.g. a decimal number between -8388608 and +8388607. 
Holding the Shift key down while using this tool will show the sample value as a hexadecimal number. 

REGION DUCK 

The Duck function is an automatic feature that can be used for lowering the level of, for instance music, 
underneath, for instance, speech.  

The idea being that the music (ideally on say stream 3&4) starts first, then the speech (on streams 1&2) comes 
in; the music will lower in level and continue underneath. When the speech finishes, the music level will rise 
again back it it’s normal level. 

There are other ways to achieve this, for instance using the Automation Dip feature; this method applies a Clip 
level change, and thus is independent of the mixer. 

Duck works in conjunction with the Left and Right locators, which of course can be set by using hotkeys or 
Region Edit. You will need to view the Region Toolbar or set some hotkeys. 

1. Set the L and R locators at the beginning and end of the “speech” audio. 

2. Disable any streams that you do not wish to be lowered in level. 
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3. Press the   “Duck” button on the Region toolbar. 
 

 
4. The Duck Dialog will appear. Here, you can set a “Duck level” – this is the relative level by which the 

music’s level will lower. And also you can set a Transition time – the is the time that the music will 
take to reach the lowered level; it takes the same time to return to it’s normal level. 

5. On pressing OK, all enabled streams will be razored at both the left and the right locators; a linear 
crossfade of length determined by the “transition” time is made; all clips between left and right 
locators will have their level reduced by the Duck level. 
 

 
If edits or cross-fades already exist in the area around the left or right locators, it may not be possible to apply 
the correct fade up/down time. If necessary and if there are lots of edits in these areas, you could bounce the 
music before applying a duck. 

Note that there are two hotkeys (under Region Editing) for Duck – one (Region Duck)which displays the 
settings and allows you to change them, whereas the other (Region Duck no configuration) will perform a 
Duck immediately. This way you can set the duck once, and then use the single-shot key to perform 
subsequent quick-ducks. Or quack-ducks if you're so inclined. 
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SPEECH EDIT 

 
Speech Edit serves two basic functions. Firstly, it can act as a high quality time scrunch for speech (or any audio 
where there are periods of "silence"). Secondly, it can also be used to perform semi-intelligent edits on a given 
clip, effectively saving a lot of time in the Edit Window finding words or removing periods of silence etc. 

The speech edit process works by scanning the selected clips or EDL entries to find periods of "audio" and 
"silence". Once it has located all the regions where it thinks audio is contained, it then forms an EDL in 
memory from the audio in the original clip, but with cuts at the start and end point of audio. 

This process can operate in the usual way by recording another track. However, since the process works by 
forming an internal EDL, the facility is also provided to "write back" the EDL into the Playlist and see the edits 
made. This means that edits can be fine adjusted in the trim window. 

HOW DOES SPEECH EDIT WORK? 

 
The diagram above shows a typical speech waveform. When an audio level is found above a "gate on" 
threshold, audio is assumed to have been located. When the level then falls below a "gate off" threshold, the 
audio is deemed to be finished and "silence" has been found. 

The process performs edits on the EDL entries in two ways. It either forms clips only out of the regions it has 
deemed to be audio (gated edits) - this works well for audio recorded in quiet environments. The other editing 
mode using "spliced edits", forms clips which have their start point at the beginning of the audio section, and 
the end point at the start of the next audio section. In this mode entries are joined by a "splice" or crossfade 
type edit, and so if you are working in 8 stream mode, entries will checkerboard across 2 (for mono) or 4 (for 
stereo) streams. At the "butts", linear crossfades of around 10 milliseconds are inserted. This mode enables 
good edits to be made on audio with noisy or ambient "silence" (e.g. cricket commentary), although it has the 
drawback that where audio originally only took up one stream, it would now take two. It is therefore most 
effective with only one clip playing at once, and so it's probably better to perform the Speech Edit process 
before laying on other tracks. 

 
Gated Entries 
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Spliced Entries 

As the process locates regions of audio and forms them into EDL entries, it can also reduce the length of the 
regions of  "silence" (or expand them) to perform time-scrunching. For gated editing mode, this means placing 
the entries closer together in the EDL (or further apart). In spliced edit mode, only time reduction can be 
performed, by bringing the end points of clips forward in time (i.e. reducing the length of the "silence" in the 
clip) but still butting the subsequent clip to the end of this one. This still produces smooth crossfades. 

CONTROLS 

 

1: Time Scrunch ratio - Sometimes it is impossible for the process to scrunch to the desired amount (if there is 
insufficient silence), and so it will warn you with a message and set itself to the nearest scrunch ratio it can. To 
enable the process to scrunch further, the gate on and gate off values can be increased, or the minimum clip 
and gap lengths can be reduced. If reduction to the minimum possible length is performed, all the gaps are 
removed, rather than scaled down in length (which is the normal mode of operation) so speech can begin to 
sound unnatural. 

2 and 3: Gate On and Gate Off - These pots control the threshold where audio is detected, as described 
above. Increasing them means that more audio is treated as silence, so higher time reduction can be 
performed, but with the loss of some audio. Higher thresholds will be required for audio with background 
noise. Gate off can never be greater than gate on. Usually keeping them the same works OK. 

4 and 5: Gated/Spliced Edits - These buttons switch between the two forms of clip formation as described 
above. 
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6: Write Back - As explained above, the resulting edit list in memory can be written back to your current 
Playlist instead of recording a new track. This allows edits to be trimmed in the trim window for fine 
adjustment. 

NOTE: If the scrunch ratio is 1.0 and spliced edits are used, then the entries can even be "glued" back 
together if unnecessary or undesired edits have been made. 

7: Minimum Clip Length - has a similar effect as the minimum gap length, but can't be too short, otherwise the 
disk won't be able to keep up with the number of clips created (unless bounce in non real-time is used). Longer 
lengths (500 milliseconds upwards) can enable distinct words and phrases to be identified and cut into sections 
which are easily editable. 

8: Minimum Gap Length - this specifies the smallest region of "silence" that the processor will treat as a "gap" 
which can be reduced. Increasing this value means that only large pauses can be detected, and may mean the 
audio can't be scrunched as much (but does mean that the process can detect large areas of silence for editing 
purposes). If the value is small, it can even find gaps inside words and so can compress further at the risk of 
sounding unnatural. 

APPLICATIONS 

Below are just a few possible uses for Speech Edit: 

EDITING 

To actually make use of the process to perform edits rather than time scrunching, longer gap and clip lengths 
are more useful. Working with a ratio of 1.0 in spliced mode is probably the most effective way of working. 
Using this method, you should be able to quickly locate regions of speech you wish to omit and edit them. 
When you've identified which of the new entries you wish to remove, and you delete them with AUTO-SHIFT 
switched on, the gap will automatically close up. 

SILENCE REMOVAL 

It can be used as a simple gate to replace ambience with digital silence. As above, you would use a Scrunch 
ratio of 1.0, but use Gated edits, so that "silence"  below the thresholds is removed. 

TIME SCRUNCHING 

To scrunch audio, gated or spliced edits can be used. If the minimum gap length is shorter, more silence can be 
found to reduce. If it won't scrunch enough, increase the threshold so that more silence and less audio can be 
found. Large scrunches may reduce the gaps between words so much that a lot of emotion/feeling can be lost 
from the speech. 

TOP AND TAIL 

If you've recorded several music tracks, set the minimum gap and minimum clip lengths high (about 5,000 ms). 
You can then use Speech Edit to find the gaps and split the recording into separate entries. 
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7 - MIXING AND PROCESSING 

The Mixer 

Mixer Processing and Plugins  

DirectX & VST Plugins 

SoundField SurroundZone 

Routing 

Reorganising the Mixer 

The Process Window and Plug-ins 

CEDAR Sound Restoration 

CEDAR Retouch 

Peak Metering 

Automation 

Surround Sound 

THE MIXER 

 

 
The Mixer window in SADiE routes audio signals between the currently active Playlist and the outside world. 
On each Stream you can control levels, pan positions and auxiliary sends as well as process the audio, by 
applying equalisation or compression for example. 

You can: 

1. Set and leave these controls when playing back an EDL . 

2. Adjust them in real time during playback. 

3. Record the adjustments you make and have them reproduced using the Automation described later in 
this chapter. 
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If you have closed the Mixer for your current Playlist, you can display it again with the SHOW 
MIXER button on the Playlist toolbar. 

NOTE: In addition to using the faders of the Mixer to control the playback levels of Streams, you can 
set the level of individual EDL Entries. See the Clip Details window. 

The Mixer is made up of channel strips which each have an input and an output. The simplest Mixer strip 
consists of a fader, a pan control and an input selection button whose label indicates what that strip is 
controlling. Other displays and buttons may be added to the strips. 

 
This is the Mixer's configuration toolbar. If it is not currently displayed on your Mixer, you can bring it back 
with "Toolbars" on SADiE's "View" menu. 

The first six buttons add or remove displays for every strip: 

 
Fader grouping buttons - see Grouping Faders. 

 
Inline process buttons - see Processing. Each button represents a blank section into which you can 
insert processes like EQ and dynamics for each strip. To reveal more buttons, enlarge the Mixer 
window vertically. 

 
Strip output selection buttons. 

 
Phase Reverse Controls. 

 
Displays "long faders". In this view, all faders are twice as high as usual and thus have a twice the 
resolution. Moving the fader with the mouse will give you 0.20 dB steps instead of 0.40 dB as in the 
normal view. 

The last five buttons turn on or off other Mixer displays: 

 
Turns on Mixer automation and displays the automation toolbar (see Automation). 

 
Displays the Process Palette toolbar from which you choose which processes to insert into a Mixer 
strip, and lets you add new strips to the Mixer. 

 
Displays the Routing toolbar. 

 
Brings up the Process Window, which acts as an "outboard rack" for other processes.. 

 
Shows the Metering Window. 



Mixing and Processing 

163 

A MIXER CHANNEL STRIP 

 

1. Fader Grouping button - see Grouping 
Faders 

2. Inline Process button (empty) - see 
Processing 

3. Input Selection button - this strip is 
controlling the audio of Stream 1 

4. Output Selection button - this strip is 
routed to internal Bus 1 and 2 

5. Phase Reverse control and left/right 
swap for stereo strips 

6. The peak level of audio through the 
strip. Figures above full digital coding 
level shown in red. Double-click to 
reset. Shows fader level in blue when 
fader is moved. 

7. Pan pot - click and drag to 
adjust. A small fader will pop 
up to indicate the setting. 
Double-clicking allows you 
to adjust the fader directly. 

8. PPM - Peak Programme 
Meter display 

9. Fader - drag it! 

10. Nudge the fader in 0.1 dB 
steps 

11. Resets the fader 0 dB gain. 
Fader is disabled whilst 
button is down. 

12. Solos this strip 

13. Mutes this strip 

NOTE: The peak level displays act as an indicator of the margin available before reaching full digital 
coding level. On channel strips routed to SADiE's inputs and outputs, they will show you how close you 
are getting to overload. However, SADiE's Streams have over 1000 dB of headroom so you will not 
overload this part of the system. Double-clicking resets them individually, Ctrl + double-click resets all 
strips. Overloads on outputs can be logged using the Log Overloads Window. 

 
Each hardware controller fader panel has eight faders which control the Mixer strips indicated by the 
LED's above them: 

ASSIGN +  and  select the next and previous bank of eight Mixer strips for control by the eight 
faders. 

SHIFT + a fader's SELECT button allows you to reassign a single fader to a different Mixer strip. 
Move the fader and the LED changes to indicate the new strip. When you let go of the fader, it is 
reassigned. Use this to set the function for the single fader on the edit panel, perhaps to control a 
stereo master strip. 

A MUTE button is provided for each strip. 

SHIFT + MUTE solos the strip. 

ASSIGN +  changes all the faders from controlling level to controlling the pan-pots. The LED at 
the top left will display "Pn" 

ASSIGN +  changes back to level control. The LED shows "Fd". 

NOTE: As you will see from the following sections, the Mixer is very flexible. You can save any Mixer 
configuration for later recall. See File Management.  

GROUPING FADERS 

To link (or "gang") on-screen faders so that they move as a group, press the  FADER GROUPING 
button on one of the strips. It will flash. You can then press the grouping buttons of other faders you want 
linked with it. They will light up indicating that they are part of the group. Finally release the flashing button. 
Moving any of the faders in the group will now move them all and their buttons will light to indicate the link. 
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Faders can be set at different levels before being linked and the offset between them is calculated so that they 
reach the bottom of their travel (fade out) together. This maintains relative stereo positions. Pressing any of 
the linked group's fader reset buttons will lose the relative offsets. 

To change the level of only one fader within a group, move it whilst holding down the keyboard Shift key. 

To remove a fader from a group, select one of the others in the group, and then release the button of the 
fader you want to remove. Finally release the flashing button. 

NOTE: You can make as many groups as you like, but each fader can only be in one group. Mute, solo 
and fader reset buttons are also linked. 

 
NOTE: Hardware controller faders are not affected by grouping when moved physically; the 
feature is designed to make it possible to move more than one fader with a mouse. The best 
way of grouping hardware faders is with your fingers! 

Right-clicking on a grouped fader will reveal an option to "Invert fader polarity". This means that if you push it 
up, the others will go down. 

PHASE REVERSE CONTROLS 

The Phase Reverse Controls button on the mixer configuration toolbar enables another set of buttons for each 
strip in the mixer. 

 
These buttons allow you to reverse the phase of the audio through the strip, and in the case of stereo strips, 
the button in the middle will swap the left and right sides of the stereo signal through the strip. 

If the button is pushed in and red, then the function is on. Grey buttons cannot be selected. 

Because these are potentially dangerous buttons if selected by mistake, there is an option in Setup, on the 
"Mixer Strip Display" sub-section of the "Mixer" page to ENABLE PHASE CONTROLS. When this is not 
ticked, the phase controls cannot be displayed.  

MIXER PROCESSING AND PLUGINS 

INSERTING PROCESSING IN MIXER STRIPS 

To allocate processes to a Mixer strip, and therefore to process the audio going through it, display the Process 
Palette toolbar. 

This shows you all the available processes you can insert inline on individual Mixer strips: 
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1. Auxiliary Send 

2. Low-pass EQ 

3. Low-shelf EQ 

4. Band-pass EQ (bell) 

5. High-shelf EQ 

6. High-pass EQ 

7. Limiter 

8. Compressor 

9. Expander 

10. Gate 

11. MS Decoder 

12. Direct X Plugin 

13. VST Plugin 

14. Cedar Denoise96 inline process 

15. These last three buttons can be used to drag new mixer strips. These can be mono, 
mono with pan, or stereo. 

 

So, if you wanted to apply compression, followed by two bands of EQ, and then take an auxiliary send from the 
audio on Stream 4 of your Playlist , you would insert those processes into the Mixer strip that is controlling 
Stream 4. It would then look like this: 

 

1. Inline Process: Compressor 

2. Inline Process: High-pass filter 

3. Inline Process: Band-pass filter 

4. Inline Process: Auxiliary Send 

5. Processing is being applied to strip 4 

 

To remove an Inline process from a strip, right-click on its button and select "Delete Process".  
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ADJUSTING MIXER PROCESSING 

 
Click on any process button in the strip. This will bring up a scrolling display of the controls for all 
processes in the strip. 

 

1. Centre 

2. Drag 

3. Nudge 

The controls on the screen appear as familiar rotary knobs. Click and drag the mouse up or 
down to adjust them. A small fader will pop up temporarily to indicate the adjustment and the 
numerical display on the left will indicate the exact setting value. Double-clicking keeps the pop-
up fader on view and allows you to adjust it more finely (click on a grey bit of the window to lose 
it again). You can also adjust the setting by entering a value directly into the numerical display in 
any of the following ways: 

 Click, hold and drag the mouse up or down over the digits (on either side of the decimal 
point, where there is one). Their value will increase or decrease, and the more you 
move the mouse, the faster they change. Release to set the new value. 

 Use the up and down arrows beside the display to nudge its value by whole units. Hold 
Ctrl to nudge by decimal points. 

 Double-click on the time display itself and directly type in a new value ending with the 
keyboard  Return key. 

At the top of each section are three buttons: 

1. A bypass button for that section. 

2. A name button that allows you to change the section to another process. 

3. A button to disable the automation for that section 

 
          Bypass  Process Name  Disable Automation 

 
At the bottom of the mixer strip bypasses all processing. There is a Setup option, in the "Mixer 
Strip Display" sub-section of the "Mixer" page, that allows you to alter the function of this bypass 
button so that only equalisation is bypassed, thus leaving dynamics, Aux sends and M&S 
unaffected. 

 
Press SELECT above the fader of the strip you want to adjust. The number of the strip will 
appear in the LED above the Rotary Shaft Encoders (Knobs to you and me). 

and  then move through the processes on that strip, selecting each in turn for adjustment and 
outlining its display. 

EQ and CMP select the Equalisation and Compressor sections directly. 

The knobs A to F now control the on-screen knobs in the selected process, from the top 
downwards. 

ASSIGN + MUTE above the relevant fader bypasses all processing. 

DYNAMICS 

The Dynamics processing has been designed to sound and act as much like a traditional analogue studio unit as 
possible, with a slightly "soft knee" to produce a natural effect. 
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The Limiter - A basic level limiter. This isn't a look-ahead limiter and so cannot possibly guarantee to clamp the 
level down to a set level. This should not be confused with the Mastering limiter. 

 

Limit - The threshold above which signals are limited. 

The Expander increases the dynamic range by reducing its gain in inverse proportion to the level of the signal: 
the lower the level, the more reduction. 

 

Attenuation - The delay between the signal dropping below the Threshold and gain being 
reduced. 

Restore - The delay between the signal exceeding the threshold and gain returning to 
normal. 

Input Range - The input level range between the expander starting to operate and 
reaching its maximum gain reduction. 

Maximum Attenuation - The maximum gain reduction. 

The Gate reduces the output by a fixed amount when it falls below a given Threshold. 

 

Attack - The delay between the signal dropping below the threshold and the gate 
"shutting" and reducing the level. 

Release - The minimum delay before the gate will reopen. 

Maximum Attenuation - The amount of gain reduction when the gate is operating. 

The Compressor reduces dynamic range by reducing its gain in proportion to the level of the signal: the higher 
the level, the more gain reduction. 

 

Attack - The delay after a transient before the compressor starts reducing the level. 

Decay - The time after the transient before level is returned to normal. 

Threshold - The level above which compression is triggered. 

Ratio - The amount of gain reduction then applied. 

Makeup Gain - Boosts output level to compensate for overall gain reduction. Be careful, as 
it will go very loud! 
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Note, that the algorithm of the Compressor has changed from v5.2 onwards to give more realistic responses. 
It has been reported that, with the quickest attack times, the output can be distorted with some material. This 
is because the compressor may be tracking too quickly, which can cause the level to be changed too quickly 
and by potentially large amounts. However, it was felt that allowing a fast attack still has some value; this can be 
used to catch a momentary peak more quickly for instance. 

Due to this algorithm change, if you load a mixer that was last saved with v5.1 or earlier, the compressor 
values will be translated to the closest match on the new compressor, thus the values shown on screen will 
appear to be different to those that were saved in the earlier version. However, the new compressor will be 
set up to sound very similar. 

EQUALISATION 

SADiE's Equaliser is divided into five sections with different slope characteristics. The frequency controls of all 
sections cover the full audio bandwidth of 20 Hz to 20 kHz. Here is a control strip with all five sections: 

 

A low-pass filter (steep high frequency cut) with a slope of 12 dB/octave. 

The frequency controls set the -3 dB point. 

 

A high-pass filter (steep low frequency cut) with a slope of 12 dB/octave. 

The frequency controls set the -3 dB point. 

 

Low-shelf EQ (low frequency cut and boost) -60 dB to +20 dB. 

The frequency controls set the -3 dB point. 

 

High-shelf EQ (high frequency cut and boost) -60 dB to +20 dB. 

The frequency controls set the -3 dB point. 

 

Band-pass EQ (bell-shaped boost and cut) -60 dB to +20 dB. 

The Q control sets the bandwidth. The higher the Q, the narrower the bell. 

The frequency control sets the centre frequency. 

The cut and boost controls operate symmetrically apart from at the extremes, where the -60 dB cut is 
provided to allow "notch" filtering with high Q settings. 

See the full frequency plots of the Equaliser.  

AUXILIARY SENDS 

Mixer Strip Knob 

 
 Full Control Display 

 

The Auxiliary Send level knob can be adjusted on the Mixer strip as well as on the full control display. 
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The routing button allows you to route the signal either to an internal bus or to the outputs. Note that the 
bypass button for this section acts as Auxiliary Send on/off.  

SAVING SETTINGS 

To save the layout of the Mixer . save the Mixer Setup file. This can be done with the File | Save command 
when the Mixer is the active window, or from the Project window, as described in File Management. 

NOTE: Processing control settings are saved as part of the Mixer Automation. 

You can also save Process settings and Mixer strip settings for a single strip. Right mouse click on the process 
section of a strip and this menu drops down: 

 
"Save process settings" saves the pot settings for a single process, which can be reloaded into the same process 
or one on another strip. 

"Save mixer strip settings" saves the whole mixer, all processes and their pot and fader settings, which can be 
reloaded onto another strip. 

If you wish to save your customised Mixer to be used again, save it as a Template.  

PROCESSING STEREO 

To apply processing equally to the two channels of stereo material, it needs to be routed through a stereo 
Mixer strip. You can merge two mono Mixer strips into a stereo one by right-clicking over the fader: 

 
Then insert the required process into the stereo strip.  

MS DECODER 

 The MS Decoder allows you to simply convert audio recorded as Mid and Side into its Left and Right 
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components. 

The knob lets you adjust the stereo width, and there is a push button for SWAP INPUTS in case the "M" 
signal is on the right side of the stereo recording. As with AUX SEND the knob can be adjusted on the mixer 
strip without opening the whole process strip. This process can only be added to a Stereo strip.  

DITHER WINDOW 

Dither and Noise Shaping can be applied to outputs in the Dither Window. 

To access this, press the D  button on the Mixer Toolbar 

 
Dither can be applied either globally or to individual output channels. When using this new interface, dither is 
always applied at a point between the Bus called i.e. O/P 1&2 and the physical output, so it is always last in the 
signal path.  

PPMs that measure output level, will be measured after the dither. 

Note however that the master Output Resolution setting in Setup / Audio determines the bit resolution at 
which the AES stream is truncated and at which the sub-code in the AES stream is set. If your master Output 
resolution is set to 16bit, then any dither applied at a Dither Resolution of 24bit will be truncated, and hence 
have no effect at the output (you will warned if you try this.) 
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Operation is simple. You have “radio” buttons to select Global or Individual. When it’s set to Global, you can 
change :- 

 The Dither Resolution, which is the bit resolution at which the dither is being applied. Dither will 
add noise to the least significant bits. 

 The Dither Type. Clicking on one of the three tabs allows to choose between and set parameters 
for:- 1) Dither, this is the standard unshaped dither that is available on all SADiE systems; 2) NS Dither 
– this adds noise shaping to the normal dither types 3) POW-r is similar to NS Dither but uses noise 
shaping filters designed by the POW-r Consortium. NS Dither and POW-r are options and will only 
be available if they are installed. 
There is a further description of NS Dither (a.k.a. HiDither96) and POW-r in the Process Window 
section of this manual. 

(If you select NS Dither without choosing any noise shaping, then this uses the standard Dither settings, which 
are always included as standard.) 

When it’s set to Individual you can alter the Dither Type and the Dither Resolution for each output pair. 

To change the parameters, select the output you wish to effect by clicking on it , it becomes highlighted in 
blue;  (note that the usual CTRL-click and SHIFT-click options apply for selecting multiple items in the list), 
choose the Type and Resolution, and press Apply. Pressing OK is the same as Apply, but will close the 
Window. Pressing Cancel will exit the window without making any changes (since the last time you pressed 
Apply or OK). 

Note that the Bypass and the POW-r Autoblack buttons can be changed without pressing Apply (this is so that 
you can apply the function in real time so as to A/B the effect of dither). If you exit the Dither Window by 
pressing Cancel, the state of these will revert to the way they were before you entered the Dither Window. 

All Dither Window Settings are saved with the mixer, and thus will be saved with mixer templates also if you 
wish. The default state is Global Off. 

Additionally there are buttons in the Dither Window to enable you to Save or Load dither settings. 

DITHER IN THE BOUNCE WINDOW 

When you’re bouncing, there is a Dither switch in the bounce window to allow you to choose between a) no 
dither (un-ticked) b) or (ticked) using the settings in the dither window (if they are set to OFF, then there will 
be no effect.) 

Note that Dither will apply (when this is ticked) for bounces that use the mixer and those that do not. 

If you are applying dither as plugins in the process window (see below) then this “Dither “ switch has no effect 
(neither ON nor OFF). 
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DITHER IN THE PROCESS WINDOW 

An alternative method for applying dither exists in the Process Window, whereby Dither or Noise Shaping 
plug-ins can be routed into busses. 

This method pre-dates the Dither Window which was first introduced in v5.3 software, but this is still available 
a) for users that wish to retain their existing methods and work-flow and b) to allow mixers created with 
earlier versions of SADiE to still work. 

Note that the Dither Plug-ins in the Process Window follow slightly different rules with respect to  

 Position in the signal path – this is where you routed them. 

 Dither Resolution – this is always at the master Output resolution. 

 

You should be aware that it’s possible to apply dither twice. Of course with the freedom of routing that’s 
always been possible, it’s just that now there are two different places to apply it – it’s your choice which tool 
you use. 

 

DIRECTX PLUGINS 

SADiE v5 software (running on the new PCM4 and PCM8 hardware platforms, and on the DSD8 running in 
PCM mode only), now has an improved method of managing and utilising DirectX-compliant audio processing 
Plugins. DirectX Plugins can now be loaded directly into the mixer strip for real-time playback (or non-real-
time bouncing through the mixer). 

There are an increasing number of PC-based Plugins available, some of excellent quality, some not so 
impressive, some costly to purchase, others available as freeware. This new architecture within SADiE gives 
you access to a great number and variety of audio processing modules, and of course the choice of Plugins is 
your own and will be determined by your applications' requirements. 

You will of course need to purchase Plugins should you wish to use them. Some may be available from SADiE 
dealers, others can be found for sale and download on the Web. 

You should be warned that the field of PC Plugins is rife with incompatibilities, and thus SADiE cannot 
guarantee that if you install any Plugin it will work with SADiE. The fact that a Plugin works fine with one 
application does not mean it will work with every application. Also it is fairly well known that "pirate" or 
"cracked" versions of some Plugins may exist, and you cannot assume that the cracked version of a Plugin is the 
same as the commercially available version, or that it will work as well. SADiE of course cannot condone the 
use of cracked Plugins, as we have a responsibility to all the other software developers working in this field. 

"Bad" and particularly "cracked" Plugins can cause performance problems on the PC, and so you do risk 
effecting SADiE's operation by loading unknown Plugins. 

Demo versions of Plugins can often be downloaded that may have some restrictions on use; a limited period of 
use is quite common, as is the idea of muting or corrupting the signal with bleeps periodically. Often demo 
Plugins may throw up "registration" dialogue boxes and warnings on loading, and these may appear invasive and 
cause certain operations to appear slow. There is nothing SADiE can do about this. 

On the positive side, SADiE has worked hard in conjunction with other developers to provide some 
recommended Plugins that work in a consistent and reliable fashion, and these can add a significant amount of 
extra flexibility to SADiE. 

The wide number of available Plugins includes those for: EQ, compression, multi-band compressors, limiters, 
reverb, pre-amps, vintage equipment emulation, microphone modellers, guitar amp emulation, flange, chorus, 
distortions, pitch shifters, harmonisers, vocal re-tuning, and more. There also exists a subset type of Plugin, 
which can emulate an instrument or synthesiser. These do not require audio input, but are driven by a MIDI 
input (which you would thus have to make available on the PC in order to use). 
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OPERATION WITH SADIE 

The Process Palette now has a new button labelled "DirectX", which, in the same way as with the EQ and 
dynamics blobs, you can drag and drop onto a mixer strip in the top grid area. On dragging and dropping, a 
"Select DirectX Process" window will pop up displaying a list of all available DirectX Plugins. Click on one to 
select it. A DirectX "Slot" will appear, displaying the Plugin's own interface. 

 Clicking on this button on the mixer strip also opens up the DirectX "Slot" which can be used to 
change the Plugin and will display the Plugin's own interface. 

There may be a small wait when you first load a Plugin. Sometimes they will validate a software protection 
mechanism when first loading. A few Plugins may have restricted usage, and may only allow a limited number of 
instances of the Plugins, but this mostly this isn't the case. 

Unlike with SADiE4's "routing" buttons, DirectX Plugins do not have to be routed. They sit in-line in the mixer 
strip in which they reside. Press play and you will immediately hear the effect (unless the process is flat or 
bypassed of course). Each DirectX slot and hence Plugin has it's own bypass button, although some may also 
have their own bypass. 

FAVOURITES 

If you have a particular Plugin that you use on a regular basis you can make it a "Favourite" Plugin so that it will 
appear at the top of your "Select DirectX Process" window. When you are displaying Plugin in its relevant 
"Slot", simply click on the "Make Favourite" Button at the top of the window, and this Plugin will appear as a 
Favourite at the top of your list, every time you select a DirectX Plugin. 

If you no longer wish a Plugin to appear as a Favourite, select it in the "Select DirectX Process" window and 
click on the "Remove Favourite" button. 

PC OPERATION AND PERFORMANCE 

DirectX is an architecture which works entirely under Windows, and hence uses the host computer to 
process the audio. Therefore the performance of the PC, and what other software is running on the PC will 
determine the performance of audio in the DirectX chains. This in turn may have a knock-on effect on SADiE's 
performance. The more Plugins you use, the more PC processing power you will require. Some Plugins can use 
significantly more processing power than others. 

CHAINING PLUGINS 

If there are a number of DirectX Plugins placed in one Mixer Strip, they will be sent in a single chain to the PC 
for processing. Therefore, four Plugins in one strip will use less resource (in terms of the PCI bus bandwidth) 
than four processes running in parallel on four separate strips. This is because in the latter scenario four times 
as much audio is being sent to the PC. If there are other SADiE native EQ's and Dynamics processors in the 
same Mixer strip, and even if the DirectX Plugins are interleaved with the native ones, the entire DirectX chain 
will sit at the beginning of the mixer strip chain. 

LATENCY AND BUFFERS 

Latency is a delay caused both by the action of sending digital audio from SADiE to the PC and back again, and 
also any internal processing delays inside the Plugin. SADiE has mechanisms for dealing with these delays. 

On a stream strip (one that feeds directly from the Playlist ), the DirectX "send and return" delay is 
automatically negated by advancing the Playlist entries by a fixed amount. There will be no change in the EDL 
itself, but the entries are advanced so that they return from the DirectX chain in correct sync. This does not 
accommodate the Plugin's own processing delay. In practice, many Plugins are latency-free. However, there are 
Plugins which deliberately produce delays (reverb and delays of course), and others which employ look-ahead 
techniques which need delays. Some processes may have delays caused by the amount of processing they 
require. 
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On non-stream strips, advancing of EDL entries is not possible (the flexibility of SADiE's mixer could for 
instance produce a stream that was feeding two different delays). Thus any strip can have a drop-in delay 
process, and the amount of advance can be selected during playback to "tune" the delay by ear if required. This 
delay can be "locked", partly for safeties sake. This delay WILL use memory resources in SADiE (and the bigger 
the delay, the more memory it uses). However if a stream strip is locked, then that delay will be added to any 
automatic compensation and will not use resources (it just advances the EDL entry playback further). 

There is a default setting for the "DirectX Buffering", in the DirectX section of the Setup Window. The default 
is 200ms. Some Plugins may require a larger buffer, perhaps 300ms, to operate correctly on some PC's, and so 
if a Plugin returns "DirectX too slow" on playback, it may be worth changing this setting. It will increase the 
overall latency (by this amount), but this is the figure that is used for the stream advancing to accommodate 
latency. 

PLUGIN ARCHITECTURES 

SADiE's DirectX support requires DirectX version 7 or 8. DirectX8 has the ability to support the automation 
of parameters (which is supported by some plugins). However this is not currently implemented in SADiE v5. 

SADiE runs on a PC platform and therefore cannot utilise TDM, RTAS, MAS or other Mac based Plugins.  

VST on PC is currently not supported. However, there exist a few DirectX "VST-Dx Wrapper" applications 
which can convert VST Plugins to make them look like DirectX Plugins. VST opens up yet another wide range 
of music Plugins for processing and MIDI instruments. These VST wrappers may operate in a number of styles. 
An amount of success has been had with the "Fxpansion VST-Dx Wrapper", available from www.fxpansion.com 
at a very reasonable price. Not every VST Plugin has worked under this scheme. However a large number have 
operated flawlessly. 

SAMPLE RATES 

The sample rates supported will be determined by the Plugin itself. The Waves Bundles for example 
(www.waves.com) have a number of Plugins that operate at all sample rates up to 192KHz. Read the Plugin's 
own documentation for details. 

MONO, STEREO, AND MULTICHANNEL 

Some Plugins can operate Mono to Mono, Stereo to Stereo, or Mono to Stereo. Many of the Waves Plugins 
offer a different module to handle each of the three variants. If a Plugin cannot support the channel format, 
SADiE will do its best to warn you when it loads. However this is only possible if the channel support is 
registered in the Plugin. Otherwise SADiE may give you a "playback error" if the channel format is incorrect.  

Some stereo Plugins are happy to run in mono, others less so. There seem not to be very many DirectX 
Plugins that support greater than 2 channels.  

PLUG-IN PRESETS 

Many Plugins come with their own mechanism for saving settings and are often bundled with presets. They may 
have their own facilities for saving and organising user presets. 

Where possible, SADiE will save the Plugins' parameter settings when the mixer is saved. Some Plugins may 
require some "customisation" to save settings. For instance Antares Autotune requires a registry change to 
enable saving of the Graphical mode "capture". 

SPECIFIC PLUGINS 

We are collecting more information about operation of specific Plugins as we test them and are made aware of 
them. We have concentrated first on Plugins that have a reputation for high quality or that perform unique or 
unusual tasks. Details of some of these follow. 

Waves 

Antares Autotune v3 
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VST PLUGINS 

SADiE 5 now also supports VST plugins. VST plugins are native plugins, running on the host PC, and follow a 
protocol designed by Steinberg Media Technologies. VST plugins are common on both the PC and Macintosh 
platforms. 

But from the user's point of view they behave much the same as DirectX plugins, except that in SADiE we have 
added the ability to record and replay parameter automation. 

As with DirectX, there is a button on the Process Pallette  which can be dragged and dropped into a 
mixer strip in the top grid area. 

A list box, similar to the DirectX list will appear, to allow you to choose a plug-in. As with DirectX there's a 
scheme for nominating "favourite" plugins whereby the favourites appear at the top of the list. 

In the usual way, clicking on the VST plugin's button in the top of the mixer strip opens its control page. Note 
that there is a setup option under DirectX to make VST and DirectX controls appear on screen with "always 
on top" set. 

FINDING VST PLUGINS 

VST plugins are not registered with Windows in the same way that DirectX are - they may be just a single DLL 
file, and have to be registered by the host application. SADiE registers VST plugins on start-up.  

If when the "Select VST process" dialog is called, this list is empty, you will need to tell SADiE in which 
directory to look for plugins. This is in the expected Setup page - View Menu; Setup Window; DirectX; VST 
Plugins Main Directory. SADiE will search this directory and any sub-directories for VST plugin DLLs.  

This defaults to C:\Program Files\Steinberg\VSTplugins - this directory would be present if you have any 
Steinberg products installed, however a number of VST plugins also default to installing into this directory. 

Ideally you should install all your VST plugins to a single directory (or sub-directories of this single directory) 
but SADiE allows you to specify a secondary directory to search for plugins. 

When you set or change these directories, SADiE will re-register VST plug-ins found in these locations. 

AUTOMATING VST PLUGINS 

All VST parameters can be automated, in much the same way that you would automate, for instance, a  SADiE 
EQ section. You can record parameters by touching and moving them with the mouse during playback. VST 
parameters can be recorded using Snapshot and Overwrite automation modes, with the new Automation 
Snapshot options in the Clip right-mouse-click menu, and the Camera snapshot button on each VST plug-ins 
top bar. 

Every parameter can be displayed (one by one) as a line on the clip, and this line can be edited using standard 
Automation Edit tools. The list of parameters will appear (when automation lines are set to display) in a drop-
down list when you right-mouse click over the Stream name buttons; select Automation Display; then select 
the plug-in name. Some plugins have a large number of automatable parameters. 

SADiE cannot re-colour the controls on the VST plugin, however a little LED on top bar of the VST plug-in will 
change colour when you touch a control to show you which automation mode you're in.  

Auto-return is near-instantaneous for VST parameters, and does not follow the normal Auto-return time. 

LATENCIES 

VST plugins in SADiE use the same buffer length as DirectX plugins (set in the DirectX Setup page). Latencies 
are accommodated in normal playback by means of automatic advancing and delaying inside SADiE - you don't 
normally have to worry about latency. However some process-intense VSTs may have latencies which exceed 
the capability of SADiE's means of accommodating latency and thus may cause delays. 

VST plug-ins (along with DirectX and all other plug-ins) can be disabled during Scrub - this is advisable as the 
latencies make scrub highly inaccurate. There is a Setup option under Setup / Mixer / Plugins / Bypass in scrub. 

WAVES PLUG-INS AS VST 

It is known that there are some difficulties with regard to VST versions with early Waves plug-ins. SADiE will 
operate well with v5 Waves plug-ins and higher. 
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Waves VST plug-ins may need to be reset on inserting them into the mixer - use the "Load" button inside the 
plug-in and use the "Full ... reset" option if necessary. 

Support for VST plug-ins is available as a software option - contact your dealer for details of how to obtain it. 

VST is a trademark of Steinberg Media Technologies GmbH. 

ROUTING 

DESCRIPTION OF MIXER ROUTING 

The default routing arrangement in SADiE will cover normal recording, editing and mixing tasks, but the system 
is very flexible and can provide many more facilities. 

Creating other routing arrangements is like making connections between the different items of equipment in a 
studio. 

Connections are made in two ways: 

1. By selecting from a list of possibilities for the inputs and outputs of Mixer strips and for the recording 
source for Playlist Streams. 

2. By using the Routing toolbar described below. 

The following diagram shows all the possible connections that can be made between the physical inputs, the 
Playlist, the Mixer strips, internals busses and the physical outputs. The Mixer's internal busses can be thought 
of as potential subgroups waiting to be used and will allow you to route signals through extra Mixer strips and 
thus to different parts of the system. 

PLAYLIST STREAM 

RECORD SOURCE 

Selection button 

on each Stream 

 

 MIXER STRIP INPUT 

Selection button 

on mixer strip 

 

 

 MIXER STRIP OUTPUT 

Selection button 

on mixer strip 

 

 

Physical Inputs 

Internal Busses 

Physical Outputs 

Other Streams 

 

 

Playlist Streams  

 

 

Physical Inputs  

Internal Busses  

 

 

 

Internal Busses 

Physical Outputs 

 
Clicking on the selection buttons gives you a pop-up list to select from. 

The common default routing arrangement in SADiE is to have Playlist Streams recording directly from the 
physical inputs and each Stream playing through a Mixer strip. These are then routed to two more strips, acting 
as master faders (via internal busses one and two), and then to the required outputs. In other words: 

INPUTS  PLAYLIST STREAMS' RECORD SOURCE (selected on the Stream record source buttons), and 
PLAYLIST STREAMS  MIXER STRIPS  INTERNAL BUSSES 1&2  "MASTER FADER" STRIPS  OUTPUTS 

For 8 streams, this is done as follows: 
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Mixer Strips Strip Input Strip Output 

1-8 Playlist Streams 1-8 Busses 1&2 

9 Bus 1 Physical Output 1 

10 Bus 2 Physical Output 2 

If you prefer, you can have a single stereo strip for the master fader instead of two mono strips. Merge them 
together by right-clicking over the left-hand one's fader. Repeat to separate again. 

Other arrangements can be achieved by using more internal busses. Selecting "New Bus" on any of the routing 
selection buttons creates a new, automatically numbered bus that can then be picked up by all other selection 
buttons. 

 
The routing toolbar is displayed by pressing the ROUTING button on the Mixer configuration 
toolbar. 

 

This displays the busses you are using. Double click to open up the 
folders for each type of bus. Double-clicking on stereo busses will reveal 
two mono busses. Double-click to close again. 

You can make routing connections from here by selecting a bus, hitting 
"load bus to cursor" (or by simply dragging with the mouse) and then 
"dropping" the other end of your imaginary patch cord on: a Mixer strip 
input or output button, a Process Window unit's input or output button, 
or a Stream record source button. Doing this with "New Bus" will 
create an automatically numbered new bus. 

Naturally, you can only connect stereo busses to stereo strips/Streams, 
and mono busses to mono strips/Streams. 

Now you may want more strips in your Mixer to accommodate the new busses. To add a new strip, drag 
across one of the following symbols from the Process Palette and drop it where you want to insert it. 

 Mono fader strip without pan pot. Output will be mono. 

 Mono fader strip with pan pot. Output will be stereo. 

 Stereo fader strip with balance (offset) control. Output will be stereo. 

To delete a whole strip, right-click near the fader. This also lets you change the fader's appearance. 

Here are some suggestions for routing arrangements.  
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SUGGESTED ROUTING ARRANGEMENTS 

EQUALISATION AND DYNAMICS ON RECORDING 

Instead of routing the physical inputs directly to the Playlist Streams for recording, you can route them via a 
Mixer strip. This allows you to apply EQ or Dynamics processing before the material is recorded onto the hard 
disk. The extra routing required would be: 

INPUT  NEW MIXER STRIP  NEW INTERNAL BUS  PLAYLIST RECORD STREAM  

BOUNCE-DOWN 

There may be times when you require more flexibility than the Bounce Window allows, and so routing can be 
set, with or without Processing and Automation to achieve this. 

To mix together and re-record selected Streams: 

REQUIRED PLAYLIST STREAMS  MIXER STRIPS  NEW INTERNAL BUS  RECORD STREAMS 

To bounce the whole Playlist, or soloed Streams: OUTPUTS  RECORD STREAMS 

SUB-GROUPING STREAMS FOR PROCESSING 

REQUIRED PLAYLIST STREAMS  MIXER STRIPS  NEW INTERNAL BUS  NEW MIXER STRIP (with 
processing)  INTERNAL BUSSES 1&2  MASTER FADER STRIPS  OUTPUTS 

EFFECTS SENDS AND RETURNS 

MIXER STRIP AUX SENDS  SPARE OUTPUT  EXTERNAL DEVICE  INPUT  NEW MIXER STRIP  
MONITORING OUTPUT 

Note that you do not have to have SADiE in record to monitor the effect return when it is routed like this. 

Or, if you want to record the effects return: 

MIXER STRIP AUX. SENDS  SPARE OUTPUT  EXTERNAL DEVICE  INPUT  NEW MIXER STRIP  
NEW INTERNAL BUS  RECORD STREAM 

Here's an example of a mixer with Aux Sends set up for routing through outboard equipment: 

 

This is a relatively minor 
customisation of a normal 8 into 
2 mixer. In this example it is 
assumed you want to patch in 
an external reverberation unit. 

To create this: 

 If the toolbars don't look quite like the picture, press: 

 
to show the output buttons, 

 
to show the mixer process slots, and 
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to show the process palette toolbar. 

 From the process palette, drag and drop a new  stereo fader onto the mixer (this is strip 1 in 
the picture) and an  Aux send onto each of the next two strips for Streams 1&2. 

 Press the output button on the new stereo fader and select Bus 1&2. 

 Press the Aux send button (it will say "Pre" at the moment and have a blue pot on it) on strip number 
2 (e.g. for stream 1) and the Mixer Strip will pop up, as in the picture (although the picture is 
displaying the mixer strip for strip 3). Press "Pre" and it will change to "Post" and press the button 
marked "Output 1" and change it to "Output 3". 

 Do the same for the next strip (strip 3 for stream 2), but this time choose "Output 4" (see note). 

 Connect up your reverb unit. Connect SADiE's outputs 3&4 to the inputs of the reverb, and connect 
the outputs of the reverb into SADiE's Input 1&2. Whether you do this as an analogue or digital 
connection will depend on your situation. If it is analogue then just check your Input source selection 
in Audio Settings. If it is digital then you will have to consider clocking (see note on clocking). 

Now, when you play SADiE, the Aux sends control how much of the signal on Playlist streams 1&2 are sent to 
the reverb, and the Fader on strip 1 controls how much reverb is returned into SADiE's mix. The last two 
strips of the mixer still control overall level because the reverb is fed back into the master bus (Bus 1&2).  

MIXER ROUTING TUTORIAL 

A mixer is a means of connecting many pieces of equipment and multiple channels of audio, and mixing them 
together to produce a stereo (or Multichannel depending on configuration) master that you can listen to, or 
record onto another piece of equipment. 

SADiE's mixing desk simulates a real mixing console, in the same way that the Playlist is simulating a multi-track 
tape recorder/player, and can be designed in a multitude of different ways. 

The vast majority of audio devices have Inputs and Outputs, and you are creating a continuous signal by passing 
the output of one device to the input of a second one. This next device processes the audio in some way 
(could be just level or pans or it could be more complex processing like reverb for instance) and then you 
connect the output of the second device to the input of a third and so on. 

Let's first consider the most basic setup, for instance you have a 4 track Playlist and you want to listen to all 4 
tracks, mixed together into one stereo output. 

You have 4 streams in the Playlist that must be connected via virtual "cables" to Outputs 1&2 so that you can 
listen to them. The concept of "busses" is perhaps one of the more difficult, but this is crucial to any 
understanding of mixer routing. You will use these as intermediate links to help connect everything together, 
and to allow us to use devices like pan pots. 

In the real world a bus is a long strip of copper cable that runs along the desk. When you connect signals to a 
bus, they are added together, and then you can take that single signal and pass it onto something else, a physical 
output for instance, or perhaps you would send them to a reverb unit or similar. 

So in your simple stereo setup you have 4 Playlist streams, each of which you connect with wire to a fader 
strip. The reason you are connecting them to a fader strip is to allow you to change the level of that stream, 
and also a pan pot on the strip allows you to feed some of each signal to the left side of your stereo image and 
some to the right. So each stream has now been converted, by the pan pot, into a stereo signal. 
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 Mono faders 

with pans 

Bus 1&2 

Stream 1  
 

Stream 2  
 

Stream 3  
 

Stream 4  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Output 1&2 

Now connect all 4 stereo signals together by means of the Bus. The left side of each pan pot is connected to 
this "copper cable" called Bus 1 and the right side to Bus 2. You could have connected them directly to the 
physical outputs and you would be able to hear the mix down in that way, but the reason for creating a Bus is 
so that you can put another fader between this Bus and the physical outputs in order to give a level control 
over the entire mix. 

In SADiE you can ignore the connecting cables, but you have to decide where the input and output of every 
device is coming from and going to respectively. 

So your basic mixer described above, with all the buttons showing, looks like this: 

 
NOTE: If you are changing the routing of your mixer, it is important to view the Output Bus buttons; 
these are revealed by pressing the button on the toolbar that is third from the top in the picture above 
(the one with OUT and a bus on it). If you cannot see this, the issue will be confused even further. 

The important buttons here are the two rows labelled: 

1 2 3 4 Bus 1&2 

Bus 1&2, Bus 1&2, Bus 1&2, Bus 1&2, o/p 1&2 
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These two rows are respectively, the "Input Bus Buttons" and the "Output Bus Buttons" and are used to select 
input and output for each fader strip. Press the button and select from the drop down list to change the 
selection. 

From the left, you have 4 mono faders, each with a pan pot. The inputs of these faders are named 1,2,3,4 and 
these are names of the Playlist streams. The outputs of these first 4 faders are all going to Bus 1&2. 

The last fader on the mixer (the yellow one) is your master level control. This is gathering up everything that is 
appearing on Bus 1&2 and sending them, via the fader, to the outside world by using Output 1&2. So it takes its 
input from Bus 1&2, and its output is set to Outputs 1&2 (labelled o/p 1&2). 

The next stage might involve introducing a plug-in into your mixer. For this example you'll put a Stereo Width 
process in the chain, although this routing method could easily apply to any stereo plug-in. 

You are going to break the chain in the first example, between Bus 1&2 and the master fader and slot the Plug-
in in between. Thus Bus 1&2 are now going to be connected to the input of the Plug-in, and then to complete 
the chain again, you're going to connect the output of the Plug-in back onto the input of the master fader. 

 
Open up the Process "Rack" by clicking on the PROCESS WINDOW button. 

 
An empty 19" rack unit will appear, and you can drag the appropriate icon (STEREO WIDTH in 
this case) from the toolbar onto the empty rack. 

It will look a little like this: 

 
When the Plug-in is first dragged onto the rack, the routing buttons on the left hand side of the Plug-in will say 
(for its input) "Stereo Width 1 In" and (for its output) "Stereo Width 1 Out". These are names of the new 
busses that the Plug-in has created in order to connect it up. In this example you won't use "Stereo Width 1 
In", because you are going to connect Bus 1&2 directly to the Plug-in (and thus all 4 streams will be going 
through the Plug-in and being processed for width). 

So, click on the top, input bus button for the Plug-in and select Bus 1&2, leave the bottom output button as it 
is. You now have to connect the output of the Plug-in back into the mixer. Go back to the main mixer, and 
click on the top button on the yellow master fader, selecting "Stereo Width 1 Out" as per the picture above. 
Done! 

Your routing diagram now looks like this: 
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As you can imagine this routing allows for many, many complex possibilities, and it does require some care if 
your mixer is going to include a number of different plug-ins operating on a number of different streams of 
audio. When you have built a mixer that you feel you'll want to use again, then you may want to save it as a 
Template. The whole purpose of a mixing desk is to provide these complex interconnections, but the 
fundamental concepts are: 

 A device's output connects to another device's input. 

 Busses provide a means of adding signals together and routing them onto another area of the mixer. 

 In SADiE terms a fader or plug-in's input can be from a Stream, Bus or Physical Input, and its output 
can be a Bus or a physical Output. 

 An audio signal must eventually make its way to a physical output. Just follow the signal path through 
all its routes if you're seeing error messages.  

REORGANISING THE MIXER 

REORGANISING THE MIXER 

You may find the mixer can get cumbersome and take up too much screen space, or perhaps you would like to 
change the order of your faders so as move related strips closer together. 

It is possible to change the layout of your mixer on the screen, in three different ways: 

1. Dragging and dropping faders to move them to another position. 

2. Hiding strips that are not in permanent use. 

3. Minimising faders to make them smaller.  

CHANGING THE ORDER OF MIXER STRIPS 

To move a fader strip to a different position in the mixer . just click in any area of the strip, holding the mouse 
button down, and drop it in a new position. 

The easiest point to pick it up is on the PPM meter, as most strips have an active area surrounding the fader 
itself. 

 
When you've "caught" the strip, the cursor will change as shown, and if you drop it over the left side 
of another fader, it will dock to the left, or on the right side, it will dock right side of that strip. 

 
If you drag it off the edge of the mixer, the cursor will change to look like a waste bucket, and 
dropping it then will delete the strip. 
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The strip movements, as with any other reorganisation of the mixer can be "undone", with the Edit menu undo 
function.  

HIDING AND REVEALING STRIPS 

 
Clicking with the right mouse button on any part of the strip will bring up strip menus, which have hiding 
options appropriate to that strip: "Hide strip" or "Reveal hidden strip?", and "Minimise Strip" or "Maximise 
Strip" (described below). 

When a strip is hidden the line between strips is darker, and strips either side will have the "Reveal hidden 
strip" right mouse menu option. 

You can reveal strips, one at a time by selecting this menu option. 

You can "Reveal all hidden strips" by right mouse clicking on the mixer unit divider bar to the left of each mixer 
unit; this is the bar with "Audio unit A" written vertically up the screen. 

Double-clicking on the mixer divider bar will hide and reveal the whole mixer unit.  

MINIMISING AND MAXIMISING STRIPS 

 
Right mouse clicking on a strip will offer either: 

 "Minimise strip" as you can see in the picture above, or 

 "Maximise strip" to return the strip to its normal size. 
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A minimised strip shows as much information as possible in the limited space (you will notice there isn't room 
for pan-pots. You can minimise and maximise strips individually, or again by right mouse clicking on the mixer 
divider bar.  

THE PROCESS WINDOW AND PLUGINS 

THE PROCESS WINDOW 

 
The PROCESS WINDOW button on the Mixer configuration toolbar brings up a Process 
Window, which is effectively an outboard rack of stereo processing units. Each of these is 
represented by a symbol at the top left that you drag into the empty rack space. 

When a process unit is in the rack, stereo internal Busses named after it will be created. These are normally 
connected to its input and output. You can then patch signals to and from these busses (as described in the 
Routing section above) to route them through the process. 

Each unit also has input and output selection buttons, normally connected to the busses named after the 
process. However, you can use the buttons to connect signals from SADiE's physical inputs, outputs and other 
busses directly to and from the process without going through the Mixer. If you do this, of course, you must 
remember that the Mixer busses named after the process are no longer connected to it! 

To remove a process unit from the rack, right-click in a blank, grey area of the unit. 

A number of processes are available. Some are provided free of charge, but other third-party plug-ins can be 
purchased. Contact your dealer for availability and pricing. 

PLUGINS 

PLUGINS 

 

Online Processes: 

 Dither 

 Reverb 

 Stereo Width 

 Mastering Limiter 

 Graphical Equalisation 

 HiDither 96 

 POW-r 

Non 1-1 Processes 

 Sample Rate Converter 

 Resampler 

 Timemod 

CEDAR Sound Restoration Tools: 

 CEDAR DeClick 

 CEDAR DeThump 

 CEDAR DeCrackle 

 CEDAR DeNoise 

 CEDAR Retouch 

Demo Plug-ins 

Offline Processing 

To enable any of the on-line processes, drag the appropriate icon onto the "19 inch rack" and patch it into the 
mixer using the busses. 

The Offline Processes mentioned operate in a different way, using the Offline Processing Window to "bounce" 
audio in non-real-time. 
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DITHER, REVERB, AND STEREO WIDTH 

 

 
DITHER offers three different types of dither. As an alternative to the Process Window, Dither can 
be applied in the Dither Window. 

 
REVERB has buttons for room size plus controllable Pre-delay, Reverb time, Absorption, Brightness 
and Mix (of input signal and "wet" processed signal) 

 
STEREO WIDTH has a single width control 

There are of course a number of ways to connect up these effects. For instance with the reverb you may want 
to set up AUX sends on the mixer strips, routed to bus "ReverbIn", and then drag a new stereo strip to route 
the "ReverbOut" bus back to the main bus. In this case you would probably need the reverb "Mix" control set 
to 100%. However, Dither is perhaps more appropriate applied "in-line" between the main bus and the output. 
The choice is yours! 

Note that these three plug-ins are stereo processes. The settings of each of these can be saved and re-called 
and a later date, using the "disc" icons.  

MASTERING LIMITER 

 
The Mastering Limiter plug-in allows you to add gain to a signal before it is limited to a set level. You can define 
the limiting in -dBFS to avoid overloads. The Limiter enables the audio material to achieve "loudness" while 
avoiding digital clipping. This is achieved by analysing the waveform on either side of a peak and reducing the 
gain to avoid distortion. 

As with other normal plug-ins, this module patches into the mixing desk via the internal busses. There is an 
"LED" array that displays the amount of gain reduction. 

There are two icons for the Mastering Limiter in the process window: one creates a mono process, the other 
is stereo. 

 Gain - adjust this to add pre-gain to the signal to "push" it into the limiter. 

 Limit - sets the maximum peak level. 

 Release - sets the release time for the gain reduction. 
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 Impact - sets the rate of change of gain reduction. This is a little like the more familiar attack function 
but on a microscopic scale. A sound with a fast attack (say, a piano) would require a high impact 
setting, as the transient nature of the sound would need the gain reduction to react very quickly, 
whereas a smoother sound would benefit from a lower, more damped setting. 

 Hysteresis - increasing the value of this reduces the sensitivity of the process to avoid the limiter being 
triggered by high transient, low level, gain changes. Note that the range of this control is reduced as 
you increase the gain. 

Note that because this process performs some analysis on the audio waveform, there is a delay of 50 ms: the 
process must receive some audio before it can start calculating. 

The Mastering Limiter is an optional plug-in, contact your dealer for details of how to obtain it.  

GRAPHICAL EQ 

 
The Graphical EQ is an all-in-one unit comprising 4 individual parametric EQ modules, low pass and high pass 
filters, master gain, along with a graphical display of the EQ curve. 

This routes into the mixer in the usual way, using the internal busses. 

The four EQ's and high/low pass filters operate in the same way as a normal SADiE EQ process. 

The green "LED" bypasses the associated EQ section, without affecting the graphical representation. 

The CONFIGURE button allows you to choose the function of the 4 EQ's, between high or low shelf, or 
bandpass, and how many are enabled. 

There are 4 presets for changing the scaling of the graph where greater precision is required. 

The CONFIGURE page also contains a preset for de-emphasis. You can save and reload settings for the 
Graphical EQ using the usual Plug-in save and load buttons. 

The Graphical EQ is an optional plug-in, contact your dealer for details of how to obtain it.  

HIDITHER 96 
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When a signal is quantised some of the detail within the signal is discarded and as a result an error is 
introduced. This error can be heard as noise and is correlated to the input of the quantiser. The noise signal 
can be very noticeable to a listener if the original signal is simple or of a low level. It is therefore desirable to 
try and reduce this correlation and subsequently produce a random noise signal. The use of dither does just 
that. It linearises the non-linear transform characteristic of a quantiser and reduces the harmonic distortion for 
low-level signals. To summarise, the use of dither has two effects on the input signal to a quantiser; firstly it 
reduces the correlation between the noise and the input signal, and secondly it increases the total noise in the 
system. In essence, dither is a low level additive signal that causes the quantised signal to jump randomly 
between quantisation levels, which when averaged by the ear forms a smooth transition between the levels. 

As the noise level has been raised by the addition of a dither signal, it is desirable to try and shape the noise to 
reduce the overall audible effect. Noise shaping filters are used to match the curve of the noise signal to that of 
the frequency response of the human ear. This reduces the noise signal where the ear is most sensitive, 
(between 1 kHz and 8 kHz) and increases the noise where the ear is less sensitive (above about 14 kHz). An 
average response is taken for the human ear and so the effect of noise shaping will be slightly different for each 
listener. When using a high sample rate, for example 96 kHz, (if your hardware supports 96 KHz) it is possible 
to keep the noise floor lower for most of the human hearing range and move most of the noise signal to 
frequencies that are completely inaudible. 

SADiE's HiDither 96 noise-shaping dither plug-in offers 5 different noise shape types, two of which are 
optimised for 96 kHz audio material. The other three are designed for 48 kHz and 44.1 kHz audio. Additionally 
Shape 1 is designed for use with emphasis. 

On the pages that follow are the plots for a -90 dB sine wave at 1 kHz passed through the different HiDither 
algorithms. The graphs for 48 kHz will be slightly different as HiDither uses slightly different filters; you can see 
the graph change in SADiE when you change sample rate. 

NOTE: Shape 1 is designed to be used in conjunction with emphasis on the audio signal. This shape 
boosts the dither noise, in such a way that when de-emphasis is applied (for instance by the CD player) 
both the signal and the dither signal are de-coded. Therefore it is inadvisable to use this shape unless 
you are using pre-emphasised audio. 

HiDither 96 is an optional plug-in, contact your dealer for details of how to obtain it. 

GRAPHS 

A 1 kHz sine wave, at -90 dB, with no dither 

A 1 kHz sine wave, at -90 dB, with high pass triangular dither 

using noise shape 1 at 44.1 kHz 

using noise shape 2 at 44.1 kHz 

using noise shape 3 at 44.1 kHz 

using noise shape 4 at 44.1 kHz 

using noise shape 1 (for high sample rates) at 96 kHz 

using noise shape 2 (for high sample rates) at 96 kHz  

POW-R 

 
POW-r (an acronym for Psychoacoustically Optimised Wordlength Reduction) is used to reduce longer word 
lengths to standard 16 bits, while retaining a high degree of perceived dynamic efficiency and very low noise. 

POW-r can operate at sample rates between 44.1 kHz and 192 kHz (if your hardware supports higher than 48 
kHz sample rates). 

The three POW-r algorithms are available in the SADiE plug-in, chosen by ticking the appropriate box. 
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Additionally the "Auto Zero" function is provided. At 16 bit resolution, when the input drops below -84 dBFS 
POW-r will turn off and output silence after about 1.5 seconds. It will then come on again as soon as the level 
comes back up above -84 dBFS. This is resolution dependant; -84 dB is the threshold for 16 bit. At other 
resolutions, Autoblack switches in when the signal drops to below 2 bits.  

NON 1-1 PROCESSES 

Non one-to-one plug-in processes (or Non 1-1 as we shall call them) are so-called because the result of the 
process is a different length (in terms of time) from the input. 

As a general rule these are not routed in the same way as normal plug-ins. You will notice that they have no 
bus buttons to allow this. 

Instead, when you drag and drop a Non 1-1 process into the "rack", the process will take effect across all 
outputs. So all playback (real-time or non-real-time), will pass through the process 

These are mostly fairly DSP intensive processes, and so only one Non 1-1 plug-in can be used at a time. 

There are different qualities available on some Non 1-1 processes. A lower quality process will use less DSP 
power, and hence you will be able to playback more audio in real time through the process. But for the highest 
quality result, it is usually necessary to bounce the result back to hard disc in non-real-time, using the Bounce 
Window. Because the Bounce Window always re-records an Output, any bounce with a Non 1-1 process 
plugged in will include the Non 1-1.  

SAMPLE RATE CONVERTER 

 
The Sample Rate Converter or SRC is a Non 1-1 process with presets to convert audio from one of SADiE's 
standard sample rates to any other. 

The five normal sample rates have a button each, and the 2x and 4x buttons enables the double and quadruple 
sample rates for 88.2/96 KHz rates and 176.4/192 KHz (if your hardware supports these higher sample rates). 

The Audition quality is the most likely to be playable in real-time. The High quality is often sufficient for most 
high-quality applications. 

See Sample Rate Conversion for a step-by-step procedure of how to perform a Sample Rate Conversion. 

There also details of Audio Precision tests for the Sample Rate Converter.  

RESAMPLER 

 
The Resampler Non 1-1 process uses the same algorithms as the Sample Rate Converter above, but has a 
different interface for setting the rate change. The Resampler performs a digital Varispeed, changing both length 
(in terms of time) and pitch. 

All of the controls are linked and provide different methods of setting this change. 

 Speed Adjust - allows you to type in the percentage change. 

 Semitones - allows you to type in the pitch change you are trying to achieve. 

 4 Presets - automatically sets the resample for 24 to 25 frame conversion, 25-24 etc. 
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 In and Out Length - the In length is the total length of the Selected entries (in red) in the current EDL 
. You can type the new total length for these entries in the Out Length time field. 

 Quality - as with the SRC, the Audition quality is the most likely to work in real-time, but you may 
want to use a higher quality setting for more critical work.  

TIMEMOD 

 
The Timemod Non 1-1 process performs a change to the length (in terms of time) without changing pitch. 

As with the Resampler, the controls are linked and provide you with different ways of setting the length 
change. 

 Ratio - allows you to type in the percentage length change. 

 4 Presets - automatically sets Timemod for 24 to 25 frame conversion, 25-24 etc. 

 In and Out Length - the In length is the total length of the Selected entries (in red) in the current EDL 
. You can type the new total length for these entries in the Out Length time field. 

 Quality - the Timemod quality settings refer to the frequency range that the signal analysis is carried 
out on. The only practical effect is on the low frequencies, e.g. low frequency signals are less affected 
when using higher quality settings. The "voice" setting just analyses the signal within the limited 
bandwidth that speech signals occur. 

NOTE: the Timemod algorithm has been designed to work with only 16 bit audio and Standard sample rates 
(e.g. 48 kHz, 44.1 kHz and not 96 kHz).  

OFFLINE PROCESSING 

 
The Offline Processing Window (available by pressing the button on the Playlist toolbar, or by 
selecting it from the View menu) provides a way of "Bouncing" audio through an offline CEDAR 
process. 

You operate this window in a similar way to the normal Bounce process: select some audio in the Playlist, open 
the Offline Processing window, and after the process has been performed the new audio will be added to the 
Playlist. 

For details of how to operate specific Offline Processes please refer to the following: 

CEDAR Auto DeClick 

CEDAR DeCrackle 

CEDAR SOUND RESTORATION 

 
SADiE has a full suite of optional plug-ins for Sound Restoration that have been designed by CEDAR Audio 
Limited of Cambridge, who are world-leaders in Sound Restoration technology. 

This section of the manual contains brief discussions on operation of the CEDAR plug-ins within SADiE, but for 
more background information on Sound Restoration processes and the methods used by the CEDAR plug-ins, 
we suggest you take a look at CEDAR Audio's web site. 

The different processes available in SADiE are designed to work by methods that are appropriate to the 
process being performed: some are fully automatic and "off line", others can be operated and adjusted in real-
time. 
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As of SADiE v5.4, all the Cedar processes can process multi-channel audio. 

The CEDAR plug-ins that are currently available for SADiE are: 

DECLICK 

DeClick allows two differing "off line" or "non-real-time" methods for removing clicks, can perform at high 
speed without sacrificing CEDAR quality, and addresses the widest possible range of scratch and click removal 
problems. 

Auto DeClick allows the user to process part or all of an entire Playlist as an Offline process. Remarkably, 
there is no need for user-controls, and the automatic process will cope with even the most severely damaged 
audio. Auto-DeClick uses CEDAR's sophisticated click detector to detect the click, then removes and replaces 
it with an interpolation based on the surrounding few milliseconds of audio. This process is completely 
automatic. The speed of auto-DeClick processing will depend on the specification of your PC. 

Manual DeClick is a similar process, however this is optimised for longer clicks than can be recovered by the 
automatic process, and allows the user to identify the click first. Manual DeClick incorporates a CEDAR 
algorithm capable of restoring clicks and other problems (such as drop-outs and digital errors) of durations up 
to 2,000 samples. It uses SADiE's region editing feature to highlight the damaged audio, and is particularly 
suitable for repairing optical soundtracks. 

CEDAR's interpolator is based on the technique of signal modelling. By analysing the signal over a region of 
several milliseconds it can build a model of the underlying resonant signal (such as music or speech) and then 
use the information to replace each click with an interpolation that fits this resonant model. 

DETHUMP 

Thumps are lower frequency non-musical sounds that are often encountered during the DeClicking process, 
and cannot be corrected by any of the normal DeClick methods. Unlike ticks, clicks, and scratches, these often 
retain real signal information throughout their durations, and a suitable algorithm can use this to interpolate 
extreme lengths of damaged signal. 

SADiE's DeThump is the only process of this nature. Like Manual DeClick, this requires that you mark the start 
and end points of the problem using the waveform display. You can then invoke DeThump to remove the 
damaged signal and replace it with an interpolation based on the retained good information within the thump, 
plus information within the surrounding, undamaged signal. 

DeThump can analyse and restore a damaged signal of up to 50,000 samples (approximately one second) 
duration. 

This makes DeThump the world's best tool for removing many of the previously intractable problems 
associated with optical soundtracks, as well as for restoring damaged cylinders and discs. For modern material, 
DeThump will cure microphone thumps and remove many other low-frequency disturbances within the signal. 

DECRACKLE 

The term "crackle removal" is slightly misleading because the CEDAR crackle removal algorithms remove a 
range of high density, small amplitude, short duration, and additive impulsive disturbances. These can cause a 
variety of degradations with differently perceived sounds. Crackle is frequently confused with clicks and ticks. 
This is not surprising, given that it too comprises many short-duration impulsive signal disturbances. 

CEDAR DeCrackle is automatic, much like Auto DeClick, and operates as an "Offline" and "non-real-time" 
process. 

DENOISE 

CEDAR DeNoise is a sophisticated process that uses an enhanced version of spectral subtraction to identify 
and remove broadband noise from recordings. 

The user can snapshot the noise "fingerprint" and use this curve with other controls to manipulate DeNoise in 
real-time which means that you can audition the results while the audio is playing. This makes the process quick 
and simple, and helps to ensure that you achieve high quality results every time. When you are satisfied with 
the results, you can use SADiE's bounce function to re-record the DeNoised result, in non-real-time. 
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Users can also manipulate this noise reduction "fingerprint" curve using the mouse, and this makes DeNoise 
particularly versatile; suitable for restoring vintage soundtracks and 78 rpm discs (which have highly coloured 
noise spectra) as well as modern recordings on good quality media. 

RETOUCH 

Retouch offers tools that localise unwanted sounds accurately in both time and frequency. Once identified, 
those sounds (whether tonal or broadband noise) are replaced with audio derived from the surrounding, good 
signal. All other audio remains untouched. 

WHICH ORDER? 

The order in which restoration processes are carried out makes a great deal of difference to the quality of the 
result. The correct sequence is DeClick, DeThump, DeCrackle and lastly DeNoise. This is because large clicks 
make it difficult for the DeCrackle process to identify and remove the tiny clicks and crackles that constitute 
surface noise, buzz, and other such problems. Furthermore, if clicks are presented to any DeNoise process 
they confuse it and create unmusical side-effects. Conversely, denoising first will make it almost impossible to 
identify and remove clicks and scratches at a later time. 

De-Crackling should be the second process because small crackles will also cause problems for DeNoise. 
Consequently, DeNoise should always be the final process in the restoration chain. 

The CEDAR Audio DeClick, DeThump, DeCrackle and DeNoise modules are third party plugins - contact 
your dealer for details of how to obtain them. They are available as individual plug-ins or as combined packages.  

AUTO DECLICK 

Auto DeClick uses Offline Processing (a function that is similar to Bounce) e.g. audio is re-recorded but instead 
of using the mixer and inline or plug-in processing, it uses a user-selectable process during the re-recording. 

The procedure is similar to bounce: 

 Select the audio that you want to process, e.g. the "Source" for the bounce. 

 Tell SADiE what you want to do with the finished result of the bounce, e.g. select the "Destination" 
for the bounce. 

 Press START and SADiE performs the action, the result is as you specified in "Destination". 

EXAMPLE: 

Let's assume you have a recording in the Playlist recorded from a scratched record. 

1. Select the audio that needs to be sent to the DeClick process. You can do this by any of the usual 
methods allowed by bounce: 

i. Complete EDL - the whole EDL will be processed. Make sure there are no clips hiding 
several hours down the Playlist otherwise the bounce will take hours! 

ii. Selected Clip (s) - you select EDL entries in red to be processed. 

iii. Selected Streams - enable the streams containing the audio, disable all the others. 

iv. Between L-R Locators - use Region Editing to define the region of the Clip(s) to be 
processed. 

For the sake of this example, and because you'll need Region Editing to use Manual DeClick, the last 
method will be described, although you may find the other methods more appropriate. In practise 
you're likely to be doing the restoration before any editing has taken place and so Selected Clips may 
be fine; just click on the clip you're going to DeClick. The region edit method gives you the advantage 
of being able to quickly top and tail the material before processing and hence you don't waste time 
processing audio that you're going to throw away immediately. 

2. Turn on Region Editing. 
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If this toolbar does not appear on the screen (on the Playlist window or floating), then you need to go 
to the "View" menu, select "Toolbars", then "Playlist", then "Region Editing" to display this. Then press 
the left-most button as shown above. 

3. Now, when your mouse is hovering over the Playlist, the cursor is shown as a  pencil. Click where 
you want the region to start, and drag the mouse leftwards, and let go of the mouse when you reach 
the end, the region will be defined in red. You can now fine tune the beginning and end to suit, by 
moving the mouse cursor over the beginning or end of the region and dragging with the left mouse 
button pressed. 
 

 
4. Enable the streams you wish to De-click by using the stream enable buttons - enabled streams are 

displayed with a pale grey background and will be processed, disabled ones appear with a dark grey 
background and will not. See Enabling and Disabling Streams in the "Arranging an EDL"  chapter for 
more detail. 

5.  
When you're happy that you've selected the right sections of audio, press the OFFLINE 
PROCESSING button or the Playlist toolbar, or alternatively go to the "View" menu again, 
this time select "Offline Processing". (If "Offline Processing" is grey then DeClick is not 
correctly installed.). This window will appear: 
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5. From the top, check that the settings here are correct: 

i. Track - Track name for the new recording (Autotake on if you wish) 

ii. Source - For this example select "Between L-R Locators" 

iii. Source Output - Select the output(s) that the clips are currently playing back through. In this 
example the clips should all be on stream 1&2 (or just 1 if it is mono). If the source clips are 
part of a multi-track EDL, and if you're using Region Editing to define the source, you should 
enable only the streams that the source material is on, and disable all others. 

iv. Destination - "Stream" will be ticked. Here you can select where the DeClicked result will 
end up. In this example, you'll tick "Replace source clips." and leave stream 1&2 selected so 
that the new clip replaces the old one. However you may choose to untick "Replace..." and 
put the new clip onto stream 3&4 so that you have both original and processed clips side by 
side in the EDL. 

v. Bounce in non-real-time - This will be handled automatically, and so you won't need to touch 
this. 

vi. Auto DeClick - This section is different to the normal bounce. Select this from the drop-
down list of Offline processes. 

When you're happy that these settings are correct, press "Accept". Note that the Offline Processing window, 
like the Bounce window, is "exclusive" and so you won't be able to click the mouse anywhere else in the 
program while this is open. If you do want to re-adjust the region, then press "Close" on the Offline Processing 
window first. 

The Auto DeClick will proceed, the bottom section of Offline Processing reporting the progress. "Pre-
processing" is loading up the source, "Processing" is the actual DeClick working, and "Post-Processing" is 
returning the new audio to the specified destination in the EDL. The speed of operation will be affected by the 
performance of your PC, and its own disk drive. 
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When "Post-Processing" reaches 100%, the new recording will be put into the EDL in the streams previously 
occupied by the original material, and you can play it back to listen to the splendid results of the DeClick 
process. You may have seen some warnings as the Auto DeClick progressed; a fairly common one is "This 
track contains one or more clicks too long for Auto DeClick to repair. Try using Manual DeClick on them. If 
you get this message then take its advice; Manual DeClick will handle much longer clicks and so may do the 
trick.  

MANUAL DECLICK 

Manual DeClick is initiated by a similar method to Auto DeClick, however it must be stressed that Manual 
DeClick uses a completely different algorithm to process the clicks to the Auto process. With Manual DeClick, 
the user defines the click, and so Manual DeClick processes the whole region selected. Manual DeClick can 
work with clicks up to 2000 samples long. 

EXAMPLE: 

1. Find the click by eye and ear while playing or scrubbing the EDL * 

2. Enter Region Editing, and draw across the click with the  pencil tool as above, except this time the 
area you're highlighting will be much shorter. 

 
To zoom in quickly on the click, press the ZOOM IN ON REGION button on the region 
editing toolbar. 

3. It may be necessary to repeatedly draw across the click and press this zoom button to zoom right in 
onto the click.  
 
If this is multi-track material, be sure to enable streams that you wish to de-click, and to disable any 
streams containing audio that you do not want to de-click. 

 
Try using Hotkeys for this (the default Hotkey for this is Shift + Z). The sequence "Hotkey, 
draw, Hotkey, draw etc." helps you zoom in much quicker than repeatedly pressing the 
normal zoom buttons. 

3.  
When you're satisfied that the click is highlighted (you can audibly check the region by using 
the preview buttons on the region editing toolbar), press the DeClick button, again on the 
region editing toolbar. 
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A message as shown above will appear on the screen briefly, and then when it disappears, the region 
will be replaced by a new DeClicked region. When you zoom out a little (Hint: try Shift + X - this is 
"Zoom to region start" and will zoom the Playlist out to a preset zoom level which you can set for 
yourself in the Playlist Display section of the Setup Window) you will see that a larger area has been 
replaced. Manual DeClick always replaces with a clip around 8000 samples long, although only the 
centre region will be DeClicked. 

NOTE: If there are repeated instances of DeClicked areas very close together in your Playlist, 
then you may find that your hardware may not be able to play them. An error message may be 
"SADiE cannot play this EDL because there is not enough DSP memory available". To resolve this 
you will have to re-bounce all the little clips together to create one longer section. It is advised 
that you choose a region (L-R locators) as the source for this "consolidation" bounce. The 
Manual DeClick process gives its replacement clips zero length crossfades, and so if you wish to 
bounce Selected Clips, you would have to set your default crossfade to zero to avoid changing 
the crossfade. If you bounce a region, all this is taken care of. 

It is important to recognise the difference between the Manual and Automatic DeClick processes; with Manual 
DeClick the user identifies the click, and thus if you include areas with no click in your region, they will be 
processed as if they are clicking. An artefact of this is a possible drop in level if you DeClick a long region 
where no click exists. So it is important with Manual DeClick to select only the click and no extra audio on 
either side. 

* You may find that your scrub settings are not appropriate for such fine detail scrubbing, either with the 
mouse or the Hardware controller, because the default settings are more general-purpose. If you open the 
Setup Window (View menu), and double click on Transport Controls on the left side to open Scrub Setup (for 
mouse) or Scrub Wheel (for Hardware controller), there are some parameters that can be adjusted to give 
you tighter control.  
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DETHUMP 

WHAT ARE THUMPS? 

Thumps are non-musical low frequency sounds. They are often caused by large clicks or discontinuities that 
induce low frequency resonances in the record or playback mechanism. 

RESTORING THUMPS 

The CEDAR DeThump process doesn't just remove the thump, it replaces it with an estimate of the signal's 
low frequency content derived from the surrounding audio. This ensures that there is no audible low-frequency 
dropout such as would be caused by punching in a high pass filter. 

PROCEDURE 

The method for using DeThump is more or less identical to that for Manual DeClick; read the DeClick 
example first. 

1. Find the thump. Use a combination of the scrub control and the waveform display to try to locate the 
thump. Normally the thump can be made clearly visible in the waveform display by using the 
magnification buttons. 

2. Manual DeClick any HF transient at the start of the thump. Most thumps have a large impulsive 
discontinuity at the start of the thump. You should first remove this using CEDAR manual DeClick. 

3. Set your Left and Right locators around the thump. Use the region editing tools to set the start and 
end points of the thump. You will probably need to extend the end locator beyond the visible end of 
the thump to make sure that you capture the oscillation decay. (You can hear this decay even if you 
can't see it on the display.) Experience will dictate how far to extend the position of this locator. 

4.  
Invoke DeThump. Click on the DeThump button on the Region editing toolbar. 

5. Set the cycles parameter. You now have to estimate how many cycles of the thump occur in the 
marked region. This gives the algorithm an estimate of the thump's fundamental oscillation frequency. 

NOTE: Because thumps are long there is a great deal of signal information lost, and DeThump will 
be unable to replace the thump with a perfect estimate of the missing signal. This effect is especially 
true at higher frequencies. As a consequence of this, it is vital that the cycles parameter is set as 
low as possible (subject, of course, to the thump being satisfactorily removed). If the cycles 
parameter is set to too high, DeThump will assume more signal destruction than has, in fact, 
occurred. It will then inappropriately replace good HF signal. 

6. Click on "Ok". The thump removal should take between 15 seconds and 2 minutes depending on PC 
performance and thump length. Not quite enough time to make a cup of tea. 

The progress window has an Abort button to terminate the processing should you wish to do so. 

7. As with DeClick process, SADiE will replace the DeThumped clip along with a handle either side. 

DETHUMP SPECIFICATIONS: 

Minimum thump length: 100 samples 

Maximum thump length: 50,000 samples 

Sample rates supported: 44.1 kHz and 48 kHz 

Minimum number of cycles: 1.00 

Maximum number of cycles: 99.99 
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DECRACKLE 

Operation of DeCrackle is identical to that of Auto DeClick. DeCrackle uses Offline Processing (a function 
similar to Bounce) e.g. audio is re-recorded but instead of using the mixer and inline or plug-in processing, it 
uses a user-selectable process during the re-recording. 

Therefore the procedure is similar to bounce: 

 Select the audio that you want to process, e.g. the "Source" for the bounce. 

 Tell SADiE what you want to do with the finished result of the bounce, e.g. select the "Destination" 
for the bounce. 

 Press "Start" and SADiE performs the action, the result is as you specified in "Destination". 

EXAMPLE: 

Let's assume you have a recording in the Playlist recorded from a scratched record. 

1. Select the audio that needs to be sent to the DeCrackle process. You can do this by any of the usual 
methods allowed by bounce: 

i. Complete EDL - the whole EDL will be processed. Make sure there are no clips hiding 
several hours down the Playlist otherwise the bounce will take hours! 

ii. Selected Clip (s) - you select EDL entries in red to be processed. 

iii. Selected Streams - enable the streams containing the audio, disable all the others. 

iv. Between L-R Locators - use Region Editing to define the region of the Clip(s) to be 
processed. 

For the sake of this example, the last method will be described, although you may find the other 
methods more appropriate. In practice you may be doing the restoration before any editing has taken 
place and so Selected Clips will be fine - just click on the clip or clips you're going to DeCrackle. The 
region edit method gives you the advantage of being able to quickly top and tail the material before 
processing and hence you don't waste time processing audio that you're going to throw away 
immediately. 

2. Turn on Region Editing. 

 
If this toolbar does not appear on the screen (on the Playlist window or floating), then you need to go 
to the "View" menu, select "Toolbars", then "Playlist", then "Region Editing", to display this. Then press 
the left-most button as shown above. 
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3. Now, when your mouse is hovering over the Playlist, the cursor is shown as a  pencil. Click where 
you want the region to start, and drag the mouse leftwards, and let go of the mouse when you reach 
the end, the region will be defined in red. You can now fine tune the beginning and end to suit, by 
moving the mouse cursor over the beginning or end of the region and dragging with the left mouse 
button pressed. 
 

 
4. Enable the streams you wish to De-click by using the stream enable buttons - enabled streams are 

displayed with a pale grey background and will be processed, disabled ones appear with a dark grey 
background and will not. See Enabling and Disabling Streams in the "Arranging an EDL"  chapter for 
more detail. 

 

5.  
When you're happy that you've selected the right sections of audio, press the OFFLINE 
PROCESSING button or the Playlist toolbar, or alternatively go to the "View" menu again, 
this time select "Offline Processing". (If "Offline Processing" is grey then DeClick is not 
correctly installed.). This window will appear: 
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5. From the top, check that the settings here are correct: 

i. Track - Track name for the new recording (Autotake on if you wish) 

ii. Source - For this example select "Between L-R Locators" 

iii. Source Output - Select the output(s) that the clips are currently playing back through. In this 
example the clips should all be on stream 1&2 (or just 1 if it is mono). If the source clips are 
part of a multi-track EDL, and if you're using Region Editing to define the source, you should 
enable only the streams that the source material is on, and disable all others. 

iv. Destination - "Stream" will be ticked. Here you can select where the DeClicked result will 
end up. In this example, we'll tick "Auto-replace..." and leave stream 1&2 selected so that the 
new clip replaces the old one. However you may choose to untick "Auto-replace..." and put 
the new clip onto stream 3&4 so that you have both original and processed clips side by side 
in the EDL. 

v. Bounce in non-real-time - This will be handled automatically, and so you won't need to touch 
this. 

vi. CEDAR DeCrackle - This section is different to the normal bounce. Select this from the 
drop-down list of Offline processes. 

6. When you're happy that these settings are correct, press "Accept". Note that the Offline Processing 
window, like the Bounce window, is "exclusive" and so you won't be able to click the mouse anywhere 
else in the program while this is open. If you do want to re-adjust the region, then press Close on the 
Offline Processing window first. 

7. DeCrackle will proceed, the bottom section of Offline Processing reporting the progress. "Pre-
processing" is loading up the source, "Processing" is the actual DeCrackle working, and "Post-
Processing" is returning the new audio to the specified destination in the EDL. The speed of operation 
will be affected by the performance of your PC, and its own disk drive. 
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8. When "Post-Processing" reaches 100%, the new recording will be put into the EDL in the streams 
previously occupied by the original material, and you can play it back to listen to the splendid results 
of the DeCrackle process.  

DENOISE 

(Installed as an option to SADiE systems. Speak to your dealer for details) 

Unlike the other Cedar processes, which are "offline", Cedar Denoise96 is a real-time process which operates 
in SADiE's mixer. It can be inserted into the mixer with two different methods: 

1. In the Process Window drag its icon  from the toolbar, and then use the routing buttons 
(Denoise96 1 In and Denoise96 1 Out in the picture) to connect it into the mixer. 

2. From the Process Pallette drag the Cedar Denoise button  into the top section of a mixer 
strip (this doesn't require further routing). 

 
Designed by CEDAR Audio, this is a broadband noise reduction system that works by removing from the audio 
signal a "fingerprint" sample that is displayed as a frequency plot called the Noise Reduction Curve (NRC). 

In order to use DeNoise effectively, you need to find a representative bit of noise-only signal. This needs to be 
½ to 1 second for best results. If necessary, copy the noise sample and repeat it in the Playlist . butting each 
Entry to the last to effectively "loop" it. 

 
Play the material and press the SAMPLE NOISE button during the period of clear noise. Release it 
to stop sampling. The noise spectrum that has been sampled will be displayed as the NRC. 

NOTE: No advantage is gained from a sample longer than a second, unless you deliberately want to 
average a varying noise, such as the "swishing" effect from an old disc. The danger of averaging, however, 
is that the resulting NRC will not be correct for the noise at any point in the noise cycle. 
Experimentation will pay off. Avoid sampling over a hard start or end to EDL Entries as the transition to 
or from no signal may cause a transient. 

You can now replay the material and adjust the Attenuation fader to the desired amount of noise reduction. 

The NRC Gain fader is normally set to its mid-point of zero. At this setting the system will attenuate (by the 
set amount) the level of noise that was sampled. Increasing or decreasing the NRC Gain alters the sensitivity of 
the system to the noise sample. This can be used to fine-tune the result, or to compensate for higher or lower 
noise levels than the sample. Note that if the nature of the noise changes, the NRC will no longer be 
appropriate. 

 
The bypass button allows you to compare signals before and after processing. 

 The graph displaying the NRC curve for the whole audible spectrum can be magnified and scrolled 
with the zoom buttons and Scrollbar. 
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You can switch between a linear and logarithmic frequency scale for the NRC. Using a logarithmic 
scale shows more detail at the low frequency end and will therefore be useful when examining the 
curve to remove rumble or hum. 

The NRC can also be manipulated and re-drawn by hand: 

 

First select either the left, right or both channels for manipulation (applies only when using a stereo 
unit). The selected channel's NRC will be drawn in a bolder line on the graph. 

The curve is made up of a lot of nodes, or points, about every 50 Hz. These will be shown by a dot 
when the mouse pointer is over them, like the data line for fader automation. You can: 

1. Click and drag each node to manipulate the NRC. 

2. Draw (drag out) a box around part of the curve and then again click and drag to raise or lower that 
section. This may be useful, say, if you have sampled some noise, but only want the system to remove 
the low-frequency component of it. 

 
When you raise or lower a section of the NRC, this button determines whether that section is 
modified in ratio to the gain or attenuation you are applying (button up), or whether it 
maintains its shape when moved ("Fixed" - button down). 

3.  
Press this button and re-draw by hand part or all of the curve. When you release the 
button, the previous curve for that section will be replaced. 

 

The NRC can be saved and re-loaded with these buttons. Thus you can set DeNoise to remove a 
previously encountered noise sample. 

PEAK METERING 

Each strip of the mixer has a line of "LED's" to display peak levels going through that strip. The Fader decimal 
display (the number in red in the drawing left) is a dual-purpose display. The information it shows depends on 
settings in the Setup page. You can identify what it is displaying by the colour of the number: 

 

Cyan - not displaying peaks, this is the fader level offset value. 

Green - the peak level detected through that fader. This is reset automatically only when you 
start play, or you can manually rest it by double clicking on the number (Ctrl + double click 
resets all peak meters) 

Red - the peak level detected through an output fader, but this is greater than zero. Actually, 
it is impossible to produce an output greater than 0 dB, so this is the level SADiE has 
calculated it would have been. In fact this shows that there have been a number of sequential 
full-scale samples on the output. This can be reset in the normal way. 

Yellow - the peak level detected through a stream or bus fader that is greater than zero. In 
this case samples aren't truncated; because of SADiE's floating-point internal calculations 
approximately 1000 dB of headroom is allowed internally. This can be reset in the normal 
way. 

In the Setup page you can choose which type of display (Fader level or Peak Hold) is being shown. Under the 
"Mixer" section, inside its sub-section "Mixer strip display", you can choose between: 
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 Only show peak levels on output strips 

 Show fader positions on all faders 

 Show peak levels on all faders 

NOTE: Peak displays on Output faders are post-fader; on other types of fader strip they are pre-fader. 

As output levels are much more critical than internal levels, the peak displays on Output faders are measured 
more frequently than those on other types of fader strip. This will explain any apparent discrepancy between 
for instance a stream strip peak and an output strip - it is the output peak that is correct. 

Output peaks are measured every 4 samples, which is adequate for most applications. However in extremely 
critical situations such as mastering, these can be switched to being measured every single sample. See Mixer 
setup "Mixer Output PPM type"; "standard"; is 4 sample accurate, "mastering" is 1 sample accurate. 

The Log Overloads Window can be used to create a list of these peaks. You can use the Metering window for 
a separate PPM display.  

METERING WINDOW 

 

 
The Metering Window is viewed by pressing the SHOW METERING WINDOW button on the 
Mixer Toolbar. This gives a separate window displaying a PPM "LED" style meter for every physical 
input and output in the system. The number of meters will depend on your hardware. The PPM 
scales are set to be the same as displayed by the normal mixer meters - this can be changed in the 
Mixer page of the Setup Window. 

The toolbar (which can be viewed or hidden in the usual way) offers some options as follows: 

 
Enlarges the PPM displays vertically so that they appear double height. 

 
Enlarges the PPM displays horizontally so that they appear double width. 

 
Views or hides the numeric Peak Level displays. 
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Toggles the peak hold mode - when the button is pressed, the highest peaks are held until the Clear 
Peaks button is pressed. 

 
Clear Peaks - all held peaks are cleared down - both on the PPM meters and the numeric Peak Level 
displays. 

 
Clears the Clip LED's at the top of each PPM strip. The Clip LED's glow brighter red when an "over" 
is detected, whether Peak Hold is enabled or not. 

NOTE: There is an option in the "Mixer Peak Displays" section of the Setup window that allows you to 
choose to clear all meters on going into playback or to hold them every time you play audio. This 
applies to the normal mixer meters and the Metering Window. 

 
For reasons of economy with screen space, the numeric Peak Level displays are displayed on the right side of 
each bank of inputs or outputs.  

LOG OVERLOADS WINDOW 
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The Log Overloads window is called up from the "View" menu, or set to pop up as an error is detected. 

The Log Overloads Window can be set to capture Audio Overloads on all digital audio outputs, whilst a 
Playlist is playing. The accuracy of this is determined by the " Mixer Output PPM type" setting as explained 
above. 

To enable, tick Log Overloads, and set a threshold above which you want the window to record the Overs. A 
list will appear below, recording the peak level, the EDL time that level occurred, the name of the EDL in which 
it occurred and the output which was peaking. Double clicking on an item in the list will locate the EDL to the 
correct time, so that you can review the problem. 

In order to produce a definitive, accurate list of peaks in an entire Playlist, SADiE effectively has to "listen" to 
the whole EDL, which involves playing the Playlist, through the mixer along with processing, and analysing the 
output signal. 

Errors can be logged as you play and edit the Playlist, but to speed up the process and produce a definitive 
Overs log, you can do a final play-through of the EDL with NON-REAL-TIME checked in the Transport 
Toolbar (at the bottom of the Record pane) 

See also Peak Metering  

AUTOMATION 

AUTOMATION OVERVIEW 

SADiE can record the positions and movements of the following controls: fader level, mute, pan, Mixer strip 
processes (e.g. Aux. send level, equalisation, and dynamics) and VST plug-ins, and then automatically replay 
them. You can update the automation data by making new adjustments as the old control movements are being 
replayed. This applies whether you are using a mouse or the hardware controllers. The advantage of the 
hardware controllers, of course, is that you can make more than one adjustment at a time. (It is not possible to 
control VST plug-ins from the Hardware controllers) 

Automation data is retained as part of the EDL , so that changes to mixes can be undone and redone using 
UNDO and REDO, and you can move between mixes by saving and loading different EDL's. The data is tied 
to the audio Entry that it affects and will move with it to different EDL times and even different Playlist 
Streams, so you can edit the Playlist after mixing.  

See the note below about Editing and Automation. 

When you scrub the Playlist, the automation data will still be followed; just watch those faders fly! 

 
Automation is enabled for the whole Mixer from this button on the Mixer's configuration toolbar. 

 
On the hardware controller the AUTO button will enable automation when the Mixer is the active 
window. 

When enabled, the Mixer automation toolbar will be displayed. 

 
This selects the modes that determine how automation data is recorded and replayed. On the hardware 
controller, they are selected with the buttons at the bottom left of the fader panel. (Note: to enable Full 
Disconnect mode, press SHIFT + AUTO-RETURN) 

Whenever the position of a control is being recorded, it will be outlined in red (by a red box around knobs and 
a red stem behind faders). Hardware controller faders will have their red "write" LED lit. 

Whenever data from a control is being replayed, it will be outlined in green and hardware controller faders will 
have their green "replay" LED's lit. 

 Each process section on the Mixer strip has a DISABLE AUTOMATION button that will stop 
movements of its controls from being recorded or replayed. Individual EDL Entries can have their 
recorded automation data disabled in the Clip Details window so that it will not be replayed (see 
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Arranging an EDL). 

NOTE: In a change to SADiE v5.4, Process sections (EQ and dynamics) now default to having 
automation ENABLED so there is no need to enable them before recording adjustments. For EDL 
Entries the default is also (as always) automation enabled. When process automation is recorded, you 
have to put the whole process section into write, thus if you have any previous automation, the whole 
section will overwrite even if you only touch one knob. For that reason if you are recording for 
instance, a sweeping equalisation, it is best to write stationary parameters first. This isn't a problem with 
a hardware controller because you can adjust more than one control simultaneously.  

AUTOMATION MODES 

The following automation modes are sensitive to a control being "touched". With the mouse, this means 
clicking on it, hardware controller fader knobs are touch-sensitive. 

 
OVERWRITE mode - applies to all controls. Any previously written data is replayed until you 
touch a control. Its position will then be recorded and will continue overwriting any previous data 
until you stop or change modes. The control will be outlined red; hardware faders show their red 
'write' LED. 

 DISCONNECT MODES 

 
FULL DISCONNECT mode - applies to all controls. Any previously written data is replayed 
until you touch a control. It then affects playback levels only and the previously recorded data will 
not be changed. The control will be outlined grey, and the hardware controller fader LED's will be 
off. After returning to another mode, each disconnected control will stay that way until it is 
touched. You can return all controls to playback by pressing AFFECT ALL followed by AUTO-
RETURN 

 
SAFE DISCONNECT mode - applies to all controls. As with Full Disconnect mode, any 
previously written data is replayed until you touch a control. It then affects playback levels for ONE 
playback pass and the previously recorded data will not be changed. The control will be outlined 
grey, and the hardware controller fader LED's will be off. The next time play is pressed, unlike with 
full disconnect mode, all controls will return to play back existing automation immediately. 

 
TEMPORARY DISCONNECT mode - applies to all controls. As with Full Disconnect mode, 
any previously written data is replayed until you touch a control. It then affects playback levels only 
and the previously recorded data will not be changed. The control will be outlined grey, and the 
hardware controller fader LED's will be off. In Temporary Disconnect mode, controls remain 
disconnected until you change mode, at which point they will be returned 

 ...in short, there are THREE DISCONNECT MODES. Once in a disconnect mode, you touch a 
control to disconnect it, but there are three ways of taking it out of disconnect:- 

Full - controls remain disconnected until you manually return them to re-play automation. 

Temporary - controls remain disconnected until you change automation mode. 

Safe - controls remain disconnected only until the next time you press play. 

NOTE that the KEEP button must be pressed for the Safe and Temporary disconnect 
modes to appear any different. When KEEP is disabled, the mode will change to Auto-return 
after a pass in Temporary disconnect, but to allow Safe Disconnect to be used as a Safe 
mode, once you're set to Safe, it will stay that way irrespective of the state of KEEP. 

 
AFFECT ALL - causes the above modes to immediately affect all controls. This is the equivalent 
of touching all the controls in the Mixer . So, if you press AFFECT ALL and then switch, say, to 
OVERWRITE mode, all control positions will be overwritten from that point. This button can 
also be used, in stop, in conjunction with AUTO-RETURN to put all controls back to playback 



SADiE v5.4 PCM Manual 

206 

mode. If you're already in auto-return, then press another mode, say, DISCONNECT, then press 
AFFECT ALL followed by AUTO-RETURN. 

 
AUTO-RETURN mode - applies to fader and pan controls only. Any previously written data is 
replayed until you touch a control. It will then enter overwrite mode until it is released, when it will 
return to replaying the previous mix. While the hardware controller's faders are being moved, the 
"write" LED will flash, and while they are returning, both LED's will flash. 

 
The time taken for the control to return can be adjusted with the adjacent knob and display. The 
knob brings up a pop-up fader that shows you a precise time in seconds; the display indicates the 
nearest whole second. Note that only faders, pans and surround controls such as Width and 
divergence can auto-return smoothly. Mutes cannot auto-return. EQ processes will "snap" 
instantaneously back to the previous setting. 

 
TRIM mode - applies to faders only, indicated by a blue fader stem and both hardware fader LED's 
lit. Entering this mode causes all faders to immediately move to a middle position. The previously 
recorded data will be replayed, but can be offset by the amount you move a fader. This is useful if 
you have a complicated mix where you got all the moves right, but the whole thing needs to be a 
bit quieter or louder. Note that you will not see the faders moving, but the automation data can be 
displayed on the Playlist Stream, as described below. 

NOTE: When you run a pass in Trim mode, on pressing stop, the final offset will be applied 
for the rest of EDL on that stream (e.g. the offset is written to end). If you don't want this to 
happen, you can press the AUTO-RETURN (green) button during playback, and the 
Trim/offset will stop being applied from that point onwards (with an AUTO-RETURN to 
join it up). 

TIP: You can change modes during playback, depending on what you want each adjustment 
to do. For example, after making an overwrite adjustment for several minutes, you might 
want to switch to auto-return, touch the fader and have it return to the previous mix. You 
can also select a mode and reposition a control before starting playback, so that the 
adjustment takes effect immediately. 

 
Once data is recorded, when you next play the EDL, SADiE will automatically switch to AUTO-
RETURN mode. You can inhibit this automatic switching by pressing the KEEP button, which 
keeps you in the selected mode each time you stop and start playback. 

 
The WRITE TO END button writes the current position of all controls that are outlined red 
(hardware faders "write" LED) to the end of the EDL. Playback must be stopped to use this 
function. There is a Hotkey available for this function. 

 
SNAPSHOT mode buttons allow you to record a constant mixer setting throughout an Entry or 
groups of Entries. See Snapshot Automation for a detailed description. 

NOTE: If you have used fader grouping buttons, movements of linked faders are recorded as if they are 
all being moved individually. So, if the link is later removed, the automation will still replay the original 
movements. Linking faders after their movements are recorded has no effect on the way they are 
replayed. 

NOTE: Automation data is tied to EDL Entries, so control movements where there is no Entry may be 
ignored.  

RECORDING AND REPLAYING A SIMPLE MIX 

1. Get a rough mix together before you enable automation. That way you can experiment with different 
settings without all your twiddling being recorded and annoying the hell out of you when it is replayed. 

2. Once you have your initial fader and processing settings, you can enable automation and they will 
become your starting point for recording. 



Mixing and Processing 

207 

NOTE: You should now position the current-time cursor at the start of the EDL (Home key), 
press the grey DISCONNECT button, then the AFFECT ALL button, and then 
OVERWRITE (all faders and mutes will go RED) followed by the WRITE TO END button; 
these positions will be written as a complete starting mix. It is important to start off with this base 
mix. If streams have no automation in them, you could run into difficulties later on, because your 
first automation will affect the whole stream. 

3. Play your EDL and move any control you want recorded. You will initially be in OVERWRITE mode. 

4. Replay that part of the EDL and the positions and movements of the controls will be reproduced. 
Unless the KEEP button is down, you will see that OVERWRITE mode has automatically switched 
to AUTO-RETURN mode. 

5. If there is any section of the mix that you want to correct, play over it and re-adjust the fader. Hold 
onto the fader until you want to return to the previous mix. If you want to re-write a long section, 
switch back to OVERWRITE mode and you won't have to hang on to the fader. 

NOTE: Holding Ctrl and clicking on a mute button in OVERWRITE mode will start recording its 
status without actually operating the button. This can be used to overwrite a previously recorded 
button operation.  

6. Having finished recording automation you may find it useful to put the automation into SAFE 

DISCONNECT mode by pressing this  button. If you touch any faders they will stop re-playing 
automation, but not write any new automation, and the next time you go into play, they will return to 
re-playing automation. 

AUTOMATION AND SCRUBBING AUDIO 

Automation cannot be recorded whilst scrubbing audio. While you are scrubbing, automation will be re-played, 
but if you touch or move a fader or other control, it will enter DISCONNECT mode until you stop 
scrubbing again. 

 
When jogging or shuttling audio using the hardware controller wheel, you should be aware that on 
stopping, the Playlist remains in scrub, albeit at zero speed. This way you can pick up the scrub and 
move on instantaneously. But this does mean that if you touch controls (say, to set a new level, 
starting at the point you've scrubbed to) you will still be in DISCONNECT mode. Pressing play at 
this point will return the controls to playback mode. 

Thus if you are using scrub with the hardware controller to accurately mark a position from whence 
you wish to record some new automation, on finding your position you should press STOP. Now 
you will be able to put your fader into overwrite and its status will continue after hitting play. 

This is not the case with the mouse method of scrubbing because when you let go of the mouse 
button the EDL stops. Likewise with the Hotkey, fixed-speed scrubs. 

SNAPSHOT AUTOMATION 

Whereas other automation modes are designed for recording dynamic changes to the mixer controls, the 
Snapshot Mode allows you to apply the same settings throughout an Entry or group of Entries. 

This feature has a number of uses. For instance: 

 You can quickly set a level on a group of Entries without having to play across them in real time 

 You may want to set a different pan on alternating Entries on the same stream. 

 Snapshot EQ's are perhaps more useful in many cases than dynamic changes 

Note: Snapshot automation records ordinary automation data onto an EDL entry, in the same as you would if 
you held a fader or pot constant for the length of the clips. This is not a special type of automation, merely an 
quick way of writing automation data if it is going to be constant. However, because you need to select EDL 
entries on which to apply the snapshot, streams that have no entries, like mixer only streams (bus faders, 
output faders etc.) cannot be "snapped". 
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RECORDING SNAPSHOT AUTOMATION 

There are two methods for recording snapshot automation to EDL entries; one method using a mode in the 
Mixer, another using menu items available by right-mouse-clicking in the Playlist. Mixer mode is possibly 
slightly easier for setting up initial settings, however the playlist menu (or hotkey) method is much quicker for 
copying automation settings. But it's up to you - use the method you prefer! 

MIXER SNAPSHOT MODE 

1. Pressing the "camera" icon on the Automation toolbar enables SNAPSHOT Mode. You will notice 
the violet SNAPSHOT READY button will be pressed and all other Automation mode buttons are 
disabled except for DISCONNECT. 

2. Select the Entries in the Playlist that you want the automation to be applied to. You can change your 
mind about this whilst in SNAPSHOT mode; the automation will only be applied to the Playlist 
Entries selected in red when SNAPSHOT Mode is exited. 

3. Set the mixer controls (faders, pans, mutes, EQ's etc.) either in play or stop. Unlike other automation 
modes nothing is recorded as you go along. When you touch a mixer control it will be outlined in 
violet. If you want to change a control without putting it into SNAPSHOT Ready mode, then click 
the grey DISCONNECT button before touching it. 

4. Press the "camera" icon again to exit SNAPSHOT Mode. At this point the current position of every 
control outlined in violet (i.e. only the controls you have touched) will be set for every EDL Entry 
selected in red to which the control applies. For instance if you set a fader for Stream 3 but only 
select entries on Stream 1 then nothing will happen. 

NOTE: Before you snapshot, it is advisable to have some automation recorded. When you first start 
automating none exists at all. If a snapshot is the first thing you do, you will find that the snapshot is 
applied across the whole Stream. Thus if you wanted to for example individually EQ or level change just 
one entry, then you should snapshot the "flat" settings for the EQ or the base level to the all entries in 
the stream first.  

PLAYLIST SNAPSHOT MENU 

This method allows you to snapshot all controls on the mixer strip(s) relating to any red-selected EDL entries, 
without having to enable the controls first - all controls are snapped at their settings at the current time. 

You have the choice between:- 
Snapshot All Automation (on the first level menu) (this is every automatable control - level, pan, divergence, 
stereo width, Aux send, EQs VSTs and Dynamics) 
  

.....or on a second level menu under Snapshot Automation... 
  

Processes (all EQ and Dynamics sections) 
EQ (all Eqs ) 
Dynamics (all Compressors, Expander, Gates) 
VST (all VST processes) 
Level only 
Pan only 
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1. First you will need to set the controls of the processes to the setting you want to snapshot. 

a) You can do this in real time, by playing and changing the controls to suit. However if automation is 
already enabled, then you will not want to record more automation while you are setting up, neither 
will you want to set something and have it auto-return to it's previous setting. Thus it's suggested that 
you use one of the three Disconnect modes to set up the snapshot. For now we'll use Temporary 
Disconnect. 

First check that the Keep button is pressed in. 

Set Temporary Disconnect mode by pressing the  green halved automation mode button on the 
mixer's automation toolbar. Twiddle your knobs until you're happy with the result. 
 
or b) you may wish to copy the control settings from somewhere else in the playlist. Snapshot always 
snaps the controls at an instant in time. If you place the current time at the position where the 
automation is correct in the source clip, the controls will be set ready to be snapped. The source clip 
must be on the same stream for this to work, and automation must be enabled - this won't work if the 
controls are disconnected.  

2. By one means or the other you have set the controls to how you want them to be snapped. Now 
select the EDL entries to which you wish the snapshot to apply. 

3. Right-mouse click over one of the selected clips and the above menu will appear.  

4. Choose Snapshot All automation, or one of the sub-menu items to suit. The snapshot will be applied. 

5. If you had disconnected any controls, you will wish to return them to playback before reviewing the 
snapshot (if they're disconnected they will not play). On the mixer's automation toolbar press the 

green  AUTO-RETURN mode button. 

There are hotkeys for each of the individual Snapshot functions, which can be set in : View menu; Setup ; 
Hotkey Setup ; Playlist ; Snapshot All etc. 
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VST SNAPSHOTS 

The small camera icon at the top of a VST plug-in can be used in the same way as the Playlist Snapshot menu 
items to snapshot the single VST processor's settings. As before: 

1. Set the controls the way you want them. 

2. Select the clips to which you want the snapshot to apply. 

3. Press the camera button to write the settings at the current time to the selected clips. 

 

AUTOMATING MUTES 

Mutes and solo buttons follow slightly different rules to faders and pans during automation, because they are 
not variable controls, merely two state; either On or Off. 

Additionally, because this is a disk editor and not purely a mixing console, there are several other ways of 
making your audio mute and un-mute, e.g. by editing. You may find that editing to produce a mute is more 
flexible and accurate. You also have the option of making a fade-up or down to suit, rather than just a hard un-
mute or mute. 
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Sometimes during a mix, there are times when you'll want to use solos or mutes to listen to one or a few 
streams in isolation. And of course you may not want to record those particular mutes. You can do this by 
switching to the grey, DISCONNECT mode before touching the mutes, however SADiE has a setup option 
that makes all mute operations work in DISCONNECT mode. You will find this in the " Mixer strip display" 
section of the Setup Window. The button is under "Mute automation - Disconnected". Having ticked this 
setting, pressing a mute will not cause that action to be recorded. Particularly if you're using other methods to 
perform the mute, working with this setting on may give you more flexibility. 

Note that whether this mode is on or off, all SOLOS are always performed in disconnect mode, and thus the 
associated mutes are never recorded. 

To mute a section of audio by editing: 

 Disable (by pressing the Stream Name button on the left side of the EDL ) the streams that you do not 
want to effect. Streams that you want to mute should be enabled. (See Enabling/Disabling Streams) 

 Make a razor cut in the Clip (s) at the mute point, and another at the un-mute point. You can make 
these razor cuts in the usual way, either hitting razor whilst you play, or by scrubbing up to the exact 
position in the EDL and then pressing razor. 

 Right mouse click on the Clip(s) to be muted, and select "Make clip inactive" either one at a time, or if 
you have a number of clips to mute, then group them together and inactivate the group clip. 
Alternatively delete the clips you don't want to hear. 

The advantage of this method over automating mute buttons is that you can make the mute point much more 
accurate. This method of inactivating the clip allows you to leave it in the EDL (for visual reference or in case 
you want to later change the mute point) without using any DSP resources. 

If you were to use the mute button method, you can probably set the mute point relatively accurately, on the 
fly, however the unmute point could be tricky, because you can't hear the audio while it is muted. If you get the 
unmute late, then you can't scrub over the correct unmute point because you can't hear it; the automation will 
be playing back, and the audio will be silent at the point you want to scrub. Editing to perform mutes gives you 
much more accuracy and flexibility. 

If you are using mute button automation, you should note that they are always in overwrite mode, whether the 
automation mode is set to overwrite, auto-return or trim.  

DISPLAYING AUTOMATION DATA 

You can display automation data for each Mixer strip. Each parameter (fader changes, pans, mutes, process 
parameters etc) can be displayed as a white line on each Stream routed to that strip. Stereo and merged 
Streams will display the appropriate number of lines. The position of the line indicates the fader level or 
parameter value. 

 
The large button at the top left of the Playlist will display automation data on all Streams. 

 
On the hardware controller this is duplicated by the AUTO button when the Playlist is the active 
window. 

 The small button by each Stream will display data for that Stream only. 

 The small fader button by each Stream allows you to choose which automation parameter to display. 
Selecting this button gives you a menu to choose from all available processes, or fader, or pan, and 
the sub-menu lets you choose which parameter within that process to display. 
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VST automation parameters can also be displayed her; some VST plug-ins can have an extraordinary number of 
parameters, and some have been seen to register spurious parameters as automatable. 

MIXER ONLY STREAMS 

 
There will usually be Mixer strips that control internal busses, input or output faders. Streams to show their 
data will be found in the Stream unit labelled "Mixer only Streams". Double-click on the thin horizontal bar to 
the left of the EDL to display or reveal this unit in the Playlist. These Streams cannot have Entries placed on 
them.  

Automation on these streams can be edited (see below). Automation on these streams is not associated with 
clips as on a normal playlist stream, and thus it cannot be tied to edits. However, the mixer-only streams  will 
respond to the slip functions - when slip is enabled, and the mixer-only stream is enabled the automation on these 
streams will follow the usual slip rules in relation to the edit. However you can disable slip on individual 
streams in the usual way, by pressing the stream button at the left hand side. 

When slip is enabled, the automaton lines will be coloured red and blue to display the effect of the slip 
function. 

Automation on mixer-only streams can also be cut, copied and pasted as part of a region. Region edits work on 
enabled streams, and thus you can disable copying of mixer-only automation by disabling the mixer only 
streams. Conversely you could region cut, copy or paste ONLY the mixer only-automation by disabling all 
other streams. 

Automation Auto-return periods 
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Whenever mixer-only automation is edited as a result of a Playlist Edit, Region Edit, Trim Edit or even a EDL 
Re-conform, an auto-return "smoothing" period is applied at the edit points. There is a setup page for this, 
under Setup / Playlist / Playlist Automation, and the auto-return period can be set differently for level, pan, EQ 
and other (VST, compressors, etc.) automation parameters. These can be set to be minimal if you prefer to 
turn this off. This does not apply to any clip-based automation. 

EDITING AUTOMATION DATA 

As an alternative to re-recording control movements, you can edit (alter) the data by directly manipulating the 
line displayed on the Playlist Stream. 

To enable automation editing, first show the Automation Editing toolbar. 

 
Press the SELECT TOOLBARS button on the Playlist toolbar again. Select "Automation Edit" to 
reveal the Automation Edit toolbar. 

 
From Left to Right in the picture above the buttons are: 

Automation Edit enable - switches this mode on and off. On pressing this button, the Playlist entries will 
change to grey and the automation data line will turn red to show that you are now working in this mode.  

This line, however curvy it looks, is made up of straight lines joining up lots of "Automation Points" where the 
line changes direction. Each point is shown by a red dot and a level indication when the mouse pointer is near 
it. 

Automation Adjust - allows you to select Automation nodes, and move them.  

You can use the mouse to move an existing Automation Point or draw a box around several Automation 
Points and move them together, either horizontally or vertically, depending on the first movement of the 
mouse. Hitting Delete on the keyboard will remove the Automation points within the box and replace them 
with a straight line. 

Having selected some automation nodes, you can right-mouse-click and Cut, Copy or Paste this automation 
to another clip on another streams or at a different position in the playlist.  

Notice that when you are pointing with this tool, a small box appears to show the level (in db) of the position 
the mouse is placed at. If you pick up any points and move them vertically, this level display box changes to 
show the level offset you are applying. 

Draw Automation - this changes the mouse to a pencil tool to allow you to free-hand draw new automation 
onto the entry or stream. 

 
Insert Point - Adds a new point to the line and set its level. 

Dip -  a) Draw a box around an area to create a "duck" or dip in level, the width and depth of which will be 
determined by the size of box you draw. 
b) Adjust the depth of an existing duck by dragging its bottom up or down. Wildlife enthusiasts should 
enjoy that one. 

Right-mouse-clicking whilst using the Draw, Insert or Dip tools, reverts to Adjust mode. 
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Each of the buttons on the Automation Edit Toolbar can be mapped to a keyboard or Hardware Controller 
hotkey. 

NOTE: You can remove all automation from an entry using an option available by right-mouse-clicking 
on the entry. 

NOTE: Editing is not applicable beyond the last Entry on the Stream. Stereo Entries must be on Stereo 
Streams if you want to edit the automation data of both left and right channels simultaneously. 

Automation editing in this manner is possible for every automation parameter that can be displayed.  

SURROUND SOUND 

SURROUND SOUND INTRODUCTION 

The v3.6 release of SADiE was the first to incorporate support for mixing to the most popular surround sound 
formats. It has been attempted, wherever possible, to integrate the new surround sound features into SADiE as 
seamlessly as possible. Hopefully, this will make your step into the world of surround sound as intuitive and 
straightforward as possible. 

As with any major new feature, there will inevitably be many questions that cannot be answered by 
experimentation alone. It is therefore recommended that you spend a little time browsing this document 
before attempting to undertake anything too ambitious. Once armed with the knowledge contained in this 
manual, working with surround sound will be as straightforward and logical as working with conventional left-
right stereo. 

If, whilst familiarising yourself with the new features, you encounter a problem that seems to defy explanation, 
your first port of call should be the last section of this chapter, where there are listed solutions to a number of 
the most commonly encountered problems. 

SURROUND TERMINOLOGY 

For many people, stereophonic implies two channels, left and right. This perception has been created by the 
dominance of the 2-channel, left-right format used by the music recording industry since the 1960's. There are 
however many "stereo" formats. Each surround format is a stereo format. Dolby™ Stereo (also known as 
Dolby™ Surround) for example, is a 4-channel stereo system. It is therefore important to try and break any 
association that you may have held in the past between the word "stereo" and the number "2"! 

To avoid confusion, this manual will refer to conventional 2-channel stereo as "L-R stereo" where there is any 
possibility of ambiguity.  

GETTING SADIE INTO SURROUND MODE 

Not everyone will need to work in surround (yet!), so SADiE can hide everything related to surround sound 
from the user. This is the default operating mode. You will therefore need to first enable the Surround Sound 
features by opening the Setup window and selecting the "Surround Sound" topic from the left pane. This will 
display the check box that allows the Surround Sound features to be activated. 
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Once activated, the features will not actually take effect until the next time a mixer is created or opened. It is 
therefore important to remember that if you switch modes whilst a project is open, you will need to close and 
then re-open the currently open mixer. This should be done from the mixer component in the project window 
rather than the mixer window itself. Better still, only change the mode whilst you don't actually have a project 
open. Most users will probably just enable the surround sound features once and then leave them enabled 
indefinitely. Having the features enabled does not restrict your ability to continue creating and working on non-
surround sound projects. 

If your system currently has the Surround Sound features turned off, and you attempt to load a mixer 
containing surround sound format strips then SADiE will automatically offer to turn the Surround Sound 
features on, so that it can successfully complete the load. If you decline the offer then SADiE will abort the 
loading of the mixer. 

The state of the "Surround Sound enabled" check box is stored in the user's INI file and can therefore be set 
depending on each user's needs or preferences.  
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DIFFERENCES WITH SURROUND ENABLED 

 
 

You can tell at a glance if surround sound is enabled by 
checking if the pan pots on the mixer strips have a 
small left-right arrow legend above them (as in the 
example strip to the left). There is also a new button 
beneath the PPM display area that is used to switch the 
PPM display between front and rear channel metering. 
This button will always be disabled on conventional 
mono and L-R stereo strips. 

The Process Toolbar will also have three extra strip 
type buttons labelled LCR, LCRS and LCRSS 
appended to the end. Note that you may have to 
resize the mixer to bring these extra buttons into 
view. 

 

SURROUND FORMAT BUSSES 

The key to successfully working with surround sound on SADiE is to understand surround format busses and 
how they have been implemented in SADiE. Once you have mastered this fundamental aspect, everything else 
will fall into place relatively easily. 

With Surround disabled SADiE features just two types of busses: mono, and conventional L&R stereo. In actual 
fact, SADiE only really features mono busses. Stereo busses are little more than a convenient pairing up of two 
adjacent mono busses. 

Surround sound in SADiE builds on this foundation. All busses are still ultimately derived from an arrangement 
of mono busses. This simply provides new "building blocks" in addition to the familiar L&R stereo pair.  
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THE LCR BUS 

The most important new bus type is the LCR bus (Left, Centre, Right). In order to understand exactly what 
this new bus consists of, open the Routing Toolbar (from the Mixer Configuration Toolbar on the mixer) 

Open up the Mixer Internal Busses folder and right mouse click on the New Bus entry. You will notice that the 
Create a new bus sub-menu offers four options. (If you do not see this sub-menu then you have not yet 
enabled the Surround Sound features and re-opened the mixer. See section above entitled Enabling Surround 
Mode for more details). The first option is a Mono pair that will create the standard L-R stereo bus with which 
you are all familiar. On this occasion, select the second option, LCR. 

 

  

 

 

 

 

 

 

This creates a new LCR bus called LCR1. You will notice that it is placed immediately beneath Bus 1&2 in the 
bus tree. Double click on LCR1 and you will find that it is constructed from three mono busses. Each of the 
mono sub-busses have an automatically generated suffix (L, C, or R) to uniquely identify them. You can rename 
a bus by right mouse clicking on it and selecting the "Rename bus" option. The one restriction with surround 
busses is that you can only rename the root bus (LCR1 in this case). All of the sub-busses will be renamed 
automatically when the root is renamed. Try renaming LCR1 to, say, Tutorial. The resulting bus tree should 
then match the example to the right. 

Finally, to return to the starting point, delete the LCR bus by right mouse clicking on it and selecting the Delete 
bus option. 

In most situations, you probably won't find yourself creating busses from the Routing Toolbar. Instead you'll 
probably create them from the familiar and more convenient "New Bus" option in a mixer strip's Input / 
Output routing drop down list boxes. It is, however, handy to know that all bus housekeeping can now be 
performed in this one place.  
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THE LCRS BUS 

Now that you've established that SADiE has mono, L-R stereo, and LCR busses at its disposal, you can take the 
next logical step. 

LCRS stands for "Left, Centre, Right, Surround" and represents the configuration used by Dolby™ Stereo (also 
known as Dolby™ Surround). This is the most common surround format in use today and consists of four 
channels in the following configuration. 

 

 

The "front" consists of three channels, which can be represented 
by an LCR bus, and the "rear", a single mono channel, which can 
be represented by a mono bus. To confirm this, create an LCRS 
bus from the Routing Toolbar by right mouse clicking on the 
New Bus entry in the bus tree and selecting LCRS from the 
Create a new bus sub-menu. The resulting LCRS bus should 
match the example to the right. 

Once again, each sub-bus within the overall LCRS 1 bus has an 
automatically generated suffix that uniquely identifies not only the 
sub-bus itself, but also its type. 

All LCRS busses will be placed in the bus tree immediately after 
any LCR busses. 
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THE LCRSS BUS 

The final surround bus to describe is the LCRSS bus, which is the same as the previously described LCRS bus, 
except for the fact that it features individual left and right surround channels. This five channel configuration is 
particularly significant because it forms the "5" of the increasingly popular "5.1" format used by Dolby™ Digital 
(SR-D), DTS Digital (DTS) and perhaps most importantly of all, Digital Versatile Disk (DVD). 

 

 

As with the LCRS bus, the front three channels can be 
represented by an LCR bus. The two rear surround channels can 
be considered a stereo pair (for bus purposes) and therefore 
represented by a conventional L-R stereo bus. A fully expanded 
LCRSS bus therefore matches the structure of the example to the 
right. 

The "5.1" format was mentioned above when listing formats that 
could make use of LCRSS busses. Some users may be wondering 
why there is no final logical step to implement a 5.1 format bus 
that consists of an integral LCRSS and mono bus. 

There are several reasons why it was decided not to take this 
approach, most of which will become apparent when you start 
working with mixer strips that handle surround busses. However, 
the reasons mainly concern the vastly differing control and 
processing requirements of the two busses. 

This absence of an integral 5.1 style bus does not mean that you cannot produce a 5.1 mix using SADiE. It 
simply means that you have to consider your total 5.1 output as consisting of an LCRSS bus (to provide the 
main 5 channels) and a separate mono bus (to provide the ".1" or LFE channel). The LCRSS bus would typically 
be routed to O/p 1-5 and the mono bus to O/p 6. 

The advantage with this approach is that it enables you to process your ".1" (LFE) channel independently of the 
other 5 channels. This is essential considering the limited frequency range requirement of the resulting channel. 
It also gives you total freedom when deciding what components of your overall mix to add to the channel.  
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SURROUND FORMAT MIXER STRIPS 

Of course, all of the surround busses would be of little use without some different mixer strips to generate and 
manipulate them. To offer maximum flexibility SADiE offers nine new types of mixer strip in addition to the 
original mono/L-R stereo strips. 

The new strips fall into three categories; those with an LCR output, those with an LCRS output, and finally 
those with an LCRSS output. Each of these three categories contain a further three strip types; one with a 
mono input, one with an L-R stereo input, and one with an input that matches the format of the output. 

The following table summarises the input and output formats of the nine new strip types: 

Input Format Output Format 

Mono LCR 

L-R Stereo LCR 

LCR LCR 

Mono LCRS 

L-R Stereo LCRS 

LCRS LCRS 

Mono LCRSS 

L-R Stereo LCRSS 

LCRSS LCRSS 

To avoid cluttering up the mixer process toolbar with nine new strip buttons we have opted to add just three 
buttons instead. These three buttons are labelled LCR, LCRS, and LCRSS and refer to the output format of 
the strips that they will create. The user must specify the input format at the moment of dropping the strip into 
the mixer. 

Depending on the surround format that you work with, a typical simple surround mixer might consist of 8 
mono in / LCRS out strips (one for each Playlist stream), and a final LCRS in / LCRS out strip for global 
processing and level control. 

To help familiarise you with process of creating a surround mixer from scratch, the following section is 
designed to walk you through the entire process from the creation of a new project right up to the moment 
where you're ready to do some real work.  



Mixing and Processing 

221 

CREATING A SURROUND MIXER 

In this example it is assumed that you are going to work with an 8 stream EDL , mixing mono material to 
LCRS. 

The first step is to create a new project . Then you need to remove all the default strips from the mixer in 
preparation for dropping the new surround strips in. This is certainly the most tedious part of the whole 
process, although it needn't be a process that you repeat every time you create a new surround project (see 
section below headed Making use of Mixer Templates for more details). Mixer strips can be deleted by 
selecting the Delete Strip option from the right-click popup menu that appears when clicking on a strip. 
Alternatively strips can be deleted by dragging them off the mixer window (you will need to pick them up by 
clicking on an area of the strip that has no other function when clicked on, for example the PPM's or strip 
number). 

Once you have emptied your mixer, you are ready to add the new surround strips. Double click on the LCRS 
button on the mixer process toolbar. This will put SADiE into "strip insert mode". A small dialogue box will 
then appear asking you to specify the input format for your strips. Just click "Ok" to select the default mono 
option. 

You are now free to insert as many strips as you like. All you have to do is point and click wherever you want 
a strip to be inserted. If the position you're pointing at is not valid, the mouse pointer will change from a mixer 
strip to a "no-go" pointer. For your example, insert eight strips; if you insert too many, don't worry, you can 
easily delete them again afterwards. When you have finished inserting strips, click the right mouse button to 
exit insert mode. 

If a horizontal Scrollbar appeared on the mixer window whilst you were inserting your strips, make sure it is 
moved to its far right extreme, in order to fully reveal strip number 8. 

To insert the final strip just drag and drop from the LCRS button on the process toolbar. Click on the button 
and drag it all the way to the right hand half of strip number 8 (or further right if your mixer window is wider 
than your mixer). When you release the mouse button, the dialogue box asking you to specify the input format 
will appear again. On this occasion select LCRS and press OK. (If the dialogue does not appear, then you are 
dropping the strip in an invalid position. Try repeating the process, making sure that the mouse pointer 
resembles a mini fader before releasing the button.) 

At this point you should have a mixer that resembles the example below: 

 
The next step is to set up the input and output routing for each strip. Currently, you will notice that all of the 
routing buttons are "Unset". (If you can only see one row of "Unset" buttons, enable the Output Bus buttons 
by clicking on the "Output bus buttons" button on the mixer configuration toolbar; the button resembles a bus 
emerging from a tunnel.) Before you start, make sure that your Playlist , rather than the Clipstore, is linked to 
the Mixer. Do this by clicking on the Playlist window and then clicking back on the mixer window. 

Click on the "Input selection" button on strip 1 (the top "Unset" button), scroll down the list and select "1" 
(this will be "A1" if you have a multiple card system). This sets the input routing of the first strip to Stream 1 of 
the Playlist. Next set the output routing for the strip by clicking on the "Output selection" button (the 
remaining "Unset" button). This time your options will be more restricted. This is because apart from the 
physical outputs, there is nowhere to route to yet. To remedy this situation select the "New Bus" option. This 
will automatically create a new LCRS bus called "LCRS 1" (LCRS A1 in multiple card systems) and assign it to 
the output of the strip. 
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Repeat this process for the next seven strips, but on each occasion select an input bus one greater than the 
previous strip. For example select "2" as the input bus for strip 2 and "3" as the input bus for strip 3. Always, 
however, select "LCRS 1" as the output bus for each strip. 

Finally, set the input routing of strip 9 to "LCRS 1" (the bus that carries the combined outputs of strips 1 to 8) 
and the output routing to O/p 1&2&3&4. 

You have now completed setting up the input and output routing for your mixer and it should match the 
example below: 

 
Your mixer is now ready for use and should be saved before proceeding any further.  

FLEXIBLE ROUTING 

The previous example described one of the most simple mixer configurations possible. In reality, more 
complexity and hence flexibility are required to achieve particular results. SADiE addresses this requirement by 
allowing a great degree of flexibility when it comes to routing internal mixer busses to mixer strips. 

For example, just because a strip has an L-R stereo input doesn't mean that you have to route a conventional 
L-R stereo bus to it. You could for example route the two rear channels of an LCRSS bus to such a strip; useful 
if you want to do some processing on just the surround component of you mix. Strips with mono inputs or 
outputs offer total freedom, as any individual sub-bus can be routed to them. 

One particularly useful aspect of this flexibility is the potential to conserve DSP power. Imagine, for example, 
that you're producing an LCRS mix for a film. Much of your material may just be dialogue and you have decided 
that you want to keep all of the dialogue in the front three speakers. Rather than create full LCRS output strips 
for each channel of dialogue, you could just create strips with LCR outputs, which you route to the LCR sub-
bus of your final surround mix bus. This is obviously "cheaper" in terms of DSP power as it saves the extra (and 
unnecessary in this case) calculations required to derive the rear channel component. 

Perhaps the best part of all this is that SADiE does the hard work for you. Whenever you want to set up the 
input or output bus of a strip, SADiE works out all the possible valid routings for you and presents them in the 
drop down list box. All you have to do is browse the list and pick the appropriate one. 

PPM MONITORING 

In most circumstances the PPM's meter pre-fader. The only exception to this rule is if a strip is routed to a 
physical output and the output format of the strip matches the input format, in which case the metering will be 
post-fader.  

UNDERSTANDING THE CONTROLS 

Although each of the surround strips has its own distinct characteristics, they all share a common interface and 
set of controls. Certain strips may disable some of the controls because they have no function due to the input 
format of the strip. Other strips may omit certain controls altogether because they have no relevance with 
respect to the output format of the strip. For example a strip with an LCR output does not require the front-
back pan control to be present. 
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Below is an example of a mono to LCRSS strip (1 in / 5 out): 

 

1. Divergence control 

2. Left-Right Pan control 

3. Width control 

4. Front-Rear Pan control 

5. Joystick control 

6. Divergence mode toggle 

7. Strip input/output format indicator 

Each of the new controls labelled in the above example will now be explained in turn, along with specific details 
about which of the new strips feature each control and which do not: 

1. Divergence control - This normally controls the amount of left-right and front-back divergence. If the 
"Divergence mode toggle" button is down, it will only control the amount of left-right divergence. By 
default the control is set to maximum (full divergence) when a strip is created. The control is only 
enabled on surround strips than have a mono or L-R stereo input. 

For more information about divergence, see the following section entitled Divergence. 

2. Left-Right Pan control - This particular control needs little introduction and will already be familiar to 
most users. It pans the front (and L-R stereo rear channels if present) between the corresponding left 
and right channels. This control is disabled on strips that feature the same input and output format 
(e.g. LCR to LCR, LCRS to LCRS and LCRSS to LCRSS). 

It is important to remember that the exact behaviour of the pan control is dependent on the current 
position of the divergence control. For example, if the divergence control is set to its minimum value, 
then the pan control will have no effect. 

3. Width control - This control will only be enabled on surround strips with a mono or L-R stereo input. 
You will probably only find yourself needing to use it if you have some non-directional L-R stereo 
source material that needs panning to a picture. 

Reducing the width of a L-R stereo input to the absolute minimum effectively collapses it into a mono 
signal. 

By default, the width control is set to its minimum for mono input strips and maximum for L-R stereo 
inputs strips. 

4. Front-Rear pan control - This control only appears on strips that have an LCRS or LCRSS output and 
performs a similar function to the Left-Right pan control except it operates between the front and 
rear channels. The control will be disabled on strips that feature the same input and output format 
(e.g. LCRS to LCRS and LCRSS to LCRSS). 

Again, it is important to remember that the behaviour of this control is dependent on the current 
position of the divergence control and also the state of the divergence mode toggle switch. 

5. Joystick control - This is not actually a true control in its own right, but a convenient interface that 
allows simultaneous control of the Left-Right and Front-Rear pan controls. The control will appear on 
strips that feature an LCRS or LCRSS output, and only be enabled on those that feature a mono or L-
R stereo input. 

The control has two modes of operation: 
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i. The first is invoked by a single downward click and hold of the left mouse button on the 
joystick control button. This will launch the joystick window with the Left-Right and Front-
Rear pan positions represented by a "knob" at the appropriate position in the window. This 
window represents the complete surround sound field and the position can be adjusted by 
moving the mouse. Releasing the mouse cancels the window. 

ii. The second mode is activated by double clicking on the joystick control button. As with the 
first mode, this launches the joystick window and positions the "knob" at the relevant 
position in the window. It will, however, remain open until you subsequently click the mouse 
outside the limits of the control window. While the window is open you can adjust the 
position of the knob by clicking on the knob and dragging it to its new position whilst holding 
the mouse button down. 

Quick centring of the joystick is possible by double clicking in either the centre of the window (on the 
cross hairs), or in the top centre of the window (beneath the centre speaker icon). 

 
Joystick Control Window 

6. Divergence mode toggle - Normally, the divergence control applies the same divergence to both the 
Left-Right and Front-Rear pan controls simultaneously. In certain situations, however, it can be 
desirable to detach the divergence control from the front-back pan control and restrict its influence to 
just the left-right pan control instead. This "detached" mode is activated by pressing the divergence 
mode toggle button into the "down" position. When in this mode the front-back pan control is always 
fully divergent allowing it complete front-back movement. 

This switch will only exist on strips that have an LCRS or LCRSS format output, and only enabled on 
strips with a mono or L-R stereo input. It is also not automated, but its current setting is saved with 
the mixer. 

7. Strip input/output format indicator - Due to the fact that all of the surround strips look very similar at 
a glance, this display forms a handy reminder of the input and output format of the strip. It uses the 
same familiar icons that appear in the Routing Toolbar: the top icon (above the downward arrow) 
indicates the input format, and the bottom icon indicates the output format. 

Because this area of the strip allows no user interaction, it also makes a handy place to click on if you 
want to drag a strip to another place in the mixer, or you want to minimise a mixer strip by double 
clicking on it.  
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DIVERGENCE 

Divergence is an important aspect of panning, and control of it becomes a significant issue when working with 
pan controls that operate on 3 (or more) channels. Consider the following example that illustrates the most 
basic panning characteristics of a 3-way pan used to control LCR stereo: 

 
Pan characteristics when Divergence is set to 100% (default) 

As you can see from the diagram, when the pan is hard left, dead centre or hard right, only the corresponding 
channel carries any signal. This movement of the signal from channel to channel is known as divergence. In this 
particular case the pan is said to have full divergence, because at no point during the complete pan does the 
signal ever appear on more than two channels at once. 

In SADiE all surround strips are created with full (maximum) divergence by default, and in many cases the 
resulting behaviour of the pan control may be perfectly acceptable. However, consider the following situation. 

Imagine you're mixing to picture and there is a particular sequence where a car drives from left to right across 
the entire scene. Obviously, a left to right pan of the sound of the car's engine is required to provide a 
convincing effect. But will a complete left to right pan with a fully divergent pan produce a convincing result, 
and perhaps more importantly, will it produce an effect that is acceptable to most (if not all) of the audience? 

In reality, the pan will fail on both counts. Due to the fact that the sound moves completely in and out of each 
speaker in turn, the pan will appear to "jump" from speaker to speaker. This effect becomes more noticeable as 
the speed of the pan is increased. It will also fail to produce a consistent effect across the entire auditorium. 
People sitting in the centre (where the limited "sweet spot" will be situated) will get the best results, whilst 
those sitting at the far left and right extremes are going to receive disproportionate amounts of the left or right 
channels even though they can clearly see the entire picture. 

To remedy this situation, you can decrease the divergence of the pan control, altering its characteristics so that 
a proportion of each signal is automatically "bled" into the adjacent channels, "spreading" the sound over a 
wider proportion of the stereo image. This will not only produce more coherent results for those seated at 
the left and right extremes of the auditorium, but will also make pans appear to glide more smoothly. 
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Pan characteristics when Divergence is set to 50% 

As you continue to decrease the divergence, the variation in the level of each channel during a pan continues to 
decrease, until you reach the minimum setting (no divergence at all) where no change occurs, and the pan 
control therefore has no effect. 

You may have gathered by now that using the divergence control is something of a compromise: too little and 
you create unnatural results that don't work across an entire auditorium, too much and you start to lose the 
benefits of stereo sound. 

The ability to control divergence is especially important when mixing to picture, and will rarely be left set at its 
maximum value. Of course, in the case of music production there are no such constraints, so you should just 
consider divergence as another creative tool. It is important to remember though, that you will not be able to 
produce truly "natural" effects whilst the divergence control is at its maximum setting.  

ROUTING SURROUND BUSSES 

The two main points that need addressing, with regard to routing surround strips to physical outputs, are: 

 Of the available physical outputs, which ones can surround strips actually be routed to? 

 In what order will the individual mono sub busses actually appear on these outputs? 

WHICH OUTPUTS CAN I ROUTE MY SURROUND STRIPS TO? 

SADiE uses a simple rule to decide where you can actually route to: 

 If the number of channels, n, is 1 or even you can route the bus to every nth physical output starting 
from O/p 1. 

 Otherwise you can route the bus to every (n+1)th physical output starting from O/p 1. 
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The second half of the rule is necessary to ensure that busses with odd numbers of channels (excluding mono 
busses) are treated as though they had an even number of channels. This guarantees that all busses (with the 
exception of mono busses) are aligned with an odd numbered output. Don't worry if you currently find all this 
a little confusing and meaningless. Once you start using SADiE you'll soon understand and appreciate the need 
for this rule. The most important thing to remember at this stage is that SADiE won't let you do anything that 
isn't allowed. 

To save you having to work out the full implications of the above rule we have produced the table below. It 
clearly illustrates all the possible valid output routings for each type of bus in a system with 8 outputs. The 
"grey holes" do not necessarily indicate unusable outputs, only that they are unusable by a bus of the same type 
as the column in which they appear. For example, if you were creating a "5.1" format mix it would be perfectly 
legal to route your main LCRSS bus to o/p 1-5 and to then route your mono bus (representing the ".1" 
channel) to O/p 6. 

Mono L-R Stereo LCR LCRS LCRSS 

O/p 1 

O/p 2 

O/p 1&2 

O/p 3 

O/p 1-3 

O/p 4 

O/p 3&4 

 

O/p 1-4 

O/p 5 

O/p 1-5 

O/p 6 

O/p 5&6 

O/p 7 

O/p 5-7 

O/p 8 

O/p 7&8 

 

O/p 5-8 
 

If you find yourself unable to route your strip to where you believe you should be able to, check that one or 
more the outputs in question are not already being used by a different type of bus in another mixer strip. The 
most common cause of not being able to route your LCRS strip to O/p 1-4 is an L-R stereo output strip 
routed to O/p 1-2 somewhere else in your mixer. Failing this, check that you don't have any Aux Send 
processes using the desired outputs. 

IN WHAT ORDER WILL THE SUB-BUSSES APPEAR ON THE OUTPUTS? 

You might be forgiven for thinking that if you routed an LCR output strip to O/p 1&2&3 that the left channel 
would appear on O/p 1, the centre on O/p 2 and the right on O/p 3. 

What actually happens in this particular situation is that the centre and right channels are "swapped over". This 
ensures that the left and right channels always occupy the first two outputs, maintaining compatibility with 
conventional L-R stereo routing. Additionally, when combined with the "odd" bus alignment rule mentioned in 
the previous point, it also ensures that the related left and right channels will be sent to the same AES output. 

The following diagrams summarise the exact routing used for each of the supported surround formats: 
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LCR LCRS LCRSS 

For consistency, a similar rearrangement of the surround channels occurs if you route a surround format input 
back into SADiE through three or more physical inputs. In order to work out which channel to apply to each 
input, use the above diagrams in reverse, following each input back to the appropriate channel.  

MAKING USE OF MIXER TEMPLATES 

You may have noticed that creating a basic mixer for surround sound work can be a rather involved and 
tedious process. First you had to start with a standard L-R stereo mixer and then remove all (or some) of the 
strips before adding the required surround sound strips. Finally, you then had to set up all the routing, creating 
the necessary surround busses as you went. 

Fortunately there is a solution to this inconvenience and it involves a feature that some users may already have 
experimented with in the past: Mixer Templates. 

SADiE features both Playlist and mixer templates, but you'll just concentrate on mixer templates, although all of 
the concepts involved apply equally to both types. 

Just think of a mixer template as an ordinary mixer, which you have created and saved in a special location. 
Actually, the only real difference between a mixer template and an ordinary mixer is its filename extension 
(*.MST rather than *.MSU). Once you have created one or more templates you can then tell SADiE to create 
any subsequent new mixers from a specific template. Alternatively you can ask SADiE to allow you to choose 
which template to use at the actual moment that a new mixer is to be created. 

CREATING A MIXER TEMPLATE 

Creating a mixer template is very simple indeed. The easiest way is to just create a new mixer using the New 
option on the main File menu (don't bother adding it to the currently open project when asked). You can then 
edit this mixer into the mixer of your choice. 

Once you are happy with the mixer you have created you will need to save it as a template. To do this select 
Save current mixer as template from the main File menu (this option will only appear on the menu if the mixer 
is the currently selected window). A suitable directory will automatically be selected, so all you need to do is 
give it a name and press OK. 

Your template has now been saved and is ready for use. 

USING A MIXER TEMPLATE 

To set SADiE up to use a template, you need to open the Setup window and go to the "Project Management 
Templates" section. This will reveal the template set up options. 

By default, templates are not used. To use specific Playlist and Mixer templates click on the "Use the specified 
templates" option. This will enable the two "Change" buttons in the section below. Click on the one next to 
the edit box labelled "Mixer". You should now see your previously created template(s) listed. Make your 
selection and press "Ok". 

From now on, all new mixers will be created from the mixer template that you have specified. Playlists will 
continue to be created in the normal non-template way, because no template has been specified. 



Mixing and Processing 

229 

If you ever want to change your choice of template or mode of working (as you inevitably will sooner or later) 
then just return to the Templates setup page and make your changes. All of the settings in this window are also 
user specific, so each user can have their own preferred template configuration.  

SURROUND FAQ'S 

If I create a project whilst the surround sound features are disabled, will I be able to incorporate surround 
sound strips into the mixer at a later date? 

 Yes. The state of the Surround Sound features option when the project is created is of no 
consequence. If you subsequently require the surround features then just enable the option in the 
Setup window and reopen your project. 

Inserting multiple strips into a mixer is a real "drag", especially when they are surround strips, because I have to 
keep responding to the "Input Format" dialogue when I drop a strip. Is there a short cut? 

 Yes. Instead of dragging the strip button from the toolbar, double click on it instead. If it is a surround 
strip button select the input format that you require. Then simply click wherever you wish to insert a 
strip into the mixer. When you have finished adding strips, click the right mouse button to exit insert 
mode. This handy feature also works for inline processes. 

I've enabled the surround sound features checkbox on the Setup window and closed and reopened my mixer, 
but I still don't get the surround format strip buttons. 

 You probably just haven't "really" closed the mixer. You need to do this from the project window by 
right mouse clicking on the mixer component and selecting "Close Component" from the popup 
menu. Once closed, double-click on it to reopen it again. Alternatively (or if you are not working in 
project mode), close the mixer from the File menu and then reopen it. 

I've got 4 (or more) physical outputs on my system but I don't seem to be able to route my final LCRS output 
strip to O/p 1&2&3&4. 

 You've probably already got O/p 1&2 assigned to an L-R stereo output strip somewhere else in your 
mixer. Reassign the output of the offending stereo strip to a different output or bus (or delete the 
strip if it isn't required). If this isn't the problem check all Aux Send processes to see if any of them are 
using O/p 1&2. This problem can also occur with inputs and the remedy is exactly the same - except 
check strip inputs, rather than strip outputs. 

My output channels seem to be jumbled up, and channels don't seem to be appearing on the expected outputs. 

 Surround busses get re-ordered slightly when they emerge into the real world. There are several 
reasons for this, but the main two are: 

i. To ensure that the first two outputs are always L and R (to prevent you having to re-route 
your output wiring when switching between L-R stereo and surround projects) 

ii. To keep related stereo pairs on the same AES output wherever possible. 

For more information about the exact channel routing used by each of the surround formats, see the 
section entitled Routing surround busses.  
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8 - FILE MANAGEMENT 

Overview 

EDL's 

Clipstores 

Mixers 

Projects 

File Recovery 

Disk Management 

Archiving 

File Formats 

FILE MANAGEMENT OVERVIEW 
Work in SADiE is held in a number of files. Firstly there are the Tracks (sound files of the audio as originally 
recorded into the system) and these are stored on dedicated audio disks. Looking after these is covered in 
"Track and file management", below. 

Then there are the files that represent the work you have done to the raw material. These are: 

 EDL's - how and when to play back which parts of the Tracks 

 Clipstores - a useful store of Clips for later use 

 Mixer setups - a record of the Mixer configuration needed to play the EDL 

 Projects - group all the above files as components, together with a list of relevant Tracks. A Project 
file can then represent all the work for a particular job. 

Just like the documents of a word processor, these files need to be saved so that they can be opened later for 
further work or playback. They are stored on the DOS hard drive of the PC. 

Creating, opening, saving and closing EDL's, Mixers and Clipstores can be done: 

1. From the Project window. Files created this way will become components of a Project 

NOTE: We strongly recommend that you always start work within a Project, as to later create a 
Project from non-Project-files requires importing all components individually. It also makes saving, 
reloading, archiving and keeping track of your work much easier. Working within Projects is 
described later in this chapter, following the basic explanation of the component EDL's, Clipstores 
and Mixer setups. 

2. From the File menu, with the New, Open, Save and Close commands. 

i. "New" creates a new EDL, Mixer or Clipstore outside the Project structure. 

ii. "Open", "Save" and "Close" refer to the type of file shown by the currently active window 
(shown by a highlighted title bar). To make a window active, click on it anywhere or use the 
WINDOW button on your hardware controller. 

iii. "Save" saves a file under its current name, thus overwriting the previously saved version. 

iv. "Save As" allows you to rename the file, thus keeping the previous version. 

The dialogue boxes that appear following "Open" and "Save As" allow you to open different folders to 
find your file or to choose the folder that you want to save it in. 

3.  
EDL files can be opened and saved from these buttons on the Playlist toolbar. Note that this 
button is "Save" and not "Save As". 
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4. You can also, of course, close the file shown in any window by double-clicking on the icon to the left 
of its title bar, or by clicking on the close window button  on the right of its title bar.  

EDL'S 

EDL files are given the file extension "*.EDL", so a typical name in full is "FRED.EDL". 

Creating a new EDL opens an empty Playlist window for you to start work in. 

Opening a previously saved EDL opens a new Playlist window containing that EDL. 

 Any previously open Playlists will stay open and you can switch between Playlists under the Window 
menu, from within the Project window or by using the WINDOW button on your hardware 
controller. 

Saving the EDL in the currently active Playlist window will save the file to the PC's DOS drive. The first time 
you use save a file, you will be asked to name it; after that, the "Save" command will save the file with the same 
name as before, overwriting the previous version. If you think you might want to keep the previous version, 
use the "Save As" command. This will let you give the new version a different name. Take care to open the 
folder that you want it saved in. The file extension ".EDL" will be automatically added to the name you type. 

Closing an EDL closes the Playlist window that is displaying it. You will be prompted to save the EDL if it has 
been changed since last saved. 

NOTE: The EDL file that you save includes the layout and names of the Streams in the Playlist displaying 
it and any Automation data, e.g. fader and other control adjustments in the Mixer. However, you will 
need to save the Mixer setup that goes with the EDL separately, as described below. If you work within 
a Project, this will be done for you when you save the whole Project. 

EDL's can be saved as a Template using the "File" menu option Save current Playlist as a template. EDL 
templates have the file extension "*.EDT".  

CLIPSTORES 

CLIPSTORES 

A Clipstore is a useful holding place for Clips that you may later want to add to an EDL . These may be 
versions of Tracks with specific fade and level characteristics, or parts of Tracks. Clips created in the Playlist 
window or the Trim Editor can be saved to the active Clipstore, where they can be grouped in folders. 

A special folder labelled "Source Tracks Folder" will appear in the first Clipstore that is opened or created, so 
the Clipstore is also useful for accessing any audio on the system. 

 If you are working within a Project . the Source Tracks folder will contain all the raw Tracks being 
used by this Project. 

 If you work outside of Projects, it will contain all the raw Tracks in the root directories of all your 
logged audio disks. 

NOTE: The Source Tracks folder is not saved as part of the Clipstore file. It is added to it to enable you 
to access Tracks on the audio disks. Clips in the Source Tracks folder are not editable. See Source 
Tracks Folder. 

Clipstore files are given the file extension "*.CLS", so a typical name in full is "FRED.CLS". 

Creating a new Clipstore opens a new Clipstore window with no Clips in it. 

Opening a previously saved Clipstore opens a new Clipstore window containing the saved list of Clips. 

 Any previously open Clipstore windows will stay open and you can switch between them under the 
Window menu, from within the Project window or by using the WINDOW button on your 
hardware controller. 

Saving the Clipstore shown in the currently active window will save the file to the PC's DOS drive. If you use 
the "Save As" command, or if the Clipstore has not been saved before, you will be prompted to give the file a 
name, and can select which folder it is saved to. The file extension "*.CLS" will be automatically added to the 
name you type. If you use the "Save" command, the file will be saved with the same name as before. 
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NOTE: You only need to save a Clipstore if you have deliberately stored specific Clips in it, as described 
below. In many cases, you may never want to do this and all your work will be contained in EDL's. 
However, it is often useful to save a list of Clips that have been "topped and tailed" or selected from 
much longer Tracks before you put them together in a specific order, in an EDL. It's a bit like having a 
shelf full of small insert reels for a particular programme, or can be used to make a library of Sound 
Effects. 

Closing a Clipstore closes the window displaying it. You will be prompted to save it if it has been changed since 
last saved. 

NOTE: If you close the Clipstore that contains your Source Tracks folder, you can get the folder back 
by opening a new Clipstore or closing and re-opening an existing one.  

USING THE CLIPSTORE WINDOW 

 
To select a Clip in the Clipstore with the hardware controller, use WINDOW to make the 
required Clipstore the active window, then the wheel will scroll through all the Clips. (Make sure it is 
not selected to jog or shuttle.) Alternatively, the PREVIOUS and NEXT buttons will step through 
the list. 

 
With the mouse, click on a clip to select it. As with most Windows® applications, multiple selection 
of items in the list can be made by selecting them while holding the Ctrl or Shift keys. 

 

The Root Node is the "top of the tree" for this Clipstore, and Clips can sit at 
this level, or be grouped into folders. Double-clicking opens and closes the 
folders to view their contents. 

Mono Clips/Tracks are shown with single blue icons. 

Stereo Clips/Tracks are shown with green, double clip icons. Double-clicking 
on these reveals the left and right channels for separate selection. 

Multichannel Clips/Tracks are shown with red icons (as "voices" is here). 
Double-clicking on these will reveal their component stereo or mono parts 
for selection. 

 
To open or close stereo and Multichannel Clip icons with the hardware controller, select the Clip 
and then press EDIT/SELECT. 

 
Clips can be listed alphabetically by name, or grouped by type (first stereo, then mono, then 
Multichannel). 

 
Allows you to create and name a NEW FOLDER. You first need to select the folder that you 
want it to appear in - this may be the Root Node, or another folder. 

 
The PREVIEW button will play the selected Clip from in point to out point, or until you release 
the button. 
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The Transport controls apply to whichever is the active window and can be used for previewing 
selected Clips. 

 
Allows you to RENAME a Clip or a folder. 

 
Allows you to DELETE a Clip (or clips) or a folder from the Clipstore. 

NOTE: Deleting a Clip will not delete any audio from the SCSI disk, but it will delete the 
reference you have created to a particular piece of audio, with particular level and fade 
characteristics. 

 
The SEARCH button lets you search for clip names with given text which can include the 
character * to represent any number of "wild" characters. The two buttons next to it review search 
results and return you to the full Clipstore listing. 

The details columns to the right of the tree of names can be customised, as in the Text EDL . by 
selecting options from the box that drops down when you click on any of the headings. 

NOTE: When the Clipstore is the active Window, a Clipstore menu will appear on the main 
menu bar. This duplicates the above buttons for NEW FOLDER, SORT BY 
NAME/TYPE and SEARCH. 

STORING AND MOVING CLIPS 

STORING CLIPS IN A CLIPSTORE 

You may want to store the new Clip you have created by editing in the Playlist or the Trim Editor: 

 
Select the Entry in the Playlist or the Clip in the Trim Editor and press the COPY TO 
CLIPSTORE button on that window's toolbar. 

 
On the hardware controller, use WINDOW to make the required Playlist or Trim Editor the active 
window and CUT or COPY the Entry or Clip to the paste buffer. Then select the required 
Clipstore as the active window and PASTE the Entry into the Clipstore. 

MOVING CLIPS AROUND CLIPSTORES 

 
Clips can be copied and moved around between folders of the same Clipstore, or between different 
Clipstores by dragging with the mouse. Dragging moves the Clip and holding the Ctrl key while 
dragging copies it. You will not be allowed to alter the contents of the "Source Tracks" folder, but 
you can copy Tracks from it to other folders. 

 
On the hardware controller, use WINDOW to make the required Clipstore the active window, 
then the wheel will scroll through all the clips if it is not selected to jog or shuttle. You can CUT or 
COPY highlighted Clips to the paste buffer and PASTE them into the next Clipstore and folder you 
select. 

MOVING CLIPS TO OTHER WINDOWS 

 
The selected Clip can be loaded to the paste buffer for pasting into a Playlist, or dragged directly to 
the Playlist window. 

 
The selected Clip can be loaded to the Trim Editor to be altered and the new version saved back to 
the Clipstore. 
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CUT or COPY the selected Clip, then PASTE it into the next window you select. 

CLIP DETAILS 

 
You can bring up the Clip Details Window for a selected Clip and make changes to it there, before 
"writing back" the new version and thereby re-saving it in the Clipstore. 

USING ONE CHANNEL OF A MULTICHANNEL CLIP 

You may want to use just one channel of a stereo or Multichannel Clip: 

 Double-click on the Clip or Track in the Clipstore to reveal the separate parts. On the hardware 
controller, select the Clip and then press EDIT/SELECT. Stereo components of Multichannel Clips 
can be further opened to show separate mono channels. 

 You can now select just one channel and paste it into the Playlist.  

MIXERS 

Mixer Set-ups are given the file extension "*.MSU", so a typical name in full is "FRED.MSU". 

NOTE: There can only be one Mixer connected to SADiE's outputs, so only one Mixer window may be 
open at a time. Creating a new Mixer or opening a saved Mixer set-up therefore closes the existing 
Mixer window. 

Creating a new Mixer replaces the existing one with the default set-up. This is specified in the Setup window 
displayed from the View menu. 

Opening a previously saved Mixer replaces the existing one with the saved set-up. 

Saving the current Mixer set-up will save it as a file to the PC's DOS drive. If you use the "Save As" command, 
or if the Mixer set-up has not been saved before, you will be prompted to give the file a name, and can select 
which folder it is saved to. The file extension "*.MSU" will be automatically added to the name you type. If you 
use the "Save" command, the file will be saved with the same name as before. 

 
Closing a Mixer closes the window displaying it. You will be prompted to save it if it has been 
changed since last saved. You can re-display the current Mixer set-up with the SHOW MIXER 
button on the Playlist toolbar. 

Mixers can be saved as a Template using the "File" menu option Save current mixer as a template. Mixer 
templates have the file extension "*.MST".  

PROJECTS 

 
To make handling the above files more convenient, they are grouped together as components of individual 
Projects. 

Every Project also has a list of audio Tracks associated with it. This is the list of Tracks that appears in the 
Source Tracks folder of its Clipstore. 

Each new Project that you name creates a folder of that name on your DOS drive under the path C:\Projects. 
This contains the files for the individual components and the actual Project file itself, which has the file 
extension "*.PRJ". 

A folder is also created on your audio disk, to group Tracks recorded under the Project. 
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Once you are working within a Project, you can use the Project window to create, save, open and close all the 
individual components that make up your work. When you save the whole Project, all these are saved 
together. Next time you work on the Project, the Project window will only show the components that are 
relevant to that piece of work. The Source Tracks Folder that is created in the Clipstore only contains audio 
that is being used by the Project. 

Whole Projects can be deleted to delete all associated files in one go. 

You can only ever have one Project open at a time and so must close the currently open Project before 
opening or a saved one or creating a new one. 

Projects can be backed up to the hard disk that contains the audio Tracks, and this may be transferred to 
another machine or posted across a network. When you want to return to a Project that has been backed up 
in this way, you restore it (and its components) to the DOS drive in order to do further work. 

A Project and its associated Tracks can also be backed up to other devices like Exabyte tape or MO disks for 
longer-term storage.  

PROJECT STARTUP 

You are presented with the following box when you run SADiE: 

 

You can then either close the box and start work with an 
empty Playlist and a default Mixer and Clipstore (which would 
have to be saved and kept track of separately, or arranged 
into Projects later), or choose to: 

1. Open the Project that was last worked on (the 
current Project). 

2. Open an existing Project that you have previously 
saved. 

3. Create (and name) a new Project. 

4. Restore a Project that has been backed up to a 
storage device. 

Once SADiE is running, these facilities are provided from the full range of options in the Project menu 
described below.  

AUTOMATIC PROJECT STARTUP 

You can setup SADiE to start a project automatically. This is much like automatic log-in and Desktop loading. 

1. First find the command line: 

i. If your system is set to run SADiE automatically when you switch on, the relevant icon can be 
found under the Start button, "Settings", "Taskbar", "Start Menu Programs". Click "Advanced" 
and, in the Explorer box that appears, open the "Programs" folder and then the "Startup" 
folder. The SADiE shortcut icon will be in the list on the right. 

ii. If you run SADiE manually from the Start button, follow the above instructions, but instead of 
finding the icon in the "Startup" folder, it will be in the "SADiE Disk Editor" one. 

iii. Alternatively, you may have an icon on your Windows desktop. Right-click on the relevant 
icon, select "Properties" and the "Shortcut" tab of the box that appears. The command-line is 
in the box labelled "Target". 

iv. A typical command line is: 

C:\SADiE5\BIN\SADiE5.EXE_/dc:\SADiE5\Desktops\1024def.dsk 
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2. Now edit the command line by clicking within it to change the text. The line may be longer than the 
box displaying it, but you can use the keyboard arrow keys to move it. Carefully add the path and 
project name for the project you want to open after the "def.dsk", for example: 

C:\SADiE5\BIN\SADiE5.EXE_/dc:\SADiE5\Desktops\1024def.dsk_"D:\projects\fishsticks on 
toast\mackrel.prj" 

Remember to keep the spaces shown as _ after "SADiE5.EXE" and after "def.dsk". 

NOTE: On Windows systems, any paths that use filenames with spaces in them must be 
enclosed in quote marks. 

MANAGING PROJECTS 

Projects are created, opened and closed from the Project menu on the main menu bar. Commands that are 
not currently available are "greyed out" in the list. 

 New Project - When you create a new Project: 

o If you have more than one Record Destination you will first be asked which one you want to 
use to record Tracks associated with the project. Alternatively, there is an option to use 
whichever Destination has most space. 

o You will be asked to give the Project a name and the Project window will open. SADiE will 
have created a new EDL/Playlist, Clipstore and Mixer named after the Project. These will 
start off in a default state and after use in the normal way will be saved, closed and re-opened 
as part of the Project. You can create additional components as well as one layer of "Sub-
Projects" within each Project; useful for episodes within a series, for example. 

NOTE: A newly created Project will have no tracks associated, and hence the Source Tracks 
Folder of the Clipstore will be empty. However any or all of the Tracks on the audio disk(s) 
may be easily imported, as described below. 

 Open Project - Lets you open an existing Project from those saved on the DOS drive. The Project 
window will appear (if minimised it will be reduced to a box at the bottom of the screen; press its 
maximise button, or select it from the "Windows" menu). 

NOTE: The list of recently used files at the bottom of the File menu will always allow you to 
directly open your last used Project. 

 Save Project - Saves the current Project and all its components that have been changed since they 
were last saved. 

NOTE: When the Project window is active, this is duplicated by the "File, Save" command and the 
Hardware Controller SAVE button. 

 Close Project - Closes the current one so that you can open a different Project to work on. 

 Delete Project - Closes the current Project and deletes its folder and all component files from the 
DOS disk. If you are using SADiE3-formatted audio disks, you will have the option of also deleting all 
audio Tracks associated with the Project. 

 Cleanup Project - Offers selections to enable you to automatically "Tag" or mark audio tracks for 
backup or deletion. 

 Backup Project - Displays a box with two options: 

o "Backup project components to the audio drive" backs up the current Project components by 
copying those files to the audio disk being used for the Project's Tracks. The disk can then be 
stored or transferred to another system, or its contents posted across a network. 

o "Total project backup to a storage device" backs up the Project and all the audio Tracks in its 
Tracklist to another storage device. 

 Restore Project - Displays a box with two options: 

o "Restore project components from the audio drive" restores a Project that was backed up to 
an audio disk by copying its components to the DOS drive, then asks you if you also want to 
open the Project. 
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o "Total project restoration from a storage device" restores a Project's Tracks and components 
from a storage device.  

MANAGING WORK WITHIN A PROJECT 

 
Once you have opened or created a Project . the Project window will appear and you will be able to see all its 
associated components in a tree structure, similar to Windows Explorer. 

Double-click on folders with + and - signs to reveal or hide their contents. 

Components of projects are EDL 's, Clipstores, Mixers and Sub-Projects. Opening, saving and closing 
components from within the Project window has exactly the same function doing the same thing from SADiE's 
File menu; it is just a far more convenient way of doing it and keeping track of everything! 

NOTE: All buttons in the Project window are duplicated by right-clicking on the relevant areas of the 
name tree. You may find this more convenient than identifying the buttons. 

 
An open yellow folder will appear against open components in the Project window. A red 
exclamation mark will appear next to the folder when you do anything to a component (e.g. 
edit an EDL) to remind you that it has been changed since you last saved it. The AUTO 
OPEN COMPONENT tag means that the component will open automatically when the 
Project is first opened. 
There is also a setup option to make the auto-open function automatic and thus to always 
re-open the componenmponentsts which were open the last time you saved a project. See 
Setup / Porject Managment / Auto-open last open project co 
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Further components may be named and created with the CREATE SUB-PROJECT, 
CREATE CLIPSTORE , CREATE EDL, and CREATE MIXER buttons. If right-
clicking, you will find them under "Create a new..." 

 
The most useful way to save your work is to SAVE PROJECT, which will save all the 
components of a Project in one go. 

NOTE: This is duplicated by the SAVE button on the hardware controller when the 
Project window is active, and by the "Save Project" command in the Project menu. 

 
Existing individual components may be opened, saved and closed by selecting them and 
hitting the OPEN/SAVE/CLOSE COMPONENTS buttons. If you select the project 
folder at the top of the tree, and select OPEN, every EDL attached to the Project will 
open. This is important when tagging audio tracks for deletion or backup (see Cleaning up 
the Project). 

NOTE: Double-clicking on a component will open it directly and is a useful way of 
bringing its window back in view. 

 
IMPORT COMPONENTS allows you to bring a component into the current Project. 
For example, a Mixer saved outside of any Project, or a Clipstore from another Project. 
You have two options: importing the original file into this Project, or importing a copy of it. 
You can select multiple components using the Ctrl or Shift keys much as you would in 
Windows Explorer. 

Other non-component files can also be imported. Right-click within the Project tree and 
select "Miscellaneous", "Import other files". When the "other file" is double-clicked it will 
open with the Windows registered program for that file type, and when a backup is made 
these files are included in the backup. 

NOTE: If you import the original file, it will not be moved from its current folder on 
the DOS drive, but the current Project will retain a link to it. If you import a copy, 
you can work on it and save new versions in the current Project while leaving the 
original where it was. 

 
REMOVE COMPONENT removes the selected component from the listing in this 
Project window. 

NOTE: You will also be asked if you want to delete the component file from the DOS drive. 
If you choose not to, it will remain in the folder where it was originally saved and can be 
imported into any Project or opened outside Projects. 

 
When you open a Project, if a component file has been moved on the DOS drive or had its 
name changed, SADiE will not be able to locate it. A warning message will be displayed and 
the missing component will appear in red in the Project window. The LOCATE 
COMPONENT command will then let you browse through different folders, and when 
you find the missing file, will update the Project to keep note of its new location. 

 
DISPLAY USERS and EDIT USER LIST let you to display or alter the list of users 
allowed to open the Project. The user that created the Project is its "Project Manager" 
(indicated by a tick in the "Manager" box), and only he/she can add or delete users from the 
list or promote other users to "Project Manager" status. Note, however, that System 
Administrators can open all Projects. The User Management software for multiple-user 
installations is described in User Management, and is outlined in Getting Started. 

 
SELECT AUDIO DISK allows you to specify which of your record destinations (if you 
have more than one) is used to record Tracks associated with the Project. Alternatively, 
you can tell SADiE to use whichever disk has most space. 

 
TAG SOURCE AUDIO TRACKS allows you to quickly mark which audio Tracks will 
be backed up when "Total Project Backup" is chosen (See Archiving). The Tag marks can 
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also be used for deleting audio that is no longer in use (see Cleanup Project). 

 
LIST MISSING TRACKS is for removing links in the project to audio tracks that no 
longer exist (see Missing Tracks). 

SUB-PROJECTS 

Sub-Projects are a useful second level in the Project structure when different users are working on different 
parts of a Project. The Project that is open when you create Sub-Project(s) becomes the master Project. 

 
The master Project will show the Sub-project as a component, but will not show all the sub-Project's 
own components unless they have been marked for global access to the master (with the EXPORT 
COMPONENT button). This is to mask possibly huge numbers of works-in-progress from the 
master and only make available the latest or best versions. 

To work on a sub-Project, once it has been created, select it from the list at the bottom of the Project menu. 
This effectively makes the sub-Project become the current Project. To return to the master Project, use the 
menu list again.  

BACKING UP, CLOSING, AND DELETING 

BACKING UP THE PROJECT 

To back-up the current Project to the audio disk, select "Backup Project" from the "Project" menu, then select 
"Backup Project Components to the Audio drive". All the files for the Project will be copied to the audio disk, 
which can then be removed and stored, put into another system or posted across a network. 

To restore a Project from an audio disk, select "Restore Project" from the "Project" menu, then "Restore 
Project components from an audio drive". The Project files will be copied to your PC's DOS drive and a 
further box will let you open the Project for more work. 

CLOSING THE PROJECT 

The only way to close the current Project is from the "Project" menu. You will be prompted to save any 
unsaved components, and the whole Project, if you have not already done so. 

DELETING THE PROJECT 

The "Delete Project" command on the Project menu closes the current Project and deletes its folder and all 
component files from the DOS disk. If you are using v3 formatted audio disks, you also have the option of also 
deleting all audio Tracks in the Project's folder on the audio disk, e.g. Tracks that were recorded under the 
Project. 

This operation will not delete audio imported into the Project, so a "Library" of sound effects is safe when 
deleting other Projects that use its Tracks. 

You cannot delete a Project that contains Sub-projects; these must be separately deleted first.  

SAVING PROJECTS IN V4.2 FORMAT 

COMPATIBILITY BETWEEN SOFTWARE VERSIONS 

For many years, SADiE has taken great care to ensure that every new version, major or minor, is able to read 
files from earlier versions (audio files, as well as EDL 's, Projects, Clipstores, and Mixers). 

This is not so difficult because the development process has been mostly linear – every higher numbered 
version appears later in date than a lower numbered version. Every version is likely to include some changes, 
but the newer version will inherit and have knowledge about the earlier version's structures. We call this 
backwards compatibility. 
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More difficult however is the ability for an earlier version to read files from a later version – the later version 
will undoubtedly contain changes that the earlier version cannot have prior knowledge of (this is easier if the 
versions are only a few weeks apart but with software such as SADiE which has developed over ten years, it 
would be too much of a restriction if file formats were not allowed to change). 

Thus, SADiE v5 can automatically load files that were created from SADIE v3 onwards. (Version 3 had the 
ability to use v2 format audio drives, which v5 does not allow, thus if SADIE2 drives have been used for audio, 
it must be transferred to a SADiE3 format or FAT32 drive first) 

However, as with the usual scheme of things, SADIE4 cannot load SADiE v5 projects directly. We have 
provided a means of converting v5 projects back to the same format as version 4.2. 

Note: SADiE v2 files cannot be read directly in SADiE v5 as there is a problem with the audio disc 
format. However any systems running v2 software could have v3 software installed. If the project is then 
loaded into v3, audio files copied to a SADIE3 format disk drive, and the project is then re-saved as v3, 
SADiE v5 will be able to open the project. 

WORKING FOR V4.2 COMPATIBILITY 

You should only save as v4.2 at the moment you intend to pass the project over to v4. If you re-open the 
Project or continue working in v5, then the next normal save will make the project incompatible with v4.2. 

If you're planning to pass the project to v4.2, then it's wise to avoid using facilities in v5 which you know are 
unavailable in v4.2, or at least make sure these are not in use at the point  of saving as v4.2. It's not a big 
problem if you do, but if you can avoid this, then it will make the v4.2 saving slicker. Those facilities unavailable 
in v4.2 include: 

1. The use of DirectX Plugins in-line in the mixer  

2. A more obscure Playlist feature - SADIE4 cannot work with EDL times greater than 12 hours when 
the sample rate is set to 96 kHz (or 2x), and 6 hours when the sample rate is 192 kHz (or 4x).  

All the audio files will need to be on a drive that can be presented to a v4.2 system so a removable 50pin SCSI 
drive attached to a PC SCSI card in the Series 5 system will be required. FAT32 format on the drive will give 
the best flexibility in both machines (SADIE3 or FAT16 or Mac would be OK, but definitely avoid NTFS which 
is not supported by v4.2) 

SAVE PROJECT IN V4.2 FORMAT 

Go to the Project Menu and select "Save project in v4.2 format". On selecting this option, you will be shown a 
dialogue box entitled Select the components to be saved in v4.2 format. This will list all the EDL's, Mixers and 
Clipstores in the project (and not any other "other files" attached to the project). By default ALL components 
will be selected, but you can decide not to export some if you wish. 

All components will first be saved (v5 format). 

Then each component will be validated for potential conversion problems. 

If a v5 feature is found which cannot be translated back to v4.2 then the v4.2 save will stop. 

You will be informed which feature has caused the v4.2 saving has failed, and the offending component will be 
left on the screen. 

You have the choice now to remove the component from the Save-as-v4.2 list or to modify the component 
appropriately so as to conform to v4.2 – SADiE does NOT auto-modify the component. 

After a failure you will have to run the v4.2 saving again until it succeeds. 

This process will save the project and the selected components in v4.2 format and will also automatically pack 
these onto the audio drive as a PPJ component backup file so that the whole project can be physically moved 
to the SADiE4 system. 

The Project will then be closed (to avoid overwriting in v5 format). 

LOADING THE PROJECT IN V4.2 

Log the SCSI Audio drive. From the Project menu, choose Restore Project, then select Restore Project 
Components form an audio drive.  
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The Packed project from v5 should be available in the list – select this one and load it. 

TRACK MANAGEMENT 

SOURCE TRACKS FOLDER 

During any SADiE session a Clipstore will contain a special folder, called the Source Tracks Folder, which gives 
you access to the raw audio Tracks in use. Inside a Project . this will contain all the Tracks associated with the 
Project, and this list is saved with the Project. If you are working outside of a Project, it will contain the entire 
root directory of your disk. Operation of the Source Tracks Folder inside a Project will be described below in 
detail. However, it is essentially the same when working outside Projects. 

The Source Tracks Folder provides a means of managing the audio Tracks that are being used in the current 
session, and adding, removing, and archiving audio belonging to your current Project should be done here. For 
a more global view of the contents of your discs you should use Disk Management. 

There is only one Source Tracks folder and it appears in the first Clipstore opened. If no open Clipstore 
contains the Source Tracks Folder, then opening another, or closing one and re-opening it will make this 
special folder re-appear. 

Tracks appear in the Source Tracks Folder if: 

 They were recorded while the current Project was open, or 

 They have been imported into the Project. 

The same functions are available in the Clipstore for clips from the Source Tracks Folder as for other clips. 
You can drag or cut and paste these as clips into EDL's, or to other folders in the Clipstore. You will notice 
however, that for these Source Tracks Clips all the fields in the right-hand table of the Clipstore are "greyed 
out" and hence it is not possible to edit these parameters.  

CLEANING UP THE PROJECT 

The CLEANUP PROJECT functions, 
available under the Project menu, give you 
extra tools to help manage your audio 
tracks within the project. 

You would use these functions for the 
following purposes: 

 To remove or delete audio that is 
no longer used by the project: 
alternative or old takes, or tracks 
that were imported by mistake or 
unnecessarily. 

 To archive the project along with 
all or some of it's audio tracks. 

 

Choosing the "Tag Tracks" option, allows you to automatically mark or "Tag" tracks that either do or don't 
belong to some components of the project. 

"Tag tracks" gives us this window: 
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"Tag the used audio tracks" operates on every EDL and 
Clipstore that is currently open. This includes minimised 
components. (There is an option to open every EDL 
associated with a Project - see Managing work within a 
Project.) Note that Clipstore does not include the 
Source tracks folder (which does not strictly belong to 
that Clipstore, it belongs to the project itself). This 
function searches through all the open components and 
tags every track as "Yes" that is in use, and tags 
everything else "No". 

"Tag the unused audio tracks" does the reverse, tagging unused tracks "Yes" and used tracks "No". 

"Tag all of the audio tracks", changes the Tag mark on every track in the Source tracks folder for the project. 

Inside the Source tracks folder, the Tag mark for each track can be manually changed, to allow you to override 
the automatic selection. You may have to change the table display of the Clipstore to show a "Tagged" column. 

There is an extra Tag option: "Always". This is a permanent mark, and "Always" tracks are always copied, never 
deleted, and never changed by the auto-tagging operations. Double-clicking on the Tagged field changes a "No" 
to "Yes" and vice-versa; right-clicking toggles it between "Always" and "No/Yes". 

To delete the tracks you've tagged, select "Remove or Destroy" from the "Project" menu: "Remove" just 
disassociates the tracks from the Project, whereas "Destroy" permanently deletes them (never to return!). Of 
course you're most likely to want to remove or destroy Unused tracks, so be careful that you've selected the 
right tagging option. 

To backup the Tagged tracks select "Backup Project" from the "Project" menu, and then select "Total Project 
Backup to a storage device", and select the drive you wish to archive the project to. The backup will proceed 
as per the Project Backup procedure. 

NOTE: "Total Project Backup to a storage device" only ever archives tracks that are tagged "Yes". 
Choose "Tag all of the audio tracks" in the Tag tracks window.  

MISSING TRACKS 

 
The "Source Tracks" folder of the Clipstore displays all the audio tracks that belong to the project . but there 
are occasions when some tracks are not available: perhaps a disc drive containing associated tracks is no longer 
on line. 
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SADiE will warn you of missing disc drives when it encounters them on loading a project, but still retains a 
record of these "missing" tracks. When they return the Source tracks folder will refresh. However there are 
times when perhaps these missing tracks are no longer needed for the project, and you may want to remove 
the link to them completely. 

 
LIST MISSING TRACKS gives you a list of these tracks and allows you to permanently remove 
them if you wish. 

 

SOURCE TRACKS TOOLBAR 

 
You will notice that clicking on a Source Track makes the buttons on this toolbar change colour from grey to 
show that these functions are now available. Also, right mouse clicking on a Track gives different options to 
those shown when clicking on normal clips. 

The Tracks are listed together with columns of details. The columns can be customised by selecting 
alternatives from the box that appears when you click on their headings buttons. 

As with most Windows® applications, multiple selection of items in the list can be made by selecting them 
while holding the Ctrl or Shift keys. 

NOTE: A newly created Project will have no tracks in the Source Tracks Folder, but any or all of the 
Tracks on the audio disk(s) may be easily imported. 

 
IMPORT TRACK opens a portion of the Disk Manager window so that you can select: 

 Individual Tracks from any audio disks, 

 A whole disk or folder. 

 Groups of Tracks (either by clicking on a Track while holding the Ctrl key to add it to the 
group selection, or clicking on the top Track in a range that want to select, then holding the 
Shift key and clicking on the Track at the bottom of the range). 

The tracks will then be added to the Source Tracks Folder for the current Project. 

There is further discussion of Importing Audio in the Recording and Importing Audio section of this 
manual. 

NOTE: An imported Track may still belong to a Project that it was originally created with. 
Deleting the original Project can delete such a Track. Tracks that you want to be available to 
many Projects should be held in a Project such as "Library" or "Effects" that you know you 
won't delete. 

 
REMOVE TRACK removes the Track from the Tracklist for the current Project without deleting 
it from the audio disk. 

 
DESTROY TRACK removes it from the Tracklist and deletes it from the audio disk entirely. It 
cannot be retrieved! 

 
RENAME TRACK allows you to change the name of the Track. 

NOTE: What name gets changed by this function depends on the audio file format. With 
SADiE3 format files, the Track name is different from the file name on the audio disc, and so 
Rename Track will not change the file name, but will change the Track name in the Source 
Tracks Folder. You can see a Track's file name and location on the disc in the Source Tracks 
Folder, if you display the "Path" field in the table. It is safest not to rename Tracks or Audio 
Files; change the name of the Clips or EDL entries instead. 
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TRACK PROPERTIES shows the Properties box for that Track 

FILE RECOVERY 
If you exit SADiE incorrectly, either: 

 Without shutting down properly (described at the end of the Tutorial), OR 

 Because you suffer a power cut, OR 

 Because your computer crashes (yes lets admit it, it does happen!) 

SADiE will attempt to recover the Project . EDL 's, etc. that were in use at the time of the problem. 

When you next run SADiE, you will be asked if you want to return to the recovered versions. This is your only 
chance to recover work done since the last "Save" command, so say yes! 

Whenever you save a file using an existing name (this happens with the "Save" command), the previous version 
with that name will be overwritten. However, it is not immediately lost. SADiE can keep the last version as a 
backup file (with the file extension "*.BKE" for EDL's, "*.BKC" for Clipstores, or "*.BKM" for mixers). 

To open a backup file, use the normal "Open" command, but in the dialogue box change the types of files listed 
to "All files". You will then see backup files included in the list and you can open the appropriate one. 

Additionally, SADiE will "Auto-Save" any unsaved files automatically, every five minutes. These are saved to the 
"C:\sadie5\Temporary Files\username" directory (where username is your login name) and are named: 

 Sd3savxx.˜dl for EDL, where xx counts up to 99 

 Sd3savxx.˜ls for Clipstore, where xx counts up to 99 

 Sd3savxx.˜su for Mixer . where xx counts up to 99 

These can be opened in the same way as opening a backup file. There are a great many of these; if you are in 
doubt as to which one you need, clicking on the View Menu button in the "Open" dialogue and selecting 
"Details" will give you time details for every file to help you choose. These files will remain in the directory, but 
cause no harm. 

The frequency of auto-saving, and the auto-backup function can be set in the "Auto-Save" section of the Setup 
window.  

DISK MANAGEMENT 
SADIE v5 can play and record audio files to any disk drive that the Windows PC can read and write to. 

Of course some devices will not have sufficient storage or performance to record a usable amount of audio 
(floppy disc for instance). Additionally some drives require special software for writing (CD-R or DVD-R are 
not really appropriate for real-time recording or playback). However, anything that operates like a normal hard 
drive (be it IDE, SCSI, Firewire, etc.) can be used in SADIE, as long as Windows can use it. 

It must be noted that Windows' own User Management may set privileges for some users on certain drives, or 
even certain folders on drives, either locally or across a network. Therefore, if the User does not have the 
ability to write files to a drive under Windows, then SADIE will not be able to record files to that drive. 

DISK MANAGER 

Disk Manager is designed to allow you to see all of the drives, folders and files on your machine, for the 
purpose of copying or deleting files, and previewing audio files in the same way as you'd expect in Windows 
Explorer. In fact you can use Windows Explorer for some of these functions, but Disk Manager will offer you 
some extra, SADIE–specific functions that Explorer cannot. 

Disk Manager allows you to "import" an audio file into a SADIE Project. You can also use it to mount and un-
mount removable drives, and to see drives that are hidden from Windows (in non Windows formats). 

The left hand pane of the Disk Management window shows a "tree": 
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Double-clicking with the mouse on each branch of the tree opens or closes the contents of that branch, so that 
you can browse down through the levels to find a particular file. 

System is just a name for the top of the tree. However, when you right-click on System, one function is 
available on the menu that appears – "Properties". You can also press the PROPERTIES button. The page 
that appears gives you details of storage capacity and usage for all drives that can be seen on the system. See 
Checking space on your disk. 

My Computer lists every drive that is currently attached to the PC. This will include: 

 Lettered drives, including system hard drives c:, d:, etc, plus any network drives that are mapped to a 
drive letter within Windows. 

 CD-ROM, CD-R, DVD-ROM, or DVD-R drives, which will probably be mapped to a letter. Normally 
these will appear with a "book" icon beside the drive name/letter, which means that the drive is read-
only. For a SADIE-supported CD-R drive, it will appear as writeable when the appropriate media is 
inserted (CD-R disk). However if a CD-ROM disk is inserted, the drive will also appear as read-only. 

 PC Network will show you a list of all the other systems on your network, much like the "My 
Network Places" within Windows Explorer. You can browse down through this tree (if you have 
access rights) to find, copy, and log files on other disc drives on other systems. 

 Underneath, but still in the My Computer section, you may see drives that are attached to the PC, but 
not assigned letters under Windows, tape drives for instance. It is also possible to view and use drives 
that Windows cannot see – these will appear as a drive icon with a red cross through them. (More on 
that later.) 

Any audio file that you find in the My Computer section (and is SADIE compatible) can be previewed and 
imported into the Clipstore using the right-click menu items. Once imported the audio files can be used in the 
SADiE project and edited in EDL's. 



File Management 

247 

A SADiE project can therefore play back files from any drive that is visible in the "My Computer" section. It is 
also possible to play files from many different drives together in the same Playlist. However, this does assume 
that the drive and/or the network connection have sufficient performance for real-time playback of these files. 
You may find that copying the files to a local hard drive that has better and more predictable performance will 
save time in the long run. You can copy files in Windows Explorer (if the drives are visible to Windows) or 
SADIE's Disk Manager. 

Record Destinations – it is usual to set a standard target drive and/or folder for new recordings. You don't 
really want to have to specify a new file every time you press record. You will need to specify at least one 
"Record Destination" folder, which will appear in this branch of Disk Manager. 

In practise, it's likely that much of your searching for audio files in SADIE will be in a Record Destination, 
because that's where most of your recordings are. Each Record Destination has it's own tree view so you can 
directly browse for files in here (as well as in the main "My Computer" section). 

To set a Record Destination, browse to the chosen folder under "My Computer" in SADiE's Disk Manager, 
then right-click, and select "Set as Record Destination". The chosen folder will be the "root" for new 
recordings. When you create a new project, a sub-folder of this Record Destination folder will be created and 
all new recordings for that project will be saved in the project's sub-folder. 

You can set a number of different Record Destinations so that you can choose one when you make a new 
project, or perhaps, for performance reasons, you may wish to spread the audio across two or more disc 
drives. 

 
You can change the current Record Destination for the project by choosing the "Select Audio Disk" 
option from the Project Window's right-click menu, or from the button on the Project toolbar.  

The Copy Bin is a simple tool that enables you to drag files from different sources for copying, then drag the 
whole copy bin to a single destination. 

 
When you browse through your drives in Disk Manager, sub-directory folders will be shown for each 
Project . You can create further folders by right-clicking on the folder or disk name, or selecting it 
and using this button. 

These project folders will contain the audio and the waveform profiles of each Track. When Projects and their 
components have been backed up as described in the Projects section above, it will also contain packed Project 
files. 

 
These buttons on the Disk Management toolbar select whether only audio Tracks or all files are 
listed in the next column. On the far right, details for each file are given in columns that can be 
customised. Click on their heading buttons and select alternatives from the box that appears. The 
dividers between column buttons can be dragged to change the column width. 

NOTE: As with most Windows applications, multiple selection of files in the list can be done by 
selecting them while holding the Ctrl or Shift keys.  

RECORD DESTINATIONS 

Before you can record in SADiE you must first have nominated at least one Disk Drive or Folder on a disk 
drive to be a potential Record Destination. 

Then, every time a project is created, you will be asked to select which of the several Record Destinations shall 
be used by the Project. If you only have one Record Destination set then there is no question to ask ! 

A Record Destination is the "root" for all Project Audio files - when a Project is set to use a Record 
Destination, all it's audio files will be in a sub-folder with the same name as the Project. 
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As an example, if I choose to create a new Project called "All my hard work" and I've selected 
"c:\Audio\Fishybits" to be my "Audio Disk", then this Project's audio files will be recorded into a directory  

c:\Audio\Fishybits\All my hard work\ 

You set Record Destinations in Disk Manager: 

1. Open Disk Management from the File menu 

2. Browse to a folder in the "My Computer" section in Disk Management. 

3. Right-Mouse-click on your nominated folder's icon and choose "Set As Record Destination". 

4. The folder will now appear in the "Record Destinations" folder in Disk Management as shown above. 

It's likely that if you have just purchased a new turnkey SADiE system, a Record Destination may have already 
be nominated for you, but of course you can change this, and remove any unwanted Record Destinations by 
right-mouse-clicking and choosing the "unlog drive" option, which removes it from this list. 

Note that if the option for "Set as Record Destination" does not appear, and there are no Record 
Destinations in the list, then SADiE has been set to record to Removable Disk only. See the topic on 
Removable Disks. 

 

REMOVABLE DRIVES 

SADiE now includes a dedicated Removable Disk Administrator. See SADiE Removable Disk 
Administrator for more details. 

Historically, SADiE systems have been able to only use disc drives attached to SADiE's own dedicated SCSI bus. 
There was never an option to use PC drives for playback and record, only import and export. Thus, removable 
drives have been required in order to move projects from one SADiE to another. 

As operation has always relied so heavily on the use of removable drives, the facilities for removable drives, 
and particularly for protecting the data on removable drives, has been well developed over a period of several 
years. 

It was never recommended, but in SADIE4 you could remove a hard drive while SADIE was recording and you 
would be able to recover from that situation, with a recording intact up to the moment the drive was pulled. 

HOWEVER, SADiE v5 and its use of PC drives offers PC networking, interchange and the flexibility you would 
expect nowadays, but Windows and PC's work quite differently with disc drives in comparison to SADIE4. For 
performance reasons, you can never expect Windows to complete a file writing operation at the exact instant 
that you requested it to, or even at the moment that it reports a copy is complete. In practise, certain 
operations in Windows can take some time to complete – even minutes. 
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In short, it is HIGHLY DANGEROUS to remove a disc drive while it is operating and you risk corrupting 
the disc drive (and others perhaps) if you do so. It is EVEN MORE dangerous to remove Windows mounted 
drives while they are operating. 

So, if you've got into the habit with SADIE4 of removing drives without telling the software that you want to 
unlog it, then you have been lucky so far, but if you continue this practice with PC drives, then you will surely 
trash a drive soon.  

THE CORRECT METHOD FOR REMOVING DISK DRIVES. 

Removable disk drives will have to be in a removable carrier. A number of carriers exist, but the better ones 
include a "HotSwap" option to allow you to safely remove the drive while the PC is powered up. However this 
"HotSwap" option does not override the need to remove the drive under software. Before proceeding, close 
any open SADiE projects. 

Drives that are attached to the PC are drives that are lettered and thus belong to the PC and are under 
Windows' control. As suggested above, removal of Windows' drives can be more long-winded than removal of 
SADIE SCSI drives in older versions. 

 
Click on the drive's name in Disk Manager, and press the REMOVE DRIVE button (or right-click 
and select "Remove Drive"). 

SADiE will then ask Windows if it's OK to remove the drive (so you need to wait until this conversation has 
completed satisfactorily). There are a number of reasons why Windows may refuse to give up the drive:  

 The drive may be shared to a network. Windows almost certainly will not allow a shared drive to be 
removed. 

 The drive may be in use by another program. 

 Did you forget to close your project? If so then Windows will detect that the files are still in use and 
refuse to allow the drive to be removed.  

 Windows may still be writing to the drive for some other reason. 

If SADiE passes this inquisition successfully, you will see the message "It's safe to remove your drive now", and 
in this case, then it IS indeed safe to remove the drive.  

However, you may well see several messages from Windows explaining why it cannot be removed. Almost 
always the way to resolve Windows' refusal to remove a drive is to power down the system. In fact the only 
foolproof and 100% safe and reliable way to remove a drive from Windows under every possible circumstance 
is to remove the drive when the system is powered down. If you remove a drive when Windows has warned 
you not to, then you are in danger of corrupting the drive. You may get away with some times, but can you 
afford to take that risk? 

You will need the appropriate Windows Administrative privileges to hot swap drives. If a removal fails due to 
"access rights" or a similar message then contact your System Administrator. 

If in any doubt, turn off the computer before pulling the drive out. 

 
To log a drive that has been newly attached to the PC, click on "My Computer" in Disk Manager, and 
press the SCAN DRIVES button. SADiE will ask Windows to refresh its disk drives – this can take 
about 30 seconds. Take care to give the new drive time to spin up – if Windows doesn't find it first 
time you may have to try again. 

YOU MUST use the "Remove Drive" command in Disk Manager to tell the software that the drive is 
about to be removed before physically turning off the drive. If you remove a drive without doing this 
and while the PC is powered, there is a strong chance that your disk drive will be corrupted. 

CHECKING SPACE ON YOUR DISK 

 
In the tree, select the storage device you want to check and press PROPERTIES. A display box will 
tell you how much space is used, how much is available. This command is also available by right-
clicking on the device. 
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You can also use this button to show you the storage properties for the whole SYSTEM, which will look 
similar to this: 

 
Note that the Time Available is displayed in the format in which you are set to record.  

COPYING FILES 

You can copy files between disks or folders by simply dragging them across and releasing them over the 
destination symbol. You can drag-and-drop files, or folders, or even an entire disc drive. The directory 
structure within folders or whole discs will be re-created on the destination. 

The copy bin can be used as a temporary store when copying files from more than one folder. So, drag some 
files into the copy bin (from any directory. as you can use the copy bin as a "shopping basket"), then click and 
drag the Copy Bin to where you want the files copied to. 

File copying is a background process, so you can do other work in the foreground. You will be informed when 
the copy is complete. The speed of copying will depend on the demand made on the system by your 
foreground activities; the copy may actually stop during periods of heavy playback/record, then continue as and 
when the processor power returns. 

There are slightly different rules for Tape drives, as you can only perform a single drag and drop process at a 
time, either by dragging multiple files onto the Tape drive's icon, or by dragging a copy bin. You cannot drag 
folders or entire disk drives onto a tape drive. Although SADiE displays a directory structure on the tape, 
there is none; each "folder" on the Tape represents a single copy or backup session. Neither can you copy files 
to a CD-R. 
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During a Copy process, a new "copy process" branch appears on the left, and clicking on it displays the 
progress of the copy, which files have completed, and how far the others have got. 

Note that the Copy Bin has it's own "Used Space" entry in the System Storage Properties window. This will 
help you check how much space you need for your copy operation.  

--------New Copy Process 

RENAMING AND DELETING FILES 

 
Select the file and press the RENAME button to rename it or the DELETE button to delete it 
from the audio disk entirely. These commands are also available by right-clicking on the file name. 

WARNING: Renaming an audio file that is used by a saved EDL will mean that the EDL will not be able 
to find it when it is next opened. Only currently open EDL's are updated with the new name. 

WARNING: You cannot retrieve a deleted file; all EDL's that refer to it will be affected. 

TAPE AND CD-R DRIVES 

Tape Drives will always appear in Disk Manager with a tape icon. These Tape drives may be attached to a PC 
SCSI card. 

Windows will not assign a letter to a Tape drive, and in fact the only sure-fire way of checking that the Tape 
drive is properly attached, is to check in Windows Device Manager, or perhaps open Windows Backup to see 
if a Tape drive is available. Or, of course, if you can see this tape icon in SADiE’s Disk Manager, then of 
course... it's there!  

Tape drives can also be used under Windows, however SADiE must be closed first before a Backup program 
can take control of  the tape. 
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Tape Backup devices are treated as normal disc drives by Disc Manager. You can copy to and from, and format 
tapes as you would an audio drive. Thus to make a backup for example, to an Exabyte tape, follow the normal 
copy procedure above: drag and drop files onto the Exabyte drive, or via the Copy Bin.  

Copying from a tape follows the same procedure: find the files you want in the directory displayed in Disc 
Manager, and drag it to the copy bin or directly to the destination drive. Due to the directory structure on the 
tape, the Tape drive will automatically seek and copy the selected files (like a hard disk!) 

You will notice that some tape drives are quite slow to react to rewind/fast forward commands, and so may 
take some time to reach the nth backup on a tape. For this reason, a tape drive (and likewise a CD-R) will not 
be fully logged on initial start-up; the drive is recognised but its contents are unknown until it is formally logged. 

Tapes must be formatted before they can be used for backup. This is not the case with DDP tapes as it is a 
very different format, and backup and DDP cannot co-exist. A tape format or a DDP write will completely 
overwrite the previous contents of the tape. 

If you attempt a copy onto an unformatted tape, you will be asked if you wish to format the tape first. 
Formatting a tape can take a few minutes, depending on the drive type. Ask you dealer about supported tape 
drives. 

CD-R drives will usually appear as a Windows letter, and, depending on the medium in the drive, may have 
the "book" icon to denote that it is Read-only. If the drive is a SADiE compatible IDE or SCSI CD-R burner, 
then this can be used for writing Red Book Audio CD's.  

Of course, this CD writer will also be available to Windows, and with the appropriate CD burning software, 
you will be able to use this drive under Windows for copying files (for backup purposes perhaps). It won't be 
that much use for DSD material as it is usually too large to fit any substantial amount of audio on a CD. 
However, you may find this useful for copying other data. 

ARCHIVING 
The quickest and most effective method of archiving your audio is to a Tape Backup drive. Transfer time is 
usually quite a bit faster than real-time and tape costs are reasonable. Consult your dealer about supported 
drives. 

There are essentially two ways of backing up and restoring in SADiE: 

 Use the Copy Process inside Disc Management. This gives you most flexibility, as you can drag and 
drop exactly the files you wish onto the Tape drive. It is possible to copy your files from the PC disk ( 
Project components, EDL 's etc.) so that they can be backed up alongside the audio. See Backing up a 
Project to the Audio disk. 

 Use the "Project Backup" and "Restore" functions described below. These are much simpler to 
operate but hence less flexible. 

There is no reason why you can't "mix and match" the two methods, perhaps using "Project backup" to archive 
the project, but then the normal Copy process to partially restore it.  

PROJECT BACKUP 

One easy method of backing up to a Tape drive is by using Disc Management's Copy process. However SADiE 
also provides a "one-shot" method of backing up a project . along with its associated audio files: 

1. Select "Backup Project" from the "Project" menu, then select "Total Project Backup to a storage 
device". 

2. The backup tape will be logged, and if necessary you will be offered the chance to format it. You will 
then be asked for a backup name. This is just the name of the directory on the tape, and so need not 
be the same as the project name, but it is wise to form a naming procedure for yourself. 

3. The Project Backup Progress box will appear: 
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4. There will be a short pause while the Tape drive prepares itself, then the list of files will be worked 

through and copied to the tape. Do not be alarmed at the number of "duplicate file names"; each 
audio file is actually at least 2 separate files. You can see in the diagram the files marked [ADM] are 
the (larger) audio files, and the [PFM] files are used for displaying the waveform information. The files 
above are mono, so stereo audio will require 4 files. The first file above (//Hippo/Kevin [APJ]) contains 
the all of the project components ( EDL 's, Mixers, Clipstores) that belong to the project. In relation 
to the audio files this is trivially small. 

5. Once the Abort / Close buttons are coloured in black and the backup is proceeding, you can hit 
CLOSE and allow the backup to carry on in the background, while you play EDL's in the foreground. 
As with the Copy process, (Project Backup is nothing but a fancy copy process) foreground demand 
will reduce the speed of the backup. 

NOTE: Only tracks tagged "Yes" or "Always" will be backed up as part of the project. This will only not 
be the case if you have run the "Cleanup Project" or "Tag Source Tracks" functions. 

A Project backup size report will be displayed in the Backup dialogue. This will only include the size of the 
tagged audio files in the project, and does not include Project components or "other files". It therefore may not 
equate exactly to the storage required for the backup. 

This method can be used to backup the project to any suitable drive. However the project will have to be 
correctly restored before all the project component files match the new audio files. 

In brief, EDL's and Clipstores look for audio tracks by name and full path. For instance the EDL would see a 
track called "KEVIN" in a directory called "FRINTON" on a drive named "HIPPO" as: 

//Hippo/frinton/kevin 

If you move the audio track to a new disk or directory, the EDL cannot find it automatically. Thus if you use 
"Project Backup" to backup a project to a normal drive, the EDL's are still looking for files on the original drive, 
and if you open the project again, with the original disk missing, all entries will be ghosted, even though you 
know the audio is on the new drive. 

The correct way to deal with a "Project Backup" is to restore it to another drive. This function should not be 
used to move the audio tracks to another disk. 

NOTE: The Exabyte drive may be busy for a long time after SADiE has apparently finished with it, and 
you'll find that you may not be able to start another backup or restore for a few minutes.  
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PROJECT RESTORE 

" Project Backup" provides a "Snapshot" of the current state of a project when it is backed up. Thus "Project 
Restore" is designed to return the Project to exactly the same state as it was at the time of the backup. If there 
are any traces of the project, or a project of the same name, on the audio drive to which you are restoring or 
the path on the PC drive where the EDL 's, Clipstores, mixers etc. reside, they will be removed or over-
written by the restore process. Thus if you have continued working on the project and wish only to restore a 
few tracks this is not the function for you! Likewise if the backup is only a partial backup and you don't wish to 
disturb the existing project, then the only way to restore is by using the Disc Manager Copy function. 

To restore a Project that has been archived by "Project Backup": 

1. Close your current project; you must be outside projects to start a Project Restore. 

2. Select Restore Project from the Project menu, then "Total Project restoration from a storage device". 

3. Choose from the list of available backed-up Projects. 

4. The Project Restore Progress box appears. This is nearly identical to the Backup Progress box above, 
and reports on the progress of the restore. 

5. As with backup, once the Tape drive has started, you can close the Progress box and continue 
working in the foreground, pushing the restore to the background. 

6. The Project files will be copied to your PC's DOS drive, the Tracks will be copied to your audio disk 
and you can then open the Project as usual. Note that project component files will returned to where 
they came from and if you have changed your working directory since the backup, then you will have 
to go hunting! 

NOTE: Some Exabyte tapes can take quite some time to log, particularly if they have a number of 
backup sessions on them. You may find that v2 backup tapes will take even longer because there is no 
main tape directory. We have a tape containing many sessions of hundreds of tracks that takes about 1 
hour to log! In this case it would be quicker to use v2 to restore this particular tape.  

SELECTIVE ARCHIVING 

If you are working inside a project . it is possible to mark files that you wish to be included in a Project Backup. 
You will notice that there is a "Tagged" field in the table section of the Source Tracks Folder inside the 
Clipstore. When "Total Project Backup" is selected, it is actually only the Tracks marked "Yes" for backup that 
are copied to the storage device. 

In the Source Tracks Folder you can manually change Tracks' tag setting by double clicking on the field to 
toggle between "Yes" and "No". 

 
TAG SOURCE AUDIO TRACKS on the Project Window toolbar brings up a dialogue box 
which allows you to: 

 Tag all the used Tracks - this will look through all open EDL 's and Clipstores in the Project, and mark 
Tracks used with "Yes" for backup. 

 Tag all of the Audio Tracks - marks every Source Track as "Yes" for backup. 

 Tag all unused Audio Tracks - this is the reverse of "Tag used tracks" above, and would be used for 
deleting unused audio. See Cleanup Project. 

If there is audio that you want to be backed up, whether or not the Track is used in open EDL's then right-
mouse clicking on the backup field in the Clipstore will change the field to "Always". Tracks marked "Always" 
are unaffected by the "Mark Audio for backup" function.  

ARCHIVING NON-PROJECT WORK 

If you have work to archive that was not kept in a Project . you can use the Copy facilities in Disk Management 
to copy Tracks to another storage device. You will then have to copy the EDL . Mixer and Clipstore files to 
floppy disk, using Windows® Explorer.  
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FILE FORMATS 
To allow interchange with other equipment, SADiE can work with a number of different Disk Formats, and 
read and write and convert a number of different audio file formats. Additionally SADiE supports several 
different Edit list formats.  

AUDIO DISK AND FILE FORMATS 

If you are taking files from other systems and/or passing audio on to be worked on with another workstation 
(which is becoming more of a regular occurrence) then read on... 

It is important to recognise the distinction between Disk Formats and File Formats. A system may require a 
disk to be configured to a particular format so that it can recognise its filing structure, whereas software 
programs will require the data files to be arranged in a certain way in order to read those files. So you may 
have the right disk format for a system, but unless the file formats are compatible for your software then they 
may not be readable, and vice versa. 

SADiE deals mostly in Audio files, and usually the organisation of the PCM audio data is similar from one file 
format to another, but the file headers (which will contain other information about the audio - sample rate, 
sometimes time-code stamps etc.) will differ from format to format. 

SADiE can work with a number of Disk Formats (as described above) and can play and record in a number of 
different types of File Format. 

NOTE: SADiE can handle these different disk and file formats at the same time, so it is quite possible to 
be playing for instance SDII files from a Mac HFS disk, Lightworks and WAV files from a FAT 32 disk, 
and SADiE3 native files from a SADiE3 disc in the same Playlist. The Playlist makes no distinction 
between the different file types and you will have mostly the same facilities throughout. The only 
differences are that certain disk and file types allow for fewer characters in the file name, and some 
audio file formats treat stereo files differently. For instance with Lightworks a stereo file will always be 
two mono files, whereas a stereo WAV is one file, although the user will perhaps only notice these 
differences during file copying and maintenance. 

You choose a file format every time you record, bounce, or use "Offline Processing or "PC audio import". To 
change the selection, pressing the "Properties" button on either the Transport Controls, Bounce Window, 
Offline Processing Window, or PC Audio import window, will show the Properties page for the file you are 
about to record, and you can change the details at this point. 

The File format selection offered will depend on the format of the disc you are recording to. When you choose 
a file format, that will persist until you change to recording to a different disc drive that has a different format, 
when SADiE will keep using that file format if it is allowed, but otherwise will flip to "Native" (the chosen 
default format for that disc format). 

When you're recording to multiple disk drives of different disk formats simultaneously (!!) if you choose a 
format that is incompatible with one of the disk drives you may be told "File is invalid". In such a case SADiE 
does not allow you to choose a specific file format for each drive, and you must choose one global file format 
or "Native". 

Some settings such as sample rate will be fixed to the current system sample rate. "Bit resolution" will default 
to the system input setting (see the "Audio" section of the Setup window), but when you change it in the 
Properties window, this setting will persist until you change the system setting again. "Take number" is not 
editable, it is automatically created when you turn on the "Auto-Take" function and increments a number on 
the end of the file name. 

 
Some fields in Properties can be edited after the recording has been made, for instance reel name, 
reel track number, comments and references (if allowed by the specified format), and you can access 
the Properties window by selecting the Track in the Source tracks folder of the Clipstore and 
pressing SOURCE TRACK DETAILS. 

Files can be recorded and played back in SADiE at a number of bit resolutions and sample rates: 

 16 to 24 bit (32 bit floating-point too in the case of SADiE3 format), OR 

 32 kHz up to 48 kHz plus, OR 
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 double (88.2 kHz/ 96 kHz) and quadruple (176.4 kHz/ 192 kHz) rates. 

Some files formats will restrict this, but if you intend to interchange this file you should make sure that the 
system waiting to accept it can handle these bit or sample rates. For instance you could make a 96 kHz 20 bit 
WAV but does the other sound card and/or software support more than 16 bit and more than 48 kHz? 

The file formats supported, as of SADiE v5.4 are: 

 SADiE3 - SADiE3 (and SADiE4) own proprietary format. 

 WAV - The standard Windows audio format. 

 BWF (Broadcast Wave Format) - an extension to the WAV format to include timecode stamping and 
other references. 

 SDII - A common format in Avid and ProTools systems. You can only record in this format in SADiE 
onto a Mac HFS formatted disc, because of the Macintosh resource fork structure. Note also that 
these files cannot be copied onto a SADiE backup tape for the same reason; the tape is essentially in a 
DOS format, which is incompatible with Mac files. 

NOTE:- as of SADiE v5.2.2, if you have “MacDrive” installed, you will be able to record SD2 files 
to NTFS formatted disk drives, but the restriction over backup tapes still applies. See the SADIE5 
and Mac Disks topic for more details as to how to use MacDrive. 

 WAVE64 -  this is a new format which has been designed to cope with the file size restriction that 
applies to normal WAV and BWF files. WAV files cannot be larger than approx 4GB, so if your 
recording is expected to exceed this, WAVE64 would be a good choice of file format. (SADiE3 format 
also allows >4GB file formats). For interchange it would be wise to check that the receiving 
application can support WAVE64 as this is nowhere near as widely spread as WAV (the current (April 
2005) Windows Media Player does not support it "out of the box"). 

 AIFF - The standard Macintosh audio format. A file of this format can be copied to a DOS or SADiE3 
formatted disc because it has no resource fork. 

 AIFC - Another standard Macintosh audio format. A file of this format can be copied to a DOS or 
SADiE3 formatted disc because it has no resource fork. 

 FilmWAV - Another extension to the WAV format for Film applications. 

 Lightworks - The Lightworks Video Editor's audio format. 

 IDS - A proprietary format used by IDS systems. 

SOUND DESIGNER 2 FILES, MACINTOSH DISK DRIVES AND MACDRIVE 

SADiE3 and SADiE4 have supported HFS Mac Drives and SD2 files as if they are native, however since 
SADiE5's move over to using Windows' own disk drives, Mac drive support requires assistance from other 
utilities because Windows does not read or write Mac drives as standard. 

SADiE v5.2.2 introduces a new method of reading and writing Mac disks and Mac files, and this integrates 
better with Windows, using a third-party utility called MacDrive. 

This adds to SADiE the facilities to read and write to/from HFS+ drives as well as reading and copying Mac CD-
ROMs  

MACDRIVE 

MacDrive is a product from MediaFour (see http://www.mediafour.com/products/macdrive/).  

MacDrive provides a simple solution for file sharing between PC's and Mac's. Note that there are a number of 
similar products on the market but SADiE is only compatible with MacDrive. 

After purchasing and installing MacDrive, Windows is able to access Mac formatted drives and files.  Mac files 
don't use file extensions (i.e. .doc, .exe etc.) in the same way that Windows does, instead its files have "type" 
and "creator" properties to identify them.  MacDrive uses "extension maps" to convert these variables into 
Windows recognisable file extensions. 
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As standard, MacDrive 5 does not have settings for Sound Designer 2 files (which tends to be Pro Tools' native 
audio format on the Mac). In order for SADiE to recognise the required file types, it is necessary to import the 
necessary extension map into MacDrive.  To do this, follow these simple steps: 

NOTE MacDrive version 6 now includes extension maps for SD2 files, however, verison 5 did not come 
with SD2 as standard. For MacDrive 5, the follow these instructions, but it's not necessary with 
MacDrive 6. 

1.  You will first need our own customised "Extensions Map file" which can be downloaded from the 
same place as the SADiE5 software. Copy this file (called MacExtensionMaps.macxtmap) to your hard 
drive. 

2. Right-Click on the MacDrive symbol in the system tool bar at the bottom right of your screen. From 
the pop-up menu select "MacDrive Properties". 

3. In the window that appears select the "Extensions Map" tab. 

4. Click the "Options" button, then select "Import Extension Maps…" from the menu. 

5. A dialogue will appear warning you that this will overwrite the existing map, select "Yes" to continue. 

6. From the browse window open the MacExtensionMaps.macxtmap file you've just copied to your hard 
drive. 

MacDrive will now correctly recognise SD2 files in such a way that SADiE will be able to read them from a 
Mac-formatted disk drive. 

DUAL FORMAT CD'S 

Some CD-ROMs have both Macintosh and PC volumes.  Normally, when presented with such a dual-format 
CD-ROM, MacDrive will ignore the Macintosh (HFS or HFS+) volume, and allow the PC (ISO-9660) volume to 
be made accessible.  You can choose to access the Mac volume, instead, by selecting the "Show Mac Files" 
option – Right click on the drive in Windows Explorer, select the MacDrive option from the menu, then select 
the "Show Mac Files" option. 

COPYING SD2 FILES 

SD2 files (but not AIFF) are an example of a Macintosh file type that has two "forks"- a data fork (which is the 
audio data in an SD2) and the "resource fork" which contains other "header" information about the file – 
sample rate, bit rate, number of channels etc. Resource forks are the component of a Mac file that Windows 
has most trouble with as Windows doesn't natively use forked files. 

If you copy an SD2 file under Windows, even using "MacDrive" so as to work with its original Mac disk, you 
must take care note to "lose" its resource fork, and thus, when it comes to log the file in SADiE, we will not be 
able to read the all-important header information. 

Fortunately, Mac files with resource forks CAN be stored on NTFS volumes under Windows. Thus if you are 
receiving the SD2 files on Mac CD-ROMs or HFS or HFS+ disk drives you WILL be able to copy the files to an 
NTFS drive, and SADiE will happily read the files via "MacDrive". 

BEWARE however – FAT32 formatted disk drives will NOT store the resource fork, and so if you copy SD2s 
to one of these, SADiE will not read the files. Likewise, if you copy SD2 files from an NTFS drive to say a 
Windows IS9660 CD-ROM or DVD-ROM then the resource fork will be lost. Similarly SADiE tape backups 
cannot retain the resource fork, and thus SD2s cannot be backed up under SADiE. Thus, it may be worthwhile 
considering bouncing the SD2 files as soon as you receive them to some other PC-centric format such as BWF. 
If you carry on working with SD2s, any other SADiE system you pass them on to will need MacDrive in order 
to work with them. 

NOTE: you cannot copy SD2 files inside SADiE's Disk manager. However copying SD2 files between 
Mac & NTFS drives will work in Windows Explorer if MacDrive is installed correctly with our Extension 
Map file. You may find that MacDrive gives you messages of the kind "File XYZ.SD2 has extra 
information attached to it that might be lost if you continue copying … Macintosh Application Info / 
Macintosh Multimedia Resources …". We are told that this message is less destructive than it sounds, 
and in practise, the SD2 files copied back to the HFS drive (under Windows Explorer) do have a 
resource fork. If you are worried, then just check that SADiE can preview a file in Disk Management 
from its new location after it has been copied – if it can, then the resource fork has copied correctly. 
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In practise, if you intend to work with SD2 files, then it makes good sense to retain a HFS or HFS+ formatted 
disk drive to keep them on. 

SD2 FILES ON CD-ROMS 

It's quite common practise to send files from one system to another by CD or DVD-ROM. However you must 
be careful because SD2 files cannot be placed on a PC / ISO-9660 CD-ROM - the resource fork will be lost. 

However, it is possible to "pack" the resource fork in with the file in such a  way that the packed files CAN be 
placed on a ISO CD-ROM. There are a couple of methods. 

Note also that if someone is supplying files on CD-ROM for you to read, then either the same methods below 
must be used, or else he/she should supply the SD2 files on a Mac format CD-ROM. It is NOT helpful to you if 
they supply SD2s on a PC format CD-ROM !! 

MACBINARY 

MacDrive has an option (which is available as a right-mouse-click on an SD2 file inside Windows Explorer) to 
"Create MacBinary files". A MacBinary file is a format which is used to contain Mac files on a non-Mac disk – 
essentially this process wraps up the data and resource forks along with its icon, file type , file creator 
properties etc. into one file. 

When MacDrive makes a Macbinary it will give the file a ".BIN" extension. MacDrive can also extract a 
MacBinary to revert it to a proper Mac file with its resource fork. Thus converting files to MacBinary format is 
a way of ensuring that the Resource fork is not lost when moving a Mac file across disk drives/ CD-ROMs / 
SADiE backups etc. 

MacBinarys will have to be "extracted" to SD2 files for SADiE to be able to use them. Stuffit by Aladdin 
systems (www.aladdinsys.com) is a file compression/archive tool for the Mac (which is also available for the PC) 
that can decode Macbinary files. 

STUFFIT 

Another method would be to use Stuffit to "zip" all the SD2s into a single archive. This single file could then be 
placed on an ISO CD_ROM - the single file could then be "unzipped" by Stuffit in the Mac. 

MACDRIVE VERSION 6 AND MAC CD BURNING 

A further solution to these problems arrives in the shape of MacDrive Version 6, which now offers two further 
useful functions. One is the inclusion of SD2 files as standard, as mentioned above. The second is the inclusion 
of the Mac CD Burning under MacDrive. This is the obvious way to go now, as the receiver of the files on a 
Macintosh will be able to read the Mac CD, along with the SD2 files and their all important Resource Forks. 

The only remaining difficulty is that you must ensure that anyone sending you SD2 files from a Mac should 
NOT attempt to make them "more readable" by putting them on a ISO 9660 disk, but should burn them to a 
Mac format CD - with MacDrive the PC can happily handle Mac CDs, and this method will retain the resource 
fork. 

FORMATTING DISK DRIVES UNDER MACDRIVE 

If you want to create files in SADiE to pass onto a Mac system, it will be useful to work with a disk drive that is 
formatted for the Mac, i.e. HFS or HFS+. SADiE can only record in SD2 format to Mac formatted drives. 
MacDrive has support for formatting to HFS or HFS+ but only for "removable" drives – i.e. FireWire, but not 
SCSI drives (which are not handled under Windows Removable Storage regimes.) 

Additionally, however, MacDrive can format any hard drive that is already formatted for Mac. For this reason 
we have retained the ability to format a disk drive to Mac format inside SADiE. 

In Disk Management, right-click on the drive you want to format (you REALLY DO want to format this 
particular drive ??); and select "Log Device Direct" (this will only be available for SCSI or removable drives). 
This removes the disk drive from Windows (if Windows agrees to its removal) and places the drive entirely 
under SADiE's own control. Now right-click again and choose "Format", and select the final option "HFS (1 
partition)". 
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SADiE will format to a single HFS partition. If you want to make an HFS+ disk, you will now be able to format 
this drive under MacDrive (right-click, "MacDrive", "Format disk…"). We've noticed that sometimes Windows 
will not allow MacDrive to format a drive if this is initiated from an Explorer window, however it seems to be 
successful if you initiate the format from a "My Computer" view. 

FILE NAME LENGTH 

In the MacDrive Properties page there is a "Save full-length MAC OS X file names" option.  If you disable this 
option MacDrive will truncate any existing Mac files who's names are greater than 31 characters (including the 
extension).   

MacDrive only truncates any offending file names: 

1. When the above option is disabled in the properties and the apply button is clicked. 

2. When the PC boots up with above option disabled. 

TRACK NAMES 

The number of characters you can use for the name of the recording depends on the disk and file format. 
SADiE allows up to 64 characters for the file name (on the disk), and 28 for Mac HFS disks. 

If you are intending the interchange with Mac, then it's advisable to restrict the number of characters you put in 
the track names, however it's always a good idea to keep the length of file names wihtin reasonable limits. 

Also, SADiE may allocate some of the final characters in the filename automatically. For instance, if you are 
recording with "Autotake" the Autotake number will use two or three characters at the end of the file-name. If 
you are recording multi-track, then additional characters at the end of a filename are used to include the 
stream name (up to 10 characters) and an Autotake number. 

You should be wary of changing file or track names after you have made an edit unless the EDL or clipstores 
using those audio files are open. The SADiE EDL, clipstore and project will be using the file name to link the 
EDL entries to the audio file. 

Files recorded in SADiE do have other ways of linking via unique identifiers, however you may still have to re-
import the file if it becomes unlinked.  It is better to rename the Entries in the EDL.  

RECREATE PROFILES 

When tracks are recorded with SADiE, a "profile" file is recorded at the same time, which is used to display 
the lower resolution waveform views in the Playlist. These appear in the file listing in Disk Management as 
"*.PFL", "*.PFR", and "*.PFM" files, but only when you choose to SHOW ALL FILES. 

However if files are recorded outside SADiE and have been copied up to SADiE's hard disk or have been 
brought in on a non-SADiE formatted disc (e.g. WAV, AIFF, Lightworks, SDII files, etc.), then they will not have 
profiles. (Files imported with "PC Audio Import" are re-recorded and will have profiles already.) 

However the first time you import any of these files into the project . SADiE will detect the lack of profile and 
automatically make a profile file for each track . This is often quite quick, however if you import long tracks or 
lots of smaller ones, then you may see the profile being drawn. If you drag a clip into the Playlist, it may not 
immediately show its profile, but will draw it as you watch. 

If you exit SADiE before a profile has finished being created it will delete any partial profiles and start re-
creating them the next time you open the project. 

It shouldn't be necessary, but if for any reason you wish to make the profile file, then there is a function to 
start this manually; the option to "Recreate Profiles" will appear in the right-click menu on the Source Tracks 
Folder of the Clipstore. You can select a number of clips (using the Shift or Ctrl modifiers) and "Recreate 
Profiles" will work on all of them. 

Note that profiles are created at the sample rate at which the track is stamped, and so if for any reason the 
track has picked up the wrong sample rate stamp, then "Recreate Profiles" is not able to change this. The 
quickest way to rectify an incorrect sample rate stamp is to bounce the whole track at the correct rate.  
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EDL FILES 

If you bring an EDL file into your PC that was created on a different system, when you open it SADiE will 
automatically detect any of seven different formats and ask you if you want to convert to SADiE v4 format as 
you open it. 

NOTE: SADiE v2 EDL's differed from v3 and v4 ones in that they lacked automation data, Stream layout, 
etc. These can also be converted to v4 format, but you cannot use the old v2 mix files. 

Alternatively, the "Convert File" command in the File menu allows you to convert files between any of the 
recognised formats: 

Press the SELECT INPUT FILE button to locate and select the file to be converted and select its file type 
from the list that appears. 

Press the SELECT OUTPUT FILE button to give the converted file a new file name and locate the folder 
you want to save it in. 

You can select "From Playlist " to convert the EDL in the active Playlist to another format, and "To Playlist" 
when converting and importing an EDL to the current Playlist.  

COPYING FILES TO AND FROM THE PC 

BOUNCE TO PC DISK 

There are some options inside the Bounce Window to enable you to record files directly onto the PC disk. 

If you check PC disk as the destination, then the result of the bounce will be a WAV file on the selected PC 
disk, rather than on SADiE's own audio disk. Use this to transfer edits as complete WAV files, or simply to 
convert a SADiE format file to a WAV on the PC disk. 

This used in conjunction with "Multi-Bounce" would enable you to mix down each entry of the Playlist as a 
separate WAV file on the PC disk. 

See Special Bounce Functions for more details.  
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9 - SPECIFIC APPLICATIONS 

This section aims to do two things: 

1. To offer tips for using methods described in detail elsewhere in the manual, where they may be 
relevant to particular areas of work. 

2. To give a detailed description of several SADiE facilities that are only relevant to certain applications. 

As many techniques can be applied to different circumstances, it is a good idea to read the tips for areas of 
work other than your own. 

Synchronisation 

Synchronising Rushes 

Autoconforming 

Surround Sound 

CD Pre-Mastering 

Radio Programmes 

Music Editing 

AES31 and OMF 

AAF Interchange 

Pro Tools 5.0 Interchange 

Video 

SYNCHRONISATION 

Whether you are working to picture, running in sync with a multi-track tape machine or recording from a 
timecode DAT, you will want to lock SADiE to other pieces of equipment. 

SADiE can generate timecode and run as a master. You may want to do this to drive a sequencer running on 
MTC (Midi Timecode), or to stripe videotape. However, most mechanical machines cannot chase timecode. 
SADiE will not only chase incoming timecode, but can also locate to any point in an EDL instantaneously, so 
you will usually run SADiE as a slave to the timecode generated by other equipment. 

With SADiE slaved to timecode, you can use the transport controls of the master machine and SADiE will run 
in sync However, if you add 9-pin control of the master machine, you can also control that machine's transport 
and locating functions from SADiE. 

Timecode carries both current-time and clocking information. 

Connecting Timecode 

Setting up sync details 

Enabling and disabling Synchronisation 

Monitoring Timecode sync 

Setting up 9-pin control 

Using 9-pin control in sync 

9-Pin Machine Control 

9-Pin Slave 

Working with Sync Material 

Maintaining Sync 

CONNECTING TIMECODE 

SADiE provides a number of different ways of reading timecode to suit the user's requirements. 

To synchronise to external equipment you will need to consider both clocking and current time information. 

SADiE's audio clock can be synchronised to: 

 Digital Audio - via AES, SPDIF or Genlock/AES Ref connector 

 LTC (Longitudinal Timecode) - via the LTC In connector 

 Video clock - via the Video In connector 

Current time can be read via: 

1. LTC 
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2. 9-pin timecode on the RS422/9-pin port 

3. VITC 

Here are three suggestions for connecting up SADiE for synchronisation. There are many other combinations 
but these are the simplest. Explanations appear later in this chapter. 

1. LTC 

i. Connect a cable from the external player's (VTR/DAT/etc.) LTC output to SADiE's LTC In. Be 
careful with respect to feeding balanced connections into unbalanced inputs or vice-versa. 
Most LTC faults are due to bad cabling. 

ii. In the "Synchronisation" section of the Setup window choose: 

 Frame rate - to suit 

 Timecode type - LTC 

 Sync mode - Slave Mode 

 Slave Mode - "Trigger Lock" for digital playback or recording, or "Chase Lock"for 
analogue. 

 Under "Autostart and Offset" set Autostart to 2 seconds. 

 Right-click on the ONLINE button and select "LTC sync" 

 No need for 9-pin connection or Video 

iii. Pressing ONLINE and putting the external player into play will start SADiE's EDL playing, 
following the player's current-time. 

2. LTC WITH 9-PIN CONTROL 

i. Connect as per the LTC method, and set the Sync Setup the same. Additionally: 

 Connect a 9-pin lead between the external player and one of SADiE's 9-pin ports. 

 In 9-pin Channels Setup, enable that 9-pin port for Sony 9-pin master. 

 Right-click on the ONLINE button and select that 9-pin port. The menu will show 
the machine's name if it recognises it. 

 No need for Video cable. 

ii. When you press ONLINE, the transport controls will now control the external player. "Play" 
puts it into play and SADiE will follow. If you double-click on the EDL's time line, the external 
player will locate to that position before playing, and SADiE will wait for it to locate before 
starting. SADiE's scrub controls will jog/shuttle the external player and SADiE in sync. 

3. 9-PIN SYNC METHOD 

i. This method requires no LTC lead or LTC setup. You will need a 9-pin lead between the 
external player and SADiE's 9-pin port. Additionally you must connect a video signal to the 
SADiE hardware's Video In to provide clocking sync. This could be from the external player (if 
it is a VTR) or could be a station video sync signal. 

ii. In Sync Setup choose: 

 Frame rate - to suit 

 Timecode type - 9-pin 

 Sync mode - Slave Mode 

 Under Autostart and Offset set Autostart to 2 seconds. 

 Audio Clocks 



Specific Applications 

263 

 The setting of Slave Mode on the sync setup page is irrelevant; SADiE is always in 
"Trigger" Mode with 9-pin timecode. Thus to avoid drifting, the audio clock must be 
locked to the timecode. See the notes on Trigger and Chase lock. 

 If you're recording digitally: Set your digital clock as normal, either "Automatic" in the 
"Audio" Setup section, or "Genlock" to the recorded input or Genlock input if you 
have a house AES/EBU signal attached to the AES Ref In (if your hardware has one). 
NOTE: the incoming digital audio signal must be in sync with the video reference. 

 If you're recording analogue: Under the "Audio" Setup section, you should set 
"Internal" Clock to "Lock to Video". 

 Right-click on the ONLINE button and select that 9-pin port. The menu will show 
the machine's name if it recognises it. 

iii. Press ONLINE to control the external machine. Operation is identical to method 2 above. 

NOTE: Video lock is like chase and so varies the audio clock to lock onto the video signal 
and increased jitter may be noticed. If you're recording or playing out digitally whilst locked 
to video you'll get more solid lock if you set the clock to AES/EBU. Video lock is fine for 
analogue recording and playback.  

SETTING UP SYNC DETAILS 

Select the "Sync" section of the Setup window. 

 Frame Rate - select the frame rate you are working to in frames per second: 

24 Cine film 

25 EBU - European TV 

29.97 North American TV (Colour) 

29.97 drop North American TV (Frame accurate Colour) 

30 North American TV (Monochrome) 

 Timecode Type - select the type you wish to generate, or slave to. 

 No Timecode Sync - incoming timecode is ignored and no timecode is generated. The ONLINE 
button in the Transport Controls, or on the hardware controller will only enable 9-pin control. 

 Master Mode - SADiE will generate timecode and output it from the relevant socket on the Breakout 
Panel, in one of two ways: 

o Sync to Video - locks the generated timecode to the clock of a video signal connected to the 
"Video" BNC socket on the panel. If you set it like this and don't connect a clock source, you 
won't get any timecode! Used for striping videotape, with a Station Clock connected to the 
BNC. 

o Sync to Word Clock - the normal setting, where the generated timecode is locked to the 
digital audio clock currently generating SADiE's sample rate. The source of this clock is 
selected in the "Audio" section of the Setup window. 

 Slave Mode: - SADiE will follow the timecode arriving at the relevant timecode input socket, in one of 
two ways: 

o Trigger Lock - after receiving timecode, SADiE starts at a synchronised point and then runs 
on its current digital audio clock, as described above. After several minutes it is possible that 
there will be a drift between SADiE and the timecode, unless you have a reliable station clock 
to which you can Genlock all equipment. 

o Chase Lock: - SADiE's audio clock follows the incoming timecode so that the sample rate is 
continuously varied to track it and therefore make slight variations in replay speed. 
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NOTE: In Chase Lock, variations in the replay sample rate from chasing a VTR will mean that 
the digital audio output is unlikely to be acceptable to other equipment, such as the digital 
inputs of a DAT recorder. It is generally best to use Trigger Lock for digital transfers and 
Chase Lock when doing analogue transfers. 

 Timecode Slave: 

o TimeSync - turns on SADiE's TimeSync function. At jumps in incoming timecode value, which 
result when a machine recording field timecode is stopped and restarted, SADiE creates a 
new Track and automatically relocates to the new value so that EDL Entries are automatically 
placed at the correct point in the EDL with respect to their timecode. Similarly in playback 
SADiE will follow the jumps in timecode. You need to have Autotake on in the Transport 
Controls when using TimeSync. 

Note: TimeSync can only be used when you are set to record in SADIE3 file format 

o Don't stop after valid Timecode - if this is selected, if timecode disappears for longer than the 
flywheel time, it will be ignored, and SADiE will continue playback. 

Double-click on the + sign next to the "Sync" label in the Setup window to display the sub-section "Autostart 
and Offset". 

 Autostart Time - sets the delay between SADiE detecting incoming timecode and starting playback in 
Slave mode, so that the current EDL can be compiled. The default value of 2 seconds is adequate for 
most situations. If you find that SADiE misses the trigger point in complicated EDL's, increase the 
delay. The display is adjustable in the same way as all other time displays. 

 Timecode Offset - sets a fixed difference between SADiE's EDL time and the incoming timecode in 
Slave mode and the generated timecode in Master mode. 

 Flywheel Length Frames - sets the amount SADiE runs-on after incoming timecode stops. 

 Record Stop Time - sets the time between timecode disappearing and SADiE stopping record while 
slave to timecode 

 Record Time Stamp Delay - the time between SADiE recognising a new timecode and time stamping 
the track it is recording. When SADiE is recording in sync it will wait until timecode is steady, and 
then it will time stamp the recording, back calculating the time to the start of the track. You may find 
that when TimeSync is enabled, during timecode breaks SADiE may recognise a number of timecode 
breaks and perhaps record a number of very short tracks before the timecode stabilises and the real 
new slate begins. If this happens, try increasing the Record Time Stamp Delay and SADiE will wait 
longer after a break before it starts time stamping and creating new tracks.  

ENABLING AND DISABLING SYNCHRONISATION 

The ONLINE button in the Transport controls or on the hardware controller enables and disables timecode 
synchronisation (and SONY 9-pin external machine control). Timecode synchronisation is enabled as follows: 

Timecode Mode When ONLINE is pressed 

Master SADiE will generate timecode when the current-time cursor is moving. 

Slave SADiE will not start until incoming timecode is present, followed by the delay set under 
"Autostart Time". The Transport Controls are operating the 9-pin external machine if 9-
pin is enabled (except record, which is still working in SADiE's Playlist). 

No Timecode sync The Online button has no effect on synchronisation. 

If 9-pin machines are enabled, right-clicking on the ONLINE button shows a menu where you can choose 
which 9-pin machine to control. If you are using LTC for synchronisation, there will be an additional option, 
"LTC sync" which will stop transport commands being sent to a 9-pin device when ONLINE is pressed. 
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NOTE: The Transport Controls have to be controlling a Playlist for the ONLINE button to be 
available, so a Playlist has to be the active window.  

MONITORING TIMECODE SYNC 

The Sync Monitor window can be displayed from the View menu and gives you a visual indication of the quality 
of the incoming LTC, MTC or VITC timecode when sync is enabled. 

 
Both the incoming and SADiE's internal timecode values are displayed at the top. 

The graph continually re-displays itself and shows the sample rate variation that would have to be applied to 
chase the incoming timecode. Maximum and minimum variations on the graph in view are shown. 

 In "Trigger Lock", this will indicate potential drift. 

 In "Chase Lock", it will represent the amount SADiE has to chase to keep in sync. 

In "Chase Lock", the "Sample Rate" display will show the sample rate being varied, and the "Sample Error" will 
indicate by how much. 

The "Timecode Reader Status" indicates whether timecode is being received. 

The picture above shows a very severe fluctuation in speed caused by changing Varispeed. You wouldn't 
normally expect this sort of behaviour, but in all honesty, the picture grabbed when it was working correctly 
was much less interesting!  

SETTING UP 9-PIN CONTROL 

Display the "9-Pin Control" section of the Setup window. 

 Nine-pin channels - There are four channels available on SADiE's CAT RS422 interface card, each 
represented by one of the four-way break-out leads connected to the card. 

One channel may be used for a set of hardware controllers. Enable them by selecting that channel to 
"Hardware Controllers" after they are connected. 

The rest are available for control of external machines. For each machine that you connect to a 9-pin 
channel, select "Sony 9-pin Master". 

Double-click on the + sign next to the "9-Pin Control" label in the Setup window to display the sub-section 
"Machine Control Setup". 

 Machines - names each machine on a 9-pin channel. The name appears in the list displayed by right-
clicking on the Transport Controls' ONLINE button, so that you can pre-select which machines 
SADiE will control when the button is pressed. 
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 Use 9-pin Locate Command and Use SADiE's Locate function - You have the choice between using 
the machine's own 9-pin locate command, or SADiE's own method which controls the fast forward 
and shuttling separately. 9-pin locate command will be more accurate, but in achieving that accuracy, 
may well take longer to position the tape. Which method you use depends on the 9-pin machine itself 
and the particular job you are working on. If for instance you are synchronising daily rushes with short 
timecode run-ups, it is likely to be more efficient to go for the accuracy of the 9-pin locate, whereas if 
you are track laying and it doesn't really matter where the 9-pin machine starts within a few frames, 
then choose SADiE's locate function. 

 Approximate machine FF/RW speed and Allowed locate error - These are the settings for SADiE's 
Locate function. "FF/RW speed" is the approximate maximum speed the machine reaches in fast 
forward; this is the speed ratio (080 for instance means the 9-pin machine moves the tape 80 seconds 
during every real-time second). "Locate error" is measured in frames. 

 Machine Time - selects the source of the timecode that SADiE reads from the external machine 
connected to the 9-pin socket. 

 Machine Control Options - allows you to disable or enable record options over 9-pin. SADiE's 
"Machine Control windows (opened from the View menu) allow you to put a remote machine into 
record, but you may wish, for instance, to disable video record options on a video machine.  

USING 9-PIN CONTROL IN SYNC 

The ONLINE button in the Transport Controls or on the Hardware Controller enables and disables both 
timecode synchronisation and 9-pin machine control. Right-clicking over the button pre-selects which (if any) 
machines will be brought Online, or allows you to select LTC sync only. 

To control and lock to a machine, such as a VTR, you will have set up machine control and be running SADiE 
as a slave to the timecode from it. 

1. Make the Playlist you want to play the active window. 

2. Press the ONLINE button. 

3. Use the Transport Controls or Hardware Controller to play or scrub the audio and picture in sync. 

NOTE: SADiE will lock to the VTR's playback position. You can locate the VTR by using SADiE's 
rewind/fwd buttons or scrubbing, going to a stored locator point, double-clicking in the time bar, or 
repositioning the current-time cursor and pressing SHIFT + PLAY on the Hardware Controller. The 
VTR will not re-locate if you position the current-time cursor and start playback normally. 

When scrubbing audio and a remote video device together in sync, the speed at which you can scrub will be 
limited by the amount of audio you have in your Playlist. However, many video machines can achieve a faster 
jog or shuttle speed (up to 16x perhaps), and you may commonly use a very fast shuttle to locate the video. 
Within SADiE it is possible to disable audio scrubbing whilst still scrubbing the picture (and thus allow faster 
scrub speeds). 

 
Press the GRABTIME button (yes it is an illogical name!) on the hardware control edit panel; this 
button toggles audio scrubbing on and off, whilst keeping the 9-pin device in scrub. 

 
There is also a Hotkey for this, under "Hotkey Setup", "Transport Controls", "9-pin scrub without 
audio".  

9-PIN MACHINE CONTROL 

You can remotely control a 9-pin machine with its own separate transport controls. This is independent of the 
Playlist, although the two methods can be combined. 

Connect and setup the 9-pin channel (see Setting up 9-pin Control). Although Sony 9-pin, or P2 protocol is a 
"standard", different machines will implement it in subtly different ways. For instance some machines will have 2 
audio channels, some 4, and others more. Some are video machines, but of course DAT's have no video 
channel. 

SADiE implements a generic set of 9-pin commands, but it is possible that some machines may not implement 
these commands in exactly the standard way. 
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Be sure to check the operation with your machine before working on master tapes. In particular check that 
your machine doesn't interpret INSERT as ASSEMBLE!! If you have trouble with 9-pin control, consult your 
dealer with details of the machine; they may be able to provide a custom software driver better suited to your 
device. 

Under the "View" menu, select "Machine Control" and then choose the device you wish to control. 

You will see this window: 

 

This gives you control of the Transport and Edit controls for 
the remote machine, allowing you to put it in and out of 
record, or play and jog it independently from the Playlist. 

The top section is for 9-pin Transport Controls: 

 Time display - for the machines current time. This 
display will say "TAPE" if there is no tape in the 
machine, or "MACHINE !!!!" if there is nothing 
connected on the 9-pin channel. If there is a good 
time display but all buttons are grey, then the 
machine is probably set to local mode. 

 Transport buttons - rewind, fast forward, stop, play, 
record. The button above "record" is for tape eject. 

 Wheel and nudge buttons - are for scrub and 
operate in the same way as SADiE's normal 
transport controls; drag left/right for scrub and 
up/down for shuttle. 

 Go to Pre-roll - locates the machine to a pre-roll 
before the Edit In Point. 

 Setup - opens up the 9-pin setup page. 

Next is the Edit section: 

 Edit In point and Edit Out Point - set the edit points. These have fields for a time, and you can double 
click and type in a new time. Or click on a digit and drag the mouse up or down to increase or 
decrease that value (as with SADiE's other green time displays). "Grab" copies the 9-pin time from the 
9-pin transport controls into the field. "Reset" sets it to nothing. After an edit has been performed, 
most 9-pin machines reset their edit points, so "Recall" will call back the last edit time. 

 Preview - locates the machine to its pre-roll time, into play, then between the edit points the machine 
will go E-E 

 Auto-Edit - actually performs the edit. It locates the machine to its pre-roll time, into play then 
punches into record on the enabled channels at the In point and out at the Out point. 

 Review - will locate to the pre-roll time and just play until it reaches the Edit Out point. You would 
use this after you've performed the edit, to check it. 

 Edit and Edit off - put the machine straight in (and out) of edit without using the In and Out points. 

Lastly the Record Enable section: 

 Record inhibit - a warning that the tape is protected. 

 Insert and Assemble - choose the record mode. Assemble mode can be disabled in 9-pin setup. 

 a1, a2, a3, a4, V, TC - enable the Audio 1,2,3,4, Video and Timecode channels for record. 
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 E-E - "Full E-E" puts all channels into "Input Monitor". "Select E-E" puts only those channels enabled for 
record into "input monitor". 

NOTE: If you have ONLINE pressed, and the same machine selected for synchronising the Playlist, 
then both Transport Controls will operate the remote machine.  

9-PIN SLAVE 

It is possible to operate SADiE remotely from a third party Edit Controller, by commands over a Sony 9-pin 
protocol interface. 

SADiE supports: 

 Transport commands, play, stop, rewind, fast forward, record, scrub, 9-pin locate. 

 Record enabling of streams. 

A 9-pin Slave setup page exists to allow you to alter the machine emulation. Some of the parameters can be 
delayed to accommodate delays inherent in the control system. 
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SYNC MODE 

This setting determines whether playback is triggered on a video frame edge or not. Ideally this should be set 
to Video - Free Run is only really a diagnostic setting. Thus a video signal must be connected to the video 
input of the CAT card. Note that this setting uses the video frame edge as a playback trigger - this is not a 
synchronisation setting. The source for Audio clocks needs to be set in the Audio setup page. Any video signal 
that the 9-pin slave playback is triggering to should be locked to any digital audio or word clock signal that the 
audio is locked to.  

Note also that 9-pin slave cannot be enabled unless the setting for Sync Mode in the main Sync Setup page 
is set to Slave Mode. 

DEVICE ID 

The drop-down box in this section contains a number of devices that SADiE can be set to emulate. The main 
reason to change this would be to allow a different number of input channels to be record enabled - i.e. when 
SADiE is acting as a Sony 7030 DAT recorder, then most controllers will only expect to record enable 2 
channels, whereas the Sony PCM-3348 is a 48 channel recorder. And emulating the GX8064 will allow 64 
channels to be record enabled where the controller supports such a number.  

There may be reasons for wanting to emulate a different machine; perhaps a controller offers special facilities 
on a particular machine. You can select "manual" from the list and then type in the Device ID yourself. 

DEFAULT TO REMOTE 

When the Default to Remote option is ticked, whenever SADiE is started, and whenever a new EDL is opened, 
the Online button will be set to 9-pin slave and enabled. Tick this if you are always controlling SADiE over 9-
pin. 

ENABLING 9-PIN SLAVE 

1. Set one port to accept 9-pin commands in "9-pin Channels" setup by selecting "9-pin Slave" from the 
drop-down list 

2. Select 9-pin Slave from the right-mouse-click menu on the Transport Controls' Online button. 

3. Press the Online button. 

LOCATING 

Some Edit Controllers will offer a "quicker" method of locating which involves the edit controller itself taking 
over the locate by fast forwarding, shuttling and/or going into play, as opposed to sending a single "9-pin locate" 
command. SADiE itself offers "Use SADiE's locate" when operating as a 9-pin controller. This can sometimes 
have advantages when controlling a VTR - a 9-pin locate command can sometimes waste time by doing a lot of 
shuttling when it's close to the locate point to ensure the locate is very precise, but in many cases you can save 
time by going into play "within a few frames or so.." 

BUT.... this "smart locate" does not work well when SADiE is a 9-pin slave - if the controller can send a single 
9-pin locate command, being a random access disk device, SADiE can jump to that position instantaneously, 
whereas combinations of fast forward and shuttling can be very slow indeed. 

Thus ensure that the controller is always sending 9-pin locate commands to locate. 

FAST FORWARD & REWIND 

Note that you can change the speed of SADiE's FFWD and RWND controls - see View menu, Setup 
Window, Transport Controls...Fast Forward and /Rewind Speed. This sets the speed for the "silent" 
FFWD and RWND and not the "Audio Scrub" shuttle, which is determined by the controller. 

9-PIN PORTS 

As standard, SADiE's 9-pin ports are wired as Masters so as to use a straight-through cable to connect to a 
VTR. Thus, to use SADiE as a slave, you will require either a cross-over 9-pin cable which wires TX to RX and 
vice versa, or else we can provide a customised 9-pin break-out lead for the CAT card with one port wired as 
Slave so that a straight pin-to-pin 9-pin cable will work.  

The 9-Pin Slave function is an optional feature; contact your dealer for details of how to obtain it.  
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WORKING WITH SYNC MATERIAL 

When working to picture, or other material where sync is important, you will want to: 

1. Record audio material that is already in sync. When SADiE is locked to the source machine, material 
you record in will be time stamped with its timecode and positioned correspondingly in the EDL . This 
also occurs when Auto-conforming and when using SADiE's "TimeSync" feature, both detailed in 
sections below. 

2. "Sync up" material that is not yet in sync, e.g. position it in the EDL so that it is correctly synchronised. 
This may take the form of synchronising film rushes, or track laying sound effects etc. 

NOTE: It is often most convenient to have two EDL's open for this. You can then have one as 
your source EDL with the Entries in their original positions, and the second as your destination 
EDL into which you paste the Entries (either cut or copied from the first EDL) at their new, 
"synced-up" positions. 

3. Then keep it in sync while you trim, edit and mix it.  

MAINTAINING SYNC 

Once material is in SADiE: 

 
The LOCK buttons on the Playlist toolbar and on each stream can stop an individual Entry or 
Entries on a stream from being moved in the EDL , and so stop accidental loss of sync. Changing an 
Entry's EDL times in the Text EDL will not alter sync when the LOCK is on, but it will slip the Entry 
when the LOCK is off. 

Editing follows all the instructions. To maintain sync, use Playlist Editing in "EDL mode". When you want to slip 
an Entry against sync, switch to "Source mode". 

TRACK LAYING 

This is only a suggested method, and you will probably develop your own.  

The hotspot is a useful marker that you can set at a particular point within any Clip or EDL Entry and then use 
as the reference when placing it in an EDL . For example, when you place a sound effect of a screech of car 
tyres followed by a crash, it is probably the crash that you want to position accurately. It is also useful for 
"back-timing", to get a certain bit of music to coincide with the end of speech, etc. 

 For each audio Entry (or Clip in the Clipstore) use Playlist Editing or the Trim Editor to set the 
hotspot at the audible cue (see Editing and Clip Details window). 

 Then, with 9-pin control of the VTR enabled, use SADiE's Scrubwheel to find to the visual cue point. 
The current-time cursor is now at the sync point. 

 If the Entry is already in the Playlist, use the Snap-Hotspot-to-Current-time function (by right-clicking 
over the Entry in the Playlist) to position the hotspot at the sync point, and so synchronise the Entry. 

 If your Entry is not yet in the Playlist, paste it in using Autoplace set to "Hotspot to current time".  

SYNCHRONISING RUSHES 
If you are using timecode synchronisation and 9-pin control, the audio takes for film rushes (dailies in the USA) 
can be put in sync in SADiE so that they can be laid back to a telecine videotape. 

Three different methods are described here: 

Non-Timecode Rushes (using Clapper boards) 

Rushes with Timecode Boards 

Aaton or Arriflex Rushes  



Specific Applications 

271 

NON-TIMECODE RUSHES (USING CLAPPER BOARDS) 

This is a recommended method; for an alternative, see the section on Track laying, which is a very similar 
process. 

If the takes are loaded into SADiE in order, you can sync them up in the same EDL . If not, it is better to open 
a second, empty EDL, then one by one cut or copy the entries out of the first and paste them into the second 
in roughly the right place, and adjust them until they are in sync. 

1. Record all the audio into SADiE, separate takes as separate Tracks. 

2. Find the audio Entry for the first take and cut or copy it to the paste buffer. 

3. With SADiE slaved to, and 9-pin controlling, the telecine VT, scrub the picture to the first 
clapperboard. SADiE's current-time cursor will now be at the sync point. 

4. Paste the Clip for this take into the (second) EDL near the current time (hardware controllers will 
paste it at the current time). 

5. Pre-select HOT and SOURCE mode and turn on Playlist Editing. 

i. If you are using a mouse, have the automatic MOUSE EDIT SELECTION OFF (button 
up), select the Entry and press the PLAYLIST EDITING button. 

ii. On the hardware controllers, simply press EDIT/SELECT. 

6. Adjust the audio, scrubbing it across the current-time cursor to line it up on the audio of the clap. 

7. Turn off Playlist Editing. The take is in sync! Repeat for the others. 

Lay back the audio from SADiE to the VTR. Run SADiE in "Chase Lock" for analogue transfers. 

NOTE: If you want to lay off an Auto-conform DAT at the same time, you can also connect SADiE's 
digital outputs to a timecode DAT machine locked to the VTR timecode output. In this case, run SADiE 
in "Trigger Lock".  

RUSHES WITH TIMECODE BOARDS 

The audio takes will have field timecode with them, assuming that this matches the timecode on the boards. 

1. Record the audio takes into SADiE, locked to the audio player, with TimeSync on. Use "Trigger Lock" 
for digital transfers and "Chase Lock" for analogue. Remember that you must also have Autotake on in 
the Transport Controls. 

You will then have an EDL Entry for each take, positioned at its field timecode value in the EDL . Each 
needs to be moved to a new EDL position representing the continuous timecode of the telecine VT. 
This is best done by opening a second EDL (the "New", "Playlist " command on the "File" menu) and 
pasting each Entry into that at the new time. 

NOTE: If SADiE stops recording at the end of a single take and doesn't go back into record again, 
it may be because you have RECORD STOP TIME in "Sync setup" set too low. This is time 
after timecode disappears and before SADiE stops recording, and thus if it is set to zero the 
TimeSync operation will stop on the first timecode break. 

2. LOCK all Entries in both EDL's. Select Autoplace "Hotspot to Current-time" in the second EDL. 

3. Check that the second EDL is active 

4. With SADiE slaved to, and 9-pin controlling, the telecine VT, scrub the picture to the first timecode 
board. SADiE's current-time cursor in the second EDL will now be at the sync point. 
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5. Make the first EDL active, pre-select HOT and SOURCE mode in the Transport Controls, 

and select the required Entry. Turn Playlist Editing on, and for safety have the automatic 
MOUSE EDIT SELECTION off (button up). 

6. Read the time on the board, and enter it into the edit point time display in the Transport 
Controls. This sets the Entry's Hotspot to the timecode value on the board. 

7. CUT or COPY the Entry, make the second EDL active and paste the Entry into it. Its 
Hotspot will be positioned at the sync point, and the take is in sync. 

 
5. Make the first EDL active with the WINDOW button. Pre-select HOT and EDL mode and 

select the required Entry (best to use PREVIOUS or NEXT). Press EDIT/SELECT to 
turn on Playlist Editing. 

6. Adjust the Scrubwheel until the time in the SOURCE display on the controller matches that 
on the board. This sets the Entry's Hotspot to the timecode value on the board. Press 
EDIT/SELECT again to confirm the adjustment. 

7. CUT or COPY the Entry. Press WINDOW to make the second EDL active and press 
PASTE. The Entry will be positioned with its hotspot at the sync point, and the take is in 
sync. 

Lay back the audio from SADiE to the VTR. Run SADiE in "Chase Lock" for analogue transfers. 

NOTE: If you want to lay off an Auto-conform DAT at the same time, you can also connect SADiE's 
digital outputs to a timecode DAT machine locked to the VTR timecode output. In this case, run SADiE 
in "Trigger Lock".  

AATON OR ARRIFLEX RUSHES 

The audio takes from these rushes will have field timecode with them. This timecode is also generated by the 
camera equipment and conventionally laid onto track 3 of the telecine VT. SADiE's TimeSync feature takes 
advantage of this to sync the rushes up totally automatically in just two passes of the EDL . 

1. Record the audio takes into SADiE, locked to the audio player, with "TimeSync" on. Use "Trigger 
Lock" for digital transfers and "Chase Lock" for analogue. Remember that you must also have 
"Autotake" on in the Transport Controls. 

You will then have an EDL Entry for each take, positioned at its field timecode value in the EDL. 
Because you can now lock SADiE to the field timecode on track 3, these can be positioned in sync as 
you lay them back to the telecine VT. 

2. Feed the output of the field timecode on the VTR (usually Track 3) to SADiE's LTC input. Run SADiE 
in "Chase Lock" and record SADiE's analogue audio outputs to the VTR. 

NOTE: If you want to lay off an Auto-conform DAT at the same time, you can also connect SADiE's 
digital outputs to a timecode DAT machine locked to the VTR timecode output. In this case, run SADiE 
in "Trigger Lock".  

AUTOCONFORMING 

In broad terms, Auto-conforming involves applying an Edit Decision List (EDL) to some kind of media in order 
to quickly and automatically produce an edited version of those media. 

The most common Auto-conforming scenario we are attempting to handle in the Professional Audio world is 
the situation where both video and audio have been edited in an offline video editing system; we now want to 
apply the same edits to the audio media (or different and perhaps better quality audio media) so that we can 
apply our audio skills and audio tools to enhancing the audio elements of the programme. 
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AUTOCONFORM FROM TAPE 

Traditionally (way back at the end of the 20th century !) some of you may remember that audio was recorded 
onto tape media. Audio and video were recorded into a computer for offline video editing and sequencing of 
the programme. Because interchange was in its infancy and file processing was slow, the quickest and most 
efficient method of getting the audio into an audio workstation was to record it in real-time. 

The video editor would provide a CMX EDL - a list of original source timecodes against the new edited times 
- and the tapes would be recorded under remote control - the audio workstation (let's call it SADiE) would 
"cherry pick" the audio from the source tapes - only recording the source timecode ranges that were used in 
the EDL. Once the audio had been recorded into SADiE, the EDL was then applied to the source material so 
as to replicate the video editor's audio work. 

Of course, tape auto-conforming is still commonly used today, and wider use of multi-channel recorders means 
that extra flexibility is required of the audio editor, which SADiE can provide. 

AUTOCONFORM FROM DISK FILES 

In more recent times, it's becoming increasingly common to find that sound for a TV programme or film is 
recorded to hard disk using one of the portable recording devices manufactured by for instance, HHB, Deva, 
Nagra, Fostex, Aaton, Sound Devices and others. 

These disk recorders may offer additional flexibility to the Sound Recordist, and rather than providing a simple 
mono or stereo mix of the sound, because most of the devices are multi-channel, it will be possible to capture 
every microphone on the set to a separate channel, along with a stereo mixdown. Thus if all this audio can be 
passed through to post-production, extra flexibility is available at a later stage - if the stereo mix has faults, it 
may be simple to remix and correct this later in the production  chain. 

Interchange of audio is much more sophisticated now and work in the video editor can be passed onto the 
audio workstation via AAF or OMF to include levels, fades and clip names. 

However there are still times when the audio editor may wish to revert to the original audio - not all the 
channels may be used in the video edit - perhaps just the stereo mix; or the video editor may have been 
working with 16-bit version of the audio and we would want to revert to the 24-bit originals. 

SADiE's auto-conforming facility provides tools for channel expanding and uses a number of techniques to 
allow re-linking an EDL to media based on meta-data in the files or other parameters.  

RECONFORMING 

Imagine the situation where the audio editor has received an OMF file and proceeded to "sweeten" the audio - 
perhaps he has substituted some auto-conformed multi-channel disk files, and he will have tidied the levels and 
fades and added some more sound effects. 

The next day the video editor sends a new edit - it has been decided to change or re-order a couple of scenes 
and shorten the program a little. But if the audio editor imports the new OMF, all of yesterday's work has been 
a waste of time.  

Reconforming is the process of applying a Change List to a work-in-progress EDL. The sweetened EDL can 
be automatically edited to match the changes between version 1 and version 2 of the video edit. 

Reconform uses similar tools to auto-conform, but whereas auto-conform is editing source audio files, 
Reconform edits EDLs. 

 

Autoconform and Reconform tools are available as part of the EDL Option Pack. 

 

 

EDL EXPAND 

When opening a CMX EDL, SADiE offers the facility for expanding the number of channels, and offsetting 
channel positions for when the EDL is converted, so that the EDL can be used to conform to source material 
with different numbers of channels. 
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On selecting Import Components(s).. from the Project menu, if you are choosing to import a CMX EDL, 
first you will be offered the Convert dialog (choose CMX 3600 if in doubt) and then you will see the EDL 
Expand dialog: 

 
A1 and A2 refer to the channels in the CMX list, and the channels displayed here will depend on what has 
been specified in the CMX. 

As another example, this CMX contains mono A1 ands A2 channels plus stereo items on A1+A2:- 

 
If we press OK, or Skip, and accept the settings on the first example, the EDL looks like this:- 

 
However, if we changed just the Width setting for channel A1, you'll see that other settings will change 
automatically to look like this:- 
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and so we have expanded the number of channels that A1 refers to to work with 8 channel material, and in the 
process, it automatically made A2 8 channel wide (which would be the usual case) and offset the A2 entries to 
start on EDL stream 9. 

 The resulting SADiE EDL looks like this:- 

 
It's also possible to change the Source Channel so as to select different channels in the source material. 

In the next example with the same EDL, we know that a stereo mixdown, which is our primary interest, exists 
in the source material on channels 7&8. And so we select a width of 2  

 
The example EDL will look like a stereo version of the first, however the Reel Track parameter of each clip 
as displayed in its column in the Text EDL will be set to 7 and 8, so that when it comes to linking the files to 
the media, channels 7&8 will be chosen (i.e. our stereo mix). 
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EDL Expand Presets 

 
You can save a number of presets so that if material comes in regular with the same channel mapping rules, 
then you can create and load a preset to handle it.  

Pressing New Preset shows the Preset Configuration dialog, where you can set up rules for any possible 
channel in a CMX 

Expand Selected Clips 

In addition there is a function in the Playlist menu to Expand Selected Clips that can be used after a CMX 
has been converted (or in fact on any audio clip that has more channels available than are associated in the 
EDL. 

Select one or more clips in the usual way, then select Expand Selected Clips - the clips will be automatically 
expanded to use any available extra channels of audio (as seen in the project's Source Track Folder) 

AUTOCONFORM FROM TAPE 

AUTOCONFORMING SETUP 

To Autoconform from tape, SADiE must: 

1. Have 9-pin control of the machine(s) you want to record from (see Setting Up 9-Pin Control). You 
can set up 9-pin control of up to four machines. Note that there is a choice of methods for controlling 
the way the 9-pin control locates a machine, but it is suggested 9-pin locate is more accurate for 
Autoconforming. 

2. Be synchronised in "Slave" mode to the machine you are currently recording from. If you are 
recording digitally, use "Trigger Lock", if analogue, use "Chase Lock" (see the Synchronisation section). 

Consequently, SADiE should have both 9-pin (RS422) and LTC (timecode) connections to the source 
machine. 

For each Entry, SADiE can record a bit more audio than has been specified in the picture editor's EDL . This 
means that you have pre- and post-handles available so that you can increase crossfades, adjust edits and so on. 
You may want to change the settings for these in the "Autoconform" page of the Setup window: 

 Lead Time Duration - Sets the "pre-handle" recorded at the beginning of each Entry. 

 Overrun Duration - Sets the "post-handle" recorded at the end of each Entry. 
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 Minimum gap between takes - The gap between items on the source reel that will cause SADiE to 
record the next one in a new take. At gaps less than this, SADiE will continue recording the next item 
in the same take and as part of the same Track . A recommended setting is 15-20 seconds. 

NOTE: These times are used to make the Autoconform list as described in step 7 below, so there 
will be no effect if you change them in the Setup window after that stage (for example, before 
continuing with a partly recorded list). Setting the pre- and post- handles too long may result in 
SADiE trying to record before the beginning or after the end of the reel! 

 Additional 9-pin pre-roll - The 9-pin locate functions already rolls the 9-pin machine back to a time 
before the actual locate time. This Autoconform setting allows you to increase this pre-roll time to 
ensure that the whole of the take is recorded. You don't need to have timecode on the source tape in 
this pre-roll as SADiE rolls the machine backwards frame by frame. Note that this setting has no effect 
on the record list, and can be changed during the Autoconform process.  

AUTOCONFORMING FROM TAPE 

1. Select "Import Component(s).." from the Project menu. In the next dialogue box, locate the file - a 
CMX EDL often has a .edl extension 

2. SADiE will detect that you are opening an EDL that is not in SADiE format, and the "Auto-Convert" 
box will appear. Select the format of the file (if in doubt, try CMX 3600), & click "Ok". 

3. SADiE will then show the "EDL Expand" dialog. This allows you to expand channels in the CMX EDL 
so that for instance a 2 channel CMX could be applied to 8 channels (or more) of source material. 
This also allows you to offset channels - i.e. with 8 channel material, you may wish that a second set of 
8 channels starts at stream 9. The EDL Expand Dialog is described in more detail later in this manual. 

4. SADiE will automatically convert the CMX to SADiE format, expanding the channels and moving the 
expanded clips to the streams you have chosen. The new EDL will be added to the project and 
opened.  

5. In the Playlist, the Entries for which audio hasn't been recorded into SADiE yet will be drawn as 
ghosts. At this point, if you wish, you may select and delete any of the ghost Entries that you know 
you don't want to be included in the list to be recorded. You can even cut them with the scissors. In 
the Text EDL pane, the "Audio Present" column for unrecorded Entries will read "No", and you can 
edit any parameters shown in black (rather than grey). 

4.  
Display the Autoconform list, which is one of the three text panes attached to the Playlist. 
Press the TEXT PANE button on the Playlist toolbar and select the "Autoconform" tab at 
the bottom left. If necessary, adjust the size of the pane by dragging the edges of the Playlist 
window or the border between the Playlist and the text pane. 

The Autoconform toolbar will appear: 

 

This can be floated or attached to the Playlist by right-
clicking on it. 

5.  
Press MAKE LIST. SADiE will compile a list of all items that need to be recorded. The 
name/number of each reel used in the EDL will appear in the column on the left. Selecting each 
reel with the mouse or the cursor (arrow) keys will display a list of items that need to be 
recorded from it, detailed in the table on the right. 

NOTE: The Autoconform list is compiled from all currently open EDL's, so don't accidentally have 
another EDL open that has any audio missing, or it will be included in the list. The list of items to be 
recorded will also remain unchanged until you MAKE LIST again, even if you close the current EDL 
and open a new one. 
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6. You now have the option of editing the list before you record the Entries. Each parameter displayed in 
black (rather than grey) can be edited by double-clicking it with the mouse. Alternatively, select it 
using the tab key to move between the reel list and the details table and the cursor keys to move 
between parameters in the table, then press the  Return key. 

You can: 

i. Alter the start or end times that came from the Picture Editor's EDL. 

ii. Change the "First Channel" setting. This indicates which channel(s) of the picture editing 
system the audio was on, and will correspond to the channels of the source reel unless they 
were re-allocated during the edit. To relate these to SADiE's inputs, see the description of 
the Autoconform Recording box in step 7, below. 

iii. Alter the "To Be Recorded" status so that individual items will not be recorded this time. 
This may be because you want to record certain items at a later date by doing another 
recording pass. Perhaps you need to take the audio from a different source, using music from 
the original CD rather than the Betacam reel used during picture editing, for example. 

iv.  
Manually ADD or DELETE items from the list to be recorded. Note that deleting 
a record item is different from deleting an Entry in the EDL, as several EDL Entries 
may come from a single item. 

v.  
From the reel list, select the first reel that you want to record from and load it into the source 
machine. Press the Autoconform RECORD button. The Autoconform Recording dialogue 
box will appear: 

 
The input channels used for recording the items can be selected as follows: 
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i. Use specified inputs - This setting uses the channel numbers in the Autoconform list to 
determine which inputs each item is recorded from. Autoconform recording can only be 
made two channels at a time, and so if four channels are in the list, you will have to make 
separate passes, recording two channels at a time and changing audio connections where 
necessary. 

ii. Override inputs - Channel numbers in the Autoconform list are ignored and all material is 
recorded from the inputs selected on the adjacent box. This will be necessary if the picture 
editing system has spread audio across several channels, but you are now recording it all from 
a stereo machine. 

iii. Output selection - Determines the outputs used to monitor the recording. As Autoconform 
recording is a background process, you can select different outputs from those used by your 
current foreground mixer and then do something else with another EDL whilst SADiE is busy 
Autoconforming. 

iv. Machine selection - Selects which 9-pin channel will be controlled. If you have more than one 
source machine, you can switch between them here, but remember to change the LTC 
connection so that SADiE is receiving timecode from the correct machine. 

8. Press the START button. SADiE will take control of the machine, locating it to the correct place, 
running in sync, dropping-in to record each Entry, then dropping-out and locating to the next. You will 
see the ghost entries become solid as they are recorded, and the to be recorded status of each item 
in the list will change. 

The CLOSE button closes the box so that you can do other work in the foreground while SADiE 
continues recording in the background. Press the RECORD button on the Autoconform toolbar to 
open the box again. 

The STOP button interrupts the process. 

NOTE: As this is a background process, the Autoconform Record box takes the place of the 
Transport Controls' ONLINE button and Record section, although you will see the Track names 
appearing there. 

9. When all the items from the reel have been recorded, every "To Be Recorded" status will have 
changed to "No". Close the Record box and repeat from step 7 for each reel in turn. 

HINT: If you wish to re-record the take for whatever reason, double-click on the "To be 
Recorded" to change it from No to Yes and you will at that point be offered the chance to delete 
the previous recording. 

The Tracks that SADiE has recorded (and the EDL Entries) will be named after the reel that they came from, 
with an Autotake number added for each take. If you are recording to a SADiE3 formatted audio disk, 
timecode values will be included in the name. 

NOTE: If you get half way through the process and decide to call it a night, simply stop recording and 
close down in the normal way. When you open the EDL again tomorrow, you can continue from step 6 
above.  

AUTOCONFORMING IN BRIEF 

The above list gave all possible options. In practice, most Autoconform jobs can be done in the following steps: 

1. Import the CMX-type EDL into your Project, converting it as it imports. 

2.  
Press the TEXT PANE button and display the Autoconform pane. 

3.  
Press the MAKE LIST button. 

4.  
Select a reel in the list, put the tape in the source machine, and press RECORD. 
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5. Check the details in the Record box and press START. 

6. When all items are recorded, CLOSE the box and repeat from step 4 for the next reel.  

HINTS AND TIPS 

RECORD STATUS 

SADiE employs a new feature to avoid insufficient timecode run-ups causing problems when Autoconforming. 
Recording is started as soon as the source machine starts playing at the required point, regardless of whether it 
is supplying good timecode. When timecode is stable, it is used to time stamp the recorded Track 
retrospectively and thus position Entries in sync. This is why the "internal time" display in the Autoconform 
Record box often briefly starts counting from zero at the beginning of each recording, and flips to the correct 
time when the timecode is stable, and also why the start times of the Tracks will often be slightly before start 
times in the Autoconform list. 

If the "internal time" never changes to be the same as the "machine time", and SADiE continues recording 
without time stamping, then this suggests that SADiE has not been able to synchronise correctly. SADiE is not 
receiving timecode for some reason. Perhaps there is no timecode on the tape, or bad code? Check that 
SADiE's sync settings are correct and that cables are good. Be particularly careful of balanced to unbalanced 
LTC cables; if the cold wire is shorted to ground, this is likely to make the timecode unreadable. Bad cables are 
the single most common reason for this type of failure. 

ENTRIES NOT FILLING IN 

If you find that some Entries in the Playlist are not becoming solid when they should, or the "To Be Recorded" 
status of record items is not changing when the item appears to have recorded, check the start times of these 
Tracks in your Clipstore. If they are later than the start times in the Autoconform list, SADiE is missing the 
very beginning of the item. Increasing the 9-pin Locate Pre-roll setting in the Setup window should cure this. At 
least 3 seconds is recommended for most machines. 

FIND NEW TRACK 

Find New Track is a command available when right-clicking a "ghost" entry in the Playlist. Ghosts are drawn 
when there is not sufficient audio in SADiE to play the whole Entry. However, it may be possible to edit the 
ghost entry leaving one that could be played. Selecting "Find New Track" will then update the Playlist, to show 
the Entry with audio present in a solid colour. "Find New Track" checks for tracks to satisfy the Reel name and 
time code range required. 

This might be useful if a long record item was not quite recorded in full, perhaps because Autoconforming was 
interrupted just before the end, or the 9-pin locate pre-roll was set so that the very beginning of the item was 
missed. Make a cut in the Entry, leaving two ghost Entries, the larger of which actually has all the audio present. 
"Find New Track" for this and it will be drawn solid, recognising that the Track is present. Now, if you make a 
new Autoconform list, you will only have to record enough audio to cover the smaller Entry. 

If you load a new CMX-type EDL that relates to audio that already exists, you will find that the "Find New 
Track" function acts automatically and so will "fill in" entries which are satisfied (reel name and timecode 
ranges) by existing audio. If the audio is not in the current project you will have to import it before it can 
match to the EDL. 

CROSS-REFERRING AUTOCONFORM LIST ENTRIES AND EDL ENTRIES 

The Autoconform list and the EDL are displaying essentially the same information but ordered differently. 
There are times when you might want to view or manipulate EDL entries that belong to Autoconform list 
items or perhaps even whole reel. 

 
The "Add EDL entries for item/reel to the selection" buttons on the Autoconform toolbar, searches 
through the current EDL for entries that come from the selected record item (or whole reel, 
depending on which button is pushed), and selects them in red. The next function you select, for 
instance copy/cut, or more complex operations like "Move Selected Clips" (see below) will operate 
on all the red entries. 
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NOTE: These add to the selection. If you only want one item or reel selected in red, then you'll have to 
click in an empty part of the EDL to clear the selection before you start. Because these add to the 
selection, you can use the function again and again to select a group of items or a number of reels. 

MULTI-TRACK EDIT LISTS AS MULTIPLE STEREO LISTS 

As the CMX-type is the most commonly recognised format, you maybe presented with a multi-track list that 
has been split into several stereo lists. Alternatively the channel information may be written in the reel name, 
as the channel information is restricted to 2 because of the CMX format. So you may have a list with say, 4 
reels referring to channels 1&2, 3&4 etc. When you convert the EDL all entries will be on streams 1&2. 

If you use the "Add EDL entries for reel..." function above, a whole reels-worth of entries will be selected in 
the EDL. You could then use the "Move selected clips onto stream..." option in the Playlist menu, to move 
those clips to a new pair of streams. 

 

MAKE STEREO / MAKE MONO 

 
The MAKE MONO/STEREO buttons, on the Autoconform toolbar change the EDL entries to be 
mono or stereo as well as the record item. Note that there is a MAKE STEREO option on the 
entry menu that appears when you right-mouse click on an entry. This is only available if stereo 
audio material is actually available for that entry. 

MONO RECORDINGS 

If your source material is mono and from a mono tape, the normal "Override Input channel" setting will still try 
to record from one side of stereo, depending on which reel channel the record item is from: left for odd 
number channels, right for even. However in the "Autoconform" page of the Setup window, there is an option 
to "Always record mono items on the left channel" to further override this. 

AUTOCONFORM LIST 

The Autoconform list in the table page of the EDL is saved along with the EDL when you press SAVE EDL. 

 
The MAKE LIST button always makes a completely fresh list, searching through the EDL for any 
ghosted or missing items and creating a brand new record item list. 

However if you are have already started the Autoconform, you may wish to retain an item in the list even if it 
has been recorded and it's marked "No" in the "To be recorded" field. Or perhaps you've made some edits to 
the list and not yet recorded these items. MAKE LIST will completely reset this. 

 
But you need to add some extra entries from a new EDL! For this situation there is the REFRESH 
LIST button, which keeps your old edited conform entries intact, but adds in new conform entries 
for the new clips. 

Or alternatively, you are given a completely new edit list that includes some extra entries. When you've 
converted this new EDL, you may want to continue using your old Autoconform list. In this case select "Import 
Conform List" from the "File" menu, and select the old EDL. This will pull in just the Autoconform list from the 
old EDL; you can then REFRESH LIST and continue, with any new entries added to the record list. 

Note that "Import Conform List" doesn't merge with any existing conform list, it overwrites it.  
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EDL FORMATS SUPPORTED BY SADIE 

This document outlines the text based EDL files that are supported by SADiE. Confusion arises when variations 
on a specific format are loaded into SADiE. There does not appear to be any strict rules as to the content of 
these files, which may cause problems when the file is being read and loaded into SADiE. To avoid these 
problems we have listed the types of entries that we handle. If a file contains lines other than these it is 
possible it will fail to load completely. 

CMX 

A line for an entry in a CMX file contains the following information: 

Entry 
Number 

Reel 
name 

Channel Edit 
type 

Fade length (if edit 
type is "D" 

Source start 
time 

Source end 
time 

Program start 
time 

Program end 
time 

 Entry number - These are 3 digits and are in the range of 001 to 999. 

 Reel name - The known maximum lengths for different formats are as follows: 

o CMX 340 – 3 characters, 0-9, that allow reel numbers from 1 to 253. This same set of reels 
is allowed with a 'B' on the end. 

o CMX 3400 – 3 characters, 0-9, that allow reel numbers from 1 to 999. This same set of reels 
can also have a 'B' on the end. 

o CMX 3400A and CMX3600 – allow 8 characters, A-Z and 0-9. 

Files have been seen with longer reel names than those specified and so there is a limit of 10 
characters in SADiE when importing a CMX file. A reel name of "BLK" or "BL" is used to define a 
silent entry or a fade to/from silence. 

 Channel - The channel information for CMX files is given in Table A. Additional channel information is 
placed on the next line, see the comment section below for more details. 

 Edit type - SADiE will only use edit types of "C" for a cut and "D" for a dissolve. All other edit types 
are ignored. The dissolve time for an entry is to be given in frames. 

 Source and program times - These times are given in frames. See the comment section below for how 
the frame rate is handled when reading the file. It is possible the EDL will not be loaded correctly if 
the correct frame rate is not selected in SADiE. 

The entries - A general entry: 

001  01 A1 C  00:00:10:00 00:10:10:00 10:00:00:00 10:10:00:00 

This would give the following entry in the SADiE Playlist on stream 1: 

 
A fade in is recognised as one of the following: 

001  01 A1 D 20 00:00:10:00 00:10:10:00 10:00:00:00 10:10:00:00 

Or 

001 BLK A1 C  00:00:00:00 00:00:00:00 10:00:00:00 10:00:00:00 

001 01 A1 D 20 00:00:10:00 00:10:10:00 10:00:00:00 10:10:00:00 
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This would give the following entry in the SADiE Playlist on stream 1: 

 
A fade out is recognised as the following: 

001 01 A1 C  00:00:10:00 00:10:10:00 10:00:00:00 10:10:00:00 

002 01 A1 C  00:10:10:00 00:10:10:00 10:10:00:00 10:10:00:00 

002 BLK A1 D 20 00:00:00:00 00:10:10:20 10:10:00:00 10:10:00:20 

 
This gives the following lines for a crossfade: 

001 01 A1 C  00:00:10:00 00:10:10:00 10:00:00:00 10:10:00:00 

002 01 A1 C  00:10:10:00 00:10:10:00 10:10:00:00 10:10:00:00 

002 02 A1 D 20 03:00:30:00 03:01:00:20 10:10:00:00 10:10:30:20 

This would give the following entries in the SADiE Playlist on stream 1: 

 
Comment lines - The following comment lines are handled in the CMX conversion. 

Frame rates - If the setting is used for multiple frame rates it is possible to alter the frame rate for each 
reel before the EDL is loaded into the Playlist. When a frame rate change line is encountered, all 
subsequent entries will use the new frame rate. The user is asked whether the system frame rate in SADiE 
is to be altered, if a frame rate is detected that is different to the current setting. 

o FCM: NON-DROP FRAME - This will set the frame rate to be 29.97 

o FCM: DROP FRAME - This will set the frame rate to be 29.97 drop frame. 

Channels - The table in Table A shows the channel information that is used in a CMX EDL file. 

Audio mapping - The following line is used to determine the audio mapping of the entry in the file: 

0072 800 A2 C 00:00:00:00 00:00:02:20 10:02:02:23 10:02:05:18 

COMMENT: AUDIO MAPPING FROM CH1 TO CH2 

This indicates that the entry on stream 2 uses audio from track 1. 

Any other lines containing information regarding, for example, the speed of the video playback, the freeze 
frames and other channel mapping formats, will be ignored. 
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SONY 

The format of the lines for fade information will be the same as those for the CMX format EDL's. 

It can be seen that additional information is placed at the end of the line for channels 3 and 4. The channel 
information is described in the table in Table A. 

GRASS VALLEY (GVG) 

The format of the entries in these EDL's is similar to that of the CMX files. Only files containing cut entries 
have been tested. EDL's have been found where the entries are not in program time order. This has not posed 
any problems when importing to SADiE. 

 Entry number - This has been found to be either 3 or 4 digits in length. 

 Channels - The channel information for this type of EDL is given in Table A. 

LIGHTWORKS MULTICHANNEL 

 The Entries - It has been found, after discussions with people at Lightworks, that there will be no 
video entries as part of a Multichannel EDL. Therefore, there is no need to put in the dummy video 
entry that spans the length of the EDL. From this it is assumed that there is no need to insert black 
entries for the silence between the audio entries in the EDL. This can be added at a later stage if 
needed. 

The format of the entries within the file is similar to that of the CMX files. 

 Dump reels - The Lightworks machine that was used for the test material was not able to export an 
EDL that contained overlapping entries using the same reel. To get around this problem it uses a 
dump reel. The dump reel entries are shown in the EDL file with a reel ID of "900". The program 
times for these entries remain the same, however, the source times used reference a separate file. 
The extra file should have the same name as the EDL file, but with a "*.DMP" extension. 

The source times for each stream start at the EDL start time. They usually have a handle of 1 second 
with entries on the same stream being adjacent. The source times in the EDL file should "fit" within 
the program times in the dump file, e.g. there should be enough audio for them to reference. The 
source times in the dump file are the actual source times of the audio. There should be no dissolve 
entries in the dump file as this implies that entries overlap and it would therefore require a further 
dump file to handle it. 

GENERAL NOTE: 

The text based EDL's that have been described only contain one piece of channel information. The user is given 
the option as to whether to use this information for, the stream the entry is to be placed on, or the track of 
audio to use, or both. SADiE handles additional lines in the EDL for channel mapping, as described in the 
comment section. This allows both the stream and track information to be read from the file. This information 
can also be exported as part of the file if required. 

EDL Channels 

 GVG 6.0 CMX 
340 

CMX 3400 + 3600 Sony 9000 LW 
Multichannel 

Maximum Channels 
Supported 

Audio - 
4 

Video - 
1 

Audio - 
2 

Video - 
1 

Audio - 4 

Video - 1 

Audio - 4 

Video - 1 

Audio - 8 

Video - 0 

V A1 A2 A3 A4   In edit 
line 

Ch 3 + 
4 

In edit 
line 

In edit 
extension 

In edit line 
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     A1 A A  A1  A1 

     A2 A2 A2  A2  A2 

     A3  NONE AUD 3 A A3 A3 

     A4  NONE AUD 4 A A4 A4 

     A12 AA AA  A1A2  A12 

     A23  A2 AUD 3 A2 A3 A23 

     A34  NONE AUD 3 
4 

A A3A4 A34 

     A13  A AUD 3 A A3 A13 

     A24  A2 AUD 4 A2 A4 A24 

     A14  A AUD 4 A1 A4 A14 

     A123  AA AUD 3 A1A2 A3 A123 

     A124  AA AUD 4 A1A2 A4 A124 

     A134  A AUD 3 
4 

A1 A3A4 A134 

     A234  A2 AUD 3 
4 

A2 A3A4 A234 

     A1234  AA AUD 3 
4 

A1A2 A3A4 A1234 

      V V  V   

     A1V B B  VA1  A1 

     A2V A2/V A2/V  VA2  A2 

     A3V  V AUD 3 V A3 A3 

     A4V  V AUD 4 V A4 A4 

     A12V AA/V AA/V  VA1A2  A12 

     A23V  A2/V AUD 3 VA2 A3 A23 
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     A34V  V AUD 3 
4 

V A3A4 A34 

     A13V  B AUD 3 VA1 A3 A13 

     A24V  A2/V AUD 4 VA2 A4 A24 

     A14V  B AUD 4 VA1 A4 A14 

     A123V  AA/V AUD 3 VA1A2 A3 A123 

     A124V  AA/V AUD 4 VA1A2 A4 A124 

     A134V  B AUD 3 
4 

VA1 A3A4 A134 

      A234V  A2/V AUD 3 
4 

VA2 A3A4 A234 

     A1234V  AA/V AUD 3 
4 

VA1A2 A3A4 A1234 

AUTOCONFORM FROM DISK 

You will require a CMX EDL, along with the Location Recorder's source files. Depending on the machine used, 
and circumstances at the time of the recording, the recorded files may : 

a. be mono, stereo or multi-channel files 

b. contain metadata describing Scene, Reel, channel, or other parameters by which they may be 
recognised as the correct source file. 

c. be grouped into directories on disk by Reel number 

d. have associated EDLs  

The CMX EDL will list items by: 

 Reel or Roll number 

 Source Timecode range; the timestamp of the file and its length will lead us to find the correct 
segment of audio. 

 EDL timecodes - to describe where the source segment is placed in the edit list. 

Reel number and Source Timecodes should be enough to give us a unique segment of audio to fill in each entry 
in the EDL. 

However, particularly with multi-channel source material, channel assignment may be something that the audio 
editor will have to change - CMX EDLs only really deal with a maximum of 4 channels. In practise, we will 
mostly be mapping one or two channels of the CMX EDL to multi-channel source material, but we do need the 
flexibility to be able to choose which CMX channels relate to which Source File channels. 
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AUTOCONFORM FROM DISK PROCEDURE 

CHECK THE SOURCE MATERIAL 

You may want to know some detail about your material first, and so it's suggested that you import the audio 
into your SADiE project to allow you to preview, view data,  count channels etc. 

This is not an entirely necessary stage however - SADiE can link to the audio files whether the audio is 
imported into the Project before or after the CMX list, and so this section is here merely to give information 
about some of the tools SADiE includes to give more information about the audio files. 

If you use Disk Management to import the files, you can use the function Import tree into Clipstore to 
quickly import the entire contents of a folder and its sub-folders. 

You may also find it useful to drag and drop some clips into a blank EDL so as to more quickly get a picture of 
what you are dealing with. I suggest that you drop clips into the EDL using Autoplace-Sync so that they snap 
to their source timestamp. You can use the Text EDL to view a number of parameters and the metadata 
inside the files such as Scene and Take numbers. 

 
Note - did you know that you can sort the Text EDL by clicking on the column headers ? You can also 
change which parameters are displayed, and their order by right-mouse-clicking on the column header. 

But perhaps you have enough detail from notes to move straight to importing the EDL ? Let's move on. 
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AUTOCONFORM FROM DISK PROCEDURE 

IMPORT THE CMX 

1. Check the settings for handles in the Autoconform setup page. If you're conforming from files, they 
will make little difference, but if you set them to zero, then the Reel list will have accurate times.  i.e. 
"Lead Time Duration", "Overrun Duration" & "Minimum gap between takes". 

2. Select "Import Component(s).." from the Project menu. In the next dialogue box, locate the file - a 
CMX EDL often has a .edl extension 

3. SADiE will detect that you are opening an EDL that is not in SADiE format, and the "Auto-Convert" 
box will appear. Select the format of the file (if in doubt, try CMX 3600), & click "Ok". 

4. SADiE will then show the "EDL Expand" dialog. This allows you to expand channels in the CMX EDL 
so that if for instance you'd found 8 channel audio you can apply the 2 channel CMX to all your of 
source material. This also allows you to offset channels - i.e. with 8 channel material, you would 
probably want a second set of 8 channels to start at stream 9. The EDL Expand Dialog is described in 
more detail later in this manual. 

Note : because flexibility is important in order to be able to cope with many different scenarios, this is 
not the only chance you'll get to expand the channels - it's possible to run a "expand" function on clips in 
the SADiE EDL. 

4. SADiE will convert the CMX to SADiE format, expanding the channels and moving the expanded clips 
to the streams you have chosen. The new EDL will be added to the project and opened.  

5. Having loaded the EDL, press the  Text Pane button. Press the Autoconform Tab to reveal the 
Autoconform Window and its toolbar. 

6. Press  MAKE LIST. SADiE will compile a list of all the source material for either recording or 
conforming from disk. The name/number of each reel used in the EDL will appear in the column on 
the left. Selecting each reel with the mouse or the cursor (arrow) keys will display a list of items that 
need to be recorded from it, detailed in the table on the right, and also select in red all the EDL 
entries associated with that reel.  

 (It might help at this stage to turn off profile view as you may have no audio in the EDL yet). 
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Before you link the EDL to audio files, the Autoconform Window has a number of tools and settings to help 
you to manipulate the EDL and Autoconform List. 

AUTO-SELECT EDL ENTRIES 

 
These two buttons on the Autoconform toolbar allow to enable or disable automatic selection of EDL entries 
(i.e. they are coloured red) when you select either Record Entries or whole Reels in the Autoconform list, so 
that you can apply Playlist functions to those EDL entries - like Expand Selected Clips for instance  

The button to the right of these allows you to change the Reel name parameter in selected EDL entries (you 
could for instance Select -All and use this button if the Conform simple and only really uses one reel.) 

 

 

AUTOCONFORM FROM DISK PROCEDURE 

RELINKING 

By the side of each Reel number in the Autoconform Window, there is a button. This allows you to 
choose how the CMX Reel or Roll number is match to data in the files. 
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There are six Rule buttons to determine which rule is used to link a Reel name to audio. Each is set by 
pressing the button on the right side of the Relink dialog: 

Directory Files inside the disk directory chosen will be used to link to entries belonging to this 
Reel.  

Reel Name Audio in the project's Source Tracks Folder that has a SADiE Reel number of the 
correct value will be used for entries on this Reel. Mostly only audio recorded by SADiE 
(since v3) has this particular metadata, however AVTransfer has an option to insert this 
into a BWF file. 

Scene No. 

Tape No. 

Scene No. and Tape No. are metadata commonly inserted into a BWF file recorded by 
many Location Recorders. Typing a name/number here will force the reel to link to files 
that include that particular value for either the Scene or Tape metadata. 

EDL 

Reconform 

Unlike the other options the CMX Reel Number is mapped to an EDL and not an audio 
file. Thus the EDL can provide a means of mapping source timecodes to a different set 
of timecodes. 

There are two types of Conform to EDL option here.  

Reconform (as you might imagine) is the same process as Reconform (see later in the 
manual) but allows you more flexibility and the ability to specify a different Source EDL 
for every Reel in a multi-reel Change List. An example use for this would be where you 
are making a "Series Highlights" compilation and each Reel in the Change List EDL might 
refer to each episode of the series. With the Reconform option, the track width of the 
chosen EDL is retained, and the width in the Change List EDL is ignored. 

Reconform will pull in automation from an EDL and video if the video stream in the 
"Change List" is enabled. 

The EDL option is simpler and will treat the chosen EDL as a "source tape reel" and 
thus will pick streams of this EDL for "Reel-track" channels in the CMX EDL. 

Some Field Recorders (HHB Portadrive for instance) provide an AES31 EDL for each 
Reel and thus this may provide a simple method of linking to files made by such a 
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recorder. 

So the main  difference between EDL and Reconform mode here is that Reconform 
uses the entire width of the selected EDL, whereas EDL uses only the channels 
specified. 

It's possible to set multiple rules in a priority order by using the SHIFT-modifier key when pressing a Rule 
button to ADD a new rule. 

WHEN TO LINK 

The search and linking of audio files happens when you press OK or APPLY on the dialog. 

However, it's possible to make the scanning for audio files automatic in the case where all the files are available 
either in the expected places or with the expected metadata. 

This is controlled by the Default tick boxes by the side of Scene, Tape and Reel. In these cases the default 
settings for Reel to Scene/Take/Reel mapping are used and thus Reel 002 would look for metadata 002; Reel 
003 would look for metadata 003 etc. 

Where zeroes are included in the reel name as in our example, SADiE would be happy to find just the number. 
Any leading zeroes, or any other characters in the metadata string will be ignored. 

WHAT DO THE RULES APPLY TO ? 

On the lower right side of this Link Dialog, you can choose what the current rule will apply to. 

The first line will show the currently selected Reel name (Reel 003 in the example) and thus the rule will apply 
to only that Reel. 

However the selection below allows you to apply the rule to All Reels - thus if you'd chosen to look for 
Scene 003, then EDL entries on ALL reels would try to find a timecode range match in only files that had Scene 
003 in the metadata. Or a more likely example is where all files for all reels are in one directory. 

The last to are reasonably self explanatory : 

"To be recorded only" will only apply the current rule to record entries that are marked "to be recorded". 
You can alter the "To Be Recorded" status by double clicking on Yes/No in the Record Entry.  

Unlinked entries only will only apply the current rule to EDL entries that have no audio. 
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CD MASTERING 

CD PRE-MASTERING 

NOTE: CD players work to a resolution of CD frames. There are 75 CD frames to a second. Earlier PQ 
editors worked to an NTSC resolution of 30 frames to a second, which was less accurate than the players 
themselves. SADiE v5 works to the full 75-frame resolution. 

It is recommended you change SADiE's time display format to CD frames in the "General" section of the Setup 
window before doing any PQ work. If you don't, you will find that times will jump in steps equivalent to CD 
frames. 

Quick Start CD Writing Tutorial - this also includes writing of DAT ID's and using Audio CD recorders. 

PQ List Overview - CD-R Method 

More detailed and technical description is found in these sections: 

Notes on Real-Time and Non-Real-Time CD Mastering 

Orange Book CD's 

Multi-session CD's  

QUICK START CD WRITING 

INTRODUCTION 

Later sections in this manual give a more full and technical description of the PQ editing and CD writing 
process. This section describes a basic "Quick Start" method of burning a CD-R from your Playlist . 

WHAT EQUIPMENT DO I NEED? 

Assuming you have a SADiE system you will also require a CD recorder drive attached to your SADiE. 

As of SADiE v5.4, all current Plextor drives, including CD-R and DVD-R drives are supported for writing CD 
Audio disks.  

Please see the note about CD-R media before proceeding. 

PREPARING THE PLAYLIST 

It is assumed that you have completed editing your Playlist, and now everything in the Playlist needs to be 
recorded onto CD-R. If you have any "loose" items and clips hanging around at the end of the Playlist that are 
no longer required then delete them now. The CD-R process will copy the entire Playlist to CD-R, and hence 
if you have a clip sitting at 14 hours where all the others are placed around 2 or 3 minutes onwards, then it will 
try and burn a 14+ hour CD: not possible! (CD-R blanks are usually a maximum of 74 minutes long. You can 
buy (more expensive) blanks which will run to about 79 minutes, and of course DAT tapes don't have this 
same restriction). 

You must also have PQ editing enabled. If this is the first time you've written a CD-R then it may not be 
enabled for your Playlist. Take a look at the top of the Playlist, just above the topmost stream; there will be a 
thin bar labelled "Audio Unit A". If PQ Editing is enabled there will be another thin bar above this labelled "PQ". 

 
If PQ Editing is not enabled you must: 

 First enable PQ Editing features. This is done with the check button "Enable PQ editing features" at 
the top of the "PQ Settings" section of the Setup window (found under the View menu). 
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 If you've already finished editing your EDL , you must create a new EDL, which will now have the 
extra Stream for PQ flags, displayed above Stream 1. 

 Then you must copy your EDL entries into this new EDL. "Select All" Entries under the "Edit" menu, 
then cut and paste them into a new EDL. If it is crucial to retain the timing of all the entries, then you 
can do the copy and paste operation with Autoplace in "EDL" mode and the EDL times in the new 
EDL will be the same. In most situations this isn't important, as the CD will start at its first flag, 
whether it occurs at 00:02:00 or 12:15:56. 

Having enabled PQ, the next time you won't have to go through this rigmarole as every subsequent EDL will be 
created including the PQ stream. 

There are a few rules for this process: 

 CD-R's can only be written with a sample rate setting of 44.1 kHz. CD's will only accept 16-bit audio, 
so if your Playlist uses 20 or 24-bit audio, then it will be truncated (and you should really use one of 
the Dither plug-in options) 

 CD's can only be written using Outputs 1&2; anything routed to other outputs will be ignored, and 
thus you should mix down to stereo before writing. Other outputs will play however, thus you could 
route to external effects units etc. 

 CD-R's can only be written from the first unit of Multi-card systems.  

CREATING PQ FLAGS 

You want to mark the start of every track on the CD, and this is done with PQ flags marking both the start 
and end of every track. There are other flags and codes that can be entered, but these aren't covered in this 
exercise. You can read up on PQ flags in PQ Lists Overview. 

A small point of terminology here: the word Track is used to define the music track on the CD. SADiE also 
refers to a Track as the name for the original unedited recording. In this section Track will be used to refer to 
CD tracks. 

The simplest way to place the PQ flags is by using SADiE's automatic "Generate PQ List" function, but first you 
should understand the ground rules for this function. 

 
GENERATE PQ LIST places a Track Start flag on the beginning of every EDL entry, and a Track 
End on the end of every EDL entry. 

However, it is quite possible that is not what you want to do! You have (presumably) edited your Playlist and it 
could be that every CD track contains a number of edits. 

There are some parameters for GENERATE PQ LIST that allow you to ignore certain edits for the Auto-
generate, however for now you'll set these to a "catch all" setup, and you will then use the GROUP ENTRY 
function, and group entries into their CD tracks. Then when the GENERATE PQ LIST function operates, it 
will see only these Group clips and place the flags in relation to these, rather than the hundreds of edits inside. 

PQ FLAG SETTINGS 

Open the "PQ Settings" section of the Setup Window, and then click on "PQ Flags". 

Set "Minimum track length" to 10 seconds: 4 seconds is the minimum allowed on a CD. 

Set "Minimum Gap length" to zero. If it is not zero, the "Generate PQ function" will look for gaps between 
entries onto which it can place flags, and thus any crossfade or butted edits will be ignored: this may be 
appropriate for your Playlist, but the method described will always work. 

GROUPING ENTRIES 

You will have already done this if you've been through the Basic Tutorial, but let's quickly go over this again. 
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Before you do the grouping, it may be worth checking that the entries that begin and end every CD track are 
reasonably tightly edited. It is not a problem if they aren't as you can fix this later by manually tweaking the 
position of the PQ flag, but if for instance there is 3 seconds of silence inside the first entry, GENERATE PQ 
LIST will place the CD flag at the entry start and not the music or audio start, hence your CD will start playing 
way too early. 

 
Press the SELECT TOOLBARS button on the Playlist toolbar again. Select "Group" to reveal the 
Group toolbar. 

 
Now select all the entries that make up the first CD track. You can do this by dragging across them with the 
mouse so that they turn red. 

 
Press GROUP SELECTED EDL ENTRIES. They will be redrawn as a single yellow block in the 
Playlist. You can rename this group (right-click on the entry and select "Rename") if you like, but it 
will make no difference to the CD. 

Now do the same for all the other tracks, and you'll end up with the exact same number of yellow 
entries in the Playlist as you're going put onto the CD-R. 

GENERATE PQ LIST 

 
Press the TEXT PANE button in the left corner of the Playlist and then select "PQ" from the tabs 
at the bottom left. If necessary drag the edges of the Playlist window or the border between the 
Playlist and the text pane. This will show a blank PQ list (just a CD icon and the words "CD Audio 
PQ data" will be seen), and the PQ toolbar will appear, usually attached to the bottom edge of the 
Playlist. Also the PQ Stream opens up at the top of the Playlist. This is where PQ flags are going to be 
displayed (but there won't be any yet). 

 
Press the button for GENERATE PQ LIST. This is the left most button on the PQ toolbar. 

Huzzah! As if by magic all the little PQ flags will place themselves onto the beginning and end of every 
one of these group entries. 



Specific Applications 

295 

 
Where there are gaps between tracks, there will be a space between the black "Start" flag and the grey "End" 
flag, but some may be at the same position, where there is a gap or crossfade between tracks.  

EDITING PQ FLAGS 

CHECK THE FLAGS 

You can now audition the starts of every track. Change the zoom a little so that you can see a bit more detail 
at the track starts. 

 
The PQ toolbar has a number of Preview options, but go for PREVIEW COUNTDOWNS, which 
plays through all track starts and ends (for a few seconds before the end flag to a few seconds after 
the start flag). 

This preview uses the standard setting for Pre/Post Roll. If it is not giving you enough select the 
"Pre/Post Roll" section of the Setup Window and change the top pair of times to make them longer. 

EDITING THE FLAGS 

There's a good chance that this has all worked out perfectly, and there's no need for further tweaking. 
However, if some flags are not exactly where you want them, you can manually move them. 

When you move the mouse over the PQ stream, the cursor changes to show a flag, or, when you are over a 
PQ flag, it becomes a hand. With the hand you can click and drag the flag to a new position. 

There are a couple of rules however: 

 You're not allowed to place a "Start" Flag (a black one which will be marked, for instance, 03:01 Track 
3) to a position before the previous CD track's "End flag" (the nearest grey one that's flying in the 
opposite direction). 
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 You're not allowed much movement on the very first Track start flag (01:01) and it's corresponding 
grey end flag. This is a special flag; the space between the grey flag and Track 1's start does not play on 
the CD. The grey flag serves no real purpose other than to conform to the Red Book CD 
specification, but it has to be greater than 2 seconds, and less than 3 seconds before the black Track 1 
"Start" flag. You can move the two of them 1 second at a time, but this can be very tedious, and so 
there's another method of moving flags, which is useful for accurate placing of all PQ flags. 

SNAP PQ FLAGS 

If, when the mouse is over a flag and the cursor is a hand and you right-mouse-click, you get a menu: 

 

Selecting "Snap PQ index to current time" moves the selected flag to 
where the dotted current time marker is positioned. Thus you can 
place the current time to the exact position you want the flag to be, 
either by eye, or of course by scrubbing the Playlist to position it 
audibly, and then use this option move the flag. 

When used on Track 1's flags (either black or the grey one), they 
will move together, and so you can move them while retaining their 
"PQ legal" relationship. 

WRITING THE CD-R 

Having tidied all the flags and done your final previews, it is now time to write everything onto the disc. 

 
On the PQ toolbar, press the READ/WRITE PQ DATA button. The "Read/Write PQ data" 
window will appear. 

 
This is where you decide which type of master to make, and this will depend on the device. 

The options offered here will depend on the type of SADiE system you are using and whether you have the 
Mastering options. You may be able choose between CD-R, PQ Burst, Tape drive (for DDP Tapes), DDP to 
Hard disk, DDP Image on PC disk, or DDP Image on SCSI disk. As this is the Quick start CD-R section, our 
main interest here is burning an Audio CD-R and so the more advanced CD Pre-Mastering options are 
described elsewhere, although the method is very similar. 

Select CD-R (if it's not already selected) 
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CD-R 

You have another decision to make for CD-R, because they are able to write the CD-R disc at speeds greater 
than real-time. The maximum speed allowed will depend partly on your CD-R's maximum speed, but also on 
the complexity of your Playlist and Mixer. SADiE plays the EDL directly and does not make an Image file, thus if 
your EDL has 24 tracks plus equalisation and processing, SADiE will not be able to play that much audio at 2x 
or 4x and so you should choose 1x. SADiE will recommend a speed when the "Read/write PQ data" box is 
opened but she is often a little conservative in her estimate. If the speed chosen is too high, then, at the point 
of playback where SADiE can cope no more, playback will stop, the CD writing will abort, and the disc made 
will be incomplete and corrupted. 

A fairly simple 44.1 kHz, 16 bit stereo edited Playlist should be able to be written at 4x. In time you will be able 
to work out if what speeds are possible from experience, but for safety's sake choose the recommended 
speed. If you can stand the cost of throwing away a disc then live dangerously, it may save time! 

If Burnproof is offered, then tick it. This will smooth over any "hiccups" in the data transfer to the CD. 

If CD Text is offered (available on PCM8 and DSD8 systems or as part of the mastering package on other 
systems), you may wish to tick this to put CD Text on the disk (but you will also have to enter titles and artist 
information). CD Text is described in more detail later. 

It is possible to do a Test run by ticking "CD-R Test Mode". This performs the write process using a low 
power laser and hence doesn't actually write anything to the disc. If you use Test mode, you will usually have to 
exit SADiE and re-power the CD-R drive to set it back to normal power laser. This is useful if you are making 
many copies in order to help optimise the CD-R speed. 

There is more discussion on CD-R write speeds in Non-Real-Time CD Mastering later in this chapter. 

Having chosen the CD-R write speed (or settled for what SADiE has chosen) press WRITE. 

You will not hear the audio while the CD-R is being written unless you deselect NON-REAL TIME which 
uses a different method to write the CD (see Notes on Real-Time and Non-Real-Time Mastering). 

A message will tell you when the operation has been completed, and a Clip named "CD Audio Image" will 
appear in the Source Tracks folder of your Clipstore.  

PLAYING THE CD-R 

You can playback the finished CD-R, directly from the disc via the CD-R device. You can use this same method 
to play other CD's, manufactured ones perhaps, and also to record the CD back into SADiE at speed. 
Alternatively there is a simple method for playing and ripping audio from the CD using the CD Import Window 
which is described in the "Recording and Importing Audio" section of this manual. The method described on 
this page does offer more flexibility however, and is better for reviewing small segments of the CD, and the 
track transitions. 

At this point, it is probably better to make a fresh Playlist otherwise you run the risk of spoiling your master 
EDL (you have been saving during this haven't you?). 

Right-click in a grey area of the Project window. Select "Create a new...", then choose "EDL component", and 
give it a name. Now double-click on the new EDL's icon in the Project window to open it. 

 
Open the PQ pane as before by pressing TEXT PANE and choosing the "PQ" tab. Press 
READ/WRITE PQ DATA as you did to start the CD-R writing, choose "CD-R" from the "CD 
Pre-master device" list, and now this time, press READ. 

Your previous blank EDL will soon have the PQ flags from the CD displayed. There are options as to which 
flags can be read (see Reading from a master for more details). 

Also in the EDL will be the outline of a single clip representing the entire CD called "CD Image". You can now 
play this "Clip" as if it were a normal SADiE recording; however it will be slower going into playback. This clip 
has no waveform. 

If you want to record a CD track or tracks back into SADiE then this is possible using the normal Bounce 
routine. You can razor the CD Image clip as normal if you only want one track for instance. 

There is more discussion on Bouncing from CD-R later in this chapter.  
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CD-R METHOD 

PQ LISTS OVERVIEW 

All CD's have Index points, which the player can locate and display timing information about. This lets the user 
play a particular item, or program the machine to play items in a certain order. PQ flags marking each index are 
embedded in a CD by the manufacturer. 

PQ flags are described by a track number, followed by an index number. 

 Track 2 Index 1 (written 02:01) is the start of CD track 2. 

 Further Index points (02:02, 02:03, 02:04...) are occasionally found within tracks. They may be used on 
Sound Effects discs where several variants of the same effect are given, or on classical disks for 
movements within a work. 

The CD player also needs a PQ flag for the end of each track. 

 The flag for the end of track 1 is 02:00, and so on for other tracks. 

 The flag for the end of the last track is labelled "AA:01" and is the "End of CD" marker. 

There is a special Start of CD flag, labelled 01:00. The Red Book Standard specifies that this should be between 
2 and 3 second before 01:01 (the start of track 1). 

On any CD there can be a maximum of 99 tracks, each with 99 Indexes. 

Therefore a CD with only three tracks, where track 2 has an internal Index point, would have the following PQ 
flags: 

 
The gap between the end of one track and the start of the next is called the countdown (or pause). This will be 
silence on many CD's, but may be applause or atmosphere on a live recording. You may notice when the CD is 
playing in a normal CD player, that when playback goes past a Zero ID (an end flag) the player's display starts 
counting down the time to the start of the next track (the next ID 1 flag). This is one of the differences 
between a Red book (disk at once) CD and an Orange book (single track at a time) CD: Orange book CD's 
have a standard silent space between tracks. 

If the countdown has a length of zero (e.g. the 00 index would be coincident with the next 01 index) the 00 
index is not written to the CD. 

When playing a whole CD in order, a player will start at 01:01 and then play continuously to AA:01. The space 
between 01:00 and 01:01 is not played by the CD, and not included in the CD's total time. 

When playing just track 2 (on its own or as part of a program), a player will play from 02:01 through to 03:00.  

PQ LISTS OFFSETS 

You will probably determine the EDL times at which PQ flags are placed with reference to the audio. These 
times are called "Start Times", or "User Times". 

CD players vary in their speed and accuracy in locating an index, starting to play, and then fading up the 
volume. To avoid the possibility of clipping the start or end of tracks and to separate mechanical noise from the 
music, the start/user times of PQ flags are offset to obtain the "PQ Times", as follows: 

 The Start of CD flag (01:00) and the first track start (01:01) are advanced by the "Start of CD 
Advance", typically one second. 

 Subsequent track start flags (02:01, 03:01,...) and all index flags within tracks are advanced by the "Start 
of Music Advance", typically 12 CD frames. 
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 Track end flags (02:00, 03:00, etc.) are delayed by the "End of Music Delay", typically 5 CD frames. 

 The End of CD flag (AA:01) is delayed by the "End of CD Delay", typically two seconds. 

NOTE: After applying offsets, a 00 index is not allowed to be after the next 01 index, so it is set 
coincident with it. In this case there will be no countdown and the 00 index is not actually written to 
the CD. Very short countdowns left after offsets also are commonly removed. 

Traditionally, the start of the first audio on a CD master tape is positioned at 00:02:00 (two minutes) with 
respect to timecode, and therefore at 00:02:00 in SADiE's EDL. The CD doesn't need to have two minute's 
silence on the front, so the actual CD Times are the PQ times with respect to the Start of CD flag (01:00).  

SADIE'S PQ EDITOR 

You can create a PQ list by manually inserting each flag, or by letting SADiE automatically generate an entire 
list based on the in and out points of Entries in the EDL . The flags can then be adjusted manually. 

SADiE will display the positions of the flags alongside the EDL Entries and apply all the above offsets for you at 
the time the PQ list is first created. 

To make an EDL with a PQ list you must: 

 First enable PQ Editing features. This is done with the check button in the "PQ Settings" section of the 
Setup window. 

 Then create a new EDL, which will have an extra Stream for PQ flags, displayed above Stream 1. 

NOTE: If you already have an EDL that was created before you enabled PQ features, and you want to 
add a PQ list to it, then enable PQ Editing, "Select All" Entries under the "Edit" menu, and finally cut and 
paste them into a new EDL. 

 
The PQ list is displayed as one of the three text panes attached to the Playlist . Use the TEXT 
PANE button on the Playlist toolbar and then select "PQ" from the tabs at the bottom left. If 
necessary drag the edges of the Playlist window or the border between the Playlist and the text pane. 

The PQ toolbar and the Stream displaying PQ flags in the Playlist will also be displayed. This is in a separate unit 
from the Streams for EDL Entries: double-click on the unit name above the Stream control buttons to 
open/close it. 

 

 
The PQ SETUP button on the PQ toolbar directly opens the PQ section of the Setup window. 
There are several setup sub-sections referred to below in capital letters. 

AUTOMATICALLY GENERATING A PQ LIST 

If your audio material is not already divided into EDL Entries, you can either put razor-cuts at all the track start 
points first, or choose to insert all flags manually. Manual insertion is covered by the section on editing an 
automatically generated list. 

1. Set the offsets (described above) that will be used in the list. These are in the PQ OFFSET setup. 

NOTE: The offsets set here are applied to a PQ list from the moment a list is automatically 
created by using the GENERATE PQ LIST button, or the first flag is manually inserted. From 
then on, they are held in the EDL and changing offset settings will not change the current PQ list, 
unless you destroy it and create a new one. Therefore be sure that you set them as you want 
before you do lots of intricate PQ editing! 

The "Normalise" function is described below. 
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2. Set the parameters for calculating PQ flag positions based on your EDL. A 01:01 flag for the start of 
track 1 will be put at the in-point of the first EDL Entry. After that, SADiE will put track end flags at 
Entry out-points, and track start flags at Entry in-points subject to the following options in the PQ 
FLAGS setup: 

i. New tracks will only be flagged when the previous track has exceeded the minimum track 
length, and after a gap between EDL Entries longer than the minimum gap length. 

ii. The first index 0 length determines how much before the start of track 1 the Start of CD flag, 
01:00, is positioned. Red Book recommendations are between 2 and 3 seconds. 

3. In the PQ FLAGS setup, you also can set the default emphasis and copy-permit settings for each track 
that is flagged. 

4.  
Press the GENERATE PQ LIST button on the PQ toolbar. 

NOTE: A minimum gap length setting of zero will find all edits, even overlaps. The GROUP CLIPS 
function in the Playlist may be very useful for preventing certain edits from affecting the PQ list creation.  

PQ LIST DISPLAY 

The PQ Stream in the Playlist should now display the PQ flags. 

 The FLAG DISPLAY MODE button to the left of the PQ Stream selects whether flags are 
displayed at the Start times, which will line up with edit points after auto-generating (button down), 
or the PQ times, which are the positions after the offsets are applied (button up). 

 
The text pane shows the details of the PQ entry at each flag: 

 On the left hand side, the list is shown in a tree structure, with the whole CD at the top, tracks within 
it, and flags within tracks. Double-click to open/close items. 

 On the right-hand side, the details of each PQ entry are shown in columns. The columns can be 
customised by clicking on their heading buttons, and the width of columns can be changed by dragging 
the dividers between the heading buttons. 

 You can click on the flag names in the tree, and the track or Index numbers in the columns to select a 
PQ entry and locate the current-time cursor in the EDL . The entry's details and the flag in the Playlist 
will be highlighted in red. 

Other columns include: 

 Track name and Index name - These allow you to enter your own names for display purposes, and for 
printouts. Double-click on the names. 

 Start time - Shows the start time (or "user time") of each PQ entry. 

 Duration - Shows the length of time between this PQ entry's start time and the next. 

 PQ time - Shows the time of each PQ entry after offsets are applied to the start time. 

 PQ duration - Shows the length of time between this PQ entry's PQ time and the next. 

 CD time - The PQ time of each PQ entry with respect to the Start of CD flag (01:00). 
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 Emphasis - Shows the setting of the emphasis flag for the following CD track:  = emphasis on. 
Double-click to change the setting. 

 Copy - Shows the setting of the copy permission flag for the following CD track:  = copy allowed. 
Double-click to change the setting. 

 ISRC - is the unique code that you can allocate to each CD track, for PRS logging purposes for 
example. Double-click to enter the code. 

 
You can generate sequential codes for the whole CD by pressing the GENERATE ISRC's 
button on the toolbar. Enter the number for track 1, and the codes for all other tracks will 
be allocated. The country and owner parts of the code are entered in the PQ FACILITY 
setup. 

PREVIEWING THE PQ ENTRY POINTS 

To audibly check the positioning of your PQ entries, the following preview buttons will play the relevant parts 
of the EDL . with pre-roll and post-roll times set in the Setup window. 

The FLAG DISPLAY MODE setting will affect which EDL times the previews apply to. 

 
PLAY UP TO INDEX plays up to the selected PQ entry. 

 
PLAY THROUGH INDEX plays through the selected PQ entry. 

 
PLAY FROM INDEX plays from the selected PQ entry. 

 
PLAY TRACK PAUSE plays through the countdown for the selected PQ entry. 

 
PREVIEW CD TRACKS plays from all the track starts for the CD. 

 
PREVIEW COUNTDOWNS plays through all the countdowns for the CD, so checking all track 
starts and ends. 

 

MANUALLY CREATING AND EDITING PQ LISTS 

NOTE: If you are creating an entire PQ list manually, use the Setup window to set the PQ offsets to be 
applied to the list before you insert the first flag. From then on, they are held in the EDL and changing 
the settings will not change the current PQ list. Also, the PQ DISPLAY setup has a button to enable the 
use of a mouse for PQ Editing in the Playlist . Some users may prefer to disable this to avoid accidentally 
moving flags with the mouse. 

INSERTING PQ ENTRIES USING THE MOUSE IN THE PLAYLIST 

The PQ INSERT MODE button pre-selects whether the PQ entry you insert will be: 

 Up - an index within the current track  

 Down - a track start. 

Position the mouse at the desired EDL time in the PQ Stream. The mouse pointer will turn to a flag and the 
mouse time display will show the time you are pointing to. Click to insert the PQ entry. Subsequent entries will 
be renumbered. 
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NOTE: If you are inserting a track start, a track end flag will also be inserted before it. The default 
countdown duration between these two is set in the PQ FLAGS setup. The default emphasis and copy 
permit settings for new track flags are also set here. 

INSERTING AND REMOVING PQ ENTRIES IN THE PQ TEXT LIST 

Use the following buttons in the PQ toolbar to: 

 
ADD TRACK adds a track start (with track end and default countdown) at the current-time. This is 
for accurately positioning flags at a point found by audible scrubbing of the Playlist. 

 
ADD INDEX adds an index flag at the current-time. 

 
DELETE INDEX deletes the selected PQ entry. 

MOVING PQ ENTRIES USING THE MOUSE IN THE PLAYLIST 

Position the mouse pointer over the flag you want to move. The flag symbol will change to a hand. You can 
then either: 

 Drag the flag to a new location, or 

 Right-click and "Snap the PQ flag to current-time". (Useful after scrubbing the audio.) 

 
The SLIP INDEXES button will cause all PQ entries to the right of the one you move or delete to 
move with it. 

NOTE: Take note of whether you are viewing Start time or PQ time, as selected by the FLAG 
DISPLAY MODE button. 

EDITING PQ ENTRY DETAILS IN THE PQ TEXT LIST 

 

You can double-click on any of the time values in the PQ list, and edit them like other 
time displays in SADiE. The PQ entry will move accordingly and the SLIP INDEXES 
button will determine whether all following PQ entries move. 

 Double-clicking also allows you to change each track's emphasis and copy permit 
settings and ISRC code. 

 
The NORMALISE button will reduce to zero all countdowns less than the value set as 
the minimum index 0 length in PQ OFFSETS. 

NOTE: This is done by moving the track end (index 0) flag up to the following 
track start flag. The PQ and CD times for the track end flag will not be displayed, 
as it is not actually written to the CD when it has zero duration. 

 
The EDIT HEADINGS button lets you enter CD details for the printout and 
manufacturer. 

 
The MODE 2 DATA text box above the PQ list tree represents the CD's bar code. 
Double-click to enter the code. 

TIP: If the audio for your CD is all one EDL Entry, and you don't want to remove noise or atmosphere 
between tracks, either: 

 Put single razor-cuts at each track start point and auto-generate the PQ list with minimum gap length 
set to zero. 
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 Manually insert each track start flag after scrubbing the Playlist to locate the point, then use the ADD 
TRACK button, or paste the flag in with the mouse and snap it to the cursor. 

 You can then move the track end flags back, if you want to create countdowns.  

PRINTING OUT THE PQ LIST 

 
PRINT PQ uses the Windows application Notepad to print the PQ list directly to your printer. 
Offsets used, CD details entered in the "Edit Headings" box and Facility details entered in the PQ 
FACILITY setup are included in the printout. 

 
PRINT PQ TO FILE saves the PQ list as a text file, which you can later open and edit in any text 
editor or word processor. 

This is available on PCM8 and DSD8 systems, or as part of the mastering package on PCM4 and H64 machines. 

MAKING A MASTER 

SADiE will write your finished PQ list and the audio to the following equipment: 

 Exabyte tape drives, using the DDP format 

 CD-R's 

 Any timecode-synchronised recorder, using a PQ burst (commonly SONY 1630/U-matic). 
Synchronisation is covered earlier in this chapter. 

 DDP Image to Disk. This allows you to put the DDP files (including the Audio Image) directly onto a 
disk drive. This format is commonly known as DDPi. 

For a further discussion on writing discs or tapes at speed, or in real-time, see Notes on Real-time and Non-
real-time Mastering. 

NOTE: PCM4, PCM2 and H64 have limited Mastering facilities, and so cannot produce PQ Bursts, or 
DDP Masters. However CD-R is possible. The mastering plug-in package is available for PCM4 and H64 
machines. 

 
On the PQ toolbar, press the READ/WRITE PQ DATA button. The "Read/Write PQ data" 
window will appear. 

 
Select your pre-mastering device: 

 Tape Drive - Press the WRITE button to create a DDP master. The SCSI Exabyte tape drive will 
locate itself and the PQ data and audio will be written to it. 
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o If you select NON-REAL TIME, this will be done as fast as possible, but you will not hear 
the audio. 

o A message will tell you when the operation has been completed. 

o A Clip named "CD Audio Image" will appear in the Source Tracks folder of your Clipstore. 

NOTE: There are some choices with regard to the format of the DDP tape. You can choose 
DDP version 1.00 or 2.00. This is chosen the "DDP Details" section of the Setup window. With 
either version of DDP, you can choose to put the DDP files before or after the audio file; there 
is a tick box in the "Read/Write PQ data window" for this "DDP at end of tape". The advantage 
of putting the DDP files at the end of the tape is that they can be replaced at a later date (to 
add ISRC codes for example) and this can be done by pressing "Overwrite DDP at tape end" 
(but this only works if the DDP files are at the tape end). It is recommended that you check 
with your manufacturing plant that they will accept DDP v2.00 and/or DDP at the end of tape, 
as these are non-standard. 

 CD-R - Press the WRITE button to create a Red book CD, complete with Table of Contents. 

o Set the CD-R Speed. The speed that SADiE can write to the CD-R will depend on the 
complexity of your EDL .  Experience will teach you how fast you can go. Please see the note 
about CD-R media before proceeding. If you're not sure, try using... 

o CD-R Test Mode. This writes the CD with the laser on low power, so that the disc is not 
actually burnt. It effectively checks whether the whole EDL can be written to your CD-R 
machine at the selected speed, without spoiling the disc. 

o You will not hear the audio while the CD-R is being written unless you deselect NON-
REAL TIME which uses a different method to write the CD (see Notes on Real-Time and 
Non-Real-Time Mastering). 

o A message will tell you when the operation has been completed. 

o A Clip named "CD Audio Image" will appear in the Source Tracks folder of your Clipstore. 

 PQ Burst - Press the WRITE button at the moment you want to send the PQ burst to the tape, then 
run the machine with SADiE in sync and record the audio. 

o The outputs used and level of the burst can be set in the PQ BURST setup; -14 dB is normal. 

NOTE: It is advisable to lock SADiE's digital audio clock to that of the 1630. Connect the 
1630's digital output to SADiE's digital input and select that input as the clock source in the 
"Further Audio settings" section of the Setup window. Then run SADiE as the slave, in "Trigger 
lock", synchronised to timecode from the U-matic. 

 DDP Image to Disk.  

o On selecting this, you will then be asked where you want to place the four files that are 
required. These are usually called: 

 DDPID - a small file that identifies the DDP 

 DDPMS - another small file. 

 SD - another small file, this one contains the PQ information. 

 Image.dat - a MUCH larger file that contains the audio data. This file could be over 
600 MB, and thus take care that you have enough space on the disk for it. 

o As with DDP tapes, you can choose DDP v1 or DDP v2. 

o You could choose a networked drive for the PC disk destination.  

NOTE: This function is not to be confused with the "DDP Headers to disk" function, which 
only copies the smaller PQ related files to a PC disc, and not the Audio Image.  

NOTE: Some factories will prefer DDP on CD-R, DVD-R or DVD-RAM disks. SADiE can write 
DDP directly to DVD-RAM or MO disks. If the delivery format is to be CD-R or DVD-R you 
will need to write a DDP Image to Hard Disk, and then create the Master Disk using a separate 
burning application. 
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CD TEXT 

It is possible to embed text fields in the CD in order to add title and artist information to the disc, and some 
CD and DVD players are able to display this while the audio plays. 

There has been some confusion about how this relates to artist, title and other information that is displayed 
when you log a disc on a PC in a multimedia application like, for instance, Windows Media Player. The Artist 
and Title information in the CD Text is NOT read by Media Player - this data goes beyond what can be stored 
on the disc and is always downloaded from an internet database. Thus if you put CD Text on your CD, it will 
not appear in Media Player - probably because , particularly if you are mastering a new disc, this information 
has yet to be entered on the databases that Media Player uses to find this information. 

However CD Text can be a useful addition to the disc and some record companies may require their discs to 
contain it. 

CD Text can only be embedded on a CD-R master, and not a DDP Image, DDP Tape or U-Matic master. 

SADiE uses the fields in the PQ Editor to add Title and Artist information for each CD track. Additionally, if 
you press the Edit Headings button on the PQ toolbar, the PQ List Title Editor has some fields for disc 
information, which is used in the PQ Print out. The  CD Title and  Artist fields here will provide the Disc 
Artist and Title information in the CD Text. 

 
The ability to add an artist for each track is provided for instance for compilation albums. You'll notice that any 
Track Artist fields that are empty when you fill in the Disc Artist field, will be filled in automatically (to avoid 
the need for extra typing when the disc isn't a compilation). 

There is a limit to the number of characters that can be put on the disc as CD Text, but it's about 4600 for the 
whole disk, so if you have less titles you can have longer titles. SADiE will warn you when you get to the limit. 
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TO WRITE THE DISC WITH CD TEXT 

 
In the usual way, when you've completed the PQ editing, and typed the artist and title information, open the 
PQ Read/Write Data window, choose CD-R, but make sure that CD Text is ticked before pressing Write. 

CD Text may make the CD writing operation slightly more stressful in terms of processing speed, and so for 
example, a playlist and mixer that burns at 8X without text may not be successful with CD Text (although 
selecting burnproof will ensure it completes anyway). 

CD Text is available as a software option - contact your dealer for details of how to obtain it. 

VERIFYING A MASTER 

 
On the PQ toolbar, press the READ/WRITE PQ DATA button and select your pre-mastering 
device. 

 DDP tape - Press VERIFY and the PQ data on the DDP tape will be checked against the current PQ 
list in SADiE. You then have an option to VERIFY AUDIO INTEGRITY. This will produce a text 
file detailing the audio error correction rate on the master. In "PQ Settings" in the Setup Window, 
you can choose how detailed this text file will be. 

NOTE: Exabyte is a fully error-correcting data medium. It checks all data as it writes, and re-writes 
if necessary. Unlike the error correction on a CD, a high error count will not affect audio quality, 
but at worst could slow the transfer rate to a point where data transfer cannot be done in real 
time. 

 DDP Image to Disk - Press VERIFY and SADiE will ask you to point to the directory containing the 
files. You can choose any of the four files, and then the PQ data will be verified. There's no option for 
verifying the audio as with DDP tapes, although DDP tapes are only verified with respect to the data 
integrity; it is not expected that a disc copy can fail. 

 CD-R - CD-R's cannot be verified. 

 PQ Burst - Press VERIFY, then play the PQ burst from the tape. Set the input you are sending the 
burst to in the PQ BURST setup. The PQ data will be checked against the current PQ list in SADiE.  

READING FROM A MASTER 

If you have been given a master that needs further editing, you will want to load both the audio and PQ data 
into SADiE: 

NOTE: First create a new EDL because the PQ data you are about to read will be attached to whatever 
is the current EDL. 
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On the PQ toolbar, press the READ/WRITE PQ DATA button and select your pre-mastering 
device. 

 DDP/CD-R - Press READ. The PQ data from the tape or CD will be read into the current EDL and 
appear in the PQ list. A "CD Image" clip will appear in the Playlist lined up with the PQ flags for 
playback or bouncing to an audio drive ** 

 DDP Image to Disk - Press READ. SADiE then asks you to point to the location of the DDP files. 
You can choose any one of them to "log" the DDP. A "CD Image" clip will appear in the Playlist lined 
up with the PQ flags for playback or bouncing to an audio drive  

 PQ Burst - Press READ, then play the PQ burst from the tape to the input you have selected in the 
PQ BURST setup. The PQ data from the tape will be loaded into the current EDL's PQ list. Record 
audio from the 1630 in the usual way. 

NOTE: You will be loading PQ times into from the master the PQ list. SADiE will apply the currently 
set offset values in reverse to derive start times. If these are different from the offsets used to generate 
the PQ list originally, you will find that the start times do not line up exactly with the audio. You will 
probably just work on the PQ times directly, but if this bothers you, either adjust all the flags' start 
times, and let SADiE produce PQ times according to your offsets, or work out what the original offsets 
must have been, set them in the PQ OFFSETS setup, then read the PQ data again. 

When you read a PQ list in off DDP or CD, the times on the medium are calculated from 00:00:00, whereas it 
is possible that when it was originally edited, you may have had an offset in the EDL and the CD started for 
instance at 00:02:00. It is usually more convenient to not start at zero. This would be where the PQ print-out 
was timed from also. 

The "EDL PQ list insert time" setup option allows you to choose the position in the EDL of Track 1 ID 0 when 
PQ data is read from a CD-R or DDP tape. 

** NOTE for SADiE v5.4 there has been a slight change in the routine for Reading a DDP or CD, in that 
the CD Image clip is automatically placed in the EDL - previously you had to drag it from the clipstore. 
Beware if you drag the CD Image from the clipstore now, you will have 2 overlaid CD images and these 
will combine - any playback or bounces may be incorrect. 

CD SUBCODE 

When reading PQ data from a CD (via a CD-R) the data SADiE can read will depend on the model of the CD-
R being able to retrieve that data from the disc. The "PQ settings" page of the Setup window has two options 
for enabling the reading of some subcodes: 

 Read ISRC from CD-R - When reading the PQ data, the disc will be located to the start of every track 
so as to read the ISRC information (if it exists). Thus reading PQ data will take a little longer with this 
ticked, but the ISRC's will appear in SADiE's PQ list afterwards. This does not work on some older 
CD-R's and they may crash if asked to perform this. 

 Read CD-R ID Zeros - With this ticked, the read PQ data process will be similar to the ISRC setting: 
SADiE will hunt for ID zeros (track end flags) throughout the disc (thus taking a bit longer), and they 
will appear in the PQ list afterwards. This again may not work on all CD-R's, but Plextor drives should 
work. 

 If the disc you are reading has CD Text, then this will be placed in the Artist and Title fields. 

 

REPLAYING A CD-R OR DDP 

After  reading the PQ list from CD-R, DDP tape or DDP Image files on hard disk, a clip named "CD Image" will 
appear in the Playlist, lined up with the PQ flags. As the Exabyte or CD-R is a PC device, its audio can be 
treated just like a SADiE Track on an audio disk, the only limitation being the speed of the device. 

The CD Image has no profiles so you won't see waveform information - just the clip outline. 

You can then play the Playlist, and preview or locate to the PQ flags. SADiE will play the audio directly from 
the CD-R or DDP (or DDP files).  



SADiE v5.4 PCM Manual 

308 

SAVING DDP PQ DATA 

The current PQ list in DDP format (without the audio) can be saved like any file and read back into SADiE's 
PQ editor for later modification. The new version can then be saved to floppy disk and sent to the factory 
separately from the master tape. This is sometimes done when a detail such as the ISRC codes gets added at a 
later date. 

 
On the PQ toolbar, press the READ/WRITE PQ DATA button and select "DDP Headers to 
Disk". 

 WRITE will save the file (to the DOS drive or the floppy drive), 

 VERIFY will compare the saved file with the current PQ list, 

 READ will re-load a saved file to the PQ editor. 

This is not to be confused with "DDP Image to Disk" as this process only copies the PQ data files and not the 
Audio Image file.  

BOUNCING FROM A CD-R OR DDP 

You can copy individual tracks or the whole CD to your audio disk by using the Bounce Window. You can 
copy from a CD-R or DDP master tape (or Image file) or in fact any CD (as long as you're not infringing any 
copyright!) and you don't have to have mastered it in SADiE. 

Note that a simpler method for importing whole CD tracks exists - see Importing from CD, however the 
method described below offers extra flexibility. 

1.  
Open the PQ Editor: press the TEXT PANE button, and select the "PQ" tab. 

2.  
Read the PQ data: Press the READ/WRITE PQ DATA button in the PQ editor. 

3. Select CD-R, Tape Drive, or DDP Image. 

4. Press READ. After a moment (usually quite a short time), the flags from your CD/DDP appear in PQ 
stream of the Playlist . Also, there will be a new clip called "CD Image" lined up to the PQ flags. 

5. You can now play the CD image. If it is from a CD-R it will take a little longer than usual to go into 
play, if it is from a DDP tape it will take MUCH longer to locate the tape. 

7.  
If you want to bounce the entire track , select the "CD Image", open the BOUNCE window, 
and tick "Stereo", "Selected clips", "Stream 1&2", "Auto-Replace", and "Bounce in non-real-
time". Press START. 

If you want to bounce only one track, then razor cut at its start and end (you can use the PQ text pane to 
locate exactly to the flags, as when you select a flag on the left-hand side of the table, the EDL locates to that 
position. You can use this, along with the keyboard down arrow to swiftly locate and razor cut on every flag.) 

It is worth choosing to view "PQ times" as opposed to "User times", as the user times will apply an offset. 

For just one CD track, select it in red and perform the bounce as above. For several CD tracks, delete the 
ones you don't need, and use the Multi-bounce option, which bounces every clip to a separate track (you'll 
need Autotake ticked for this). 

Currently, the non-real-time bounce speed is set to 2x on a CD-R drive, unless you change the setting under 
PQ settings. This is because we cannot guarantee the integrity of the audio at faster speeds. 

There is further discussion of this in CD-R Playback Problems.  
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NOTES ON REAL-TIME AND NON-REAL-TIME MASTERING 

It is possible to create the CD master, to DDP or CD-R, as a data process in non-real-time. This has the 
advantage of running faster than real-time, but you do not hear the audio being played. Another method allows 
the audio to be monitored as it transfers, either for the purpose of listening tests or because you may want to 
patch some external equipment into the audio path during the transfer. 

Non-Real-Time CD Mastering 

Real-Time CD Mastering  

NON-REAL-TIME MASTERING 

Usually you will probably want to write the CD-Master to either DDP or to CD-R as quickly as possible, and 
SADiE is able to make the master quicker than single playback speed. How fast it will go depends on the 
complexity of your EDL and the hardware you are using. This is called "non-real-time", which you may be 
familiar with from other areas of the program. The master will proceed at a speed regulated by the hardware 
(which in practise may stop and start and perhaps change speed to accommodate different levels of complexity 
throughout the EDL) but you will not be able to hear the audio as it transfers to the master. As there is no 
audio playback, you will not be able to use any external processing during the write, however of course you 
can get round this by re-recording to include the processing before the final writing process. 

The speed of writing will vary for different hardware platforms and CD/DDP writers, but here are some rules 
of thumb: 

 Non-real-time DDP to Exabyte - The Exabyte drive works at a number of different speeds and is able 
to stop and start and change the speed while it is writing a master. You don't have to consider speed, 
as the drive will run as fast as it can, and SADiE will slow it down if necessary. 

 Non-real-time CD-R - This is much more complex for the user to work out. CD writers have fixed 
speeds - 1x, 2x, 4x and 8x are relatively common, however this speed setting is fixed when you press 
WRITE. Therefore if SADiE is not able to feed the audio data to the CD-R drive at this speed, then 
the CD-R will run out of data and the write process will stop. CD-R's are usually write-once and so 
you will have spoiled a disc. SADiE will recommend a conservative write speed before you start the 
burn, however, if you're feeling confident, you can over-ride this. The speed that SADiE can deliver 
data at can be worked out approximately, based on the number of streams playing back (don't forget 
to allow for the two tracks you're recording to the CD-R and bear in mind that 4 tracks playing at 2x 
speed is the same as 8 tracks playing at normal real-time speed), however if you are using plug-in 
processing within SADiE, these figures will be changed radically. Note also that bit -rate will seriously 
effect possible write speed because more data is being processed. 

In practise, you will get a feel for what's possible with your hardware. You can perform Test Writes 
by clicking on the "CD-R Test Mode" button in the "Read and Write PQ data" window, before 
pressing WRITE. This sets the CD-R to a special low power laser mode and the CD-R will go 
through all the motions of writing the disc without actually burning anything onto the disc. And so if 
the test write completes you will know that a real write is possible. 

NOTE: after running a CD-R in test mode, you should re-power the CD-R device to set the laser 
back to its correct level. 

You should be aware that 1x CD-R speed is NOT real-time. If you are set to write non-real-time and 
1x you will not hear audio being played back.  

BURNPROOF 

V5.2.2 adds the "Burnproof" option for writing CD's. When this is ticked in the Read/Write PQ data dialog, it 
enables the function on a CD writer that supports burnproof. Without this function, CD writers require data 
to be reliably streamed at a constant rate, which is not always possible with a complicated SADiE Playlist. 
However, burnproof can pause the write and pick it up again when buffers are full (i.e. more like a normal disk 
drive), and thus you can generally choose a faster speed than would be possible without it. More importantly, 
with CD-R drives now not supporting write speeds slower than 4X, if your EDL is too complex for a 4x burn, 
then with burnproof enabled, you will be able to write the CD without bouncing it first. 
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We cannot guarantee quality or error rates on any CD's that are written. If you are in doubt as to the 
performance of disks written with burnproof enabled, we suggest you perform some Disk tests with the media 
you intend to use 

REAL-TIME MASTERING 

There is a special mode that enables you to make a CD Master to DDP or CD-R while listening in real-time, 
which will also allow you to use real-time inputs and outputs so that you can use external processing. 

 Real-time DDP - Most Exabyte drives are able to play and record audio at real-time, however, please 
note that one of the most popular drives, the 8505 model, performs a re-calibration every nine 
minutes or so, which stops the process for too long to continue a real-time playback. If you are 
unsure, test your drive first. 

 Real-time CD-R - Under normal circumstances, there are some difficulties with real-time CD-R; in 
particular the fact that when a CD-R is written, there is a long halt near the beginning while the PQ 
data is being written. However, SADiE can accommodate this by delaying the writing process (but still 
playing back continuously) until the CD writer is ready for more data. To initiate Real-time CD-R 
writing, edit the PQ as normal, and when it comes to writing the CD-R, open the "Read and Write 
PQ data" Window, and press the button next to "Non-Real-Time" so that it is not ticked (e.g. not non-
real-time). 

When you press WRITE the Playlist will start to playback as normal. The CD-R will start soon, but 
there will be a significant delay between play finishing and the CD-R write process finishing. Do not 
eject the disc until you're sure the CD-R write is complete. SADiE will continue playing for about 
twenty seconds after the end of the PQ list, but when SADiE automatically stops there will be up to 
about 4 minutes before the CD-R itself is completed. During this period it is recommended that you 
do not use SADiE to play/edit etc. If for instance, by playing back or scrubbing too many tracks you 
were to cause a DSP overload, the CD-R write would be spoiled. 

Wait for the CD-R write to finish, and at the end of writing, a message will pop-up "Winding Up 
Audio i/o - writing lead out" and then SADiE will report "PQ audio image file written successfully". 

NOTE: When you first enter the "Read and Write PQ data" window, a write speed will be 
recommended in the usual way. When you de-select non-real-time (e.g. select real-time) this 
setting is over-ridden. Of course, a real-time CD write will have to be at 1x, but you don't have to 
change that setting, as it will happen automatically. 

ROUTING HINTS FOR REAL-TIME CD WRITING 

As suggested above, one of the reasons you will want to use Real-Time CD-Writing is to allow you to use your 
external processors in-line during the write and hence avoid a time-consuming re-record process. 

Have a look at Chapter 6, which describes the mixer and particularly its routing methods. However here is a 
brief discussion on how to patch external equipment into the mixer. 

Due to the flexibility of SADiE's mixer routing, there are a number of different ways of setting the mixer for 
this purpose. This is just one example. 

This simple example uses 4 outputs and 2 inputs. You're using output 1&2 for monitoring (plus, it should be 
noted, the CD master is always made from Outputs 1&2). Outputs 3&4 will be used to send audio to the 
external equipment (for example an EQ unit and a compressor, as in this example you'll be putting the whole 
signal through the external equipment). Inputs 1&2 are used to patch the outputs of the external equipment 
back into SADiE. 

To produce a mixer like this, some un-needed strips have been delete, the master output (the right hand 
yellow fader) has been changed to be sent to Output 3&4, and a new stereo fader has been dragged onto the 
mixer. As it happens the default routing for a new stereo fader is from Input 1&2 to Output 1&2 so that does 
not need to change. 
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The routing here is: 

STREAMS 1-4  BUS 1&2  OUTPUT 3&4  EXTERNAL EQUIPMENT  INPUT 1&2  OUTPUT 1&2  
CD-R 

 
A variation on this might involve using a SADiE plug-in somewhere in the chain, for instance a Digital 
Limiter or perhaps UV22 or Dither. These particular processes would normally be placed right at 
the end of the chain. To add a digital limiter to the mixer above, open the PROCESS WINDOW, 
and drag a DIGITAL LIMITER onto the "rack". You'll want to route the return from the external 
equipment, through the Limiter and then on to Output 1&2 so that the result can be recorded to 
the CD-R. 

So, starting with the first mixer, now change the routing as per the picture below: the Input fader has its output 
routed to "DigiLim 1 In", the Limiter has its input set to this same "DigiLim 1 In" bus, and you should change its 
output to go direct to Output 1&2. 
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Now the routing is like this: 

STREAMS 1-4  BUS 1&2  OUTPUT 3&4  EXTERNAL EQUIPMENT  INPUT 1&2 DIGILIM 1 IN  
MASTERING LIMITER  OUTPUT 1&2  CD-R 

You will also have to consider your Audio Settings. If you are feeding the external equipment an analogue 
signal, then the normal "Automatic" clock settings with the Input source set to "Analogue" is fine. If you are 
feeding digitally to the external equipment then you will have to set up the clock source in a way that avoids a 
feedback loop. There are a number of ways of doing this. If you already have SADiE locked via a separate AES 
Genlock clock, then presumably you will also have the external equipment locked to the same AES clock. 
However if this is stand-alone, then it is best to set the Audio Input to "AES", and the Clock Source to 
"Internal". This way, SADiE is the master clock, and the external equipment should be set to clock to its input. 
If it is possible to set one of the external units to be Master clock, then you will need to change SADiE's clock 
source to be "Genlock to Input 1&2". 

HINT: If you're using the same kind of processing and mixer setups for most jobs, save the mixer as a 
template.  

ORANGE BOOK CDS 

In addition to Red Book disk-at-once CDs, SADiE can create Orange Book track-at-once CDs. 

Red Book CDs include the full PQ data (multiple ID's per track . ISRC codes, Mode 2 bar codes etc.), and 
these have to be written to the CD-R media in one go. Once the disc is burnt it is complete and no more 
tracks can be added. 

Orange Book CDs have reduced features: each track has essentially only a Track Start flag, but an advantage is 
that tracks can be added at different times. However, the disadvantage of Orange book discs is that a normal 
CD player will not play them, unless they have been "fixed up". When an Orange book disc is "fixed up", no 
more tracks can be added to it and it effectively becomes a finished Red Book disc. 

Before they are fixed up, there are some devices that will play them back. For instance you can buy Orange 
Book players and recorders. SADiE will play Orange Book discs with some CD-R drives. 

Recording Orange Book Tracks 

Playing Orange Book CDs  

RECORDING ORANGE BOOK TRACKS 

 
To add a track to an Orange Book disc is very simple. This is part of the normal Bounce procedure. 
Select an entry or group of entries and press the BOUNCE button. 

In the "Destination" section of the Bounce window, there is an option for CD-R. Ticking this box will first log 
the disk in the CD-R drive to check if it can be used for Orange Book tracks, and then it shows a new section 
on the bottom of the Bounce window, as in the diagram. 

This section shows information about the CD recorder and the disc, and allows you to change some settings 
for the track you are about to record: 
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 CD-R Test Mode - this sets the laser to low 
power and so SADiE will go through the 
motions of recording the track, without actually 
burning it to the disc. This is useful in case you 
want to check to see if the system is fast enough 
to write at the chosen speed. After using Test 
mode, some CD-recorders need to be powered 
down and up again to reset the laser to full 
power again. 

 CD-R (1) - in the diagram above shows you 
which device (1 in this case) you are using. 

 CD-R Speed - sets the speed for the recording. 
It is advisable to calculate whether your system 
is capable of the speed you've set before 
recording. CD-R's have to be recorded in a 
constant stream and so if SADiE cannot deliver 
the audio continuously at the set speed, the CD-
R recording will stop and the disc will be 
wasted. If for instance your SADiE hardware is a 
capable of playing approximately 8 tracks in real-
time, then it is unlikely to be able to achieve 
more than 2 tracks at 4x speed. Processing and 
crossfades will have an affect too. If in doubt, try 
"Test mode" first. 

 Fix Up CD - pressing this button will fix up the 
CD. You will not be able to add any more tracks 
to the CD after fixing it up, but you will be able 
to play it in a normal CD player. There are 
other places in SADiE to do this: in the 
"Read/Write PQ Data" window, available from 
the PQ toolbar, and also in Disc Manager. 

When you are ready to record the track, press START and the recording will proceed. Note that with 
"Source" set to anything other "Multi" will write just one track to the CD-R, but the "Multi" option will create a 
separate track for each entry in the EDL .  

PLAYING ORANGE BOOK CDS 

NOTE: You cannot log tracks off an orange book disc in a Yamaha CD-R 100 and therefore you will not 
be able to play the disc with SADiE, until it is fixed up. This is possible with a Yamaha CD-R 400 drive. 
You may not be able to log tracks created with another recorder. 

If the CD-R drive allows it, Orange book CD's can be logged in the usual way in either Disc Manager or from 
the PQ data window (available from the PQ toolbar). 

Logging the disc in Disc manager will show each track separately, and these can be imported into the project 
via the Clipstore, and then dragged into an EDL like a normal clip . 

If you are able to log the disc in the PQ data window (press READ) then the track start flags for each existing 
track on the disc will appear in the current EDL.  

MULTI SESSION CDS 

It is possible to create a CD-R disc with two sessions: one a normal Red Book CD Audio session, the other 
might contain data of another sort. A CD player only recognises the first session on a disc, and so will see this 
disk as an ordinary red book CD. A CD-ROM drive will see the data session, which could contain graphics, 
video or other data. 
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If you tick the "Multi Session" button in the "Read/Write PQ data" window before writing a CD-R, SADiE will 
write the red book session as normal using the PQ list, but on finishing this session, will leave the disc open for 
another session. 

 
Currently the second session will have to be written outside SADiE, but this does allow you to use the 
powerful PQ editing tools in SADiE for the CD Audio session, and then take the disc onto a different CD 
authoring system to write the data session. 

Multi session support is an optional feature; contact your dealer for details of how to obtain it.  

RADIO 

RADIO PROGRAMMES 

A few hints and tips for: 

EDL START TIME 

If you are not synchronising to timecode, it might seem logical to start the first Entry in your EDL at 00:00. 
However, this makes it more difficult to start playback from the beginning by using the mouse in the time bar, 
and it also prohibits the SLIP function from moving any Entries to the left. If you start the EDL at 00:01:00 or 
01:00:00, you will leave plenty of room to the left and can easily subtract one minute or one hour from the 
current-time display to get an idea of your running-time. You can do this at any time by moving all the Entries 
along, with SLIP on. 

USING CLIPSTORES AS YOU RECORD 

If you are using SADiE to assemble a programme from lots of material that is on another medium, and not in 
the correct order, it may be most convenient to dedicate a Clipstore to the programme, and work from that. 

Say you have a ¼" tape or DAT with many inserts, you can record them into your Playlist in one go, but use 
the razor-cut between each to create separate EDL Entries. Whilst recording continues, you can rename each 
with a name relevant to the material (right-click over the Entry in the Playlist), then select it and save it to the 
Clipstore. 

Then, rather than re-ordering the Entries in the EDL that has just been created, open a new Playlist, pull Clips 
out of the Clipstore and paste them into it in the required order. Have "Autoplace Butt" on and they will butt 
up together as you drop them in, and you can use Playlist Editing to fix each join later. 

PICKING THE GOOD BITS 

You didn't mean to, but it happened again: you came back to the office with two hours' worth of material on 
tape and the interview needs to be six minutes maximum! 
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Record it all into SADiE, whilst having a listen and getting an idea of where the good bits are. Then, with the 
whole interview on Stream 1, 1&2, or whatever, you can scrub-and-cut to identify the rough bits you want to 
use. Rather than remove the rest, drag out the bits you like and paste them onto the next empty Stream(s). 
Have "Autoplace butt" on and they will join up together. 

You can now keep referring backwards and forwards between what you're picking and what you're leaving 
behind. Use the Solo buttons on the Streams to choose which you are listening to. 

LIVE COMPILING 

You can make a very good approximation to the old way of recording a programme of pre-recorded inserts 
linked by a live presenter: 

 Have all your inserts ready topped and tailed in a Clipstore. If you put a number in front of their 
name, they will be listed in the correct order for the programme. Enable Autoplace-at-current time 
and have Autotake on in the Transport Controls. 

 Decide which Stream(s) you are going to use for inserts, and which for the presenter(s). 

 If the programme starts with an insert, paste it into the Playlist. 

 Record-enable the presenter Stream, and play the first insert. Drop into record (by pressing the 
record button) just before it ends, and the presenter can pick up straight away with their link. 

 While they are reading the link, pull the next insert out of the Clipstore, (if using a mouse, have it 
hovering over the correct Stream, with your finger still on the button) and paste it in on cue. 
Autoplace will position it for you. As SADiE is playing an EDL that doesn't know the Clip is there yet 
and you won't hear it immediately, so 

 Stop playback, and re-start from just before the new insert (with the mouse you can do this in one go, 
by double-clicking in the time bar). 

 You are now ready to drop into record at the next link, and repeat the above. 

 After recording, the whole programme is in order, with the joins between links and inserts very likely 
to need no more attention. You can go through checking them and editing any presenter fluffs. 

The great advantage of this is that the Presenter can hear and respond to each insert, and you get the flow of 
the programme. The slight delay (four or five seconds, tops) that everyone hears between each link and the 
following insert should not be much of a problem. 

ROCK-AND-ROLL RETAKES 

It is easy to record this way with SADiE: 

If the artist fluffs, stop recording but keep the voice-over Stream(s) record-enabled. You can play back their last 
few words and drop in by hitting the record button on the fly. 

If the drop-in doesn't sound too good, don't worry, as you haven't lost any of the previous take! The join 
between the two Playlist entries at the drop-in point is an edit that can be adjusted like any other. The previous 
take is there for bits of it to be pulled back in.  

AES31 INTERCHANGE 

THE AES31 UNIVERSAL INTERCHANGE FORMAT 

AES31 is the new standard for network and file interchange of digital audio, designed and specified over a 
period over 4 years by the AES Standards Body. The goal of the standard is to reintroduce to the professional 
audio industry the concept of universal interchange. A universal format for interchanging audio has not been 
present since the days of analogue tape. 

AES31 defines source material alongside edited audio (including cross fades) and is text-based in the manner of 
a traditional EDL . which makes it easily readable and correctable if circumstances require it. The format is 
sample-accurate and supports Multichannel files in excess of 99 channels, as well as interchange between PAL 
and NTSC formats and frame rates. The format (crucial parts of which have already been ratified as an 
international standard) is open and non-proprietary and thus not exclusive to any single manufacturer. It was 
designed to be as simple as possible to implement to reduce development time, and allow access for all. 
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AES31 consists of four parts: 

1. Disk Format 

2. File Format 

3. An edit list for the files residing on the disks, known as the Audio Decision List (ADL) 

4. An Object Orientated Interchange (as yet undefined) 

AES31-1 specifies a disk format that is fully compatible with FAT32, allowing physical interchange on a disk. 
This format was chosen because, since its introduction in Windows 95B, it has been well received, and has 
been adopted by many DAW's and other digital recording equipment. More importantly, the majority of other 
operating systems can also read and write to it. It is one of the simplest disk formats for programmers to 
implement, which allows disks larger than 2GB to be addressed. 

 

AES31-2 specifies the file format as the EBU's Broadcast Wave 
File (BWF). This is a WAV/RIFF1 file with a SMPTE/EBU timecode 
stamp contained within the header. The main benefit of building 
on the WAV format is its universality across computers, DAW's, 
etc. Every RIFF file (and hence the WAV/BWF) is made up of 
"chunks" of information, which can be utilised or discarded 
depending on the capabilities of the receiving equipment. 

Every RIFF file MUST contain a [fmt] chunk and a [data] chunk. 
This is the bare minimum that a piece of receiving equipment will 
need to open and read the file. The number that immediately 
follows the chunk header will define the number of bytes in that 
particular chunk. In the case of audio WAV files, the [fmt] chunk 
contains the sample rate, bit depth, frame rate, etc. The [data] 
chunk contains the audio PCM data. There can then be additional 
chunks containing extra information (marked [chk1] and [chk2] in 
the example). If the receiving equipment knows how to read and 
interpret the data in a particular chunk it will do so. If the 
equipment doesn't recognise the chunk header it simply skips the 
relevant number of bytes until it reaches the next chunk 
header.  In this way, new chunks can be added to the file format 
without breaking older equipment that does not understand the 
newer sections.  

A Broadcast Wave File contains a chunk labelled [bext] (Broadcast Audio Extension). This contains the 
Originator Reference, a 32 character ASCII string containing a non-ambiguous reference allocated by the 
originating organisation. This ensures references to a BWF file will always be correctly matched. It also, most 
vitally, contains a SMPTE/EBU timecode stamp, as well as other information such as copyright and recording 
history. 

As the file is made up of chunks, simple music programs like Media Player and QuickTime can simply ignore the 
[bext] chunk, and search for the next readable header. This means that the BWF can contain useful and 
important information that more versatile equipment/software can interpret, whilst still maintaining 
compatibility with all WAV capable equipment. It is important to note that MONO Broadcast WAV's are the 
norm with AES31, as there is no useful consensus on the use of stereo or Multichannel Broadcast WAV's.  

AES31-3 was the first section to be published in 1999 and describes the Audio Decision List or ADL. This was 
the hardest part and took the longest to define. Video and audio editors had become accustomed to the 
"human readability" of traditional CMX and Sony edit lists, using a simple word processor to modify them or to 
identify problems. The AES31 ADL is written in XML (similar to the HTML language commonly used on the 
Internet), and is readable in any word processor on any platform. The ADL is also chunk based (allowing for 
future expansion and functionality), and uses XML style tags to specify a number of sections. The <VERSION>, 
<PROJECT>, <SYSTEM>, and <SEQUENCE> sections specify general information about the ADL and where it 
has come from. The <SOURCE_INDEX> section describes the source material (i.e. audio files) that the ADL 
requires, whilst the <EVENT_LIST> section describes the individual ADL entries.  The ADL is sample-accurate 
(unlike CMX/Sony lists which are only frame-accurate) and has provisions for video pull-up and pull-down 
rates. Having experienced practical implementations of this format, the specification has been reviewed to 
further define and clarify it. 
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From the outset, this specification has been designed to be very simple, built wherever possible on existing 
standards and traditional working methods.  This simplicity tends to make the standard more robust. However, 
it also dictates that certain practices must be followed or the simple mechanism will not be able to cope with 
the errors introduced. An example of this fragility would be an ADL's "path" to the audio; if audio source files 
are moved, or placed in a different location, you could end up with a blank non-playing audio event. Once made 
in one machine, the audio and ADL files should not be moved within that machine, (i.e. moving the files into 
another folder, renaming the drive, changing drive letters, etc) without exporting and subsequently re-
importing the project.  The files are linked to their locations when the ADL is created and moving them 
outside the normal structure might un-link them.  

A useful mechanism for repairing links is the 32-character BWF "Originator Reference" (mentioned above), 
which is now implemented by several manufacturers. This is a unique sequence of ASCII characters that 
is automatically stamped onto the BWF file at creation time and is referenced alongside each source track 
entry specified in the<SOURCE_INDEX> section of the ADL. By using this information the reading application 
can ensure that tracks are reliably identified and correctly matched with individual ADL entries. 

Efforts to establish an AES31 Trade Association, to promote its adoption by manufacturers and provide an 
information exchange forum for the audio community at large, have proven to be over optimistic. However, 
with multiple manufacturers already on board2 the testing and interoperability issues are being quickly resolved. 
SADiE, amongst others, are testing as many other manufacturer's files as possible to ensure compatibility issues 
will be stamped out more quickly than relying on a single company's proprietary format.  

The specification may well be revised and amended, and like all international standards will be subject to review 
after 5 years. However it will evolve with all manufacturers on-board, and will not be reliant on a single 
company's proprietary "interchange" format. Additional sections (chunks) may even be added as supplements 
rather than as extensions or amendments, to ensure that all manufacturers are equally able to implement the 
standard. One future addition may well be to include edit automation, including gain, mute, and pan 
information. However, defining the specification for the transfer of this information will take a significant period 
of time. 

One final word of caution to customers: make sure that the manufacturer who offers AES31 compatibility has 
truly implemented the specification. A few companies have merely implemented Broadcast Wave Files and yet 
claim full AES31 compliance. Though this would enable you to import the audio from these manufacturers' 
machines, you will NOT have a compatible edit list, which is where the real benefits lay in terms of reducing 
workload.  

FURTHER REFERENCES: 

AES Standards Publications – Only Part 1 and Part 3 are currently published as ratified standards. These are 
available for download in PDF format from:  

http://www.aes.org/standards/reports/AES-STANDARDS-IN-PRINT.html  

 AESSC, 2001: " AES standard for network and file transfer of audio - Audio-file transfer and exchange 
- Part 1: Disk format", AES31-1-2001  

 AESSC, 1999: "AES standard for network and file transfer of audio - Audio-file transfer and exchange - 
Part 3: Simple project interchange", AES31-3-1999 

The current status for the remainder of the project is posted at: 

http://www.aes.org/standards/policies/PROJECT-STATUS.html 

 

EBU BWF Specification - These are available for download in PDF format from:  

http://www.ebu.ch/tech_t3285_v1.html 

 EBU, 2001: "BWF - a format for audio data files in broadcasting", Tech 3285 
1 RIFF stands for "Resource Interchange File Format" as originally specified by Electronic Arts, and now wholeheartedly adopted by 
Microsoft and others as the most popular extensible file format. 

2 The following companies have so far announced AES31 compliant products: SADiE, DAR, Akai, Euphonix, Tascam, Timeline, Steinberg, 
Fairlight, AVTransfer, Merging Technologies, Genex, Zaxcom DEVA, HHB Portadrive, iZ-Technologies RADAR, Digigram, Waveframe, 
Audio-CUBE, Nagra, Sek'd.  



SADiE v5.4 PCM Manual 

318 

USING AES31 WITH SADIE 

SADiE has capabilities for importing audio and AES31 ADL's (Audio Decision Lists). You will need to have an 
AES31 project, including an ADL and it's associated audio files, on a Windows compatible disk. Insert the disk 
into the SADiE machine. Switch on the PC and open SADiE. Cancel the Project dialogue that pops up. Set the 
sample rate and frame rate in the Setup Window to match the AES31 audio you'll be working on. If the sample 
rate is wrong, the conversion to SADiE will also be wrong. (If it is wrong, you can easily change it and run the 
conversion again.) 

Open SADiE and open the project into which you wish to import the AES31 file (or create a new one). Go to 
the Project window, select "Miscellaneous" then "Import Component".  

 
A conversion dialogue will appear. A file selection dialogue will appear.  

 
Select the relevant ".adl" file, and click "Open". SADiE will then convert the ADL, create a new Playlist (with 
the same name) within your Project, and will open it. The relevant audio will be imported in to your Clipstore 
and the profiles will slowly fill in. Once the "Profiles" have filled in with the foreign audio, you should be able to 
work in the normal way. 
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TROUBLESHOOTING AES31 

1. No clips filled in once the project is in SADiE 

Open the Clipstore and check that it contains the audio files for the project. Open the Text EDL . and 
check the PATH column, to see where the EDL is expecting the audio to be. 

If the Clipstore is empty it's likely that the path specified in the ADL is not the same as the path to the 
audio on the drive. This could be due to anomalies in the AVTransfer setup. However a more likely 
reason is that the files have been moved after they have been converted in AVTransfer. As the paths 
in AES31 are absolute, the ADL will no longer be able to find the audio files, as it will be expecting 
them in the original location. Either way, if you open the Clipstore, right click on the Source Tracks 
folder and select "Import Source Tracks". Navigate to the Project directory and select all of the audio 
files. When the audio files have been imported the clips should fill in automatically. 

2. Most clips are filled but a few are not 

There are two possible reasons for this: 

i. Incorrect Sample Rate – If the sample rate is incorrect, many clips may not fill in, as the audio 
files will appear to short by calculation at the wrong sample rate. If so, close the project, 
change the sample rate in the Setup Window, and repeat the AES31 Import. 

ii. Lack of Handles – SADiE clips always have a default crossfade applied to their beginning and 
end. In order to avoid a "dip" in the middle of a "cut" edit (one with no crossfade) SADiE 
extends every "cut" clip by half the default crossfade length at each end. Thus the true edit 
point is halfway through a fade. The value used for the crossfade length of a cut under AES31 
is 1000 samples (linear). Note this only applies to "cut" edits, if a fade has been specified in 
the AES31 ADL then that is what will be used. 

In the majority of cases, this procedure will be fine. The audio was created with handles, and so 
extending the clip minutely will work. However, if an entry from the Avid was used in its entirety (and 
includes all available samples), SADiE will be extending the clip to include samples that do not (never 
did) exist in the source file. Therefore the clip will remain ghosted, as the total audio required to 
satisfy the clip does not exist. 



SADiE v5.4 PCM Manual 

320 

To solve this problem, you will need to identify which clips have not been filled in. The navigator 
window is of some help here, as the ghost clips will appear grey (although very small clips will be 
difficult to make out). The "Material Present" column in the Text EDL can also be useful, as you will be 
able to identify the odd "No" if you scroll down the list. 

Having identified the ghost clips, a quick fix is to scissor cut very close to the beginning and end of the 
clip, right-click on the centre section, and select "Find new track ". The main clip should fill in, and you 
can delete the slivers at either end. You can then use the Playlist Edit function to stretch the clip back 
out again to its maximum length. 

3. If in doubt… 

If there is still an empty clip that cannot be filled, you will need to check whether the audio exists: 

i. Check the "Path" column in the Text EDL to verify the project is looking for the audio in the 
correct location 

ii. Check the Clipstore for a clip with the correct name (it may have had the last two digits 
converted to a SADiE take number, but this is ok). 

iii. Check the source times – double click the ghost clip in the EDL and view the Source In and 
Out times that appear in the Clip Details dialogue. Then inspect the track Start and End times 
in the Clipstore and check that the Source times fall within the Start and End times. If they 
don't then there has been a problem with the transfer. It could be that the audio file has lost 
its time stamp, or that it is a WAV file, not a BWF and so has no time stamp (this shouldn't 
happen but it's best to check).  Either way check the whole process has been run correctly 
according to these instructions. 

OMF INTERCHANGE USING AVTRANSFER AND AES31 

OMF INTERCHANGE WITH SADIE 

AVTransfer is a software product designed to run on a PC, and can convert audio files and EDL information to 
a number of different formats. The current version can import and export OMF, AES31, OpenTL, discreet edit, 
Fairlight ML4 and DSP Media. Please check the AVTransfer web site for any additions. This software can be 
used in conjunction with SADiE's own AES31 capabilities to provide import from and export to the file types 
listed above for interchange with many other workstations. 

This document seeks to explain how an OMF project can be taken from an Avid system, converted through 
the AVTransfer software on a PC to AES31 format, then transferred to SADiE and converted to SADiE's native 
format for playback and editing. 

There are three main elements in this interchange: 

1. Disc Drive 

2. Audio Files 

3. Edit List 

AVTransfer operates directly on the host PC on which it is installed, using host-mounted drives. For ease of 
manoeuvrability, removable drives are recommended for this purpose. The drive will need to be readable by 
SADiE and the PC, and will need to compliant with AES31. Therefore it should be formatted FAT32, supported 
by SADiE v5, and Windows 2000.  

The way in which the original OMF Project is presented to AVTransfer for conversion needs to be considered. 
This could be a disc drive or a Jaz disc, in which case the appropriate device will be necessary on the PC to 
accept these. An OMF project may be presented on a Mac formatted drive (depending on the operating system 
used on the Avid). In this case software will be necessary on the PC to enable mounting of Mac disks. 
Macopener from DataViz Inc. is recommended, but there are number of utilities available. 

Finally, if the PC running AVTransfer and the Avid are on a network, and can both see the same drive, 
AVTransfer will be able to convert the OMF file directly across the network without the need for removable 
media.  

There are many ways in which this transfer and conversion can happen. The sequence below details only one 
possible iteration, but is efficient and simple. 
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OMF EXPORT 

OMF compositions can be created in a number of different styles. However, the most convenient, and most 
suited for conversion is the Embedded or "Bento". The OMF composition will consist of a single large file, 
normally hundreds of MB's in size, which wraps all edit information along with all the necessary audio in to one 
file. 

The "Consolidate" process is recommended before export. This reduces the audio wrapped in to the OMF to 
only the elements required. This means that if an hour long recording has only one 10 second element used 
anywhere in the project . only that 10 seconds of audio will be transferred. However, it is important to apply 
"handles" to the audio when consolidating (2 seconds is usually ok).  

Video files are unnecessary so choose the "Audio Only" option when exporting. OMF can usually be exported 
as Version 1 or Version 2. AVTransfer supports both versions. However, v2 is more complex, and includes 
functions not relevant or supported by SADiE, so choose v1.  

AVTRANSFER 

The AVTransfer software can be downloaded from the AVTransfer web site. The free download is a demo 
version. This has full functionality but it places periodic "bleeps" in the audio files upon conversion. However it 
is quite adequate for test purposes. 

In this example, the single large OMF file from the stage above will be converted to AES31 format. AES31 
consists of: 

 Audio Decision List (ADL) – this is an edit list in a simple, human readable format. This file can be 
opened and viewed in a normal text editor. The important sections are: 

o <source_index> - This gives a list files used in the project . Each of these will include an index 
number called the Originator Reference, which is referred to by the… 

o <event_list> - This is the edit description; a list of edit events (referring to a source 
Originator Reference), which describes the Source In time, and Edit In and Out times, along 
with channel numbers, fade lengths and shapes, clip levels, etc. 

 Audio files – These should be in Broadcast Wave (BWF) format. These chunk-based files are much the 
same as WAV files, but include an extra Broadcast Extension chunk carrying extra information, most 
importantly a timecode stamp. However due to the chunk basis of the file, this file can still be read and 
played by all WAV capable equipment. 

The original OMF file is unaffected by the conversion process, and remains intact. The AES31 is a copy, and 
hence will require its own similar disk space. 

Mount the OMF Media on the PC. Also mount the drive that is going to hold the AES31 files. The total storage 
space for the AES31 will be similar to the size of the OMF file.  If you wish to output the AES31 to the 
removable media holding the OMF file, but there is insufficient space, move the OMF on to the host PC's hard 
drive before conversion, freeing up space for the AES31. 

NOTE: Hard drives in removable cradles are not registered by Windows as removable devices and thus 
should only be inserted and removed when the PC is shut down. SADiE has it's own mechanism for 
swapping removable drives whilst powered on, but this does NOT apply to the host PC. 

Switch on the PC if you haven't already. Open AVTransfer, and at the first page select "Open OMF Project".  
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Use the browser to navigate to the location of your OMF file, and select it by double clicking. 

 
AVTransfer will open a dialogue box, offering you options for "Import Filter" and "Audio Data Mode". Select 
"Smart" and "Embedded Audio – all audio is in one file". Press "OK" and AVTransfer will proceed to unwrap 
the OMF file.  

 
AVTransfer may ask if you want to "render dissolves". SADiE can work with "virtual fades" rather than having 
to have them rendered first, so say "No". The next dialogue that appears will show the composition (edit list). 
There may be a number of these compositions, but only one will be the major composition, so select it by 
clicking on it and highlighting the line. (The dialogue also shows audio data and "master mobs". Ignore this for 
now.) In the "Export Project as", click the "AES31" button.  
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Choose the destination for the AES31. 

 
The ADL will be placed in the directory you select or create, and the audio will be placed in a separate sub-
directory called "AES Audio". Do not use the root directory for your ADL file. You can choose it but will 
receive an error when conversion begins, due to the restrictions on root directories. Before the conversion 
takes place you will be asked some further questions.  

 
Choose: 

 Copy All Files (recommended) 

 .WAV for the Broadcast WAV extension 

 DO NOT TICK "Include rendered Cross Fades" 
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The conversion will continue and you will see a progress metre, the speed of which will depend on your PC 
specification. On average a 500MB file on a Pentium 3 PC, takes approximately 3-4 minutes. When the 
conversion is finished, exit AVTransfer. 

NOTE: As you may have noticed, AVTransfer does not need to be running on the same PC as SADiE, 
and there may be reasons for putting it on a different PC, or for keeping it on the SADiE PC. However, 
AVTransfer is registered to one PC, and so cannot be moved once registered. 

You will now need to import the AES31 ADL and audio in to SADiE. See "Using AES31 with SADiE" for details 
on this process. 

IN SHORT 

 Create an embedded style OMF on removable media. 

 Move the drive to the AVTransfer PC. 

 Open AVTransfer. 

 Import the OMF. 

 Export as an AES31. Try not to move or copy the files after AES31 conversion, as paths will be 
broken. 

 Convert the AES31 ADL in SADiE. 

 Check it's completed. 

This process can also be reversed in order to export from SADiE to OMF via AVTransfer. 

AAF INTERCHANGE 
The Advanced Authoring Format (AAF) is a multimedia file format that enables content creators to easily 
exchange digital media and metadata across platforms, and between systems and applications. 

http://ww.aafassociation.org is a good resource for information about AAF and includes FAQ's, technical 
information, and lists of AAF members. As of November 2003. AAF import and export is available on many 
other products including Digidesign ProTools v6.1, Avid Xpress, Media Composer, Symphony and other Avid 
platforms, Adobe Premiere Pro, and all GenerationQ Quantel products. 

AAF import and export is now available as an option for SADiE v5 software. The information herein is correct 
as of November 2003 

WHAT IS AN AAF? 

An AAF can contain: 

 Edit information – often known as the "composition" or "sequence" in other systems; SADiE users will 
usually refer to this as an "EDL". The edit information contained in the AAF will usually be source and 
EDL times for the entries, and it may also include fades, fade shapes, clip levels, and level automation 
data. There is the possibility of other types of data. 

 Video files – SADiE cannot currently import video entries or video files. However, if a video stream is 
being displayed, then video entries found in an AAF will be shown as "ghost" clips along with their 
source times for reference. 

 Audio files – these will be in AIFC or WAV format. SADiE can currently only support AIFC or WAV 
files at our standard sample and bit rates. 

The AAF Project can be presented in two ways: 

1. "linked" or "external" media – where the composition is a *.aaf file, but the audio and/or video files are 
separate files. 

2. "embedded" media files – where everything is wrapped up in one big *.aaf file.  
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Both methods have advantages. With external files, there may not be a requirement to convert files and to 
package them and thus the process of export and import will be quicker. On the other hand, external files may 
be scattered across a number of drive locations, and thus the process of embedding the media into the AAF 
will collect everything neatly in one place; there's a lot less chance of something going missing with an 
embedded file. On importing an embedded file, it's easy to find the media files because SADiE has unwrapped it 
from the large embedded file and so will know exactly where they are. With an AAF with external files, during 
the transfer from one machine to another, it's quite likely that the files will have changed directory or disc 
drive name and thus some searching may be required. 

With modern processor and disk drive performances, the act of embedding may not take such a significant 
extra time and it may be worthwhile for the added benefit of being more certain that your media is not missing 
crucial elements. 

An exporting application may have options for exporting in either fashion, and it may also allow you to 
"consolidate" the media files before exporting. Consolidating is a process where if parts of a media file are not 
used in the composition/EDL then new shorter media files are made and linked to the entries in place of the 
larger file. Thus the AAF can be smaller in terms of data size. SADiE does not currently consolidate audio files. 

IMPORTING AN AAF IN TO SADIE 

The process is the same as importing any EDL into your project. The AAF to SADiE conversion, along with any 
unwrapping of files from an embedded AAF will happen automatically. 

You have a project open. This may be work in progress or perhaps you have just made a new project into 
which you wish to import the AAF. 

1. Select the "Project" menu on the top menu bar.  

2. From this list, select "Import Component". 

3. Now browse to the directory where the AAF file is located. 

4. On selecting the AAF file, the "EDL Conversion" dialogue will pop up, with "AAF" pre-selected on the 
left hand side, as the file type. Pressing "OK" will start the conversion. 

5. You will see some progress bars. The length of time taken will depend on the size of the project and 
also if it's an "embedded" or "external media" type AAF. An embedded file will take longer to unpack. 

6. The converted EDL will open; it will have the same name as the original AAF file (but this is a new file 
with an .EDL extension now). You will see the clips' profiles drawing on the screen; SADIE may take a 
short while to create these profiles. It's a bad idea to exit SADiE during this period as you may end up 
with half-cooked profiles. 

7. If this is an external-media AAF, it is possible that SADIE won't automatically find the external files and 
the clips in the EDL will be drawn in outline only as a "ghost" clip. Usually the reason for this is that 
the files are no longer in the same directory as they were when they were exported. If this is the case, 
in Disk Manager (or else using the "Import Source Tracks" function inside the Clipstore), find the 
directory where the audio files belonging to this AAF file are placed, and import all the files into your 
project's Clipstore. Disk Manager has a right-click option to "Import into Clipstore". This can be used 
on multiple clips or just by right-clicking on a directory name to import the whole directory if 
required. 

When all the clips are imported into the Project, the EDL will be able to link to the audio files, and as 
above, the profile drawing will start. 

EXPORTING AN AAF FROM SADIE 

The AAF section of the EDL Conversion page in the Setup Window has some options for exporting (note 
there are no options for import). You can choose to: 

 Export Audio – embedded in AAF or external audio files. As explained above, when you choose 
embedded, the audio and the edit data are packaged up into one big file, whereas external makes the 
AAF export in many files – one file for the edit list (the *.AAF file) plus many audio files.  
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 Consolidate source tracks – WAV or AIFC chooses the format that your audio files will be converted 
to during the export. Sample and bit rates of the original files are retained (this means 32 bit source 
files are not allowed). The term "consolidate" is perhaps a little confusing; currently (v5.2.1 Nov 2003) 
source audio files are copied and converted exactly as they are, with no possibility of reducing the 
amount of data to exclude audio that's not in use. 

 Export clip level as - Varying fader-level automation, Fixed Clip gain, or None. SADiE has two ways of 
applying level to clips, either as moving fader information or as clip levels (as applied in the Clip Details 
Window). Currently (v5.2.1 Nov 2003) SADiE can only export one of these two sets of data. This 
option chooses which is included in the export.  

Your choice of any of these options may be determined by the capabilities of the application that is going to be 
receiving the AAF file.  

The procedure for exporting to AAF is therefore: 

1. Choose the exporting options above. 

2. Open and select the EDL that you wish to export. 

3. From the "File" menu select "Convert". 

4. This will display the Convert dialogue, with a list of possible formats on two sides – "Input" and 
"Output" format. 

5. On the left side of this dialogue select "From Playlist" and on the right select "AAF". Then press the 
"Select Output File" button, browse for a location that you want to export to, give the AAF file a 
name, and press "OK".  

External audio files (if that's your choice) will be created in the same directory as the AAF file. Thus 
duplicate file names are not allowed for an external file export, although they are allowed in an 
embedded file. 

6. The process will continue, with some progress bars to inform you how it's going. 

IMPORTING AND EXPORTING OMF FILES USING AAF 

SADiE's AAF converter can also support OMF files, both external media and embedded files. When exporting 
OMF, the AAF setup options will apply (thus for instance the choice of embedded or external will be that same 
as your setting for AAF). 

When handling OMF files, SADiE's AAF converter will convert an OMF to AAF first and then import, (or 
conversely, for export we convert to AAF, followed by an AAF to OMF stage). This all happens internally, but 
will explain why an OMF may take a little longer. 

It has been noted that this OMF converter will work with standard OMF files, but there could be some 
complex non-standard files that will fail.  

PRO TOOLS 5.0 INTERCHANGE 
This optional software plug-in allows import and export of sessions and audio files to and from Pro Tools v5.0 
format. 

There are two options for Import and Export to Pro Tools Session in the File Menu  

You will require MacDrive and our extension map customisation – the interchange can only work with Mac 
format sessions and SD2 audio files.  

For interchange with Pro Tools versions higher than 5.0, the Pro Tools system itself will be able to import and 
export to v5.0 session format. PC Pro Tools systems cannot provide Mac format sessions, and so cannot 
interchange using this method, although with modern systems, AAF can provide an interchange method. 

As part of the Export to Protools function, all audio files used by the source EDL will be copied and format 
converted to SD2 (if necessary) into a directory called “Audio Files”. This is what is required at the Protools 
end, and avoids the need for any further format conversion. 
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NOTE that all the “Mac files on Mac Disk Drive” rules apply – ideally when exporting you should export to a 
Mac HFS drive that the ProTools can read. You can’t export to FAT32 drives, because they cannot hold the 
resource forks for the Mac files (the Pro Tools session does rely on having the resource fork). You can export 
to NTFS drives, but the Mac won’t read NTFS drives, so it will have to be copied to a Mac drive at some point.  

If you are transferring the files via CD-ROM, then only a Mac CD-ROM can hold the resource forks, and so if 
you are burning the CD from the PC, it will lose the resource fork – either use Macbinary to pack the 
resource fork in with the file for transfer on PC CD-ROM; or else pack all the files using Aladdin's Stuffit 
Compression tool .. there's more explanation in the “Mac files on Mac Disk Drive” section. 
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VIDEO 
There is an optional Plugin for Video in SADiE Version 5, which adds video recording and playback capabilities 
to a SADiE system. When installed, and enabled in the Setup Window, the software adds a video stream at the 
top of the EDL, which can contain video Entries. The video entries are fully integrated into SADiE and can be 
manipulated in similar ways to ordinary audio entries: drag-and-drop, razor, copy/cut and paste, Autoplace, Slip 
etc, and some editing functions operate exactly the same. The video Entries are coloured magenta to 
distinguish them from audio entries, and you'll notice that video Clips appear in the Clipstore and Disk 
Management with a  "film" icon. 

 

AUDIO VIDEO INTERLEAVED (AVI) FILES 

SADiE's Video Plugin utilises the Audio Video Interleave (AVI) format for playback and recording of video. 

Audio Video Interleave (AVI) is a special type of Resource Interchange File Format (RIFF), as defined by 
Microsoft. The ".AVI" file format is the most common format for an audio and video file on a Windows PC. 
AVI files can contain any resolution of video, and most frame rates are available (however, SADiE will only be 
able to accept standard frame rates). 

Audio content and/or video content is compressed with a specific codec and is then stored in an AVI file as 
interleaved data. There are a wide variety of codecs available. Once created, these files can then be played in 
Windows Media Player on any computer, as long as the appropriate codec is installed and available. Video 
recorded by SADiE will be stored in DV format. 

SADiE will not necessarily be able to play back all AVI files. The AVI will have to be at a frame rate compatible 
with SADiE's capabilities (24fps, 25fps, 29.97fps drop or non drop, or 30fps). The codec will also have to be 
present for play back. If you are unsure if the codec is present, try playing the AVI file in Media Player first of 
all. If the codec is not present Media Player will attempt to download an appropriate one. If this fails, you may 
have to ascertain which programme the AVI was created with, and install it. If the AVI file will play in Media 
Player, generally it will play in SADiE, provided it is at a supported frame rate. 

No extra hardware is required to play back preexisting video in AVI format, but recording from an external 
source will require a DV compatible device. DV (short for Digital Video) is a digital standard for video created 
by a consortium of vendors, which uses Motion JPEG video at 720x480 resolution, at 29.97 frames per second, 
or 720x576 resolution at 25 frames per second, and is stored at a rate of 2.5MB per second. As standard, it is 
transmitted to the computer via an IEEE1394 (FireWire) connection. 
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PREPARING THE PLAYLIST 

To use Video in SADiE it must be enabled. If this is the first time you've used Video then it may not be enabled 
for your Playlist. Take a look at the top of the Playlist, just above the topmost stream; there will be a thin bar 
labelled "Audio Unit A". If Video Editing is enabled there will be another thin bar above this labelled "Video 
Unit". 

 
If Video is not enabled you must first enable Video features. This is done with the check button "Create Video 
Stream in Playlist" at the top of the "Video" section of the Setup window (found under the View menu). You 
can also tick "Auto Open Video Window in Projects" if you wish every Video Project to open the window 
automatically. Having enabled Video, every subsequent EDL will be created including the Video stream. 

VIDEO IN SADIE 

AVI Video files to be used for playback in SADiE should be placed on a dedicated video drive, in much the same 
way as your audio files will be. The video files could be placed on the same drive as your audio data, but this 
will result in a loss of performance, as the data rate for video is much higher. For best results, store on a 
separate drive. 

Once on the drive, the clips are brought in to a Project's Clipstore in the same way as audio clips, etc. See the 
Track Management section for more details. Once associated with your Project, the clips can then be dragged 
in to the EDL in the same way as audio. 

Video entries in the EDL are treated in much the same way as audio entries. All of these functions are exactly 
the same: CUT, COPY, PASTE, RAZOR, SCISSORS, GLUE, REMOVE GAP, COPY TO 
CLIPSTORE, LOCK, all AUTOPLACE and SLIP functions, GROUP and UNGROUP, UNDO, and 
REDO. 

Video entries are saved as part of the EDL; they are just another EDL entry, and can be viewed as entries in 
the Text EDL. 

Scrubbing the EDL works in the same way, and most importantly of course, the video clips scrub in sync with 
the audio clips. 

You cannot use the Playlist Editing mode, they can't be edited in Trim windows, and you can't bounce video 
Clips. However, you can still use Region Editing, and Quick Edit. 

It is possible to make edits in the video stream, using the razor and scissors tools. There are a few basic areas 
where Video editing differs from normal audio editing. 

1. There is only a single channel of video, and so there are no fades. 

2. All edits are made at frame boundaries. 

3. Dragging and dropping a video entry to a new position in the EDL will replace any existing video 
entries in the new area, shortening them to make room for the new clip. 

4. The Playlist will take the resolution from the 1st clip in the EDL, so any further clips at different 
resolutions will be re-sized to match. This may result in reduced video quality. 

5. There are three additional editing tools, that are made available by right-mouse clicking on a video 
entry: 

i. "Extend entry start to fill gap" and "Extend entry end to fill gap" - these two options keep the 
video entry locked in time, and if more video is available in the video track that this entry is 
cut from, these will lengthen it forwards or backwards to meet a preceding or following 
entry. In other words fill the holes in the EDL. 
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ii. "Move nearest cut to current time" - you would use this if you have an edit between two 
video entries, that are in sync, but the edit point is not at the right position. Move the current 
time to a new position, and once again, only if the excess video exists in the recorded video 
tracks, this option will move the edit point to be at the new position. 

These three options are greyed out if SADiE detects that it is not possible to do that action, if for example, 
there is not enough spare video to move the entry start or end. 

THE VIDEO WINDOW 

 
Playback of the Video Clips is displayed in a dedicated Video Window on screen. This is accessed from "View", 
"Video Window". This can be resized freely, and placed anywhere on the screen. There are tools to help you 
set the Window size correctly for your Video: 

 
The first button, "Stretch to Fit" will resize the video playback as you resize 
the Video Window. However, irregular sizes can cause artifacts. A better 
option is to use one of the preset zooms, 50%, 100%, or 200% to get a more 
accurate picture. 

 
The "Source Aspect Ratio" Lock button will lock the aspect ratio of the clip to 
the aspect ratio of the original source file. Alternatively you can use the aspect 
ratio buttons of 4:3 or 16:9. 

GRAPHICS CARDS AND EXTERNAL MONITORING 

Playback of Video Clips in SADiE utilises the "Hardware Overlay" capabilities of your graphics card, and this 
function will need to be switched on in the graphics card setup. This overlays the Video stream on to the 
normal screen display from a special separate memory. 

Any graphics card with Hardware Overlay functionality can be used to display the Video Window. If you wish 
to run two VGA monitors you will need a card with dual VGA outputs. Note that to display the Video 
Window on the second screen you will need to select the VMR9 option in the Setup Window. 

If you wish to view the Video Window on an external monitor you will require a card with a composite video 
output. Simply connect the Composite Output of the card to the Composite Video Monitor. Hardware 
Overlay will replicate the Video Window on an external composite video monitor. However, the Video 
Window must be present on the VGA monitor for Video to appear on an external monitor. The physical size 
of the window in SADiE itself is non-consequential, but the zoom level and aspect ratio settings will affect the 
external display. You will also need to select the VMR7 option in the Setup Window. 

Testing in house has been performed using a Matrox Parhelia graphics card, which has two VGA outputs for 
dual monitor display, plus a composite video output, for use with an external video monitor. Full details of 
settings for this recommended graphics card are available. 

There are two "VMR" options in the Setup Window: 

 VMR7 - This utilises the Windows Hardware Overlay, and is necessary for playback on an external 
Composite monitor 
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 VMR9 - This bypasses the Hardware Overlay, and is designed if you require a dual VGA setup with no 
external monitor, and the Video Window on screen 2. 

The Video Plugin utilises Windows Direct Show. The quality of playback and recording will be dependant on 
your graphics card, and is outside of SADiE's control. Contact your dealer for advice on the most appropriate 
graphics card for your requirements. 

RECORDING VIDEO 

Video can be recorded in to SADiE from any DV compatible source. This can be a DV Camera, an input from a 
convertor box such as those made by Canopus, or any other DV device connected to an IEEE1394 FireWire 
port. For in house testing, good results have been achieved with the reasonably priced Canopus ADVC-100 
convertor. This can take any S-Video or composite input signal and convert it to DV (and vice versa). Canopus 
make a wide range of convertors, from entry level to professional broadcast quality. Choose an input device of 
a quality appropriate to your application. Contact your dealer for more information. 

Recording Video clips in SADiE is much the same as recording audio. Record Enable the Video Stream in the 
EDL, then press Record. With DV, if a CAT card is present in the SADiE, the video can be kept in sync. Any 
audio can be recorded simultaneously, by connecting the relevant inputs, and record enabling any relevant 
audio streams. 

When recording, you will see a noticeable delay between the video and the audio, due to the inherent delay in 
the DirectShow recording graph. This delay will not be present during subsequent playback. Any additional 
external delay in the recording process (perhaps and external DV encoder) can be compensated for using the 
frame compensation option in the "Video" section of the Setup Window. This defaults to 1 frame. 

It is always best to record and store Video in SADiE on a separate drive to your audio, as mentioned 
previously. You can specify a root directory and drive for recording video in the "Video" section of the Setup 
Window. Video will then be recorded in to a "ProjectName" sub directory. 

 

IMPORT AUDIO FROM AN AVI FILE 

If you have imported an AVI file into your project which includes audio, it's often useful to be able to use that 
as a sync reference. 

For this purpose, SADiE has the option to Rip audio from AVI file - right mouse click on the AVI file in the 
Clipstore and select this option. 

The audio will be copied to a new linear audio file and will appear in the clipstore after the conversion. 

TIPS, HINTS, AND TROUBLESHOOTING 

Here are a few tips, pointers, hints and general information for when using the SADiE Video option: 

 To be able to run video with SADiE you require: 

 Windows XP (pro or home although we have only ever tested using XP Pro) 

 Service Pack 1 (or higher)  

 DirectX 9B (or higher) 

 (XP Service Pack 2 and DirectX v9c are fine) 

 The video records to DV format AVI files at about 12GBytes an hour - 1GByte will therefore last 
about 5 minutes.  



SADiE v5.4 PCM Manual 

332 

 Display Hardware - it is possible to run the SADiE Video plug-in without  special hardware. If you 
are displaying video on the main PC monitors as opposed on a separate composite video monitor, 
then it's advisable to choose the VMR-9 renderer, which does not use hardware overlay. Aside from 
anything else, you will be able to view the video window on either screen. 
If you have a Matrox Parhelia card, to view the video on the composite video output, you must select 
the VMR-7 renderer. 
More recently, a customised Matrox Parhelia card is available from SADiE distributors (this is not 
available from regular Matrox suppliers) which gives performance enhancements over the normal 
Parhelia - synchronisation between audio and video is tighter, and single frames can be displayed in 
stop, to avoid the inter-field flicker. Note that to work with SADiE v5.3, these customised Parhelia 
cards must be running with driver version 1.08.072. If you have a customised Parhelia card, the 
Advanced Video Setup page will be present. 

 The Low, Medium and High settings in the Setup Window only apply to the playback video and don't 
have any affect on the recording quality: 

 High quality displays - full vertical and horizontal resolution  

 Medium quality displays - half vertical and full horizontal resolution 

 Low quality displays - half vertical and horizontal resolution 

When set to high quality playback, the flicker on an interlaced video monitor is unavoidable (unless 
you have the customised Matrox Parhelia card, see above), and the only way to stop it happening is to 
set the playback quality to medium. This restricts each frame to just a single field thereby avoiding the 
problem. Film will only contain a single frame, and so will be unaffected. 

 SADiE utilises the graphics cards "Hardware Overlay" facility. This must be switched on in the graphics 
card setup for the Video Plugin to work. If your Video Window appears blank, ensure hardware 
overlay is switched on. 

 Due to the functioning of hardware overlay on the Matrox Parhelia card with dual VGA monitors, the 
video image will only show on screen 1. When you put the video window on screen 2, the video 
window will appear black, although the picture will still appear on any external Video monitor.  

 Also due to hardware overlay, the Video Window must be present on the VGA monitor for Video to 
appear on an external monitor. If the Video Window is minimised or closed the external Video feed 
will disappear. If you wish to hide the Video Window on your VGA screen resize to its smallest 
dimensions and place behind the EDL Window. When the Video Stream in the EDL is Record 
Enabled, you cannot shut the Video Window. 

 Recording Video utilises Windows Direct Show. This has certain requirements for the legality of video 
clips. If when you are recording in a video clip, and upon pressing stop the video clip disappears from 
the video stream, the video that was recorded doesn't meet the requirements and so Direct Show 
removes it. If this happens, check the video input connections to make sure they have not come loose 
or are completely disconnected. 

 When working with a video enabled EDL, it is advisable to only have that video EDL open. Working 
with multiple EDL’s open takes up processing power which SADiE needs to display the video. As the 
performance of the PC drops, the video display will suffer before the audio quality so you may 
experiences glitches and drop frames. 

ADVANCED VIDEO SETUP 

The Advanced Video Setup page is only present if you have a Customised Matrox Parhelia card, which will give 
improved performance for SADiE's AVI playback. 

This page is available to set up the "single field on stop" function and determine which field is displayed. 

In simple terms, with 50 field (@25fps) or 60 field (@29.97/30 fps) AVI files, you should set the page as below. 
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10 - CUSTOMISING SADIE 

Setup Window 

Playlist & Mixer Templates 

Desktops 

Changing how SADiE starts up 

User Management 

SETUP WINDOW 
The Setup window can be displayed under the View menu and allows you to change many settings that affect 
the way SADiE is working. These are stored for each User in a file called "Username.INI" which is used by 
Windows® to recall them whenever you run SADiE. 

 
The settings are grouped under topics that can be selected from the list in the left-hand part of the window. 
Double-click on topics with a "+" next to them to reveal sub-topics for selection. 



SADiE v5.4 PCM Manual 

336 

The window is fully interactive, so you can leave it open and make changes while using SADiE. Options that are 
currently not available (like changing sample rate while recording) will be greyed out. 

This section details the options available to you for user setup. Items in Bold refer to options in the right hand 
pane of the Setup window.  

GENERAL SETUP 

Time Format Selects the format for all time displays: 

 Timecode Hours : Minutes : Seconds : SMPTE frames : SMPTE subframes 

 Milliseconds Hours : Minutes : Seconds : Milliseconds 

 Samples Hours : Minutes : Seconds : Samples 

 CD Hours : Minutes : Seconds : CD Frames 

 Bars and 
beats 

Bars : beats : ppqn (parts per quarter note) 

Time Format Settings Allows you to set the Tempo, Time signature, and ppqn for the Bars and beats 
display 

Popup Help Enables the yellow pop-up captions when resting the mouse pointer over a button. 

Warning Messages Allows a choice of four different settings. Display all messages until you are familiar 
with using SADiE 

Message Box 
Placement 

Allows you change the position on the desktop at which messages, warnings and 
errors appear. 

Popup Help When ticked this will display yellow popup boxes displaying button names when 
focused on a button. 

Disk Integrity Test When ticked this will perform a disk integrity test. 

Classic View When ticked this will display SADiE's interface in Classic Mode, with all textures 
and backgrounds removed. 

STATUS DISPLAYS SETUP 

Status displays 1-8 Lets you choose which displays of important settings are shown in any of five 
positions on the Status bar at the bottom of the screen. You can display any of 
the following: 

 Sample Rate Double-clicking on the display will take you to the relevant part of the Setup 
window to change the setting. 

 Frame Rate As above 

 Transport Ctrl Simple Play and Stop buttons and current-time display. Use as you would the 
main Transport Controls, which you can close to save screen space. Double 
clicking in the time display allows you to change the current time in the Playlist 
. Also, clicking and dragging any digit up or down, increments or decrements 
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that digit and hence moves the current time. 

 Autoplace Right-click on the display to change Autoplace settings. 

 Slip Right-click to change Slip settings. 

 Input Source Double-clicking on the display will take you to the Audio Setup page, to allow 
you to change this. 

 Clock Source Double-clicking on the display will take you to the Audio Setup / Further 
Audio Settings page, to allow you to change this. 

 Input Res Double-clicking on the display will take you to the Audio Setup page 

 Output Res Double-clicking on the display will take you to the Audio Setup page 

 Tempo Double-clicking on the display will allow you to alter the tempo directly 
without having to go to the General Setup page. 

 Varispeed Double-clicking on the display will take you to the Audio Setup page 

 Output Format Double-clicking on the display will take you to the Audio Setup / Further 
Audio Settings page. 

 Record Format Double clicking on this has no effect - this is display only. 

 Return on Stop Right-click to turn Return on Stop on or off. 

 Scroll Playlist Right-click to turn Scroll Playlist on or off. 

 Stationary 
Timeline 

Right-click to turn Stationary Timeline on or off. 

Display 
Titles 

When selected, each display shows its description in full. 

AUTO-SAVE SETUP 

Create backup files When any file ( EDL . Clipstore etc.) is saved, the previous version, before the 
save, is renamed to "*.bk?", e.g. when you save "FRED.EDL", the old version 
becomes "FRED.BKE". 

Auto-save files Sets the time between automatic saves of EDL, Clipstore and Mixer files. These 
are saved to the Windows directory and are named: 

 Sd3savxx.˜dl - for EDL, where xx counts up to 99 

 Sd3savxx.˜ls - for Clipstore, 

 Sd3savxx.˜su for mixer 

See File Recovery for details on how to recall these files 
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AUDIO SETUP 

NOTE: Audio Setup can be quickly called up by double clicking on the sample rate on the bottom Status 
bar 

Input Source Select which physical inputs are active for routing and recording. 

Input Resolution Select the sample resolution (how many bits per sample) of the input. For 
analogue input, the maximum bit depth produced by your A-D (and D-A) 
convertors will depend on the hardware you are using, so check with the 
Hardware leaflet. For digital input, set to match the input data, unless you want to 
reduce the resolution. 

Sample Rate Sets SADiE's working sample rate, for recording and playback. Obviously, SADiE 
can only replay audio at one sample rate at any time, so if you mix Tracks 
recorded at different sample rates in the same EDL, one of them will be replayed 
at the wrong rate and sound speeded up or slowed down. Use the 2x and 4x 
buttons to switch to for example 88.2/96 kHz or 192 kHz etc. 

Varispeed Allows you to vary the sample rate for special effects. This is variably adjusting the 
system clock, and can't be used when recording digitally or locking to an external 
reference. 

Output resolution Sets the output resolution at the digital outputs, or supplied to the digital-analogue 
converters. 

Default record disk Only applies to recording outside any Project. When recording within a Project, 
there is a separate disk selection in the Project window's Tracklist. 

Note on Sample Resolution: Unlike the situation with different Sample rates, SADiE can play audio with 
differing bit resolutions in the same Playlist . The Input Resolution setting sets the bit resolution for the 
physical inputs, and the Output Resolution setting does the same for the physical outputs. Thus if you are 
playing a mixture of 16, 20 and 24 bit audio with the output resolution set to 24 bit, then the resulting output 
will be a full 24 bit number. SADiE's internal processing is at 32 bit floating point, and is then truncated to the 
final output resolution at the physical output. Thus for instance if your entire Playlist is using 16 bit audio, but 
your output resolution is set to 24 bit, if there is any audio processing whatsoever (level changes, EQ's fades 
etc.) the resulting output will be a full 24 bit number. 

You can choose to record audio at a different bit resolution to the input setting however. When you change 
the Input Resolution setting, the Track Properties setting (using the Properties button in Transport 
Controls, and is the setting for your next recording) follows this global setting, but it can then be over-ridden 
manually. For instance there may be reasons why you would require a 24 bit resolution on the input, but you 
wish to record at 16 bit resolution, and so changing Track Properties could force the new recording to be 
16 bit. Note that the Track Properties remains at the last setting until you either change the global setting 
(in Audio Setup) or manually change it to something different. 

It is generally recommended to use dither of some sort when truncating any digital signal. SADiE supports a 
number of different dither algorithms. You can see that any audio processed in SADiE will be truncated (unless 
there is no processing of any kind) to the output resolution. Dither always works at the setting of the Output 
Resolution, thus if for instance you're recording to a 16 bit DAT tape, you would want to set SADiE's 
Output Resolution to 16 bit so that the dither is operating on the correct bit. In this particular case, if the 
Output Resolution setting was 24 bit, then the dither would be applied to bits that would be truncated by the 
DAT input, and hence the dither would have no effect. 

In the case of internal recordings (e.g. bounce or CD-R/DDP) the Output and Input Resolution settings are 
important to some degree. The output resolution's only use in these cases is to set the bit depth at which 
dither is working. Track Properties (which is affected by the setting of Input Resolution as just described) 
will set the bit resolution of the new recording/bounce etc. CD-R and DDP however automatically truncate to 
16 bit as is the standard for these media. 



Customising SADiE 

339 

FURTHER AUDIO SETTINGS 

Clock Source Sets what digital audio clock is used as the reference for generating SADiE's sample 
rate: 

 Automatic When a digital input is in use (either for recording or routing to a 
Mixer input strip), the clock is derived from that. When no digital 
input is in use, SADiE's own internal clock is the reference. This is 
the usual setting, unless you are recording from a digital device 
that needs to take its clock reference from SADiE (e.g. bouncing 
through an external digital processor or mixer), in which case 
they would each be trying to follow the other, so you must use 
SADiE's Internal setting. 

 Internal Internal clock used at all times. 

 Genlock External clock reference used at all times. This setting is for those 
who use a station clock to reference all their digital equipment. 

 
Clock Source Digital I/P Analogue I/P No I/P 

Automatic lowest 
numbered 

digital input in 
use 

internal internal 

Internal internal internal internal 

Genlock AES reference 
input 

AES reference 
input 

AES reference 
input 

 

Output Format Selects whether SADiE produces digital output signal to the SPDIF or AES/EBU 
protocol. The selected format is actually supplied to all digital outputs. 

Emphasis Turns Emphasis (of either flavour) on and off in the analogue domain. This is a 
global setting, so either everything is de-emphasised or not and thus if you need to 
mix material, it is best to de-emphasise by other methods (Graphical EQ has a 
preset for this). 

Internal Clock "Free run" or "Lock to Video". This determines whether the audio clock is frame 
locked to a video input present on the video input of the CAT card, or not. This 
will need to be set if you are locking timecode sync to 9-pin or VITC.  

SYNC SETUP 

NOTE: Sync Setup can be quickly called up by double clicking on the sample rate on the bottom Status 
bar 

These settings are described in full in the section on Synchronisation.  

PRE AND POST ROLL SETUP 

Here you can set how much SADiE plays before (pre-roll) and after (post-roll) an edit when you use the 
preview buttons in the Transport Controls or Trim Editor. These times also apply to the preview buttons in 
the PQ editor. 

Three alternative times are available: using the preview buttons alone, with the Shift key and with the Ctrl. Key.  
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PLAYLIST SETUP 

No. of Playlist Streams Tick the box and set the indicator number if you want to specify how 
many Streams new Playlists are generated with. Otherwise, SADiE will 
generate Playlists with 16 Streams per audio unit by default. See also 
Playlist Templates 

Cut Mode Determines the joins created between Entries when the Razor-cut is 
used: 

 Splice Fade-out of first Entry overlaps fade-in of next (a 
crossfade). 

 V cut Fade-out ends where fade-in starts. 

Stop automatically on razor cut Applies when razor-cutting during normal playback. 

Auto-locate on cut Means that when SLIP is on, cutting an Entry from the Playlist will 
reposition the current time cursor so as to take account of the slip. To 
be used in conjunction with the above. 

Double-click opens Clip details Clip Details window opens when double-clicking on the Playlist Entry. 

Auto load new EDL to current if 
empty 

If your current Playlist is empty, opening an EDL file will load it into the 
empty Playlist instead of creating another one. 

Autoplace options The time display is used to set the gap between Entries when using the 
"Autoplace with Separation" option. 

Use Fades When selected, the gap length includes the fade-out of the earlier Entry. 

Playlist and Trim Edit Never Scrub crossfades edges when editing - when this is ticked, 
scrubbing is automatically disabled when you are editing fade edges. 

PLAYLIST DISPLAY 

Stream comment space Choose between displaying the "comments" or "dialogue" that can be 
written in the Clip Details window. 

Always display mouse time in 
Playlist 

Changes the behaviour of the little red time display at the bottom left 
of the Playlist. With this ticked, the mouse pointer position is always 
displayed there. Unticked, and this displays the In point of a clip when 
you pick it up. 

PPM's in Playlist Turns on or off the miniature meters on the left of each Stream. 

Multitrack Rec Enable When ticked, this changes the appearance of the Red "R" record enable 
buttons to larger coloured "LEDs". The colour changes to give 
information about the record status:- 

- record mode is disabled on this stream 

- record is enabled, but playback has stopped 

flashing - record is enabled, the playlist is playing, but recording 
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hasn't yet started. 

- recording is in progress. 

- record mode has been enabled but there is no digital signal on the 
input (or it is invalid). 

Hide non-essential stream 
buttons 

The small buttons for Solo, mute, profile, automation and automation 
display mode are hidden to gain a little more "real-estate" on screen. 

Time lock split views Determines whether the secondary view of the Playlist (reveal by 
grabbing the edge of the Playlist on the right hand side, just inside the 
scroll bar, and dragging leftwards) scrolls in sync with the main view or 
not. 

Horizontal Zoom level... Sets the Zoom level for "View left/right edge of region", when in 
Region Edit. 

Start Navigator Window... Determines whether the Navigator will display the whole Playlist from 
time zero, or from the beginning of the first clip. 

Stationary Timeline This option turns the Stationary Timeline on and off, and determines its 
position on the screen. 

PLAYLIST ENTRY DISPLAY 

Fade display mode Show fades on all streams as 
splices: 

Show fades on all streams as cuts: 

 

Fade curve display mode Show fades as curves: 

 

Keep updating waveforms when 
playing 

Determines whether waveforms are re-drawn or not when you play the 
Playlist whilst viewing at a horizontal zoom of level 16 or greater. 
Depending on the performance of your PC, this re-draw can be slow at 
higher zooms. 

Show higher zoom waveforms 
as lines 

Again above horizontal zoom 16, an Entry's waveform display can be 
shown as point-to-point lines, or as bar graphs. 

Draw Profiles proportional to 
clip level 

Determines whether clip profiles stay constant in size, regardless of level 
changes, or profiles appear proportional to any clip level changes. 

Draw black outline on profiles 
up to zoom... 

Determines at what high zoom level black profiles disappear to make the 
profiles clearer 

Auto-select recording clip on 
entering record 

Determines whether the clip currently being recorded is automatically 
selected (red) when entering record. 

On Copy/Move Entry show 
guidelines for... 

Determines which Guidelines will be displayed for a particular clip when 
it is moved or copied. There is also an option to show these guidelines 
for grouped entries. 
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PLAYLIST NUDGE 

Nudge amount Sets the amount by which Playlist Entries are nudged with the button 
on the Autoplace toolbar, or the Hotkeys. 

Alt + Nudge amount Sets the amount by which Entries are nudged when holding the Alt key 
and using the Autoplace buttons. The "Zoom dependent" setting means 
that the higher magnification you use, the finer the nudge adjustment 

PLAYLIST AUTO-STOP 

SADiE can be set to stop playback on reaching the end of the last entry in the EDL.  

TRIM EDITOR SETUP 

Playlist Auto Follow When selected, the current-time cursor in the Playlist will move to 
keep up with the latest edit point in the Trim Editor. 

Auto write back to Playlist Entries currently in the Trim Editor are automatically written back 
when you RAZOR, or the LOAD NEXT EDIT or LOAD 
PREVIOUS EDIT buttons are used. 

Double click opens Clip details Double-clicking on the relevant profile does just that! 

Stop automatically when razor 
cutting 

Applies when razor-cutting during normal playback. 

Include fades when playing out-
takes 

Includes fades for the "Play out-takes" preview. 

Draw Hotspot on the Trim 
waveform 

Does what it says (or not) 

Auto-select matching fades... When ticked, when you click on the fade out of the left hand Trim clip, 
the fade in of the Right hand clip is automatically selected as well. Or 
not if it is unticked. 

Write back single clips with 
Autoplace 

You may use the Trim window as a means of tidying a clip from the 
Clipstore, before you place it into the Playlist. If this is the case, then 
setting this will allow you to use Autoplace settings on writing back, 
and so speed up the spotting process. 

Trim slips auto-follow EDL 
settings 

Ticking on this keeps the Slip setting of the Trim window the same as 
the EDL setting. You can over-ride the Slip setting for one edit, but on 
re-opening Trim, the slip will revert to the EDL setting. With this 
unticked, then the settings are completely independent, and so you 
could perhaps leave slip off in the Playlist, but always have it switched 
on in Trim. If most of your editing is in the Trim Window then this can 
be an easier method of using Slip functions. 

Auto-close Trim when writing 
back 

Closes the Trim Window automatically after a write back to source. 

Auto write back to source when 
closing the trim window 

Entries currently in the Trim Editor will write back to their source 
when the trim window is closed. 
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TRIM EDIT NUDGE 

Sets the amount by which edit points are nudged either in Playlist editing, or the Trim Editor. There is also a 
/10 tick box for more than one pixel per nudge, when using the Zoom dependant nudge. 

Nudge amount Applies to the on-screen nudge buttons (in the transport controls or 
Trim Editor), and the Transport Control Hotkeys. 

Alt + Nudge amount Applies to the on-screen nudge buttons (in the transport controls or 
Trim Editor), when holding down the Alt. key. The "Zoom dependent" 
setting means that the higher magnification you use, the finer the nudge 
adjustment 

MIXER SETUP 

Select PPM scale Selects the scaling of the PPM level meters in the Mixer . Scales 1-3 
emphasise different areas of the dynamic range and are calibrated in dBFS 
(decibels with respect to 0 dB, which is the maximum coding level). The BBC 
scale is numbered 1-7, with green segments up to PPM4, then yellow 
segments up to PPM6 and red above PPM6. 

Output PPM type The Mastering setting makes the peak hold displays accurate to 1 sample. 
This is at the expense of a little DSP power. 

Peak Displays "Clear on play" clears the peak holds every time you go into play. Unticked 
retains their value until you manually clear them. 

Default Mixer Tick the box and set the indicator numbers if you want to specify the layout 
of mono or stereo strips when new Mixers are created. Otherwise, SADiE 
will generate Mixers with 16 mono Streams strips and 2 mono output strips 
per audio unit. See also Mixer Templates 

E to E mode When selected, E to E mode gives you input monitoring on record-enabled 
Streams before you press the record button. E to E is cancelled when you 
disable record on the EDL stream. 

Mixer auto-resizing Determines how the mixer resizes on screen. 

Plug-ins bypass in Scrub Turns off Plug-ins during scrub for the purpose of relieving the DSP power 
and allowing an EDL to scrub, whereas the plug-ins may have pushed it over 
the DSP limit if they were scrubbing too. 

Window Style Determines whether to use the Blue Mixer or the classic Grey Mixer. 

MIXER STRIP DISPLAY 

Fader decimal displays Chooses whether to display peak holds meters (green/red) or fader offset 
values (light blue) in the faders' small numeric displays. Note that output 
fader peak holds are sampled more frequently than other faders and thus will 
be more accurate. Also "overs" on non-output faders are unimportant 
anyway because these are processed internally and are still floating point 
numbers. 

Enable phase reverse 
controls 

Allows you to disable (for the sake of safety) the phase reverse controls. 
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Strip bypass only effects EQ Leaves dynamics processors and MS decoder in line when bypassing the 
whole strip. 

Mute automation 
disconnected 

Disconnects and disallows mute automation. 

UNDO SETUP 

Enable undo Strongly recommended! In fact, there is really no reason not to use it. You can set 
any number of undo levels up to 50. More levels use slightly more disc space in the 
PC. 

DEFAULT CROSSFADE SETUP 

This sets the fade curves and lengths that are created at the beginning and end of Clips after recording and 
when using the razor-cut function. The normal default is around 40 subframes (20 milliseconds).  

9-PIN CONTROL SETUP 

These settings are described in full in the section on 9-pin Control  

TRANSPORT CONTROLS SETUP 

Loop pre/post-roll Sets the amount played either side of the Left and Right locator points when the 
LOOP button is used. 

Fast Forward and 
Rewind Speed 

Sets the speed for the Transport Controls Fast forward and Rewind buttons. 

SCRUB SETUP 

This section sets the sensitivity parameters for the Mouse Scrub Wheel 

Mouse Jog ratio Sets how much the audio is scrubbed for a given horizontal mouse movement. 
Default setting 040. Reducing this number means that a larger left/right mouse 
movement is required to move the audio at normal speed. 

Mouse Jog Damping Defines a rate of change of speed. This sets how quickly the audio speed responds 
to the mouse speed changes when jogging. Default setting 80. Damping allows you 
to retain a smoother playback speed, even thought the mouse movements may be 
jerky. Reducing this number will tighten the link between mouse and audio 
movement. 

Mouse Shuttle 
sensitivity 

Sets the speed of shuttle for a given vertical mouse movement. Default Setting 40. 
Reducing this number means that a larger up/down mouse movement is required 
to move the audio at normal speed. 

Fixed Scrub Speeds Set three fixed shuttle speeds used by the Hotkeys for forward and reverse 
scrubbing. These are set by default to being on the numeric keypad (NUM LOCK 
on!) - 1&3, 4&6, 7&9. 

The default settings are usually fine for general purpose scrubbing, but you may find that if very fine detail is 
required you might need to change these, and perhaps change them significantly. 

The performance of scrubbing with the mouse can be altered by PC performance. You will also notice that 
changing the Horizontal zoom in the Playlist will have an effect on the scrub speed. 
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This is an example setting found to work well with CEDAR DeClick, for which you will need much finer detail 
than the normal settings allow: 

 Mouse Jog Ratio about 5 -7 

 Mouse Jog Damping 2 

 Mouse Shuttle sensitivity 10 

These are significantly different from the defaults, and reducing the Ratio like this means that a much larger 
left/right mouse movement is required to move the audio in Jog at any speed. Likewise, reducing the Shuttle 
Sensitivity has the same effect on shuttle. However, it does mean that you have far greater control when 
moving very small distances. Reducing the Jog Damping means that the scrub playback is much closer linked to 
the mouse movement; this reduces the "rubber-band" effect if you like. 

Whilst discussing scrub, note that you can optionally turn off Plug-ins whilst scrubbing. This allows you to scrub 
when otherwise you would have been working right up against the DSP limit. The switch is found in the Mixer 
section of Setup. 

SCRUB WHEEL 

This section sets the sensitivity parameters for the Hardware Controller's Scrub Wheel. This is slightly more 
complex than setup for the mouse. The Jog function works on two levels: "Damped" for larger movements, and 
"undamped" when the wheel movement is smaller. The two levels have different sensitivity settings so that 
moving the wheel at one speed will produce a rapid movement through the audio, whereas when you slow the 
wheel down the sensitivity can become finer and un-damped. 

Damping factor Is equivalent to "Jog damping", and defines how quickly the audio speed changes 
when the mouse speed changes. Default is 87. This control is very sensitive: 
increasing to 99 will give you "full-on" damping. Essentially there's only +/-10 
throw on this adjustment. 

Damping Sensitivity Sets how much the audio is scrubbed for a given wheel movement. Default setting 
050. Reducing this number means that a larger wheel movement is required to 
move the audio at normal speed. 

Undamped Range This control sets the range inside which wheel movements flip to the "undamped" 
sensitivity setting. This value is the number of sample blocks (blocks of 32 samples) 
The default is 300, thus any movement of less than 9600 samples will stay at the 
undamped sensitivity setting. 

Undamped Sensitivity Sets how much the audio is scrubbed for a given wheel movement inside the 
undamped range. Default setting 512. Reducing this number means that a large 
wheel movement will produce a smaller audio movement. 

Undamped Offset This smoothes the transition from the undamped range to the damped sensitivity 
range. Default is 64. Increasing this will produce a smoother transition. 

Shuttle Sensitivity Entirely unrelated to the other settings, this sets the sensitivity for the Shuttle 
mode. Default is 10, increasing this will provide a greater audio speed for a smaller 
rotation of the wheel. 

Enable Hardware 
Controller Shuttle 

When unticked the Scrub button on the Edit/Jog Panel is a two-way toggle 
between Jog and Move Cursor; when ticked it provides the three way toggle 
including shuttle mode. 

Maximum Jog Speed You can set a Maximum Speed for the Jog wheel as an aid to achieving a steady 
play speed in jog. For instance, when set to 1X, no matter how fast you turn the 
wheel, playback will be a steady real-time speed. 
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Zoom Timeout By default, when you press the hardware controller's Zoom button, a few seconds 
later it will turn off, allowing the wheel to revert to scrubbing the EDL or edit. 
Unticking this option will allow it to remain on until you turn it off manually. 

The five Jog settings, particularly the settings for the undamped range, interact to a fair degree. For instance if 
you reduce the undamped sensitivity and increase the undamped range, you will find that the jog never 
switches over to the damped sensitivity setting. Thus if you reduce the undamped sensitivity to gain tighter 
control for fine movements of the wheel, you may need to reduce the undamped range setting as well, and 
possibly the undamped offset too. 

The default settings are designed for normal operation, and, because of the undamped range, the defaults will 
work well for fine detail work too.  

AUTOCONFORM SETUP 

See the Autoconforming section.  

PROJECT MANAGEMENT SETUP 

The default directory for project files is C:\PROJECTS and thus all files for a project called FRED would reside 
in a sub-directory: C:\PROJECTS\FRED 

In Project Management setup you can change the working directory for the project files if, for instance, you 
wanted to keep the projects on a network drive. 

There are two other options here which may help with workflow in specific circumstances:- 

Record to Removable Drives Only 

This disables the "Record Destination" in Disk Management, and forces projects to record audio to Removable 
drives. You must have reserved drive letters in Removable Disk Admin for this to work.  

In an emergency, a user can always disable this setting and revert to recording on an internal or other drive. 

Record to Project Component Directory 

This setting, as suggested, forces the project to record audio to the Project's Component directory, i.e. to the 
location specified in the "Default Root directory in which to create new projects". 

Quite simply this ensures that audio and EDLs, Mixers, Clipstores and Projects are all saved in the same 
location. Because this is a User setting, it has the added benefit (which may be useful in some workflows) of 
allowing different SADiE users to save their entire projects into different locations. 

Auto-open last open project components 

When this is ticked, the “auto-open” setting will keep changing as you open/close EDLs in the project, leaving it 
so that when you re-open the project, the components that were open the last time it was in use will re-open 
again, as opposed to the normal method where the user chooses which components auto-open.  

The Templates sub-section allows you set-up the how EDL and mixer templates are used.  

PQ SETUP 

For a full description, see CD Pre-mastering. 

Enable PQ Editing features Enables or disables PQ editing. The ability to use PQ is set when you 
create a Playlist, and thus if you need to use PQ, having previously 
made an EDL with it set it to OFF, then you will need to: 

 Enable PQ editing in setup 

 Create a new EDL 

 Copy your edited entries from your original, non-PQ-enabled 
EDL, into the new one. 

If you're using PQ, it is easiest to leave it on, but if you never use it 
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then turn it off, and you'll get a tiny bit more space on screen. 

Select PQ Audio Verify report 
style 

Applies to DDP only. This allows you to decide which type of report is 
created (to printer or disc) when you verify a DDP. A complete audio 
integrity report will run to several pages, thus you may wish to print a 
simpler one. 

Print PQ list at 30 FPS Normally SADiE will round PQ times to CD frames (75 frames per 
second) and will print times resolved to 75 frames also. If you are 
working with 1630/U-matic masters, you may require the print out to 
be 30 FPS. 

Use record pre-roll before CD-R 
track  

Only applies to Orange Book audio (e.g. not SCSI) CD-R's. The use for 
this depends on the way your CD-R responds to the start of the CD. 
With this option ticked, when SADiE starts playing the EDL, it will play 
x seconds (depending on the setting) before the start of the first track 
flag, and thus the first track flag will trigger a track start on the CD. 

EDL PQ lists insert time When you read PQ data in from a 1630, DDP or CD, the first track 
track's start time on the Master will be 00:00:00, and the information 
concerning its EDL offset time does not exist, even if this was created 
in SADiE. This setup time field allows you to determine where the first 
track starts when it is read back into SADiE. 

Allow initial countdown to be > 
3s 

Otherwise known as "hidden tracks". It is usual for the time between 
"Track 1 ID 0" and "Track 1 ID1" to be between 2 and 3 seconds. 
However some PQ authors have taken advantage of a "grey" area in 
the Red Book specification, and placed audio in this first countdown, 
which (if the consumer knows the trick) can be played back on most 
CD players. Normally, when you place a CD in a player and press play, 
playback will always start from "Track 1 ID 1" thus this first-countdown 
is never played. 

However if you extend this gap (backwards as it were) then audio 
inside the gap can be played by pressing play, then immediately shuttle-
rewinding behind the start of the CD, and playing again at the 
appropriate moment. 

By default, SADiE disallows extended first countdowns, but this can be 
over-ridden (with this switch) to enable you to perform this trick if 
required. It is advisable to set it back to normal afterwards, as all your 
subsequent CD masters could end up with a "semi-legal" first 
countdown. There are other methods of making "hidden tracks"; 
sometimes placing audio after half an hour of silence is called a hidden 
track, but hidden tracks created in this way are more hidden! 

It is advisable to consult your plant before presenting them with a 
master like this. These are relatively common these days, but still a 
little unusual, and it is best to confirm that they are able to process a 
master like this, otherwise it may be considered "illegal" and the hidden 
audio may be missed. Extended first countdowns cannot be written to 
DDP, as the DDP audio file is specified to start at CD time 00:00:00 
and thus audio before "Track 1 ID 1" is never transferred to the DDP 
audio file. 

Be careful with this one! 

CD-R PQ reading Allows or disallows the reading of ISRC's and Index Zeros when 
reading PQ from CD's. This may not work with some models of CD-R. 
See Reading PQ data and audio from a master 
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Non-real-time CD playback Sets the read speed of a CD-R device, when used for bouncing data 
back into SADiE (aka "ripping" audio from CD). See Bounce from CD-
R 

PQ DISPLAY 

Enable PQ editing in the Playlist Allows PQ flags to be inserted or moved with the mouse. Disabling this 
is a way of locking the PQ list. 

Auto-show the PQ Playlist 
Stream  

The Playlist will automatically open the PQ Stream displaying PQ flags, 
when the EDL is loaded. 

There are some other pages for selecting PQ settings: 

 PQ Facility - The country code and owner code entered here will form part of the ISRC number that 
can be generated for each CD track. Production details can also be entered for the printout of the PQ 
list. 

 PQ Burst - Sets SADiE's input channel for reading a PQ burst, and the output channel and level used 
when writing a PQ burst. 

 PQ Offsets - Sets the length below which all countdowns will be removed when using the 
NORMALISE button, and the parameters for applying offsets to the PQ Entries. 

NOTE: The offsets set here are applied to a PQ list from the moment you start creating it. From 
then on, they are held in the EDL and changing these settings will not change the current PQ list. 
Be sure that you set them as you want before you do lots of intricate PQ editing! 

 PQ Flags - Sets the parameters used when automatically generating a PQ list, and when adding new 
track flags. 

 PQ Text Output - Allows you to choose a format and editor for viewing the PQ printout. 

 DDP Details - Allows you to choose between creating a version 1 or version 2 DDP master.  

HOTKEY SETUP 

Here you can set a wide range of computer keyboard key-presses and hardware controller buttons to 
duplicate on-screen commands, so avoiding the use of a mouse. 

Categories First select the window in which the Hotkey will operate. Remember that Hotkeys 
set for the Transport Controls will affect other windows. 

Commands Select the command you want to check or assign to a new Hotkey. 

Hotkeys assigned This box will list what Hotkeys are currently assigned to the selected command. 

New Hotkey Select a key by scrolling down the box and tick the Ctrl, Shift or Alt key(s) to be 
pressed in combination with it if desired.  

For hardware controller buttons, select F1-F12 and tick HWC Shift and/or HWC 
Assign if they are to be used in combination. 

Assign Adds the selected New Hotkey to the list of those assigned to the command. 

Remove Removes the selected item in the Hotkeys assigned box from the list assigned to 
the command. 

Reset All Resets all Hotkeys in SADiE to the standard factory defaults. 
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Dump Keys Allows you to save the current Hotkey settings to a text file so that you can print 
it out. Note these dumps cannot be reloaded; this is a job for SADiE Settings files. 

AutoRepeat When setting hotkeys it's possible to set them to automatically repeat when the 
key is held down - tick "AutoRepeat" before pressing assign. If you wish to add the 
AutoRepeat function to an existing hotkey setting, you must Remove the old key 
and re-apply it with AutoRepeat set. If you don't like the repeat speed, there's a 
Windows setting for this  in Control Panel/Keyboard. 

All alphanumeric keys can be used, along with the keyboard function keys F1-F12. Certain non- alphanumeric 
keys can also be used: 

¬ - = [ ] ; ' # \.. /  

Tab, Esc, and Scroll Lock 

and on the number pad (when set to Num lock on!)  

/ * - + 

(note that Del and Enter on the numeric pad are the same as the other Del and Enter and so are already 
included, but cannot be set separately) 

Some key combinations are fixed to standard Windows functions i.e. CTRL-C, CTRL-V, CTRL-X for copy 
paste and cut; CTRL-Z, CTRL-Y for undo & redo; CTRL-A & Esc for Select and De-select All. 

CLIP DETAILS SETUP 

Write back Clip on exit Automatically writes back the changes you make in a Clip Details window when 
you close it. 

EDL CONVERSION SETUP 

This sections allows you some options when converting to and from external EDL 's in the following formats: 
Lightworks, CMX, Sony, Grass Valley, or Lightworks Multi-track.  

BOUNCE SETTINGS 

Close Bounce dialogue on 
Start 

Either leaves the Bounce Window on screen or hidden during the bounce 
process. 

PC bounce Destination Allows you to set the directory on the PC drive where Bounce to PC disk 
files will go. 

Record Pre and Post handle Allows you to add handles to a file when using bounce. 

Multi-session CD fix up When ticked a bounce to CD will automatically fix up the orange book CD 
after the bounce. 

PRINTING SETUP 

This is used in conjunction with the "Print Text EDL " function under the Playlist menu 

You can set the number of characters to a line for your printer, and also, when Printing to file, allows you to 
set delimiting characters for import into a spreadsheet or database if required.  

DIRECTX SETUP 

DirectX Timestamp Determines the Timestamp of audio through the DirectX Plugin. 
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DirectX Buffering (ms) This allows you to set the buffering for the DirectX Plugin to allow for latency. 

 

VIDEO SETUP 

General "Create Video Stream in Playlists" effectively switches video on. On creation or 
opening of any EDL that contains video entries, a video stream will be added at the 
top. "Auto Open Video Window in Projects" will automatically open a Video Window 
in any Project which contains a Video stream. 

Playback Quality High quality displays full vertical and horizontal resolution, Medium quality displays half 
vertical and full horizontal resolution, Low quality displays - half vertical and horizontal 
resolution. When set to high quality playback, the flicker on an interlaced video 
monitor is unavoidable, and the only way to stop it happening is to set the playback 
quality to medium. This restricts each frame to just a single field thereby avoiding the 
problem. Film will only contain a single frame, and so will be unaffected. 

Record Allows you to select the root directory for recording video to. You can also alter the 
Playback Delay compensation, in frames. 

Renderer Select VMR-7 to utilise Hardware Overlay for output to an external composite 
monitor. Select VMR-9 to switch it off for display on the second VGA monitor of a 
dual display. 

 

PLAYLIST AND MIXER TEMPLATES 
The Templates feature allows you to further customise your working environment, by allowing you to easily 
save custom Playlists and Mixer Setups for future use. 

In normal use you will save Playlists and Mixers but these will contain other information EDL entries, Fader 
levels and pan and EQ settings for instance, which are of no further use. Once you have customised a Playlist 
or Mixer, if you save it as a Template you can use it again and again. 

For instance you may always require a Playlist with 2 mono streams and 1 stereo, with a mixer that has 
perhaps 2 mono and 1 stereo strips with an EQ and maybe a reverb. If, having constructed this blank Playlist 
and mixer you save them as template files, then you can set SADiE to use these for the defaults. 

To save a Playlist or Mixer as a template select the option under the "File" menu, "Save current Playlist (or 
mixer) as a template". The files will be saved with an EDT or MST extension. 

If (and only if) you are working in a Project . you can enable Templates in the "Templates Setup" page (which is 
a sub-section of Project Management Setup). 

The three options for using templates are: 

 Do not use templates - this is the default choice. Templates are disabled, and the type of EDL/mixer 
that is created when you make a new EDL/mixer is determined by the Setup page options (see Playlist 
Setup and Mixer Setup). 

 Use the specified templates below - In this setup page you can choose a single EDT Playlist template, 
and MST Mixer template, which will automatically be used as the basis for your Playlist and Mixer every 
time you create a new Playlist and Mixer (either using the "File", "New" function or the CREATE 
EDL and CREATE MIXER buttons in the Project window. 

 Choose a template at Playlist or mixer creation time - when you create the new EDL/Mixer, SADiE 
will ask you to name the file in the usual way, and then offer you a list of all the available templates files 
that appear in your own template directory. 
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NOTES: Templates are saved and reloaded on a user basis, e.g. the user "Joe" will find his templates in 
C:\SADiE5\templates\Joe (assuming C:\SADiE5 is the normal working directory for SADiE). You will 
notice that if you press CANCEL (or press the Esc key) you will bypass the template and the new 
EDL/mixer will be based on the Setup page setting. You will also notice that you will be first offered the 
template that was chosen last, and so you only need to press the  Return key to use that same 
template again.  

DESKTOPS 
The arrangement of windows and toolbars (groups of buttons) on your screen is called a desktop. As described 
below, this can be saved as a file, just like an EDL. You can save several different Desktops for different tasks 
and then reload them to quickly rearrange the screen whenever you want. Note that a desktop will not look 
the same when viewed with a different screen resolution. Several Desktops files are provided with the 
software.  

ARRANGING WINDOWS 

Moving and Resizing windows with the mouse is covered in Windows® Help 

The Window menu has the following commands which are standard for Windows® applications: 

 "Tile" will attempt to fit all open windows onto the desktop. 

 "Cascade" will arrange all open windows on top of each other, with all the title bars visible. 

 "Arrange icons" will align the symbols for minimised windows along the bottom of the desktop. Again, 
not especially useful unless you have lots of minimised windows. 

 The list at the bottom of the menu shows all open windows and is useful for quickly restoring to size a 
minimised one, or making active (and so bringing to the top) an obscured one.  

SPLIT AND DUPLICATE WINDOWS 

The "Window" menu's "New Window" command creates a duplicate of the active window so that you can 
effectively split it and place different parts in different places on your desktop. 

For example, you may have a very large Mixer of, say 24 channels. You could put the first 12 channels in the 
top half of the screen and the rest below. Or, if you are using a dual graphics card to spread the desktop across 
two monitors, channels 1-12 on one screen and 13-24 on the other. 

You might want to have two Playlist windows, one looking at one part of the EDL . and the second at a 
different part. You can also create a quite separate Text EDL window like this. 

 Make the window you want to duplicate the active one. 

 Select "New Window". An exact duplicate will be displayed. If duplicating the Playlist, you have the 
option of a new Playlist or Text EDL. If duplicating the Mixer, you have the option of a new Mixer or 
Process window. 

 You can now resize the two duplicates and use their separate scroll and zoom functions so that they 
display the bits that interest you. 

 Move the new windows where you want them on your desktop, which can then be saved as described 
below.  

TOOLBAR DISPLAY 

The various toolbars used in SADiE can be attached to different parts of their windows or floated and moved 
around the screen. 

Right-click over any toolbar to see the list of options: 

 Each toolbar can be docked to any of the four sides of its window. 

 The toolbar can be floated, in which case it becomes a separate, "always-on-top" box that can be 
positioned anywhere on the desktop. A floating toolbar can also be re-shaped by dragging its sides in 
or out. 
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 Each toolbar can also be hidden, so that it doesn't appear on the desktop at all. To re-display a hidden 
toolbar, look under the View menu, where the "Toolbars" command will let you select which toolbars 
are displayed. 

NOTE: The Transport Controls are a special toolbar that cannot be reshaped or docked. They can, 
however, be displayed or hidden under the "View" menu.  

SAVING AND LOADING DESKTOPS 

To save the current arrangement of your desktop (which includes the size and position of all windows, even if 
they are not currently on view), select "Save Desktop" from the Desktop menu. The save box that appears 
allows you to give the new desktop file a name and open the folder that you want it saved in. There is a folder 
for Desktops within the main SADiE folder. 

To load a previously saved desktop select "Load Desktop" from the Desktop menu and find it in the relevant 
folder. Alternatively, select it from the list of recently used Desktops at the bottom of the Desktop menu. 

You can load any of the five suggested Desktops, which are provided in the Desktops folder, for each of the 
following screen resolutions: 

800 (x 600), 1024 (x 768), and 1280 (x 1024). 

The resolution forms the first part of the filename. 

There is a general "Default" desktop, which will be the one loaded when you start SADiE, two editing 
Desktops, one for mixing and one for PQ editing. 

The "Environment / Desktop" menu has an option to "Save desktop as start up desktop" (see Automatic Log-In 
and Desktop Load).  

CHANGING SCREEN RESOLUTION 

WHY DOES MY SADIE LOOK DIFFERENT TO THEIRS? 

A PC's display is a grid of coloured squares called pixels. Most PC's can display at different screen resolutions, 
(a different number of pixels) across the same size screen. A high screen resolution of 1024 pixels horizontally 
by 768 pixels vertically will use smaller pixels than a resolution of 640 x 480. This means the elements of any 
display will appear smaller, yet you can fit more onto the screen. 

The choice is down to your personal preference for the size of monitor you are using. SADiE can work equally 
well at either 640 x 480, 800 x 600, 1024 x 768 or even 1280 x 1024. It is worth bearing in mind that the PC 
will be working harder if you increase the resolution, so the display may be slower to refresh. Another factor 
that can change the speed of operation is the number of colours. SADiE only uses 16 colours, and so if you set 
the display driver to use 256 or more colours, it is processing numbers unnecessarily and could work slower. 
Some display cards, however, are optimised to run at a certain resolution and number of colours, so there is 
no hard and fast rule. 

Generally, 800 x 600 (often called SVGA) is a good default. You may prefer 640 x 480 (often called VGA) if you 
have a small monitor or a SADiE portable, and 1024 x 768 if you've got a 17" monitor. The method of changing 
resolution may be different for different PC's and different display cards, but the following are most common. 

WINDOWS  

From the Windows desktop, right-click on an empty area on the desktop and choose "Properties" from the 
menu that appears. Select the "Settings" tab of the box that appears. There is a sliding control to change 
resolution, and a selection box for the number of colours. Most changes can be done without closing down and 
restarting Windows, but if that is necessary, the screen instructions will warn you and you can close SADiE and 
save your work accordingly. 

Alternatively your PC's video adapter may have its own application for setting up the display.  

MESSAGE BOX PLACEMENT 

In the Setup window, on the "General" page there are settings to allow you change the position on the desktop 
at which messages, warnings and errors appear. You can alter the percentage from left of desktop, and the 
percentage from top of desktop, and you're able to Test the settings to see where you've placed the messages. 
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This is particularly useful if you are running SADiE on a machine with more than one monitor. With the default 
setting, messages appear in the middle of the screen, which can be spread across two monitors on a twin 
screen system.  

MULTIPLE MONITORS 

It is possible to work with more than one screen on your PC, as there is support for multiple graphics cards in 
Windows. Alternatively you can buy graphics cards that have more than one monitor port. 

There are a number of different ways that these screens are handled, and this will be determined by the 
operating system and graphics drivers. 

There are a few things to watch out for, but mostly there are ways of accommodating "oddities". 

"SADiE will only ever fit onto one screen" - This can happen because Windows may be set to maximise single 
applications to one screen. This is the standard way you are expected to work with two screens, e.g. one 
application on each monitor. To get SADiE to spread across two (or more) screens is not to maximise SADiE, 
but to set SADiE to run in a Normal window then resize to fit. This is set in the shortcut you use to run 
SADiE. Right-click on the desktop shortcut, select "Properties" and then on the "Shortcut" tab, check that 
"Run" is set to "Normal window". If "Run" is set to "Maximise" this could cause SADiE to only fit to one screen. 

"Messages appear in the middle of two screens" - If everything is configured correctly, then messages should 
appear in the centre of the screen on which the mouse is settled. However, we have seen graphics cards and 
drivers that do not follow this convention. Sometimes updating the graphics drivers will correct this problem, 
but if the card insists on seeing the desktop as one big, say, 2048 x 768 screen, rather than two 1024 x 768's, 
then there is a setup option, under "General Settings" (Message box placement) that allows you to re-position 
message boxes, thus changing the distance from the left to 25%, will push the messages to the centre of the left 
screen in a two-screen setup. 

Note that the placement of SADiE's main windows (Playlist, Mixer, etc. plus the Setup window, Disk Manager, 
and Transport controls) is controlled by the Desktop. If you are adding extra monitors, you may want to 
design a different desktop and save it as the start up desktop to make it the default.  

CHANGING HOW SADIE STARTS UP 

STARTING SADIE AUTOMATICALLY 

To make SADiE start automatically when Windows starts: 

1. Click on the Start button and point to "Settings" 

2. Click "Taskbar", then the "Start Menu Programs" tab 

3. Click "Add" followed by "Browse" 

4. Open folders to locate the icon that you use to run SADiE. It should be under "Windows", "Start 
menu", "Programs", "SADiE" 

5. Click "Next", then double-click on the Start Up folder. 

6. Type a display name for the new icon, then press "Finish" 

To stop SADiE starting automatically: 

1. Click on the Start button and point to "Settings" 

2. Click "Taskbar", then the "Start Menu Programs" tab 

3. Click "Remove" 

4. Open the folders "Programs" and "Start Up" 

5. Select the SADiE icon and press "Remove"  

AUTOMATIC LOG-IN AND DESKTOP LOAD 

You may want SADiE to start with a particular desktop file that you have previously saved, particularly if you 
have changed screen resolution. You can also set the login process to be done automatically when SADiE 
boots up. 



SADiE v5.4 PCM Manual 

354 

The icon that you select to run SADiE contains instructions to run the program. These take the form of a 
command line, to which you can add the desktop to be used, and your user name and password. 

TO CHANGE THE START-UP DESKTOP 

There's an easy way or a more complex method, which describes in more detail how SADiE chooses the 
desktop. 

Easy method - Under the "Environment" menu, choose "Desktop", then "Save Desktop as Startup desktop". 
This function will detect which screen resolution you are running at, then overwrite the default desktop (e.g. 
"1024def.dsk" for 1024 x 768 resolution) with your current desktop layout. 

This method will not work if you have changed your screen resolution since installing the software. This is 
because the current resolution's default desktop will be over-written, but the icon on the desktop will still be 
loading up the default desktop for the original screen resolution when the software was loaded. This is perhaps 
why you wanted to do this in the first place. If this is the case, then use the "hacker's method" below to change 
the command line to the correct desktop. 

Hacker's method - To modify these instructions for desktop and login: 

1. First find the command line: 

i. If your system is set to run SADiE automatically when you switch on, the relevant icon can be 
found under the Start button, "Settings", "Taskbar", "Start Menu Programs". Click "Advanced" 
and, in the Explorer box that appears, open the "Programs" folder and then the "Startup" 
folder. The SADiE shortcut icon will be in the list on the right. 

ii. If you run SADiE manually from the Start button, follow the above instructions, but instead of 
finding the icon in the "Startup" folder, it will be in the "SADiE Disk Editor" one. 

iii. Alternatively, you may have an icon on your Windows desktop. Right-click on the relevant 
icon, select "Properties" and the "Shortcut" tab of the box that appears. The command-line is 
in the box labelled "Target". 

iv. A typical command line is: 

C:\SADiE5\BIN\SADiE5.EXE_/dc:\SADiE5\Desktops\1024def.dsk 

v. The first part of the command line, "C:\SADiE5\BIN\SADiE5.EXE" is the instruction to run 
the program file "SADiE5.EXE" which runs SADiE. It gives the full location (or "path"), of the 
file, e.g. it is in the "Bin" folder, which in turn is in the "SADiE5" folder, which is on the C 
drive. 

vi. The second part starts with a space (shown above as _) and then /d, which is the instruction 
to load the following file as the desktop, in this case "1024def.dsk", which is in the "Desktops" 
folder, in the "SADiE5" folder, on the C drive. 

2. Now edit the command line by clicking within it to change the text. The line may be longer than the 
box displaying it, but you can use the keyboard arrow keys to move it. 

i. To automatically load a desktop file, carefully change the current desktop file name to the 
one you want to use. You probably won't have to change the folder parts of the path, unless 
you have been storing Desktops in strange places. 

Remember to keep the space shown as _ after "SADiE5.EXE". 

NOTE: On Windows systems, any paths that use filenames with spaces in them must be 
enclosed in quote marks. 

NOTE: SADiE v5 uses user-based Desktops. Alternative Desktops can be set for 
different screen resolutions. You will need to edit the Windows desktop shortcut to 
remove the /dc:\SADiE5\Desktops\1024def.dsk part of the command line .  

ii. To login automatically, carefully add the following to the end of the command line, after any 
quotation marks - 

_/uNNNNN_pWWWWW 

where "NNNNN" and "WWWWW" are your user name and password respectively. Note 
the spaces shown as _ before the first oblique and between your user name and the P. 
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USER MANAGEMENT 

 
User Management allows full access to SADiE v5 to be restricted to a list of specified users, held in a User 
Database. The SADiE v5 Project system further restricts access to individual Projects to a list of specified 
Project users (a subset of the User Database). 

The "SADiE v5 User Management" application is a separate Windows-based utility for creating and altering a 
User Database. 

All installations require a User Database even if it only contains one user. In a one-user installation the User 
Management Application is not strictly required, as SADiE v5 will construct a default User Database the first 
time it is run if one is not found. 

You will need to run the Application if: 

 You are setting up a multi-user system, 

 Additional users need to be added to a system, 

 An existing user wants to change their username, 

 You want to point SADiE v5 at a different User Database (perhaps on a networked drive). 

Each user has their own username, password (optional), management privilege level, and SADiE settings file.  

USERNAMES AND PASSWORDS 

USERNAMES 

A "username" is a unique name given to each user and can be up to 16 characters long. Valid characters are any 
unicode character. The application will validate all input, so there is no possibility of entering an illegal character 
accidentally. 

PASSWORDS 

Passwords are optional, although recommended in any system that has more than one user. The same rules for 
usernames also apply to passwords.  

MANAGEMENT PRIVILEGE LEVEL 

This determines whether a user can run the User Management application, and what they can do within it. It 
also allows certain users access to all SADiE Projects. 

There are three levels of privilege: 

ORDINARY USERS 

Most users will be created as ordinary users. They can run SADiE and gain access to projects that they are 
signed on to. They cannot run this application and therefore have no power to alter the User Database. 

SYSTEM ADMINISTRATORS 

These users can run the User Management Application and alter the User Database by adding and removing 
(and altering the details of) ordinary users. They also have access to all SADiE projects. This is to prevent a 
lowly pip-squeak of a user creating a project that cannot be accessed by anyone, however powerful. 

There is no restriction on the number of System Administrators that there can be in a User Database, but for 
security reasons it is advisable to keep it to a minimum. 

System Administrators can only be created by the Super System Administrator. 
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SUPER SYSTEM ADMINISTRATOR 

This is the most powerful user of all. Each User Database contains only one Super System Administrator, who 
is appointed when the database is created. 

Super System Administrators can run the User Management Application and alter the User Database by adding 
and removing (and altering the details of) System Administrators and ordinary users. They also have access to 
all SADiE Projects.  

SADIE SETTINGS FILES 

USER INI FILES 

Every user in the User Database will have their own settings file. A User "INI" file has a filename of 
"Username.INI", where "username" is the first eight characters of the user's username. The files are derived 
initially from "SADiE5.INI" (situated in the C:\windows directory) 

These "INI" files contain information on every setting in the SADiE program; fundamental things such as sample 
rate, record input, as well as more obscure functions hidden away inside the Setup pages. These settings are 
carried from session to session, so that if you change a setting, it will stay that way until you change it again. 
Hotkeys are stored here. 

If an anonymous user logs on (e.g. presses "Skip" in the log in dialogue) then they will be considered to have a 
username of "DEFAULT", and therefore will use the "DEFAULT.INI" User "INI" file. It is therefore important 
to bear in mind that all anonymous users will share one "INI" file. 

You can find out which User "INI" file is being used at any given time by opening the settings view and looking 
at the filename that appears in the title bar of the window. 

USER INI FILE DIRECTORY 

The User "INI" files are kept in a separate directory on the PC hard drive. This will be created automatically 
when you run the new version of SADiE (or the User Management application). By default it will be created in 
the same directory that contains the current User Database and will always be called "settings". Initially the 
directory will be empty, but as users log onto the system, User "INI" files will be created in this directory. 

SADIE SETTINGS FILES 

Just as you can save your Desktops to "*.DSK" files, you can save your current environment (e.g. your User 
"INI" file) to "*.SST" files. This is an advanced feature that most users will probably never venture into, but it 
can be found under the "Environment" menu on the main application menu system. Settings files can be saved 
anywhere and are accessible to all users (who have access to where you save them). 

Loading a setting file will instantly reconfigure your settings and screen to the way it was when you saved the 
settings.  

USING USER MANAGEMENT 

What happens when you run the User Management application for the first time depends on whether you have 
already run SADiE software on the machine in question. 

If you have already run SADiE software, the application will automatically select the User Database that SADiE 
created, and display the Log In dialogue box. 
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The path of the User Database currently being used by SADiE v5 will be displayed at the bottom of the box, as 
a reminder for administrators who may be maintaining several User Databases. (It doesn't matter if you're 
using an existing user database that was created in an earlier version of software, as long as you don't delete 
this if and when you remove the earlier software) 

You should enter the Username (and password if there is one) of the user that was specified when SADiE was 
run for the first time. This user will be a Super System Administrator, who is always the first user to be 
inserted into a User Database when it is created. 

If you have not yet run SADiE, the following message box will be displayed: 

 
If you answer "No" at this point, the application will shut down since a User Database is required for it to run 
successfully. 

Answering "Yes" will launch the "Create or Select a different SADiE User Database" dialogue box: 

 
This is a standard Windows browser window and allows you to open the folder where you would like the 
User Database created, or locate one that already exists (perhaps on a network drive). If a User Database 
exists in a selected folder, it will appear in the left hand list box. 

A User Database always has the filename "SADiE3.UDB". 

Once you have chosen your folder, press "Ok". If a User Database already exists, the Log In dialogue will be 
displayed and you should log in using the identity of one of the users in the database. 
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Alternatively, if no User Database exists, the application will automatically offer to create one for you, 
displaying the following message: 

 
Replying "No" will terminate the application while "Yes" will create a default User Database and display the 
following message: 

 
Note that the one user added to the User Database at creation time is given the username "admin" and no 
password. As mentioned previously, this user will be a Super System Administrator. The user will also be 
granted the highest possible SADiE privilege level. 

Once the message box has been closed, the User Management Log In dialogue box will be displayed. You 
should now enter "admin" as a username and no password.  

THE MAIN WINDOW 

Having successfully logged on to a User Database, the main window of the application will be displayed. It is 
from here that all the user management tasks can be performed. 



Customising SADiE 

359 

 

The main part of the window is occupied by a list 
displaying all the usernames in the selected User 
Database. The list is ordered alphabetically with a total 
user count at the top right. Initially you will only see one 
user, the default "admin" user that was automatically 
inserted when the database was created. 

The user's Management privilege level is shown against 
each username (in the case of ordinary users, nothing is 
displayed). 

ADDING, EDITING, REMOVING, AND SAVING 

ADDING A USER 

To add a new user to the system, select the user in the user list and press the "Add" button (or press Alt-A). 
This will launch the "Add New User" dialogue box: 

 
From here you can enter a new user's Username, password (optional), and their SADiE privilege level. A 
Username of SADiE5, SADiE4, SADiE3, or DEFAULT is not allowed. 

If you enter a password you must enter it in both the "Password" and "Confirm Password" boxes. 

If you are the Super System Administrator, you can also use the check box to make the new user a System 
Administrator. 

When you have finished, press "Ok" to add the new user to the system. 
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EDITING AN EXISTING USER'S DETAILS 

To edit an existing user's details, select the user in the main window and press the "Edit..." button (or just 
double-click on the user). This will launch the "Edit User" dialogue box, which is identical to the "Add New 
User" dialogue box described above. 

If you are the Super System Administrator, you can use the check box to grant or revoke System 
Administrator status. 

When you have entered all of the new details, press "Ok" to confirm, or "Cancel" to abort. 

REMOVING A USER 

To remove an existing user from the system, select the user in the main window and press the "Remove" 
button (or press Alt + R). You will be asked for confirmation before the user is removed. 

Remember that only the Super System Administrator can remove System Administrators from the system. If 
you do not have the privilege level to remove a particular user the "Remove" button will automatically be 
disabled. 

SAVING CHANGES TO THE USER DATABASE 

As you add, edit and remove users from the current User Database, your changes are not actually being saved 
to the real database file. This will only happen when you select "Save changes to User Database" from the "File" 
menu, or exit the application from the "File" menu.  

SELECTING A DIFFERENT USER DATABASE 

Occasionally it might be necessary to point the User Management application and SADiE v5 at a different User 
Database. This is likely to occur if you want a previously isolated machine to refer to a User Database on a 
network drive. To change the currently selected User Database press the "Change..." button under "Current 
User Database" in the main window. 

This will launch the User Database browser dialogue box: 

 
A User Database always has the filename SADiE3.UDB. 

Locate the new User Database and press "Ok". The application will confirm that it has selected the newly 
chosen database and advise you that it will now shutdown: 
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This is done for security reasons. Should you wish to make changes to the newly selected User Database you 
will have to re-run the application and log in accordingly.  

CHANGING THE SETTINGS DIRECTORY 

You can alter the location of the settings directory, where User Settings files are saved. It will probably not be 
required in many situations (provided the User Database location has been configured to a sensible location). 
However, this is the place to alter it should the need arise. The procedure is similar to changing the current 
User Database above.  

IMPORTANT POINTS 

 Whilst User Management and SADiE v5 are separate applications, they both reference the same User 
Database (on any given PC). 

 The start-up of SADiE v5 will not be affected by any User Management changes until the database is 
saved. This happens when the User Management application is exited (or when "File", "Save Changes" 
is selected). 

 When a new User Database is created, one Super System Administrator is added to the database 
automatically, with the username "admin" and no password. You are advised to give this user a 
password as soon as possible. 

 The User Database is heavily encrypted on disk and is effectively un-hackable. Any tampering with a 
User Database file is likely to result in it failing to be read correctly. The usual symptom is lost users.  
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11 - ADDITIONAL NOTES & FAQS 

Hardware Controller Functions 

A guide to Playlist Buttons 

Controlling SADiE with a Console 

FAQ - SADiE5 & BB2 interchange using removable drives. 

FAQ - Networking SADiEs in a small Workgroup 

SOFTWARE DIFFERENCES BETWEEN HARDWARE 
PLATFORMS 

PCM8 

Is the standard SADiE Mastering platform. PCM8 has 8 inputs and 8 outputs in analog and AES/EBU format. 
This has full capability as described in this manual, and all current plug-ins can be installed on this hardware. 

Multiple PCM8 cards can be installed to give more DSP power and up to 32 channels of I/O.  

PCM4 

Is a smaller-scale general purpose workstation with 4 input and outputs in analog and AES/EBU. This has full 
capability, including sync operations (which requires the CAT timecode card), except for the Mastering facilities 
- i.e. DDP, PQ Bursts, PQ print-outs, but does include PQ editing and CD writing. 

The Mastering facilities are available as an option. 

PCM-H64 

Is the larger-scale multi-track workstation offering up to 64 inputs and outputs per DSP card. Input and Output 
interfaces are modular and include Analog, AES/EBU and MADI options. 

PCM-H64 has full standard software capabilities except for the Mastering facilities (DDP, PQ bursts, PQ Print 
out) which are available as an option. PCM-H64 is able to install any of the plug-in options. 

Multiple PCM-H64 cards can be installed to give more DSP power and extra I/O above 64 channels. 

DSD8 

Is our top of the range Mastering Platform, which includes DSD recording and processing and SACD Mastering 
and Authoring facilities. DSD8 has 8 inputs and outputs in Analog, AES/EBU, SDIF2, SDIF3, and optional MAC-
DSD format. 

This has full capability as described in this manual, and all current plug-ins can be installed on this hardware. 
DSD operation and SACD Mastering and Authoring are available in a separate manual describing "DSD Mode" 
of operation. 

BB2, BB2-J & PCM2 

These are based on the BB2 hardware platform - the BB2 and BB2-J are USB2 devices that include the SADiE 
DSP in an external box. As standard, they run the BB2 software, which has streamlined functionality aimed at 
Radio Production. BB2 software has its own manual and help file. 

The BB2-J (which includes a Jog Wheel controller) is also available as part of the PCM2 package, which can run 
a variant of the standard SADiE software, which is described in this manual. 

PCM2 has full software capabilities except for:- 

No Mastering facilities (DDP, PQ bursts, PQ print-outs) (but available as an option) 

No Sync or RS422/9-pin capability 

Restricted to 8 streams in the Playlist (at up to 48KHz sampling) 
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BB2 and standard SADiE software are compatible and thus EDLs can be transferred from one to the other. 

PCM2-24V 

PCM2-24V is another variant of the PCM2 software which includes the AVI playback option as well as 
extending the track playback capability of the BB2 to 24 tracks. 

HARDWARE CONTROLLER FUNCTIONS 

 
Firstly, a blatant plug: the hardware controllers are brilliant! They really speed up your work, and after a 
couple of hours you'll wonder how you ever managed without them. If you've already got some, read 
on. If not, have a word with your SADiE dealer and try them out! 

When you first connect your hardware controllers, you will need to initialise them by selecting them to a 9-pin 
channel. This is done in the "9-Pin Control" section of the Setup window. 

The controls on the hardware controllers apply to whichever is the active window on the screen. Therefore in 
many cases you will need to use the WINDOW button to select the required window before using other 
controls. 

The SHIFT button on the hardware controllers doesn't need to be held down unless you are following it with 
more than one further button push. 

The ASSIGN key is latching and affects other button actions until it is released. 

 

EDIT / JOG PANEL 

SCRUBWHEEL Is used for audio jog/shuttle and, in other modes, selection. The mode is 
selected by the SCRUB button and will apply to the active window, as selected 
by the WINDOW button. 

ONLINE Puts the selected external machine on line for control by SADiE and puts SADiE 
on line for timecode synchronisation. 

SLIP Turns Slip on/off (the cross/tick button in Autoplace toolbar). Turning Slip on 
will enable left or right slipping as pre-selected on the Autoplace toolbar or 
status bar display. 

AUTO If the Playlist is active, this turns the automation display on/off for all Streams. If 
the Mixer is active, this enables automation. 

LOCK Locks all Streams to EDL time. SHIFT + UNLOCK will unlock all Streams 
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STREAM  Allows Stream selection: Both the wheel and the PREVIOUS/NEXT buttons 
select the Stream by moving a red highlight around the Stream enable button on 
screen. Then using EDIT/SELECT enables/disables that Stream. 

Pressing SHIFT + EDIT/SELECT changes the status of a group of Streams: 
Select one stream, SHIFT + SELECT another, and all in between will get 
toggled (similar to Explorer). 

CLIP  The Wheel selects EDL Entries on enabled Streams in order. Used with 
IN/OUT/HOT, it will jump the cursor to the appropriate point. 

ZOOM The Wheel changes the horizontal zoom. 

SHIFT + ZOOM The Wheel changes the vertical zoom. 

PREVIOUS/NEXT If the Playlist is active, these select the previous/next EDL Entry and jump the 
cursor to the selected IN/HOT/OUT point. If the STREAM button is on, 
they select the previous/next Playlist Stream. If the Trim Editor is active, they 
select the previous/next Entry in it. If the Clipstore is active, they select the 
previous/next Clip in it. 

WINDOW Toggles through which window is active. 

END Moves the cursor to the end of the last Entry in the EDL. 

SHIFT + END Moves the cursor to the start of the first Entry in the EDL. 

PLAY/STOP/REC/PAUSE Produce toast from floppy disc slot! Well, what do you think??? 

CROSSFADE In Playlist Editing mode this selects the inside fade point, e.g. the end of the fade-
in if IN is selected, the start of the fade-out if OUT selected. 

SHIFT + CROSSFADE Selects the outside point of the fade. 

EDL/SOURCE Switches between edit modes: EDL with no light on, Source with light on. 

EDIT/SELECT 1. Selects Streams (as above). 

2. Selects EDL Entries: With no IN/OUT/HOT point selected, it will 
select the Entry under the cursor on the first enabled Stream. (SHIFT + 
SELECT gives multiple selection as described above) 

3. Turns on Playlist Editing mode: With an IN/OUT/HOT point lit it will 
put the Entry under the cursor into editing mode, working on the 
selected IN/HOT/OUT point. PREVIOUS/NEXT will then select 
another Entry for editing. 

RAZOR Razor cut on enabled Streams. 

CUT/COPY/PASTE Clips and EDL Entries to/from all windows. Pasting into an EDL pastes the in-
point at the current cursor position on the lowest numbered, enabled Stream. 

IN/HOT/OUT In the Trim editor, and in the Playlist with Playlist Editing mode on, select the 
point for adjustment and jump the cursor to that point. 

GRABTIME The label on this button is highly illogical! This button toggles audible scrubbing 



SADiE v5.4 PCM Manual 

366 

on and off, whilst keeping an Online 9-pin device in scrub. 

LOCATE + F1-F12 Sets or Locates to a numbered locator. F11 and F12 work as the Left and Right 
locators. 

SHIFT + LOCATE + F1-
F12 

Overwrites an existing locator point. 

PREVIEW Previews an edit in Playlist Editing mode or the Trim Editor. 

SAVE Duplicates "File", "Save" on the menu bar, so saves the current EDL, Clipstore, 
Mixer, etc. The exception being when the Project window is active, the button 
will save the Project and all of its components. 

F1-F12 Programmable function keys, which can be assigned in the Setup window. There 
are four banks in all: F1-F12, SHIFT + F1-F12, ASSIGN / F1-F12, and 
ASSIGN / SHIFT + F1-F12, giving 48 possible Hotkey actions. 

ASSIGN / F5, F1, F2, F3 Nudges the selected EDL Entry up, left, down, right as per buttons in Autoplace 
toolbar. 

F12 Default Hotkey to turn the waveform display on/off for all Streams 

SCRUB Toggles the Scrubwheel action through Jog / Shuttle / Move cursor. There is a 
Setup Preference under Setup / Transport Controls / Scrub Wheel / Enable 
hardware controller shuttle - when unticked the Scrub button is a two-way 
toggle between Jog and Move Cursor; when ticked it provides the three way 
toggle including shuttle mode. 

UNDO Undo. 

SHIFT + UNDO Redo. 

FADER PANEL 

MUTE Mutes the selected strip. 

SHIFT + MUTE Solos the selected strip. 

ASSIGN + Left/Right arrows Bank select - will select the next eight Mixer strips. 

ASSIGN + Up/Down arrows Changes faders from Level control (Fd in top left LED) to Pan (Pn 
in LED) 

SELECT Selects this strip's processing for adjustment. Strip number appears 
in top left LED and processing strip is displayed. 

Up/Down arrows Toggles through the selected strip's processes for adjustment by 
rotary knobs. Knobs A-F control the section parameters from the 
top down. 

EQ Allows direct selection of the EQ sections 
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CMP Allows direct selection of the compressor sections. 

ASSIGN + MUTE Bypasses all processing on the strip. 

SHIFT + SELECT Reassigns the fader to a new on-screen Mixer strip. Move the fader 
and the new strip number is shown by the LED, Let go of the fader 
and it selects. 

OVERWRITE/TRIM/AUTORETURN Changes the automation mode. 

These controls also apply to the single fader on the edit / jog panel.  

PLAYLIST BUTTONS 
What do all the little buttons in the Playlist do? And where can I find a function on the Playlist toolbars? 

There are two tables, the first listing the toolbars and the names of each button on each toolbar. 

There second lists Playlist functions in alphabetical order (including some aliases or common names), and tells 
you which toolbar it belongs to. 

 

 

LIST OF PLAYLIST TOOLBARS AND THEIR BUTTONS 

What do all the little buttons do? 

(in the Help file )Click on the link to jump to a part of the help-file which describes the button in more detail. 
The button names are listed as they appear, left to right, (or top to bottom) along the toolbar. 

To see a cross-reference, listing functions alphabetically and telling you where to find, see Playlist Functions. 

Don't forget that you can find out the name of a button in SADiE by hovering over it with the mouse and 
waiting for the yellow pop-up box. 

 

Main Playlist Tools 

 Select Toolbars - this is a pretty important button as pressing it gives access to all the other Playlist 
toolbars! 

 Razor 

 Scissors 

 Glue 

 Remove Gap 

 Undo 

 Redo 

 

Paste Tools 

 Paste 

 Paste to current time 
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 Cut 

 Copy 

 

Group Tools 

 Group 

 Ungroup 

 

Bounce Tools 

 Clip details 

 Copy to Clipstore 

 Bounce 

 Offline Bounce 

 

Load/Save Tools 

 Load EDL 

 Save EDL 

 

Edit Tools 

 Open Trim Editor 

 Enable Playlist Editing 

 Enable Region Editing 

 

Window Tools 

 Show Project Window 

 Show Clipstore 

 Show Mixer 

 Show/hide Transport Controls 

 

Automation Edit Tools 

 Insert automation point 

 Automation Dip mode 
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 Smooth Automation 

 

Autoplace Tools 

 Autoplace On/Off 

 Autoplace Mode Selection 

 Snap ... to Quantise 

 Quantise to ... 

 

Slip Tools 

 Slip On/Off 

 Slip Left 

 Slip Right 

 

Lock Streams Tools 

 Lock Streams 

 Unlock Streams 

 

Nudge Tools 

 Nudge Left 

 Nudge Right 

 Nudge Up 

 Nudge Down 

 

Region Edit 
Tools 

 Region Edit On/Off 

 Razor Region 

 Reset Region 

 View all region 

 View Left edge 

 View right edge 

 Show sample values 

 CEDAR DeClick 
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 CEDAR DeThump 

 Select Region start 

 Select Region end 

 Preview from 

 Preview through 

 Preview whole region 

 Preview up to 

 Hop-over preview 

 Region insert mode - when copying 

 Region Overwrite mode - when copying 

LIST OF PLAYLIST FUNCTIONS 

This is a cross reference, which lists the Playlist functions in alphabetical order and tells you which toolbar to 
find them on. 

Toolbars referred to can be shown by pressing the Select Toolbar button and choosing the appropriate toolbar 
from the drop down menu. 

To see a list of Playlist Toolbars and their buttons see Playlist Toolbars. 

Function Alternative Name Toolbar 

 
Automation Dip Mode Duck, Dip Automation Edit Toolbar 

 
Duck Automation Dip mode Automation Edit Toolbar 

 
Smooth Automation  Automation Edit Toolbar 

 
Insert automation point  Automation Edit Toolbar 

 

 
Autoplace On/Off  Autoplace Toolbar 

 
Butt  Autoplace Toolbar 

 
By hotspot  Autoplace Toolbar 

 
By track start (sync)  Autoplace Toolbar 

 
End to current time  Autoplace Toolbar 

 
Gap With separation Autoplace Toolbar 
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Hotspot to current time  Autoplace Toolbar 

 
Now To current time Autoplace Toolbar 

 
Start time By track start (sync) Autoplace Toolbar 

 
Sync By track start (sync) Autoplace Toolbar 

 
To current time  Autoplace Toolbar 

 
To original EDL time  Autoplace Toolbar 

 
With separation  Autoplace Toolbar 

 

 
Bounce  Bounce Toolbar 

 
CEDAR DeClick DeClick Region Editing Toolbar 

 
CEDAR DeThump DeThump Region Editing Toolbar 

 
CEDAR Retouch Retouch Region Editing Toolbar 

 
Clip details  Bounce Toolbar 

 
Clipstore show Show Clipstore Windows Toolbar 

 
Copy to Clipstore  Bounce Toolbar 

 
Copy  Paste Toolbar 

 
Cut  Paste Toolbar 

 
DeClick CEDAR DeClick Region Editing Toolbar 

 
DeThump CEDAR DeThump Region Editing Toolbar 

 
Enable Playlist Editing Playlist Edit Edit Toolbar 
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Enable Region Editing Region Edit Edit Toolbar 

 
Glue  Playlist Tools 

 
Group  Group Toolbar 

 
Load EDL   Load and Save Toolbar 

 
Lock/unlock Streams  Lock Toolbar 

 
Mixer Show Show Mixer  Windows Toolbar 

 
Nudge Down  Nudge Toolbar 

 
Nudge Left  Nudge Toolbar 

 
Nudge Right  Nudge Toolbar 

 
Nudge Up  Nudge Toolbar 

 
Offline Bounce  Bounce Toolbar 

 
Open Trim Editor Trim Editor Edit Toolbar 

 
Paste to current time  Paste Toolbar 

 
Paste  Paste Toolbar 

 
Playlist Edit Enable Playlist Editing Edit Toolbar 

 
Project window show Show Project Window Windows Toolbar 

 
Razor  Playlist Tools 

 
Redo  Playlist Tools 

 

 
Region Edit Enable Region Editing Region Editing and Editing 

Toolbar 
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Hop-over preview  Region Editing Toolbar 

 
Preview from  Region Editing Toolbar 

 
Preview through  Region Editing Toolbar 

 
Preview up to  Region Editing Toolbar 

 
Preview whole region  Region Editing Toolbar 

 
Razor Region  Region Editing Toolbar 

 
Region insert mode (when 
copying) 

 Region Editing Toolbar 

 
Region Overwrite mode (when 
copying) 

 Region Editing Toolbar 

 
View all region  Region Editing Toolbar 

 
View Left edge  Region Editing Toolbar 

 
View Right edge  Region Editing Toolbar 

 
Select Region start  Region Editing Toolbar 

 
Select region end  Region Editing Toolbar 

 

 
Remove Gap  Playlist Tools 

 
Retouch CEDAR Retouch Region Editing Toolbar 

 
Save EDL  Load and Save Toolbar 

 
Sample values Show sample values Region Editing Toolbar 

 
Scissors  Playlist Tools 

 
Select Toolbars Toolbars show Playlist Tools 



SADiE v5.4 PCM Manual 

374 

 
Show Clipstore  Windows Toolbar 

 
Show Mixer  Windows Toolbar 

 
Show Project Window  Windows Toolbar 

 
Show sample values Sample values Region Editing Toolbar 

 
Show/hide Transport Controls Transport Controls show Windows Toolbar 

 
Slip left  Slip Toolbar 

 
Slip On/Off  Slip Toolbar 

 
Slip right  Slip Toolbar 

 
Toolbars show Select Toolbars Playlist Tools 

 
Transport Controls show Show/hide Transport Controls Windows Toolbar 

 
Trim Editor Open Trim Editor Edit Toolbar 

 
Undo  Playlist Tools 

 
Ungroup  Group Toolbar 

CONTROL BY CONSOLE 

CONTROLLING SADIE WITH A CONSOLE 

It is possible to control some of SADiE's functions from a mixing console or third party hardware controller. 

Currently this uses MIDI, either via MIDI DIN connectors or USB, depending on the device. 

Currently (as of v5.3) we support:- 

 HUI protocol 

 Mackie Universal Control Protocol 

Specific known working devices are :- 

 Yamaha's current range of consoles: 
DM200O 
DM1000 
O2R96 
O1V96 

 Mackie Universal Control  
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 SSL AWS 900 

MIDI CONTROLLER SETUP 

The top section of this page - MIDI Controller Protocol - sets up preset protocols to work with specific 
known devices.  

"None" is a generic HUI protocol, which doesn't have the special functions for the other named consoles. 

"Mackie" is the selection for Mackie Control protocol. 

The bottom section - Manual Controller device configuration - is where you set up the MIDI ports, as 
described in more detaill below. 

 

 

 

MACKIE & HUI CONTROL 

This describes how to set up the Mackie Universal Control, but these instructions will cover any HUI 
controller that connects via regular MIDI connections. 

INSTALLING THE MACKIE UNIVERSAL CONTROL 

The Mackie Universal Control is a hardware control surface only and, unlike the Yamaha consoles, does not 
have any audio mixing capabilities. 

The Mackie Universal Control attaches to the PC via MIDI cables (using DIN connectors). Thus you will need a 
MIDI interface in your PC in order to attach the Mackie. 

For what it's worth, we can recommend a M-Audio Midisport 4X4 which has the advantage of being connected 
via USB, hence there is no need to open up the PC to install a MIDI card. In our case, we installed drivers for 
the MIDI interface; there's no need for drivers for the Mackie Control itself. 

All HUI devices require a MIDI port for each set of 8 faders, thus the Universal Control will need one MIDI In 
and one MIDI Out, whereas for instance the SSL AWS 900 which has 24 faders, requires 3 x MIDI In and 3 x 
MIDI Out. 

SETTING THE PROTOCOL 

The Mackie Universal Control can operate under three different protocols - "Mackie Control", "HUI", and 
"Logic Control"; SADiE can work with two of those - the HUI or the Mackie Control. 

To set the Protocol on the Mackie,(and perhaps it's a good idea to check how this is set the first time you try it 
with SADiE)  press the Channel 1 and 2 SELECT buttons, then power up the Control. You will see a menu in 
the display which allows you to choose between the three protocols - press the Ch. 1 Pot for Mackie Control 
or the Ch4 pot for HUI. 



SADiE v5.4 PCM Manual 

376 

SETTING UP SADIE TO USE THE MACKIE 

 
Under SADiE's View menu, select the Setup Window item, and then view the MIDI Controllers page as 
above. 

The top section of this window sets the Protocol, as well as setting up some of the specific controls that are 
available on each control surface. 

For the Mackie Control select Mackie. 

Alternatively for HUI tick None. 

Also you will need to set which MIDI Port(s) the Mackie Control is connected to.  

As you would expect, you should connect the Mackie MIDI In to the PC's MIDI Out and vice versa. 

In SADiE's MIDI Controllers setup page 

1. Set type to HUI (even if Mackie Control is the chosen protocol) 

2. Set channels to 8. 

3. From the drop-down list, choose the PC's MIDI In port(s) which is connected to the Mackie's Out 
port . 

4. From the drop-down list, choose the PC's MIDI Out port(s) which is connected to the Mackie's In 
port . 

5. Exit SADiE and re-enter to complete the setup. 

MACKIE CONTROL AVAILABLE FUNCTIONS 

 8 Faders 

 Solo buttons above faders 

 Mute buttons above faders 
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 Rec/Rdy Buttons (Record enable) 

 Pans and Pan displays 

 “Scribble Strip” displays first few characters of the Sadie mixer strip’s input 

 Stream level Metering under Scribble strip 

 Transport Controls - Play, stop record etc. 

 Data Wheel locates the playlist. 

 User Defined keys (1-12) – these are set as “HWC F1- F12” in SADiE’s hotkey setup. 

 Time Display 

 

Also there  is a hotkey inside SADiE,(and thus triggered from SADiE, although  this could be mapped to a 
“User Key” on the console) to “Bank Toggle”. This is set under Setup\Hotkeys\MIDI Controllers. This will shift 
the faders and Solo/Sel buttons up by 8 (thus the faders will control faders 9-16 in SADiE). 

  

 

 

YAMAHA HUI CONTROL 

This section describes how to set up the Yamaha consoles – DM2000, DM1000, O2R96, O1V96, which utilise 
a USB connection for MIDI. 

Functions supported will depend on the console.  

SETTING UP THE CONSOLE   

follow the instructions for the console for connecting to ProTools. These are available from the Yamaha Web 
site. 

http://www.yamaha.co.jp/english/product/proaudio/ has a download section for each console, and the doc you 
want is under “Other”  

ie. 

http://www.yamaha.co.jp/english/product/proaudio/download/utility_lib/dm2000/others/othersbox/dm2000_nue
ndo_2.pdf  

While you’re there, get the USB MIDI driver from:- 

http://www.yamaha.co.jp/english/product/proaudio/download/utility_lib/usb_midi/usbmidi_win.htm 

 

In short (there are slightly different buttons on each console). 

YAMAHA DRIVERS 

1. Copy the Yamaha USB-MIDI driver disk to the SADiE PC 

2. Connect the console via a USB cable to a USB2 port on the SADiE PC. 

3. At this point some “plug and play” will be triggered and the PC will ask for drivers. Point the plug-and-
play dialog to the location of the Yamaha drivers. 

4. You will need to re-boot the PC after installing the drivers. 
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TURN ON THE YAMAHA REMOTE MODE 

 
1. Use the “Display Access” button to go to the MIDI/Host page (F4 under the LCD display) 

2. Move around the page using the cursor controls. Check that “To Host Serial” is set to PC 

3. Move to “DAW” and select USB. On the DM2000 it will use 4 ports, on the O1V96 it’s only two. 
Choose ports 1-4 (or 1-2)  
 

 
4. Press “Display Access” again then F1 under the LCD to get to Remote Page 1 

5. Use the Cursor keys to get to “Target” then the data entry wheel to select “Protools”  

6. Then Press the “Layer/Remote 1” Button to enable the remote layer. 

7. Note that the message “DM2000 has gone off-line ….” will remain on the screen. 
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SETTING UP SADIE FOR YAMAHA CONTROL 
 

 

1. Go to : View menu; Setup Window; select MIDI Controllers on the left side; tick “DM2000”. For 
other consoles, either select the preset if it exists, or "None".  These selectors merely set up some 
default or custom controls for the specific consoles, you will still need to set up the MIDI ports. 

2. Under "Manual controller device configuration" you will need to set the send and receive channels for 
the MIDI. Controllers use 1 MIDI channel for each 8 faders. Thus if the console has 24 faders (i.e. the 
DM2000), you must set up 3 separate MIDI channels as the diagram above, whereas i.e. the O1V96, 
which has only 16 faders, requires only the first two channels to be set. 

3. It may be necessary and advisable to re-start SADiE after selecting this. 

DM2000 AVAILABLE FUNCTIONS: 

 Faders 

 Solo buttons above faders 

 Sel Buttons (Record enable) 

 Pans and Pan displays 

 “Scribble Strip” displays first few characters of the Sadie mixer strip’s input 

 Transport Controls 

 Data Wheel locates the playlist. 

 Locate Memories (1-8) Display + Locate number is store. 

 User Defined keys (1-12) – these are set as “HWC F1- F12” in SADiE’s hotkey setup. 

 PPM displays on meter bridge. 

 Time Display 
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Also there  is a hotkey inside SADiE, (and thus triggered from SADiE, although  this could be mapped to a 
“User Key” on the console) to “Bank Toggle”. This is set under Setup\Hotkeys\MIDI Controllers. This will shift 
the faders and Solo/Sel buttons up by 24 (thus the faders will control faders 25-48 in SADiE). 

 

The other three consoles that support Yamaha HUI Control will have different facilities.  

O1V96 

We have used the 01V96,this has some differences: 

 No Pans 

 Scribble strip is in the main display (Meters tab). So too are the PPM displays 

 No Transports 

 Data Wheel does not send MIDI messages 

 No Locates 

 The User Defined keys do not send MIDI. However we’ve programmed “Fader Mode” keys (which 
do) to User Keys 1-7 
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